PREFACE

Thank you for purchasing the LT integrated development software, "LT
Editor Ver. 2.0”, hereafter referred to asthe “LT Editor".

Please read this manual carefully in order to use this software properly, and
be sure to keep this manual handy for future reference.

NOTES

(1) The copyrightsto all programs and manualsincluded inthe LT Editor
Ver. 2.0 Operation Manual - Screen Creation Guide (hereinafter
referred to as "this product™) are reserved by the Digital Electronics
Corporation. Digital grants the use of this product to its users as
described in the " Software Operating License Conditions' documenta-
tion, included with this product's CD-ROM. Any actions violating the
above-mentioned conditions are prohibited by both Japanese and
foreign regulations.

(2) The contents of this manual have been thoroughly inspected. How-
ever, if you should find any errors or omissionsin this manual, please
inform your local LT Editor representative of your findings.

(3) Regardless of article (2), the Digital Electronics Corporation shall not
be held responsible for any damages or third party claims resulting
from the use of this product.

(4) Differences may occur between the descriptions found in this manual
and the actual functioning of this product. Therefore, the latest infor-
mation on this product is provided in datafiles (i.e. Readme.txt files,
etc. ) and in separate documents. Please consult these sources as well
as thismanual prior to using the product.

(5) Even though the information contained in and displayed by this prod-
uct may be related to intangible or intellectual properties of the Digital
Electronics Corporation or third parties, the Digital Electronics Corpo-
ration shall not warrant or grant the use of said properties to any users
and/or other third parties. Digital Electronics Corporation accepts no
liability for issues related to the intellectual property rights of third
parties or any issues related to the use of the information contained in
or displayed by this product.

(6) The specifications set out in this manual are for overseas products
only. As aresult, some differences may exist between the specifica-
tions given here and for those of the identical Japanese product.

o —————— —————— — — — — — — — — — — — — — — — — — — — — — —— —

© Copyright 2002 Digital Electronics Corporation. All rights reserved.
Digital Electronics Corporation, November 2002

The LogiTouch isreferred to as"LT" in this manual.
For the rights to trademarks and trade names, see “TRADEMARK RIGHTS".
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TRADEMARK RIGHTS

All company or product names used in this manual are the trade names,
trademarks (including registered trademarks), or service marks of their
respective companies.

This product omits individual descriptions of each of these rights.

Trademark / Trade Name Right Holder
Microsoft, MS, MS-DOS, Windows, Windows
95, Windows 98, Windows Me, Windows NT,
Windows 2000, Windows XP, Windows
Explorer, Microsoft Excel 95

Intel, Pentium Intel Corporation, USA

Digital Electronics Corporation

(in Japan and other countries)

Ethernet Western Digital Electric Corporation, USA
International Business Machines

Corporation (IBM), USA

Microsoft Corporation, USA

Pro-face, Flex Network

IBM, VGA, PC/IAT

The following terms differ from the above mentioned formal trade names
and trademarks.

Termused in this manual | Formal Trade Name or Trademark
Windows 95 Microsoft® Windows®95 Operating System
Windows 98 Microsoft® Windows®98 Operating System
Windows Me Microsoft® Windows®Me Operating System
Windows NT Microsoft® Windows NT® Operating System
Windows 2000 Microsoft® Windows®2000 Operating System
Windows XP Microsoft® Windows®XP Operating System
MS-DOS Microsoff® MS-DOS® Operating System
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Version Upgrade Information

The LT Editor Ver. 2.0 features arange of new functions upgraded from the
LT Editor Ver. 1.0, including Multi-language Display function, Extended
Function of Keypad Input Display, and Parts Palette function. The following
briefly describes each function.

@ PartsPalette

The parts are displayed in a palette on the Screen Editor. The desired part
can be set up on the screen simply by selecting it from the Parts Palette and
positioning it at the desired point using the drag & drop operation.
1.3.1 Screen Editor Item Names and Functions

€ Extended Function of Keypad Input Display

This function allows you to configure the interlock setting of the pop-up
keypad. In addition, this function enables extended display format, allowing
you to select the input style using alarm and barcode reader, and display
style including the Shift Left/Shift Right and Zero Suppress modes.

2.1.14 Keypad | nput Display
€ Extended Function of Numeric Displays

This function allows you to select the display style of the Numeric display
including the Shift Left/Shift Right and Zero Suppress modes.

2.1.21 Numeric Displays
€ Extended Function of Trend Graphs

This function displays the trend data stored in a sequence of contiguous
word addresses on a single trend graph.

2.1.12 Trend Graphs
€ Keypad Parts

Some new Keypad Parts have been added.
2.1.13 Keypad Display

€ Window Registration Function on Window Screen and Window Parts

Windows registered on the Window (U) Screen can be displayed on the
Base (B) Screen as awindow. The display can be selected from Local and
Global modes. Use Window Parts to call up awindow.

2.1.20 Window Parts, 3.3 Window Display-Window Screen
€ Multi-language Display Function

The text display used for drawing/Part's L abel/Message Display/Alarm
Display (Index text) can be switched while operating the LT by using the
Index text registered via the Text Table Editor. This function allows you to
change the language and parameters of the items displayed on the screen
easly.

4.3 Text Table Editor
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& Print Function

Connect the LT Tool connector to the serial printer using atransfer cable and
conversion cable. Alarm messages, L ogging data, and hard copies of screens
can be printed with the Print function.

6.1 Menu Setting Items. LT Setup, PLC Manual 1.1.4
Content and Range of System Data Area, LT Series User's Manual

€ Address Conversion with the Global Cross Reference

The desired address can be converted viathe global crossreference that lists
the address-all ocation status of the entire Project file.

2.9.7 Cross Reference/Global Cross Reference List
@ Project Backup Function

When saving a Project file, a backup of the most recently saved Project file
is saved in abackup file (* .bak).

4.2.2 Backing up a Project
€ Address Conversion when changing the PLC

When changing the PL C types selected in a Project file, the conversion
pattern can be specified for the available device of the destination PLC. The
addresses belong to the specified pattern can be converted by one operation.
The conversion pattern can be edited and appended.

4.2.8 Changing the PLC and Addresses

B New PL C Protocol
» Fenwal Controls of Japan: Temperature Controller AL Series
» JT Engineering: Moisture Meter JE-70 Series
» Yasukawa Electric: Inverter Variable Speed G7/F7 Series, VS mini V7/J7
Series
* YokogawaM&C: UT100 Series
» MatsushitaElectric Industrial: MINAS-A/S Series
* RKC Instrument: CB/REX-F/LE100 Series
* SHIMADEN: SR253/SR90/SR80/MR13/FP93/SD16/EM 70 Series

PLC Manual
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MANUAL SYMBOLS AND TERMINOLOGY

This manual uses the following symbols and terminol ogy.

B Safety Symbolsand Terms

This manual uses the following symbols and terms to identify important
information related to the correct and safe operation of this product.

Symbol Description

Indicates a potentially hazardous situation that could result in serious injury
A or death.
WARNING

Indicates a potentially hazardous situation that could result in minor injury or
equipment damage.
CAUTION

Indicates a potentially damaging action or dangerous situation that could
result in abnormal equipment operation or data loss.

Indicates instructions or procedures that must be performed to ensure
correct product use.

e

5
8
[~
b~

Indicates instructions or procedures that must not be performed.

(3|6

B General Information Symbolsand Terms

This manual uses the following symbols and terms for general information.

Symbol Description

@\ Provides hints on correct product use, or supplementary
Nowtej information.

Indicates an item's related information (manual name, page
number).

Refers to keys on the computer keyboard.
m Keyboard Compatibility List

Indicates an external device (temperature controller, inverter,

W Reference .4

E;S/EZ:' etc.) connected via serial communications. Does not include
devices connected via the Flex Network or DIO.
T Generic name for the "LT" Graphic Logic Controller made by

Digital Electronics Corporation.

Indicates LT Version 2.0 (hereinatfter referred as "this product”),
LT Editor  [LT integrated development software made by Digital
Electronics Corporation.
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B Keyboard Compatibility List
This manual uses the following symbolsto indicate computer keyboard
keys.

The key names used by your computer keyboard may differ. Please use the
chart below for reference.

Type| PS/2 Compatible
Symbol 101 Keyboard
Esc Esc
Tab 155
Ctrl
1 Shift
Alt
Delete
SBpZ%I; Backspace
LT SERIES

The LT Editor supports the following LT models.

Series Type Product Model
Type-Al  [GLC150B-XY32SK [GLC150-BG41-XY32SK-24V

Type-Al  [GLC150B-XY32SC |GLC150-BG41-XY32SC-24V
Type-B GLC150B-RSFL GLC150-BG41-FLEX-24V
Type-B+ [GLC150B-XY32KF |GLC150-BG41-XY32KF-24V
Type-C GLC150B-XY32SK  |GLC150-BG41-RSFL-24V
GLC150B-ADK GLC150-BG41-ADK-24V
Type H1I  |GLC150B-ADPK GLC150-BG41-ADPK-24V
GLC150B-ADTK GLC150-BG41-ADTK-24V
GLC150B-ADC GLC150-BG41-ADC-24V
Type H2  |GLC150B-ADPC GLC150-BG41-ADPC-24V
GLC150B-ADTC GLC150-BG41-ADT C-24V
Type D GLC150B-DNM GLC150-BG41-DNM-24V

LT Series

@V\ote: For thetypes of Device/PL Cssupported by the LT Editor, pleaserefer to the
2] " Device/PLC Connection Manual”.

HOW TO USE THIS MANUAL
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HOW TO USE THIS MANUAL

B Structure of the Manual

The"LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide" isthe
second in a series of manuals for this product and explains how to use the
LT Editor. There are three other manuals in the series as well as online help.
Please refer to "Chapter 1 LT EDITOR FUNDAMENTALS' for an over-
view of this product.

1.6 LT Editor Manuals and Help

In addition to these manuals, data files containing supplemental information
on updated functions are also provided.To read these additional datafiles,
click on the [Start] button in your Windows OS main screen and select the
[Programs] - [Pro-face] - [LT Editor] menu. Then, click on the [Readme]
selection.

For detailed information on LT series of operator interfaces, please refer to
the"LT Series User’'s Manua". (Separately sold)

LT Editor Describes the operating procedures for the LT Editor and
Operation Manual |all functions except for Logic Program development
(this manual) (provided as a PDF fle).

Describes logic program development The manual

LT Editor consists oftwo parts, "Programming" which focuses on
the tutorial lesson to help users to learn the operation
Included on procedures, and "Functions” which explains the sofware
CD-Rom Manual setings required for the combination of the LT main unit
and the LT Editor (provided as a PDF fie).

Describes the LT Editor's pre-made Parts and symbols

Programming

Parts List .
(provided as PDF data).
Device/PLC _ _ .
Connection De;crlbes the methods for cqnnecnng the Device/PLC of
various manufacturers (provided as a PDF file).
Manual
Available on Describes the methods for seting the LT Editor's windows
the LT Editor|Online Help and dialog boxes, instructions and functions of logic
screen programs as well as how to seteach driver.

@\ e Address settings described in these manuals are for explanatory purposes
XNote: Only. Appropriate addresses must be set according to your requirements.

S Device/PL Cs Connection Manual
e If you have any questions about the contents of this manual, please contact
your local LT distributor. LT distributorswill answer to your technical
inquiries and provide you with technical consultation.

Software Trouble Report
If you have any question about your personal computer or Microsoft®
Windows®, please contact your PC distributor or manufacturer.
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B Chapter Breakdown

This manual contains 10 chapters and an appendix.
Thefollowing is ageneral description of each chapter:

€ CHAPTER 1: LT EDITOR FUNDAMENTALS
This chapter describes the operation of the LT Editor from start to finish. It
also explains the overall structure of the LT Editor Project Manager, Logic
Program Editor, and Screen Editor areas.

& CHAPTER 2: CREATING BASE SCREENS
This chapter describes the basic operations and terminology used for draw-
ing functions, such as*Part”, “Library”, and “D-Script”.

€ CHAPTER 3: DRAWING APPLICATIONS: CREATING AND USING
SCREENS
This chapter describes the procedures for creating and using various screens,
such asthe M (Mark) Screen and | (Image Library) screens, which enable
you to create high-quality images and provide advanced-level functionality.

& CHAPTER 4: SCREEN AND PROJECT MANAGEMENT
This chapter describes the procedures for editing and saving created screens
and project files, and information management procedure.

€ CHAPTER 5: CREATING AND EDITING ALARMS
This chapter describes the alarm creating and editing procedures.

€ CHAPTER 6: LT INITIAL AND SYSTEM SETTINGS
This chapter describes the initial setup procedure required to usethe LT
display unit. For details, please refer to the online help or the users' manual
for the LT main unit.

€ CHAPTER 7: TRANSFERRING DATA
This chapter describes the procedures for sending screens and logic pro-
grams created with the LT Editor to an LT display unit.

& CHAPTER 8: SSMULATION
This chapter describes the procedures for simulating the operation between
an LT and LT Editor.

€ CHAPTER 9: PRINTING
This chapter describes the procedure for printing created screens.

& CHAPTER 10: ADVANCED FEATURES
This chapter describes the procedures for using the LT Editor's advanced
functions such asfiling data (recipe) and logging functions.
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€ APPENDI X
e Error Messages
Lists the error messages, causes of the errors and solutions that will be
displayed during operation of LT Editor.

* Troubleshooting
Providesinformation for diagnosis and corrective actions for dealing with
errors or abnormal operation.

* Address Conversion Tables
Lists the addresses for each manufacturer’s product.

» Software Trouble Report

Thisisaform in which you can write down any trouble you might have with
the LT Editor and your LT Editor’s operating conditions that can then be
sent to us by facsimile. If you have any inquires about the LT Editor, please
use this form.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 9
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PRECAUTIONS

B CD-ROM Usage Precautions

To prevent CD-ROM damage or malfunctions, please observe the following
instructions:

* Do not remove the CD-ROM from the CD-ROM drive while the drive’s
operation lamp is lit.

Do not touch the CD-ROM recording surface.

« Do not place CD-ROMs in a place where they may be exposed to extremely
high or low temperatures, high humidity, or dust.

B Product Usage Precautions

To prevent program malfunction or accidents, be sure to observe the follow-
ing instructions:

A Touch panel switches should NOT be used for a

warning device’s Emergency Stop Switch. Generally speak-
ing, all industrial machinery/systems must be
equipped with a mechanical, manually operated
emergency stop switch. Also, for other kinds of
systems, similar mechanical switches must be
provided to ensure safe operation of those sys-
tems.

+ Do not turn off your personal computer’s power switch during the execu-
tion of a program.

« Do not change the contents of this product’s project files using the Text
Editor software.

10 LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide
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@ Drawing

* ThelLT Editor’s display screen and descriptions used in the manuals are
based on the color display when the LT main unit isin the "REVERSE"
L CD mode. Please note that white/black color on the LT Editor screen and
LT main unit screen will be reversed when the LCD isin the "NORMAL"
mode.
LT SeriesUser’'s Manual

*  When arranging characters on atiling pattern, the dot patterns of character may overlap
with the tiling pattern; as the result, the characters will not be displayed properly on
the LT when the same color is selected for the characters and thetiling pattern. In such
acase, re-arrange the characters by displacing the position by 1 dot.

*  WhenanLT unitisverticaly instaled, the panel’s coordinates will differ from those
used on the screen editor software. Therefore, when you enter screen coordinates
using tags or D-Script, please consider the LT’s orientation.

(0. 0) on the screen editor software

(0. 0) on the LT series’ panel

€ Functions and Settings

e Certain functions and settings supported by the LT unit are not supported
by the LT Editor program, and vice versa.

[Setting and functions set viathe LT unit (Not by LT Editor) ]

- Language Font selection
- LT Date/Time settings
- LT Sdf-Diagnosis Function

[Functions and settings supported by LT Editor only (Not by the LT
unit)]

The following settings are included in the “LT System Settings’ area:

"Checksum Verification" settings

- Screen Change Order in hierarchical display mode

- Screen Change according to standby mode time

- Shift to OFFLINE mode settings

- Setting the frequency of Keypad Display processing performed per
scanning time

- LT unit'sinterna memory (LS area) backup function settings

- "Error Display Reset" settings

- "Watch Dog" settings (Communication monitoring between the LT
and the Device/PLC)

- Communication Monitoring Period settings (Designate transmis-
sion walit time)

- Printing settings (Settings for printing functions with Tool connec-
tor)
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12

€ Logic Program Restrictions

Variables (Logic symbols) are processed in 32-bit order.

Values different from the input values may display during monitoring due
to the difference in the real number accuracy between a personal com-
puter and the LT.

If the LT'slogic time (scan time) becomes too long, the sampling time
designated for the trend graph may not be accurately maintained.

All LT Retentive Variable datais retained by SRAM backup memory that
uses alithium battery. The battery's back up period |asts approximately
60 daysinitsinitial condition (fully charged), and approximately 6 days
when the battery lifeis amost finished. If you need to back up datafor a
longer period, you need to either use back up datain your host computer,
or configure the Editor system so that the Editor can back up data.
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LT EDITOR FUNDAMENTALS

T his chapter describes LT Editor basic operations such ashow to start
and quit the software. It also explains the Project Manager and Screen
Editor areas, which are used for the majority of screen creation work. Also,
anumber of tools are introduced here, such as online help, which provide
explanations of LT Editor functions and operations.

L L e Overview
L2 From Start to Finish
L o ———— Project Manager
L4 s L ogic Program Editor
L e Screen Editor
16 LT Editor Manualsand Help
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Chapter 1 - LT Editor Fundamentals 1.1 Overview

m Overview

The LT provides I/O control functions and can also be used as an operating
swich and adisplay.

LT Editor isthe LT integrated devel opment software, providing both an LT
L ogic Programming environment and screen creation and editing capabili-
tiesfor creating LT display screens.

B Programming Functions
Utilizing Window's easy-to-use interface, you can quickly and easily de-
velop logic programs that conform to the IEC 61131-3 standard .
LT Editor provides I/O drivers that can be selected according to the LT type.
Logic programs are developed with the LT Editor's Logic Program Editor.

For more information on the Logic Program Editor, please refer to the online
help. Also, the "L ogic Programming Operation Manual" provides tutorials
for learning logic programming procedures as well as providing lists of
instructions and variables used in Logic Programs. It aso explainsthe
operation of the LT main unit.

B Drawing Functions
You can create a screen by drawing objects and placing Parts.

A large variety of pre-made Parts and D-Scripts alow you to quickly display
various operations and objects.

A set of logic programs created with the Logic Program Editor and a Part's
display function enable you to make a drawing that corresponds to logic
program operations. For example, you can show the variables on the LT
screen and set avalue to the variable using a touch panel switch.
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1.1 Overview Chapter 1 - LT Editor Fundamentals

@ Prior to Operating the LT ]

Follow the procedure below to create projects for the LT unit.

1. Preparation —Before using the LT, make sure that you have all the
required hardware and have read all the specifications,
wiring, and installation information.

LT SeriesUser’'s Manual, Chapter 2 —* Specifications’ and
Chapter 3 —"Installation and Wiring”
2. Design Screen — Design a screen layout and create alogic program.

3. Install theLT Editor —Install the LT Editor on a PC.

LT Editor CD Jacket (included with the LT Editor)
4. Develop Logic Program —Usethe LT Editor to develop alogic program
and set the operation mode.

LT Editor Operation Manual — Logic Programming Guide
5. Create Screen/Run Screen Setup — Usethe LT Editor to set up the
screen and parts based on your screen design.

LT Editor Operation Manual — Screen Creation Guide

6. Transfer the Screen Data and a L ogic Program — Usethe LT Editor on
your PC to transfer the data and alogic program to the LT
unit.

LT Editor Operation Manual — Screen Creation Guide
7. Monitor Logic Program — Check the transferred logic program through
the monitor feature of the LT Editor.

LT Editor Operation Manual — Logic Programming Guide
8. Initializethe LT —Initialize the LT, based on how you will useit.

LT SeriesUser’s Manual, Chapter 6 —“Initializing the LT”
and LT Editor Device/PLC Connection Manual
9. Operation — Runthe LT by connecting it to an Device/PLC.

LT Editor Device/PLC Connection Manual
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1.2 From Sart to Finish

p From Start to Finish

This section describes the LT Editor program’s operation flow from start to

finish.

Usage Pattern |

Create/Edit a
Logic Program
with the Logic
Program Editor.

Create/Select a
Start — project file with the —
Project Manager.

— screen with the — and quit the

Create/Edit a Save the project,

Screen Editor. Project Manager.

@ Getting Started

W Starting LT Editor

The following explanation assumes your PC is turned on and the Windows

desktop has appeared.

PROCEDURE

REMARKS

(2) Click on the [Start] button, and point to the
[Programsg| - [Pro-face] - [LT Editor] menu. Then,
click on the[1. Project Manager] command.

& LT Editor HAT 1 Project Manager

ey
<
5

=)
o
=
3
o
=
3

[T 1 B R (o}
£ @™ 3 T
o =
=
=1
@

-

gﬁ@ﬂ@@@ H

AL

Shut Dawn

(2) The Project Manager starts.

The Tips screen appears upon the startups. This screen
displays one-point descriptions on the new features.

[x]

Tips

__ g___ Did wou know that... )
|_—Tips screen

Multi-language tables allow you to easily -

switch between different languages

1-4

If you double-click directly on a
previously made project file (*.Ite
file) in Windows Explorer, LT Edi-
tor will automatically start.

To hidethe Tips screen, remove the
checkmark from the "Show at
Startup checkbox), and click the
[Close] button.
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PROCEDURE REMARKS

When 256 colorsis selected on the
[Display Properties] screen of the
Control Panel, the display of the
_ Project Manager may change, but
preject its functioning will not be affected.

logic (o) @ = [
Pruggrcm % *

%
E|E

Pro-face

Open alarm for ediing [Lppet, ) .4

@ Creating/Selecting/Saving a Project ]

A project file (LTE file) normally contains multiple screens and alogic
program intended for the operation of a certain system. LT Editor creates
one project file for the operation of one system, enabling system manage-
ment by project file units.

After you have transferred a project file and set up an LT, you can transfer
updated logic programsindividually to the LT.

B Creating a New Project

When you create a new project, you must designate the LT and Device/PLC
information, according to your current application.

& LT Type

Select your typeof LT.
LT Series

If your LT will beinstalled vertically instead of horizontally, be sureto
select avertical type LT. The Screen Editor will automatically create a
vertical drawing areafor you.

LT machine type LT type of project
Type AL Type A
Type A2

Type B Type BB+
Type B+

TypeC Type C
Type H1 Type H
Type H2
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@ Device/lPLC Type

1.2 From Sart to Finish

Select the type of Device/PLC to be connected to your LT unit.

This setting isrequired only when the LT isa Type-C.
Device/PLC Connection Manual

PROCEDURE

REMARKS

(1) Select the Project Manger's[Project] menu - [New]

command, or click on .

Projact ’
ploste |

Pro-fare

Open alam for edting [ Typeds Il |.£

(2) Enter adescription and select the LT (Display) and

Device/PLC. Then, clickon[ o |

[
Description:
‘Fadmyﬁ " oK L
Display Type ‘ Cancel
‘TypeC Uﬂl
PLC/Device Type:
[OMRON THERMAC NEQ SERIES =]

(3)TheLT Editor will then ask you if you wish to create
a logic program or a screen. If you click on the
| editogeregen | button, the Logic Program Editor
will start. If you click on the\' Edit Screen \button,
the Screen Editor will start. If you click on the[ cae |
button, you will go back to the Project Manager
Screen.

New

Edit Logic Program

Edit Screen

When entering a description, you
can use up to 60 single-byte char-
acters.

To set the Device/
PLC, refer to “LT Editor Device/

PLC Connection Manual”.

1.2.3 Creating/
Editing/Saving a Logic Pro-
gram, 1.2.4 Opening/Closing/
Saving a screen.
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@Ik\l:)t If you attempt to create another project file without saving a newly created
M project file, the system asksif you wish to save the current file. If you click on

- button the [Save As] dialog box appears. If you click on the

m | ns |button, the system opens a new screen without saving the current
project file.

1.2.2 B Saving a Project File under a Different Name

B Selecting an Existing Project
Select the Project Manger's [Project] menu - [Select] command, or click on

=

et | When you select a project, the following setting screen appears.

Used to select the
folder containing the
target project file
Select

[ £ datebase lE”

Look in:

Lists the current ~_| |

folder and existing
project files B ot ot
|+ Displays_ the
Fiepame: & Manufochaing System he T | project file name
Files of type:  [Windiows Project Fies "] =l ” Carcel | selected from the
'Descmplinn : | Factory B list. .
it e [T You can specify

the project file by
typing the file

Devica/PLC Type: | OMRON THERMAC MED SERIES
\.

4l name.
Displays the project file’s Used to select the
comment and the selected project file type desired

LT unit and Device/PLC

@ File Types
The only project file that can be selected is the one created with the LT
Editor (*.Ite).

'I'Vote: Double-clicking on thefile (project file: *.Ite) itself in Explorer automatically
) startsLT Editor and opensthefile.
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1.2 From Sart to Finish

PROCEDURE

REMARKS

(1) Select the Project Manger [Project] menu’s [Select]

=

command, or click on |s.ee

(2) Select a project filefrom thelist that appears, or

typethe project file name.
Select “Factory A”

RS

File riamne: [ Manutactuing System. e i “ Open I

Files of type:  [windows Froject Files [* be] | | cencel |

Drescription : ‘ Factory B "

Dizplay Type: ‘ Typell "

Dieviee/PLE Type: \ OMRON THERMAC NED SERIES ||

To type a
_— file name
viathe

type the
file name
here.

(3) Click onthe[ oeen ] button to open the selected

file.

B Saving aProject

keyboard,

To select a project file located in
another folder, find a desired file
from the“Look in: (Filelocation)”.

When you double-click on thefile
name selected in step (2), you can

skip the command.

To create a screen,
refer to 1.2.4 Opening/Closing/
Saving a Screen.

When the data of an existing project file is changed, the changes will be automati-

cally saved.

However, if you attempt to create aanother new project file without first saving your
current project file, the LT Editor will ask if you wish to save the current file. If you

click onthe[ ves ]button, the [Save As] dialog box will appear.
1.2.2 W Saving a Project File under a Different Name
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B Saving aProject Fileunder a Different Name
You can save an existing project file under a different name or with different LT
type/Device/PLC settings.

PROCEDURE REMARKS

(1) Select the [Project ] menu - [Save As] command in
the Project Manager.

(2) Thecomment, LT type and Device/PLC of thecur- | Thefile name can contain up to 255
rently opened project file are displayed. characters(including the path-name

Enter the desired file name, and enter the items to be and/ extension.)

changed. '\

]
Important

Save As

Save jn |ﬁ databaze

ﬁh M arufacturing Spstem. e
ﬁ B Manufacturing System e
Production Process. lte

edule Control lbe

Before changing the LT type,
check the preset data, since
the drawing area and func-

tions vary depending on the

type of the LT unit.
4.2.6 Changing a

File name:  [Schedule Control e | [ sae | Pr Oj ect'sLT Type
Save as type: [windows Project Files [*te) F] [ coned | A

Descriptian : [& Marufacturing System | |

Display Type: [Typel = Imp;rtant

Once the Device/PLC is
changed, you must change
4 the addresses of the Parts,
D-Scripts and alarms, and
perform the LT system setup
again.

Device/PLC Type: [OMRON THERMAC MED SERIES [

(3) Click on the[ _s== ]button to savethefile.

If aproject file with the same name exists, LT Editor
will ask if you want to replace (overwrite) the existing 4.2.8 Changing
project file with the project file you are attempting to | Your Project’s Device/PLC

save.

If so, click onthe[ = ] button. If you do not wish to To open another
overwritethe existing project file, click onthe[  no | | project file, referto 1.2.2 ®
button. Creating a New Project or B
Selecting an Existing Project.

& g:\Program Fitles\F'lro-fac_:;\LT\database\Schedule Control ke already exists. TO Cl OSE LT EDI =
! e TOR for Windows, refer to 1.2.5
Quitting LT Editor for Windows.
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A

. *When a Vertical LT unit is replaced with the horizontal type, or

! vice-versa, the displayed screen will rotate 90° relative to the
Important  Original data. In this case, you must edit the displayed data
using the [Rotate] command. After editing, be sure to check
the displayed data.

Example)
.
ABC
1 O 0
<
Horizontal type Vertical type
@ Creating/Editing/Saving a Logic Program ]

To create alogic program, you must move from the Project Manager to the

Logic Program Editor. Only one logic program can be created for one
project.

B Creating/Editing a L ogic Program

When the Logic Program Editor is started, the logic program being created
in the current project fileis displayed.

PROCEDURE REMARKS

(1) Select the Project Manager's[Control] menu-[Cre-
ate/Edit Controls] command, or click on .

The Logic Program Editor starts.

,
ChbFe

J[Programrming Mode

(2)Create/Edit alogic program. For detailson logic program devel -
You can insert arung and instructions as well as set 1/0 opment_, refer to Fhe Logic Pro-
configuration. gramming Operation Manual.

soft dr
%x1.0.7 %1.0.7 %0QX1.0.0

Power_On_pushbution  Power_Off_pushbutton
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B Savingalogic Program

PROCEDURE

REMARKS

(1) Select the Logic Program Editor's [File] menu-
[Save(s)] command, or click on [[&F].

Thelogic program you are saving will replace the exist-
ing program.

B Closingalogic Program

After saving the program, the Logic
Program Editor remains open.

When saving alogic program, vari-
ablesregistered with the Logic Pro-
gram Editor will be registered with
the Symbol Editor as Logic sym-
bols.

4.2.6 Symbol
Editor

A
\

]
Important

When variables are used in
adrawing, be sure to make a
drawing after saving a logic
program.

PROCEDURE

REMARKS

(1) Select theL ogic Program Editor's[File] menu - [Exit]
command.

(2) TheLogic Program Editor will close.

If you attempt to close an updated logic program with-
out saving it, the system asks if you wish to save the

current program. If you click on the button,

the system saves the updated data. If you click on the

button, the system closes the Logic Program
Editor without saving the updated data.

4 C:\Program Files\Pro-face\LThdatabaseA Manufacluring System

@ Do you want to save the changes to "C:\Program Files\Proface\L T \databasehad Manufacturing Systern'?

Mo ||| Cancel ||| Help

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

You can also close the logic pro-
gram by clicking on the x button at
the upper right corner of the Logic
Program Editor.

When saving alogic program, vari-
ablesregistered with the Logic Pro-
gram Editor will be registered with
the Symbol Editor as Logic sym-
bols.

4.2.6 Symbol
Editor

]
Important

When variables are used in
adrawing, be sure to make a
drawing after saving a logic
program.
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@ Opening/Closing/Saving a Screen ]

To create a screen, you must switch from the Project Manager to the Screen
Editor, and open a screen. This section describes the procedures for opening,
closing, and saving a screen.

B Opening a New Screen

PROCEDURE REMARKS

(1) Select the Project Manger's [Screen/Setup] menu - | Whenthe Screen Editor hasalready
[Editor] command, or click on \ been started, skip step (1).

(2) Select the Screen Editor [Screen] menu’s - [New] | Selecting the [Screen] menu’s -
command, or click on _ [Open] command or clicking on
and entering an unregistered

(3) Select the screen type. screen number can also be used to

ew open anew screen.
et — Enter the screen number and title
B when saving the screen.
1.2.4 W Saving a

Screen under a Different Name

(4 Click onthe[ ok ]button to createthedesired | Up to twenty screens can be simul-

type of screen. taneously opened.

A screen corresponding to the designated LT type will Multiple types of windows can be
appear opened on any one screen at the
"' same time.

T o

POREEBEFPEDOCHIREODEE

J_ 7201 ] Ready
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B Opening a Previously Saved Screen

Chapter 1- LT Editor Fundamentals

PROCEDURE

REMARKS

(1) Select the [Screen/Setup] menu’s - [Editor] com-

mand, or click on \ in the Project Manager.
The Screen Editor’s opening screen will appear.

(2) Sdlect the[Screen] menu’s- [Open] command or click
on ]

(3) Use this screen to select a screen name from thelist,
or select the screen type and enter the screen number.

When checking the [Preview] check box, the selected
screen image can be viewed in the dialog box.

Open Screen

Project File: A M anufacturing . Ite
Screen: B

Open |
2 Operation Maoritar [ Copy
4 Eraor Screen ;
11 Keypad Input Change

iy

| Delete
Baze Screen id
Y

Open Screen

Froject File: A Manufacturing . Ite

Screen: B

i [ oeen_]

2 Operation bonitar Copy

4 Error Screen |

11 K.eypad Input Change

k=2
| Delete
Preview
Y

N

Preview Check Box
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When the Screen Editor hasaready
been started, skip step (1).

When you double-click on the de-
sired screen number in step (3), you
can skip the operation of the

button.

If you enter a screen number that
has not been registered inthelist, a
new screen will be opened and that
number will be assigned to it.

When selecting multiple screens, a
screen with the smallest screen
number of them will be displayed.
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PROCEDURE REMARKS

(4) Click onthe[ geen ] button to open the screen.

The selected screen will open.

M Diawing Board - Faclory A
Screen  Edit VWiew Option Draw Parts Special Libray  Window Help
pedwplaajcr|eloalsne]s|eaes o ¥Rw|P]
NEEEEEEYT T R Mw]znxm F [=]
O CE T — - -
] [l
@ z
1<} + 4
Ll 5
_ 5
2y | ¥ Parts T
B o <] s %
& ﬂ Tl'sjﬂ@| > ¥
& 7] Link Select Order "
A
= "
=] "”
13
(TS L]
15
n —
[243. 63 | 1701%] | Ready @ [FREGROL | |

@\ Up to twenty screens can be open at the sametime.
“Note: Tosdect several screenssimultaneously, while pressing the key, click on a
2] screen and dragthemouse over desired adjacent screens, or, you can sefect
screensindividually by clicking on them while pressing the key.

Project File: A Manufacturing, [te
Screen E
——— Open
[ com
[ Change
i
[ Delete
DiPrevient [ o>
Screen Type:
Base Screen id

BT+

EE—a ]

ﬁ‘? e [

BERPEDOCEICEQLEE]

IE ScrednDatai &
R —

FPats ¥ Objests

DLk Seect 5] Change Orde

»*E

—
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W Saving a Screen

PROCEDURE REMARKS
(1) Select the [Screen] menu- [Save] command, or click | After the screenissaved, it will re-
on [F]in the Screen Editor main open.
The current screen will be saved, overwriting the previ-
Ous One. When you attempt to save a new
screen, the [Save As| dialog box
will appear.

1.2.4 W Saving a
Screen under a Different Name

B Saving a Screen under a Different Name

PROCEDURE REMARKS

(1) Select the[Screen] menu - [Save As| command in
the Screen Editor.

(2) Thetype, number, and title of the current screenis | A “,” (comma) cannot be usedin a
displayed. description.

You can change the setting of a desired item; however,
the screen’s type cannot be changed.

Save As
Froject File: b anufacturing System.lte
S Type: j

creen Type: Base Screen
Screen:

Description: JDperation I anitar |

12 Aggregate % Summary
12 Trauble

14 Kepboard Input

(3) Click onthe[ ok ]button to register the above | After the screen is saved, it will
settings. remain open.

If ascreen with the same number exists, the system asks | |f the screenis saved as a different
if you want to replace the existing screen with the screen | Screen number, the screen of the up-
you are atternpn ng to save. dated number will be dlSpI ayaj

If so, click onthe[ ok | button. If you do not wish to

overwrite the existing screen, click onthe|[ cancel | but-
ton.

Screen Already Existsl

@ Cro pou wizh to Ovenarite?
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B Closing a Screen

1.2 From Sart to Finish

PROCEDURE

REMARKS

(1) Select the [Screen] menu - [Close] command in the
Screen Editor.

(2) The screen will close.

If you attempt to close an updated screen without saving
it, the system asksif you wish to save the current screen.

If you click on the button, the system saves
the updated data. If you click onthe[  n. ] button,

the system closes the screen without saving the updated
data.

Drawing Board

B Quitting the Screen Editor

You can also close the screen by
clicking on the[[x] button at the up-
per right corner of the window
(drawing area).

When you attempt to save a new
screen, the[Save As| dialog box ap-
pears.

1.2.4 W Saving a
Screen under a Different Name

PROCEDURE

REMARKS

(1) Select the[Screen] menu - [Exit] command, or click
on in the Screen Editor.

(2) The Screen Editor will close.

If you attempt to close the Screen Editor without first
saving the currently edited screen, LT Editor asksif you
wish to save the updated screen. If you click on the

button, LT Editor saves the updated data. |f
you click on the button, LT Editor quits the

Screen Editor without saving the updated data.

Drawing Board

When you save a new screen, the
[Save As] dialog box appears.

1.2.4 B Saving a
Screen under a Different Name
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@ Quitting LT Editor ]

B Quitting LT Editor

PROCEDURE REMARKS

(1) Select the [Project] menu - [Exit] command, or click | When you are working on the
. . Screen Editor or the Logic Program
on I e+ in the Project Manager. Editor, quit the Screen Editor or the

Logic Program Editor, or select the
(2) The Project Manger will quit. Project Manager.

If you attempt to close the Project Manager without sav- 1.2.4 H Quiting
ing the currently opened screen’s updated data, LT Edi- | the Screen Editor
tor asks if you wish to save your project’s data. If you

clickonthe[ ve |button, LT Editor saves the up-

dated data. If you clickonthe[  ns  ]button, LT Edi-
tor quits (closes) without saving the updated data.

Saving the screen

Drawing Board

@ Save changes to Screen: Untitled1 ?

[ mo ][ Cancel ]

Saving the L ogic Program

C:\Program Files\Pro-face\LT\database\A Manufacturing Spstem

@ Do you want ta save the changes to "C:%Program Files\Proface\L T \databaseha Manufacturing Systern''?

Efe [ wo | Hep
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E Project Manager ]

All LT Editor system level settings and functions are controlled viathe
Project Manager.

E Project Manager Areas and Functions ]

Here, each of the Project Manager’s featuresis explained. To begin working
with LT Editor, smply click on the desired button.

a. Title Bar

Soeen o : c. Pull-Down Menu
oo

Prujen;i @ lobal :uss_e erence L3
e. Function Buttons —| logie [T [ 2 :
Prug%lgm "7&/}7; \gj i

b. Menu Bar

d. Status Bar \

a. TitleBar:
Displays the current project’s file name and title.
b. Menu Bar:

Displays the menus used for the operation of LT Editor. When you select a
desired menu using the mouse or keyboard, one of the pull-down menus
described below will appear.

c. Pull-Down Menu:

When you select adesired item on the menu bar, its pull-down menu ap-
pears. These menusincludes avariety of commands.

d. StatusBar:

Displays LT and Device/PLC aswell as LT Editor operation related mes-
sages.
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e. Function Buttons

These buttons indicate the LT Editor program’s main functions (e.g. creating
screens, alarms, printing, etc.). You can start each function by simply click-
ing on that function’s button. You can also start these functions by selecting
the corresponding command from the Project Manager’s pull-down menu.

Creates a new project Selects an existing project

Makes initial
setting of the LT
main unit

Monitors the

logic program

Displays a list
Creates a logic of variables
program with
the Logic . .
Program Editor Sets I/0 configuration
Creates a
screen with the Creates alarms with
Screen Editor the Alarm Editor
Transmits screen and Quits the LT Editor

logic program to the LT
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m Logic Program Editor

Logic programs are created with the Logic Program Editor.

The online help provides you with detailed information on the Logic Pro-
gram Editor.

Also, the "Logic Programming Operation Manual" explains procedures
using tutorias. It also explains instructions and settings required for combin-
ing the LT main unit with the LT Editor.

m Logic Program Editor Item Names and Functions ]

Here, basic item names and functions of the Logic Program Editor main
window are explained.

For details, refer to online help.

a. Title Bar c. Pull-down Menu

E Logic Program Editor - A Manufacturing System
| File Edit “iew Search | [nsert || Data Conbbller Help
I Unstiwetiog., / s oo e [ - |
d. Tool Bar = |y D% 000 . 1o [P
- Bung Chil+R
Label
Sbroting:

b. Menu Bar —__|

Program Descr]

/

3|-PEND e. Programming
Area

f. Status Bar
| Programrming Mode | [ [

a. Title Bar
Displays the project file name, screen number and title.
b. Menu Bar

Displays the menus used to operate LT Editor. When you select adesired
menu using the mouse or keypad, the pull-down menu (c) appears.

c. Pull-down Menu

When you select a desired menu from the menu bar, the pull-down menu
appears. This menu includes various commands.

d. Tool Bar

The Tool Bar provides icons representing such commands as Creating/
Editing a Logic Program and RUN/STORP. Clicking one of theseicons
performs that command. The Tool Bar can either be hidden or displayed.
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e. Programming Area

Creates alogic program.
The entire program may not display depending on the size of the window or
program. In such cases, use the window’s scroll bar to change the display

area.

f. StatusBar

Displays information on the edited logic program and messages concerning
the operation.
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Fundamentals 1.5 Screen Editor

B Screen Editor

To create a screen, start the Screen Editor viathe Project Manager.

There are three types of screens used for different purposes; Base Screen,
Mark Screen and Image Screen.

Screen | Screen Maximum Size
Contents
Type | Number per Screen
This screen is displayed when the LT is in RUN mode.
Base(B) | Blto |Shared drawings and Active images loaded on another Aoorox. 16 KB
Screen | B8999 |base screen can be used. One partofa Base Screen can PRIOX.
be registered as a window.
Mark M1 Used to create marks and foreign characters on a 48 x 48
(M) dot screen. These marks and foreign characters are Approx. 576 bytes
M8999 | . o
Screen displayed as still or Active images on a Base Screen.
Bitmap image data can be registered here as LT screen
Image ()| I1to , : .
data. Image screens are displayed as still or Active Approx. 58 KB
Screen | 18999 |.
images on a Base Screen.
Window UL This screen is used to register screens you want to display
V) 18999 in the window. The window is displayed on the base Approx. 16 KB
Screen screen.
@\ » Although screen files can be numbered from 1 to 8999, the maximum
Note: number of screensthat can be created for and used by a LT depends on
X2) your PC's hard disk capacity and the amount of RAM (memory)

1-22

available,

The number of screensthat can betransferred to the LT will depend on
how much internal memory the LT has. The actual screen sizeand
total number of transferable screens can be viewed in the" Project
Manager" window by selecting the [Project] menu, and then [Project
Information].

4.4.1 B Project Information
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E Screen Editor Item Names and Functions ]
The names and functions of the LT Editor editor’s screen items are as
follows:
a. Title Bar
b. Menu Bar
h. Tool Bar — e E
—— ]. Selection
c. Pull-down E e [ — = Tool Box
Menu E <[> D
. R —— i. Zoom Box
d. Drawing  —j :
[Ewetn | [ oo |
Area Dtincer eorce | 77— k. Screen
Sw_NO_BORDER Sw/_3000- Data LiSt
e. Screen o -
Center Mark | “T—1. Parts
) . / \ Palette
f. Grid Points
o5 neanpIel&alas HEGE|NE|
g. Status Bar —j=—p~a = Yo — h. Tool Bar

h. Tool Bar

Title Bar
Displays the project file name, screen number and title.

. Menu Bar

Displays the menus used to operate LT Editor. When you select adesired
menu using the mouse or keypad, the pull-down menu (c) appears.

Pull-down Menu

When you select a desired menu from the menu bar, the pull-down menu
appears. This menu includes various commands.

. Drawing Area

Here, you can create a screen for your LT unit. The size of the screen you
see here is designated viathe “Display Type” setting you entered when you
first created the project file.

Depending on the size of your PC’s display, the screen’s entire display area
may not be displayed. In this case, ssimply scroll up or down to view the
entire screen.

Screen Center Mark

Indicates the center of the screen. This mark is not displayed when the data
issent to the LT unit.

Grid Points

Used as reference points when you draw or paste an object in the drawing
mode. Grid points will not be displayed on the LT unit’s screen. The Option
area’s " Snap” function allows you to position your screen objects using a
pre-made grid. You can aso set theinterval and display ON/OFF status of

the grid points.

2.7.1 Grid/Snap
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g. StatusBar

Displaysinformation related to the current screen and provides messages
explaining the screen operation you are currently performing.

2hE 142 | A482%]) | Ready [ =[i@
Coordinates /Amount of Screen Description of the / Disoiay area’s
of current memory c_urrently currently selected  Project’s P ]}’ tion/
mouse used (Ratio of usgd command Device/ ngnlt_lca IOtr)
position screen area to entire PLC reauction ratio
screen)
h. Tool Bar

The Tool Bar provides easy to use icons for drawing and editing. Clicking
on one of these icons performs that command. The Tool Bar can either be
hidden or displayed, and individual Tool Bar areas can be moved freely
around the Screen Editor screen, i.e. top, bottom, left, or right.

Thefollowing Tool Bar areas are available:

Main Tool Bar

Edit Tool Bar

Draw Tool Bar

Option Tool Bar

Grid/Snap Tool Bar

Parts Tool Bar

Parts State Change Tool Bar

i. Zoom Box
Shows the cursor’s current position at three times magnification.
j. Selection Tool Box

Used to select objects to be edited (Parts and figures). Using the commands
included in thistool box, you can select objects using a variety of methods.

k. Screen Data List
Lists the settings and layout conditions of the objects (Parts and figures) that
have been arranged on the screen. You can select adesired object from the
list.
SO 2.7.4 Screen Data List
|. Parts Palette

Parts such as switches, lamps and graphs are placed on a tabbed palette
(except for the keypad, alarms, File Name Display, Logging Display, Picture
Display, and Window parts).

To place parts on the drawing screen, simply select the desired part from the
palette and place it on the screen with drag & drop operation. Only one part
can be selected per operation.
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Chapter 1- LT Editor Fundamentals

@ Display Area (50%, 100%, 200%) ]

‘Note:

You can enlarge or reduce the drawing area by selecting a magnification/
reduction ratio.

To change the display area, select the[[&] or [&]icon on the tool bar, or
select the [50%], [100%], or [200%] command from the [View] menu.

|iew || Option  Draw  Parts
Btz Sampling List..

. Partz List ...

| Load Seeemlish...

i Lpad Seesmiesting
Crozz-FReference Ligt ...k

Prexiew

50%
v 100%
200%

v\E'cﬁan Data Box

Tool Bar 3
v Status Bar
v Zoom Box

RYEY

Zoom out Zoom in

Zoom out: Used to reduce the current display areato 50%.
Zoom in: Usedto enlarge the current display areato 200%.

In the[50%] display mode, the created screen dataisreduced. I n this case,
the displayed screen data may be different from the actual data. We recom-
mend you to use a[100%] or larger display area.

@ Tool/Icon Display ]

The Parts tool box, tool bar, status bar, and parts palette can be designated as
either shown (displayed) or not shown (not displayed). Each time you select
the [View] menu's [ Screen Data Box], [ Status Bar], [Zoom Box], or [Parts
Palette] aswell asthe [Tool Bar] command's [Main], [Edit], [Draw], [Op-
tion], [Grid/Snap], [Parts], [Parts State Change], or [String Table] sub-
commands, these View/Hide settings will toggle ON or OFF.

IM' Option  Draw  Parts  Special Library  ‘window
Diata Sampling L.
Barts: L.,

Lnad Seemlish...

Lo ad Sermem st
Cross-Reference List .. »

Freview

B0

w1003
me— |

/Screen Data Box

v Status Bar v Edit
w Zoom Box v Draw

v Parts Palette v Option

v [Grd/Shap

v Parts

v Partz State Change
v ShingTable
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E LT Editor Manuals and Help

While you are learning how to use the LT Editor software, please refer to the
following learning aids:

- Related User Manuals

- On-line Help Topics

- Tips Screen

- Digital’s Home Page

For the help concerning the operation of the Windows operating system, see
the Windows software’s manuals and help screens.

B Using LT Editor Manuals
The following manuals have been created for the LT Editor software.

CD Jacket: Describes LT Editor's installation procedures and
system requirements.

Drawing Operation Manual : Provides detailed explanation of operating
proceduresfor al LT Editor's commands except
those for logic program devel opment.

Logic Programming Operation Manual: Provides tutorials to help you to
learn operating procedures of Logic Program
Editor. Also describes operation of the LT main
unit aswell asinstructions and variablesused in
logic programs.

Parts List: Describesthe LT Editor's pre-made Parts and
symbols.

Device/PLC Connection Manual: Describes the methods for connecting the
LT to the external devices of various manufactur-
ers and system requirements.

B Using the Help Feature

If you have any problems or questions during LT Editor operation, you can
view the explanations for each feature and setting via each window’s Help
button, or from the main menu’s Help feature.

The Help explains settings of each window and dialog box, instructions and
functions of alogic program as well as each driver's setting.

B Using the Tips Screen

The Tips screen displays one-point descriptions of the new features upon the
startups of the LT Editor.

B Using the Home Page

You can obtain the latest LT Editor information by addressing the Digital
Electronics Corporation Home Page on the LT Editor screen.
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@ Browsing Help Topics ]

To display the help screen, select the [Help] menu or click onthe[  Hep |
button in the dialog box.

A - When multiple screens are loaded or many Parts have been
! registered on the screens, the PC’s system memory may not be
Important  sufficient to display the help screen.

- If you jump from one topic to another on the help screen, an
error message may be displayed. When this happens, simply
quit and then re-start help.

B Searching for a Topic and then Display Help

Select the [Help Topics] command from the [Help] menu, or press the [F1]
key. A list of help topicswill be displayed.

You can search for atopic by either trying to find it from the table of con-
tents, or entering a keyword for that topic.
@ Searching for a Topic from the Contents M enu

To select atopic from the contents menu, double-click on the [ Contents] tab.
Follow the screen instructions to search for a desired topic.

Help Topics: GP-PRO/PBE 3 for Windows 95

" Contents | inde< | Find |

Click a opic, and then cics Dispap. Orcick another tak, suchaz hdes.

@ Pioj=ct tdanager

B Lty
B rep
@ Screen
® Tag
@ Partz
@ Setup
@ Alarn
@ Tiangher

' Dizplay I| Pt | ceree
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1.6 LT Editor Manuals and Help

@ Searching for a Topic by a Keyword

To enter akeyword, click on the [Index] tab.
Search for adesired topic according to the instruction indicated on the

Sscreen.

(When you enter initial characters of the keyword, the topics specified with
theseinitial characters are also automatically listed)

Help Topics: GP-PRO/PE 3 for Windows 95

| Contents] Inds | Find |

1 Type the first few letters of the word wou'ne laaking for.

2 LClick the index entry you want, and theen click Display.

Aliaz
Change GP
Change PLC
Change Project Manager
Corvert Address
Copy Screen
Delete Project
Drevice Manitar
What iz it?
Dizplay Type
Editar
GP Type
GP-PC communication
Mew Project
Mew Screen
PC-GP communication
Presviewm

|| Dizplay ||| Bririt..

||| Cancel |

B Calling up Help from a Dialog Box

When you click on the button in the dialog box or pressthe [F1]
key during execution of acommand, a description of the currently-executed

command will be displayed.

Bit Switch Settings [BS_001]

General Sethings | Shape/Color || Label [ Extend |

Desciiption Operation Bit Address
| Monitor
Wnitar Bl deldiess
o —|
¢ Function:
%) Bit Set
1 Bit Reset
17 Momentary
1 Bit lrveert

|| Place ||| Cancel |\| Help ,\J

@ Viewing the Tips Screen ]

To view the Tips screen, select the [Tips] option from the [Help] menu on
the Project Manager or the Screen Editor.
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@ Browsing the Home Page ]

The procedure to connect to Digita Electronic Corporation's home pageis

described here.
A - Tobrowsethe home page, you must have hardware environ-
[ ] ment to access the Internet. You also must have a browser to

,,,,p;,,a,,, view the home page, and subscribe to an Internet provider.

Please understand that Digital Electronics Corporation can-
not respond to any questions about your Internet connection.

Operating procedures
c Click on the
[Help] - LConnectto = aqd/divDelete _,
Home Page] Connect home page
button.
Overview of the Home Page Connection screen:
Home page [<] Used to add a home
Home page page address

L Used to edit aregis-
tered home page

address and title
Displays the registered

home page address (title) Used to delete a

registered home
page address

Used to connect to the—— Connect home page | Close ” Help ]
specified home page

B Registering a Home Page Address

The address of Digital Electronics Corporation’s Home Page has been

preregistered in your LT Editor software. When you click on the[ aaaList |
button, the address setting dialog box appears.

W How to Register a Home Page Address

B Deleting a Home Page Address

Any registered home page address can be deleted. When you select the
home page address to be deleted and click on the button, the
confirmation dialog box appears. If you click onthe[ ok ]button, the

selected home page address will be deleted. If you click on the
button, the deleting operation will be canceled.
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B Editing a Home Page Address
The registered home page address or title can be changed. When you select the home
page address to be edited and click onthe[ et | button, the address setting dialog
box appears (same as for the home page addition procedure), enabling you to change
the title and address of the home page. If Digital Electronics Corporation’s home
page address is changed in the future, please edit the currently registered address.

B Connecting to the Home Page

PROCEDURE REMARKS

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

(2) Select the target home page address.

Home page [X]
Home page
Connect home page | Close ” Help I

(3) Click on the| comnecthome page | button to start connection. If abrowser has not been spet:|f|ed,

The browser is started, and you will be connected to the the f(.)l lowing dialog box appears.
home page Specify a browser, and re-start the

connecting procedure.

Project Manager

Intermet browszer Mot Selected Yet,
Pleaze select a Browser.

1-30 LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



1.6 LT Editor Manuals and Help Chapter 1 - LT Editor Fundamentals

B How To Register a Home Page Address

PROCEDURE REMARKS

(1) Select the [Help] menu - [Connect to Home Page]
command in the Project Manager.

(2) Click on the| adsList | button.

Home page |
Home page
Digital's Homepage Sy
o Edit k

Connect home page " Clase || Help

(3) Enter ahome pagetitleand addressto beregistered

and click on .

The specified home page address will be registered.

Home page address

%]
Title JPro-face Service Shop ] “k

Address Jp:a"a"www.fa-plaza.com#profacex’indeﬂhtml] %

U

Home page X

Home page

Digital's Homepaage
Pro-face Service Shop

Crmmgel home: page " Closs || Help
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p CREATING BASE SCREENS

commands can all be used. Also, Edit commands can be used to
modify any Parts or objects that you have created. In addition to
editing these screen objects, the procedures for registering Library
Items and Windows are also explained.

T 0 create Base screens, the Editor area's Part, Draw and Menu Bar

2 e Parts
2.2 e ——————— Drawing
2.3 Object Editing
24 s Libraries
25 s D-Script/Global D-Script
2.6 Data Sampling
2.7 e Efficient Drawing Techniques
2.8 DXF Conversion
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2-2

m Parts

Parts such as Switches, Lamps, and Graphs can be placed on Base screens.

Each Part’s attributes such as setting Addresses and colors will be desig-
nated viathe dialog box. Switches and Lamps can be selected while viewing
their images viathe Browser. After designating all the necessary Part at-
tributes, decide their position and size on the object drawing area.

Parts can be placed on the drawing screen ssmply by selecting the desired
part from the palette and placing it on the screen with drag & drop opera-
tion.

The [Parts] menu’'s commands are effective only on Base screens.

Usage Pattern |

Decide on Select the specific Specify its Place it
o[Parts] - atypeof — Partfrom the o ope — onthe
Attributes
Part Browser Screen
or - Select a desired icon from the Parts Tool Bar.

Place the part on the

Select the . Specify the
'P el —_
arts Palette desired part Screen W'th. drag & Attributes
drop operation
B LT Editor Part Type Summary
Each of the Partsused in LT Editor islisted below.
Icon Name Function Reference

Bit Switch Used to change a External Device’s Bit  |2.1.1 Bit Switches
Address data.

Word Switch Changes a External Device’s Word 2.1.2 Word Switches
Address data.

Function Switch [Used to go back to the previous screen, |2.1.3 Function Switches
to switch screens, and to reset the LT.

Lamp Turns ON or OFF, according to whether |2.1.4 Lamps
the External Device’s Monitor Bit is ON
or OFF.

Bar Graph Displays the External Device’s Word 2.1.5 Bar Graphs
Address data in a bar graph.

Pie Graph Displays the External Device’s Word 2.1.6 Pie Graphs

Address data in a pie graph.
Half-Pie Graph Displays the External Device’s Word 2.1.7 Half-Pie Graphs
Address data in a Half-Pie graph.
Meter Displays the External Device’s Word 2.1.8 Meters
Address data in a Meter graph.
Trend Graph Displays the External Device’s Word 2.1.9 Trend Graphs
Address data as absolute values in a
trend graph.

Keypad Used to enter a External Device’s Word
Address data.

2.1.10 Keypads

Keypad Input
Display

&) @] |31 e & <€ (/%) @

Displays data input via the keypad. 2.1.11 Keypad Display
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o
(@]
S

Name

Function

Reference

B

Alarm Display

When monitored Bits are turned ON, a
list of “Basic” Alarm summary messages
appear that have been previously
registered in the Alarm Editor.

2.1.12 Alarm Displays

Filing Data
Display

Displays data registered in the Filing
Data list by specifying the
corresponding file number.

2.1.13 File Name Display

||

Logging Display

Displays External Device data loaded in
the data logging settings by specifying
the address for the corresponding block
number.

2.1.14 Data Logging
Display

(&l

Numeric Display

Displays the External Device’'s Word
Address numeric data as an absolute
value.

2.1.15 Numeric Displays

=L
m
M

Message Display

Displays a previously registered
message, according to External Device
Word Address data changes. A
maximum of 16 messages can be
displayed in a single Message Display.

2.1.16 Message Displays

Date Display

Displays the current date, using the LT’s
internal calendar.

2.1.17 Date Displays

O =]

Time Display

Displays the current time, using the LT's
internal clock.

2.1.18 Time Displays

4

Picture Display

Displays a single registered Library
image (only graphic data), according to
External Device Word Address data
changes. A maximum of 16 different
Library images can be displayed in a
single Picture Display. (One at a time)

2.1.19 Picture Displays

=

Window Parts

Windows created on the Window
Screen (U) can be called up on the Base

Screen (B).

2.1.20 Window Parts

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

2-3



Chapter 2 - CREATING BASE SCREENS 2.1 Parts

B Entering a Comment

If desired, a comment can be entered for a Part.

Bit Switch Settings [BS_001]
General Settings | Shape/Colo | Label | Extend | .
(DESCIiDliUI’] ration Bit &ddress T A p pl 1€S th S
Up to 20 | 1 device com-
alphanumeric ment

Wity B dididiasy

Function

180 Bit Set

(single-byte)
characters can
be entered

20 Momertary
20 Bit Irvert

|| Flace I || Cancel | || Help

@ Reflection of a Device Comment

If you click on the@ [Apply Device Comment] button after entering an
address, the device comment entered using the Symbol Editor is automati-
cally searched for, and the comment corresponding to the entered device
appears in the Description field.

4.2.6 Symbol Editor
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B Entering Addresses

A
\

]
Important

Ko,

2l

Here, Addresses that are operated for Parts' functions and that are monitored
are designated.

A variable to be used in alogic program (Logic symbol) can be designated
as aPart's address.

4.2.6 Symbol Editor

When a function requires consecutive addresses and a variable
(Logic symbol) is used as a start address, an integer array must
be designated.

For an integer array, an appropriate size required for consecu-
tive addresses needs to be allocated.

Bit Switch Settings [BS_001]

General Settings | Shape/Color || Label || Extend |

[ escription Operation Bit Address

(I =
0

) Enter the address
data here

S

[t Sdldiass
¥ [<onnon FlE

Furctior

%) Bit Set

i) Bit Reset
20 Momentary
20 Bit Invert

Browser...

|| Place | || Cancel | || Help |

* The addressto be entered varies depending on your LT and external device.
Note that the sample configuration in this manual isjust an example.

@ Entering from a keyboard

Click on the address entering field, and the cursor will appear there, which
indicates data entry is now effective. Then, enter device and address datavia
the keyboard.

€ Entering from a pull-down list

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

Click on the [<] box next to the Address entering field, and a pull-down list
appears including symbols and L ogic symbols selected via the Symbol
Editor and device comments together with corresponding Addresses. Select-
ing a symbol, Logic symbol or device comment from the list designates an
Address.

Bit Switch Settings [BS_001]

General Settings | Shape/Color || Label [ Extend |

Description Operation Bit Address

fon |2
+{#00100-5tap Line
O} |

#]:00101-5tart Line
@ﬂﬁj B dddizssy

2-5
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€ Entering from the Address K eypad

Click on the [Address Keypad] icon, and the Address Keypad will appear,
allowing you to enter numeric data and addresses on the screen viathe
mouse.

When designating a variable for alogic program (Logic symbol) by bit, use
the Logic Symbol Keypad that will be displayed by clicking the [Logic]
button in the Address Keypad window.

Bit Switch Settings [BS_001]

Gereral Settings | Shape/Color || Label || Extend |

Drescription Operation Bit Addiess

A T Activates the Address
O Moritor Keypad

Wity Bitdiddiess

] fonnno =

To move the Addrgss [Address Keypad]

keypad to the desired

position, drag its title bar. _ To close the pop-up
Bit Address [ ] keypad, click here.

To display the device

names in alist, click here\. I | 000000 :|—— Display
Backspace key /@— LS T Glear key
Hexadecimal [i” B|C [ 8] 4
number entry key [E”E F Li" 5|6

L‘1_I|'2 g Enter key

Displays the LogiC/ [ﬂ] ENT:I

Symbol Keypad

[Logic Symbol Keypad]

Bit Address []]
— A pull down list
#avglogicTime JEH—— shows Logic
Designates aLogic— | ¢ m symbols.

symbol by bit

Returns to the Address—— RET ‘'EWT#H— The Logic symbol

Keypad — will be accepted
with a click on the
Enter key.

A Part’s specified address can be entered so that it isdisplayed during Base
Screen creation.

2.7.2 Property Settings

Regar dless of whether addresses are designated as either displayed or not
displayed during Base screen creation, they will not be displayed on the LT
panel after screen transfer.
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B Selecting a Part Shape

Click on the General Settings Area’s button in the dial og box,
and the Shape Browser (hereafter called “Browser”) will be displayed.

The Browser’s Part Shapes are stored in a Part File (PDB file), separate
from the main Project File (LTE file). Searching through different pre-made
Part files allows you to easily find useful Part Shapes for almost any applica
tion.

Click on aPart number and then the button, or double-click
directly on the Part number to select a Part Shape. (Browser disappears)

ﬁé\te: Part Fileand Part Shape lists for each fileareincluded in the LT Editor Parts

2]l List Manual.

Shape Browser

|~ Clicking here scrolls

V through the Part

The ID number

gfh?peeFi’Sar;is_ SW 30002 Shapes in this file
played here.

Reverse video
(highlighting)
indicates it is

__| —~Calls up alist of the
other Part files

S el eCted Current PDE File : |c:\program f\les\pro-face\\t\pdb\pdb.p"
Tite :[w/_3D001 FIl B |
Shows the ID number of the Shows the Path-name of the
currently selected Part Shape currently open Part File
& PartsFiles

Click on the button, and alist of the Part files will appear.
After clicking on a Part File, the information displayed will change to reflect
that file. Next, click onthe[ geen ] button and the selected PDB File's
Part Shapes will appear in the Browser.

Moves to the next higher Creates a

Shows the,  fjle directory level new folder

currently

Displays file

open folder .
P names and details
) | e e q ' '
Lists the 5] Dbl pdt ™ Displays file names
names of b] Ophell.pdb  [=] Opd-spOt pob in summary form
all the b Opd-hmitpd [ Pdbpdb
. Opdlc.peb
PDB files Dp4-|mU1.pdb
; ; Opd-me01.pdb
in this ] Dpd-rmmipdb
folder &) Dpd-pl0.pob
Opd-pli2. pdb
File name:  [0pd-3d07.pdb | [ Geen |
Files of type:  [PDB fies [“PDE] ] | cancel |
Shows the ——{—Ereverptior—[30 Parta0] |
currently y
selected
PDB file's Shows the name of the currently selected PDB file.
comment A name can also be entered here to select a file
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When the LT Editor softwareisfirst installed, all Part Fileswill be included
in afolder named PDB and automatically installed in the same directory/
folder asthe LT Editor program. If desired, these Part Files can be moved to
other foldersand, to find a Part File that has been moved, use the [L ook in:]
areato display Part Fileslocated in other folders.

B Selecting Colors

Specify Part colors using the Shape/Color setting screen. The setting items
will differ depending on the Part, i.e. the border type, ON/OFF states,
graphs, and label colors.

Tiling patterns can be selected for some of the Parts, Lamps, and Graphs.

‘word Switch Settings [WS_001]

I‘ General Settings | Shape/Color | Label ]

Border Color

[ ) m  lm] [ EETSyG]

Color

Fo 1) I I O o B
B0 MWW IWE]NBk ]

. Place ] | Cancel | | Help

& Colors

There are 8 colors available in the color bar. Use this bar to select the
foreground (Fg), background (Bg) and other colors.

On amonochrome LT screen, black, blue, green, and cyan will be displayed
as black (same as background); red, magenta, yellow, and white will be
displayed as white.

Fo. I IO T I ] ]
o 0 N O O O 1] B

Color LT unit BK|BL |GR|CY|RD|MG] YL |wH

Black (not | White (dis-
displayed) |played)

Monochrome LT unit
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@ Blink

When the Blink (Blk) Check Box checked [l#l| , the color bar isdisplayed in a
darker color and the specified Part will blink on the LT’s screen.

Fo [/ @) 1] @D Blink Check Box
Ba N ) ) /][] Bk

When either text charactersor Mark backgrounds (Bg) are specified as
Black, and theBlk (Blink) featureisturned on, they will become transpar -
ent; so that even when overlaid on other objects, the rear abject’s color isalso
visible. Thisfunction is useful when overlaying text on Switches, Lamps, and
other objects.

For example:

Sinitch —

G ) N O OO0 1] Bk [ O O N [ [ s ]

Specifying a Label’s However, specifying the Label’s
background color as background color as Black and
Black does not allow you turning on Blk (blink), causes
to see the background the background color to be-
color. come visible.

@ States

Only Parts which can have two states are displayed with this feature. Dis-
play colorsfor Parts can be specified separately for each state. Click on
either state button to select it, and specify that state’s color using the color
bar.
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B Alarm Settings

In both graph and numeric value displays, Alarms can be set up.

First, click on the [Alarm Settings] tab at the top of the Dialog box. When
checking the Alarm Display box (Check mark [ appears), the Alarm setting
items will appear.

Bar Graph Settings [BA_001]

|"General Settings | Graph Gettings | Shape/Color| &lam Settings ] t Sets the Alarm
S Al Typo ; value's Format

it to fixed or
22 Indirect )
variable
Jarm Color
Sets the minimum — =)0 7o o I |
and maximum Tz mEEOE®ECC) ) Sets the Alarm
Alarm values colors used

& Alarm Type

The Alarm value can be specified as either direct (fixed value) or indirect
(variable value) by ssmply clicking on the appropriate circle.

€ Alarm Range

Here, you can specify the maximum and minimum Alarm values.

When the Alarm value has been specified as indirect, the maximum and
minimum values can also be specified asindirect. In this case, the Word
Address number used to store these values will be automatically assigned
continuously from the Word Address currently specified.

The following example uses “n” to denote where the Word Address' display
datais stored:

<Relationship between display data’s storage address and Alarm register

address>
With 16 Bit data With 32 Bit data

n Display Data n .

n+1 |Data value - Max. n+1 — Display Data -

n+2 |Data value - Min. +
n+2 — Data value - Max. -
n+3
n+4 — Data value - Min. -
n+5

(e.g.) When the Word Address is set to "D00000"

Alarm Fange
. =] Word Addresses are automati-
Min Walue |10 | .
- cally allocated in sequence,
Max Yalue |90 | starting from the Address desig-
- nated

(e.g.) When the Word Addressisset to " Symbol” (Logic Symbol)
=/ |arm FHange

kir. W alue !5yml:u:n|+2
b ax. Walue !Syml:u:ul+'|
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A When avariable (Logic symbol) is used as a start address, an

! integer array must be designated. For an integer array, an ap-
important Propriate size required for consecutive addresses needs to be
allocated.

¢ Alarm Color

Here, you can select the colors used for an Alarm display.
2.1 Parts B Selecting Colors

B Creating Labels

Here, aLabel means the text characters shown on the faces of the Switch
and Lamp button Parts. Labels can be registered viathe Part’s Setting

dialog box. Label

Aswith Parts, Label display colors can be created for each of a 2-state Part’s
states; up to 4 lines of text can be used for each state.

<OFF state> <ON state>

When a lamp’s Text Display changes
(This Switch’s ON/OFF colors are also selected)

@V\ote: The Part must be large enough to display the entire L abel.

Enter the charac-
Bit Switch Settings [BS_001] 4] ters here
Wh en the Part has ‘ General Settings H Shape/Calar ” Label |Extend | .
two states, the || b= v tors im the Deserip.
appropriate Label tgrs m e Deserip-
R ol - . Tk tion field to the

label for the se-

. [on | ox Tum O
with these buttons lected state.

switched On/Off.
— Copies the charac-
ters to the label for
the Off state.

1

Sel ect th e Character Size Spacing Alignment
character’s size [ J\
OFF Text Color

Sl

Selects the Y | [ Tal | [wa 8 T~ Settings required
character’s type 3 8qq | o I ) O O O e [ only when the text
£3 Rsised extends to more

than one line.

|| Flace I || Cancel | || Help

Select the label’s
color here
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€ Labe

Here, you can typein the text displayed on abutton. When typing in text,
press the |J| key to move to anew line. When the [Tracking] check box is
checked | (enabled), after the Part has been placed on the screen, if the
Label’s size or position is changed, for either state, the alternate state’s L abel
size and position will be aso changed. If, however, the Label’s size and
position need to be specified independently for each state, DO NOT check

this box.
2.3.3 Scaling Up/Down

€ Copy from Description

The characters entered in the Description field are copied to the label in the
selected state without changing the character size.

& Copy to Off (On) state

When the state is On, the characters entered in the label are copied to the label in
the Off state without changing the character size. When Off, the characters are
copied to the label in the On dtate.

& State

States are displayed only for Lamps, and for those switches with two states
(ON and OFF). Thetext displayed for each state can be specified indepen-
dently. Simply click on either state button to specify itstext and colors.

@ Character Size
Specifiesthe size of character.
2.2.9 Text
@ Style (Font)
Specifies the type of character (Normal, Bold, Raised) used in each Label.
2.2.9 Text
@ Text Color (ON/OFF)

Specifies Label colors.
The default settings are Fg: White, and Bg: Transparent mode (Black + BIk).

@ Line space
When the text extends to more than one line, set the line space.
@ Alignment (Justification)

When the text input for aLabel exceeds one line, the Alignment icons will
appear. Select Left, or Right justification, or Centering.

State OFF Teut Tracking
[On] on

v |
Character Size Spacing Aligrirmes
7l

Left-justified Centered Right-justified
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B |D Numbers

When creating a Part, an ID number is automatically assigned to the Part
beforeit is placed on the screen. This number shows how many of that kind
of Part were previously placed on the current screen. When a Part is deleted
from a screen, all following Part numbers will be adjusted downwards.

Example of an ID number

BS-010
|

Indicates that this Part is a Bit L Indicates the placement/
Switch creation order of the Part; in
(Varies according to the Part) this case, it is the 10th.

The ID number isdisplayed in thetitle bar at the top of the Setting dialog
box.

Bit Switch Settings [B5_001]

—
General Settings | Shape/Color || Label || Extend |

D escription

@Iiv\ote: The D number can be entered so that it isdisplayed during Base screen

) drawing.

Operation Bit Address:

—

Fmmmitia Bt & iz

2.7.2 Screen Property Settings

Even if the ID number isentered to be displayed during Base screen draw-

ing, it will not be displayed on the LT panel after screen data transfer.

<|D Number List>

Part Name ID Number

Bit Switch BS-*
Word Switch WS-
Function Switch FS-#e
Lamp LA+
Bar Graph BA-*+
Pie Graph P-He
Half-Pie Graph HP-#+
Meter MT-*ex
Trend Graph TR-*+
Keypad KE-*+*
Keypad Input Display KD-*+
Alarm Display AL-#*
File Name Display FD-*
Data Logging Display LG-***
Numeric Display ND-*+
Message Display (Operation Mode: Bit) MB-++*
Message Display (Operation Mode: Word) [MW-*
Date Display DD-***
Time Display TD-**
Picture Display (Motion mode: Bit) LB-**
Picture Display (Motion mode: Word) LW -
Window Parts W|-

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide
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B Maximum Number of Automatically Created Part Libraries

When a Part isused in aproject, aPart Library will be automatically created
in preparation for data transfer. The number of Part Library items are

limited to 6000 per project. If this number exceeds 6000, all Partsin excess
of 6000 cannot be transferred to the LT. To avoid this, please remember the

following:

1. Automatic Library creation will be performed follows: (per screen)
Switches: 2 (only switches with the Monitor function selected)
Lamps: 2
M essages. 2 to 16 (depending on the number of states used)
Picture Displays: 2 to 16 (depending on the number of states used)
Trends: 1 to 20 (depending on the number of channels)

However, Part Libraries using the same Parts (i.e. Part’s that are the
same size, same attributes, and without labels or other items) will be used
commonly.

For example:
When 30 Switches (Monitor function is selected) and 20 Lamps are
placed on a single Base screen, (30 x 2) + (20 x 2) = 100 Part Library
itemswill be automatically created. Therefore, 60 of these size
screens can be used in one project('s data).

2. When using the same Parts for multiple Base screens, register the Part on
one Base screen and then place it other Base screens using the Load
Screen function. Thus, when multiple Base screens use those Parts, only
one Part Library will be used, thereby reducing the Project File's size.

B Placing a Part in Position

After al of aPart’s attributes have been entered or selected, click on the
desired position on the screen to place the Part.
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PROCEDURE

REMARKS

(1)After all of a Part’s attributes have been entered or

selected, click on the button.

The Part’s outline will appear on the Base screen, next
to your cursor.

”I Y[ coel [ e | '

(2)Click on the point wherethe Part’stop left corner is
to be placed.
The selected Part will then appear on the screen.

(3)Adjust the Part’s size, if desired.
Click on the Part to select it, and drag any one of the
handles to change the size of the Part.
To change the size of a Part, move the cursor to a Part
“handle’ and click, then drag the “handle” to re-size the
Part, and click again.

S

2.3.3 Scaling Up/
Down

After placing the Part, double-
clicking on it automatically brings
up its Attribute Setting dialog box.

2.3.15 Changing
Attributes

@Ikv\ote: Depending on the Part, when scaling up or down, one dot error may occur in

2] the framewidth.
E.g) 9

10
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@ Bit Switches ]

Here, the creation of atouch panel switch, used for turning a specified Bit
ON or OFF, is explained.

If the LT unitis Type C, Bit Switches with the Monitor function
1 selected will not be displayed on the LT unit after the Project
Important  Fjle transferred unless the LT has been connected to a external

device.

/A

B Bit Switch [General Settings] Attributes

Enter Comment Bit Switch Settings [BS_001]

Enter the Bit

data here Gerneral Settings | Shape/Color || Latel | Extend | Swi
witch Address
Deseription Operation Bit Address

Image of the ~__ l " rmtm ) H When creating
currently se- X Wotor Bl ess / a Bit Switch
lected Part Shape (] [onaan || with two states,

Funcion check this box
Calls up the Part [ Brows giii\ and enter the
Shape Browser, £ Momeriay alternate Bit
where different 3 BitInvert Switch Address
Part Shapes can below
be selected
Sets the switch’s
function

[ Pace |\| Caneel ||| Help

@ Operation Bit Address
Here, the Bit Address data controlled by the Switch isinput.
€ Monitor Bit Address

Only after the Monitor check box is checked can the Monitor Bit Address
used to change the Switch’s display setting be entered. The Switch's state
(ON/OFF) display can be specified so that it will change according to
changesin this Bit Address. Addressesinput in the Bit Address area can
also be done here.

Bit Switch Settings [B5_001]

General Setlings | Shaps/Color || Label || Extand |

Diescription Operation Bit Addiess

Appears only when

. . . %00000 Rl
creating a Bit Switch l ” Jlt F]
Wlth tWO States' Mo;itoornl;;[Address
Toggles the switch’s (%] froo000

state either ON or
OFF, allowing you to
set the attributes of
each state.
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After entering the Bit Address, if you attempt to perform another area's
operation before entering the Monitor Bit’'s address data, the dialog box

shown below will appear. Clickingonthe[ ves | button automatically
inputs the Bit Address's datainto the Monitor Bit Address. To enter a

different address, click onthe[ w0 | button and input the desired ad-
dress.

Bit Switch

Do you want to use the zame Bit Address
far the Monitor Bit Address?

& Function
The Bit Switch functions are as follows.

Bit Set: When the Bit Switch is pressed, the Device/PLC’s desig-
nated Bit Addressisturned ON. This state continues (i.e.
remains ON) even after the switch is released.

Bit Reset:  When the Bit Switch is pressed, the Device/PLC’s desig-
nated Bit Addressisturned OFF. This state continues (i.e.
remains OFF) even after the switch is released.

Momentary: Only while the Bit Switch is pressed and held isthe
specified Device/PLC Bit Address turned ON. Thus,
when the switch is released, the specified Bit Addressis
turned OFF.

Bit Invert:  Every timethe Bit Switch is pressed, the Device/PLC's
designated Bit Address state is changed (from ON to OFF,
or from OFF to ON).

W Bit Switch [Shape/Color] Attributes

Here, the Switch’s border color (Frame), ON/OFF state colors (On Color,
Off Color), and pattern can be selected.

2.1 Parts B Selecting Colors
The color and pattern settings available will differ depending on the switch’'s
Settings.

B Bit Switch [Label] Attributes

Here, the text of the Label to be displayed on the Switch button is entered.
2.1 Parts B Creating Labels
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B Bit Switch [Extend] Attributes

Set up the Interlock and Buzzer functions.

Bit Switch Settings [BS_001]

| Gieneral Settings || Shape/Color || Label || Extend |
Optior
Interlock Address Buzzer
00000 iz O @ Sha
Touch available condition
1% Bit On 20 Bit Off
|| Place | || Cancel | || Help
@ Interlock

2.1 Parts

Can be set at the
momentary

Selects the Interlock
function

Only when a bit designated via Interlock Addressisin a state that has been
selected via [ Touch available condition], the switch becomes effective,
Whether the switch is effectivein ON state or in OFF state is selectable

here.

Touch Available |Interlock Address |Touch Available/

Condition Status Not Available

. Touch Availabl
BN o Laee e
. Touch Not Availabl
StOFF C?FNF T

& Buzzer

Select ON or OFF for the buzzer sound.

When buzzer setting is enabled, the buzzer sounds while the touch switch is

being pressed.
€ One-Shot

Enable/disable the "One-Shot" feature.

This setting can be enabled only when "Momentary" mode is selected in the
"Function" areain the "Genera Settings' tab. When the "One-Shot" feature
Is enabled, the buzzer will sound briefly only at the moment the touch

switch is pressed.
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B Placing a Bit Switch

Chapter 2 - CREATING BASE SCREENS

An example of how to place a Bit Invert switch is shown below.

] 6T oy (6T

First press of the Switch
sets M0016

The next press resets M0016

PROCEDURE

REMARKS

(1) Select the [Parts] menu - [Bit Switch] command, or
click on the[&]icon.

(2)In the [General Settings] screen, input the Bit Ad-
dress and select the Bit’s Function.

Bit Switch Settings [BS_001]

General Settings | Shape/Color || Label [ Extend |

Operation Bit Address H—Enter MOO16

QMUmtDr
Yotz Bily s ——When the
p— switch’s state
can change,
click here

Select the Bit
Invert function

|| Place |” Cancel |” Help |

(3)Select a Part Shape from the Browser.
Specify settings for Shape/Color, Label and Extension
Settings if necessary.

Shape Browszer

Sw 30002

SW 30005

Current PDE File : |c:\prog|am fiIas\pro-face\lt\pdb\pdb.p”

Title - [3w_a0M Fl e |

(4)After all of a Part’s attributes have been entered or
selected, click on the[__Fee= | button.

The Switch’soutlinewill appear on the Base screen, next
to your cursor.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

When the Change State function se-
lected, after entering the Bit Ad-
dress, if you attempt to perform
another area’s operation before en-
tering the Monitor Bit Address, the
dialog box shown below will ap-

pear. Click onthe[  ves  ]button

to input the same address as used
for the Bit Address. To enter adif-
ferent address, click on the

" we | button and input the de-
sired address.

Bit Switch

Do pou want to uze the same Bit Address
fior the Monitor Bit Address?

AT 2.1 Parts B Select-
ing a Part Shape
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PROCEDURE REMARKS

(5)Click on the point where the Switch’stop left corner | To cancel the placement, click on
isto be placed. the[=] icon.

If desired, use the Switch’s handlesto alter its size. To change the
Part’s size, refer to 2.3.3 Scaling
Up/Down.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s Attribute Setting dialog
box.

2.3.15 Changing
Attributes

@ Word Switches ]

Here, atouch panel switch for setting data to a specified Word Address can
be created.

B Word Switch [General Settings] Attributes

Enter Comment

data here Word SwilchSellings w5_001] / Enter the WOI’d
General Settings | Shape/Color || Label | Extend | Ad d ress yo u
Th e WO rd Drescription wiord Address . h t
- e ] [ @pnnuna /Eﬂ = WIS 0O use
Switch’s image ~| I

appears here

=

+— Enter the data

Ca”s up the Part — |l 3 %3 word Set for the SWltCh

Shape Browser = D il to send to the
' £49 DighiADD]

Parts can be QD;MSUB] Word Address

selected directly
from the Browser

Select the
Switch’s
|| Place | || Cancel | “ Help fu n Ctlo n
& Word Address
Here, the desired Word Address is entered.
& Constant

Here, number registered to the Word Addressisinput. The dataformat is
Decimal (Base 10), and the input range is from -32768 to 32767.
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& Function
The Word Switch’s functions are as follows;

Word Set:  When the Word Switch is pressed, constant data is written
to the Device/PLC’s designated Word Address. Fixed or
default values will be written to the timer, counter, etc.

Add/Sub:  Every time the Word Switch is pressed, the Datavalueis
added to the data currently in the Device/PLC’s designated
Word Address, and the result is then written to the Device/
PLC'saddress. If aDatavalueis positive, the function will
increment, and if it is negative, it will decrement.

Digit (ADD): Every time the Word Switch is pressed, the designated
decimal place's datawill be added by the Constant’s value.
The result will not be carried up to the next digit, so “9”
simply rollsaround to “0”. Select the data format from Bin
and BCD.

Digit (SUB): Every time the Word Switch is pressed, the designated
decimal place's data will be subtracted by the Constant’s
value. Theresult will not be carried down to the lower
digit, s0“9” ssimply rollsaround “0”. Select the data
format from Bin and BCD.

B Word Switch [Shape/Color] Attributes

Here, aWord Switch’s color, and pattern can be selected.

2.1 Parts B Selecting Colors

The color and pattern settings available will differ depending on the
Switch’s settings, such as its shape and Change State condition.

B Word Switch [Label] Attributes

Here, the text characters shown (engraved) on the Switch button face are
input.
2.1 Parts B Creating Labels
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E\Word Switch [Extend] Attributes
Here, the interlock and the buzzer can be set as shown below.

Word Switch Settings [WS5_001]
| General Settings || Shape/Color || Label || Extend |
..................... Option
Unfsinck: sy Buzzer
00000 Fl|E
. N Select the
Trianzhy ol afle canditon Interlock
1) Bt Bn L By B .
function
State
|| Flace | || Canicel | || Help

@ Interlock

Only when a bit designated via Interlock Addressisin a state that has been
selected via [ Touch available condition], the switch becomes effective.
Whether the switch is effectivein ON state or in OFF sate is selectable here.

Touch Available Interlock Address |[Touch Available/
Condition Status Not Available
_ ON Touch Available
Bit ON -
OFF Touch Not Available
) ON Touch Not Available
Bit OFF -
OFF Touch Available
& Buzzer
Sets the buzzer to ON/OFF
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MW Placing a Word Switch

An example of how to place a Word Set Switch is shown below.

i e e

When the button is pressed, 34 is sent to D00001

PROCEDURE REMARKS

(1) Select the [Parts] menu - [Word Switch] command,
or click on the [&]icon.

(2)In the [General Settings] area, input the Word Ad-
dress and Constant data, and select a function.

Word Switch Settings [WS5_001]

General Settings | Shape/Calor || Label || Extend |

Description ‘Waord Address Enter Dooool

[E¥] [poooo ~

Constant

—H
Function=——=

_ 5 word 5ot Enter 34
Erowser... 9 Add/Sub

ich Digit/aDD)
ioh DigitfSUR)

Select Word Set

“ Place ||| Cancel ||| Help |

(3)Select a Part Shape from the Browser.

2.1 Parts ® Select-
Specify settings for Shape/Color, Label and Extension | jng a Part Shape
Settings if necessary.

Shape Browszer

Sw_3D002

SW_3D006|[~]| [Pz F
Current FDE File : |c:\program fiIes\pro-lace\lt\pdb\pdb.p”

Title - [Sw_3D007 I

SW_3D004|

(4)After all of the Part’s attributes have been entered
or selected, click onthe[ race | button.

The Switch’soutlinewill appear on the Base screen, next
to your cursor.
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PROCEDURE REMARKS

(5)Click on the point where the Switch’stop left corner
isto be placed.

To cancel the placement, click on

the[=]icon.

To change the
Part’s size, refer to 2.3.3 Scaling
Up/Down

If desired, use the Switch's handles to alter its size.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.
2.3.15 Changing
Attributes

@ Function Switches ]

Here, atouch panel with special functions can be created.

B Function Switch [General Settings] Attributes

Enter Comment
data here

The Function
Switch’s image
appears here

Calls up the Part —

Shape Browser.
Parts can be
selected directly
from the Browser

Function Switch Settings [F5_001]

General Settings | Shaps/Color || Label || Exstend |

cior
0 Previous Screen
% Go To Screen
20 Reset Display Unil
2 File Name Key

1D No. 0
2 Data Logging Key

20 Ot line

l‘ Bin  BCD

oK

|H Cancel Hl Help

Select the
Switch’s
operation

T~When “Go To

Screen” is
selected, the (Go
To) screen’s
number and data
format must be
entered

€ Function (Switch Operation)
The Function Switch's attributes are as follows;

Previous Screen:

Go To Screen:

When the Switch is pressed, the currently

displayed screen on the LT will changeto
the previously displayed one.

When the Switch is pressed, the currently

displayed screen on the LT will changeto
the specified screen. Input the screen
number to be changed (jumped) to. The
Data Format can be either Bin or BCD.

@Ikv\ote: If a screen number is specified in the BCD data format to place the corre-
2] sponding screen, it isstill displayed in the BIN data format when the screen is

closed and then opened.

2-24 LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



2.1 Parts Chapter 2 - CREATING BASE SCREENS

Reset LT: When the Switch is pressed, the LT will be
reset to the save status aswhen the LT's
power was turned ON.

\ Resetting the LT turns the I/O signal off. Consider this when
lmp;”am designing your system.

File NameKey: Thisisafunction switch corresponding to
the File Name Display and is the same as
the one that is automatically placed together
with the File Name Display.

Designate the same ID number as the one of
the File Name Display and select a opera-
tion mode.

2.1.13 File Name Display
Data L ogging Key: Thisisafunction switch corresponding to
the Data Logging Display and is the same
asthe one that is automatically placed
together with the Data Logging Display.
Designate the scroll direction and the
number of lines being rolled up or down.

2.1.14 Data Logging
Display
Off line: When this switch is pressed, the LT enters
the OFFLINE mode.

B Function Switch [Shape/Color] Attributes
The Switch’s color, and pattern are selected here.
2.1 Parts B Selecting Colors
The color and pattern settings available will differ depending on the switch
shape.

B Function Switch [Label] Attributes
Here, the characters shown (drawn) on the Switch button face are entered.
2.1 Parts B Creating Labels
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B Function Switch [Extend] Attributes
Here, the interlock and the buzzer are set.
Function Switch Settings [F5_001]
| General Settings || ShapeColor || Label || Extend |
i oo
ek ldiess Buzzer
;;m Select the
Towek analable eondtim
o R e 11T Interlock
function state
“ Place I u Cancel | || Help
@ Interlock

Only when a bit designated via Interlock Addressisin a state that has been
selected via [ Touch available condition], the switch becomes effective,
Whether the switch is effectivein ON state or in OFF sate is selectable here.

Touch Available Interlock Address |Touch Available/
Condition Status Not Available
_ ON Touch Available
Bit ON -
OFF Touch Not Available
_ ON Touch Not Available
Bit OFF -
OFF Touch Available
& Buzzer
Sets the buzzer to ON/OFF.
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B Placing a Function Switch

The Screen Switching (Function) Switch’s placement procedure is shown

bel ow.
e ™
Bl o B10
H EI:‘ ) —@ E
Pressing this button, shifts to screen B10.
AN /
PROCEDURE REMARKS

(1) Select the[Parts] menu - [Function Switch] command,
or click on the ] icon.

~Frclo 1L Select Go To
2 Previous Scresn
B GoToswem | B @B‘% Screen

£2) Fieset Display Uni
3 File Mame Key

1D Mo o

\ .
Select Bin
2 Diata Logging Key
£ Off line

Enter 10

| |H Cancel |H Help |

(3)Select a Part Shape from the Browser. 2.1 Part B Select-
Specify settings for Shape/Color, Label and Extension | ing a Part Shape
Settings if necessary.

ETIERITH, |'Sw 30002

e

t PDE File |c:\program F\Ies\plo-lace\lt\pdh\pdb.p||
Tille:[$w/_30001 |

(4)After all of Part’s attributes have been entered or
selected, click on the[ rec= | button.

The Switch’s outline will appear in the Base screen, next
to your cursor.
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PROCEDURE REMARKS

(5)Click on the point where the Switch’stop left corner | To cancel the placement, click on
isto be placed. the[=]icon.

If necessary, use the Switch’s handlesto alter its size. MEEEIX To change the Part’s
size, refer to 2.3.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen callsup that Part’ s At-
tribute Setting dialog box.

2.3.15 Changing
Attributes

@ Lamps ]

Here alamp is created, which turns ON or OFF according to the Device/
PLC's Monitor Bit Address stete.

- When the LT is Type C, the lamp that specifies the address of
! the Device/PLC. will not display on the LT unless the LT has
Important been connected to the Device/PLC.

When placing a Lamp, DO NOT overlap it with other objects. If
you do so, it may not be displayed correctly.

B Lamp [General Setting] Attributes

Enter comment Lamp Settings [LA_001]
data here  General Settings Shape/Colar | Label ] _— Enter the

Deseription Bil Adchess desired Bit

i I [ oos
Address here

Displays the cur- Stats

rently selected Part \‘

Calls up the Part —|

|~ Changes the
state of the

Shape Browser. [ Eowser ] dia'log qu’s
Part Shapes can switch display
be selected to either ON or
directly from here OFF
" Place I | Cancel ] | Help
& Bit Address

The Bit Address to be monitored is entered here.
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B L amp [Shape/Color] Attributes

Here, border colors for both ON and OFF states, and Lamp’s colors and
tiling pattern in each state can be selected.

2.1 Parts B Selecting Colors
The color and pattern settings available will differ depending on each lamp
shape.

B Lamp [Label] Attributes
Here, the text characters shown on aLamp button’s face are entered.

2.1 Parts B Creating Labels
B PlacingaLamp

The procedures for creating and placing aLamp are shown bel ow.

T

(11T

When X00017  the Lamp When X00017 the Lamp
is ON... lights up. is OFF... turns off.
PROCEDURE REMARKS

(1) Select the[Parts] menu - [Lamp] command, or click

on the[&] icon.

(2)In the [General Settings] area, enter a Bit Address.

Lamp Settings [LA_001] [<]]

General Settings | Skape/Color || Label |
Descriptiar

T

— Enter X00017 here

|| ZNace ”l Cancel Hl Hels |

(3)Select a Part Shape from the Browser. 2.1 Parts W Select-
Select Colorsand input aLabel, if desired. ing a Part Shape

Shape Browszer

LM_3D002

——————

LM_3D005 LM_3D006 || Paits File...

Current PDE File : |c'\prngram fileshpro-faceiltypdbhpdh. p”
Title: [LW_30001 I
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2.1 Parts

PROCEDURE

REMARKS

(4)Switch the state of the lamp with the On/Off but-
tons, and then select Colorsand input a L abel.

General Settivcs | Skape/Color || Label |
Bt Address

D ezcriptiar

State | IN [ 2FF]

Switches the
lamp On/Off

|| Zlace I” Cancel ||| Helo |

(5)After all of the Lamp’sattributeshave been entered

or selected, click on the button.

The Lamp’s outline will appear in the Base screen, next
to your cursor.

(6)Click on the point wherethe Lamp’stop left corner
isto be placed.

If necessary, use the Lamp’s handlesto ater its size.

2-30

With the Blink check box checked
[, and if the Bit is turned ON, the
Lamp will blink. Lamp blinking
can also be seen viathe pull down
menu [View]'s [Preview] com-
mand.

Screen

2.7.3 Preview

To cancel the placement, click on
the icon.

To change the Part’s
size, refer to 2.3.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.

2.3.15 Changing
Attributes
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E Bar Graphs ]

Bar Graphs are used to display Device/PLC’'s Word Address numeric datain
absolute or relative values. This graph’s display will change according to
Word Address data changes.

B Bar Graph [General Settings] Attributes
<When displaying Word Address numeric data in absolute values>

Select absolute or relative
value display

Enter comment

data here Bar Graph Settings [BA_DO1]
General Settings | Graph Settings | Shae/Golar | Alam Setings | | Enter the
Descipton ([ gpabsoe 1 Aelative ) desired Word
Displays the Word Address Address to
currently se- [£¥] [pon [ = I Diply oce - store graph
lected Part [gtgfnﬂm = data here
Calls up the Part —| == \\
Shape Browser. || T o= ¥S.electthe ,
Part Shapes can be R TRIEET display data’s
selected directly e — data format

from here

& Absolute

Data stored in the Word Address is displayed in absolute values from 0 to
100 (with Display Mode +/- selected, -100 to 100).

€ Word Address
Here, enter the Word Address used for storing the Bar Graph’s data.
& Data Format

The display data’s format can be either Bin or BCD.
When Bin is selected, negative numeric data can also be displayed. In that

case, check [[]| the Display Mode +/- check box.
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2.1 Parts

<When displaying Device/PL C Word Addressnumeric datain reative

values>

Select the Relative value display

Enter comment

Used to store the

d ata h ere Bar Graph Settings [BA_001] | — g rap h 1S d ata.
General Settings | Graph Settings | Shape/Color [[ Alarm Settings | Enter th e d es | red
Displays the e Dt ©0ede Word Address
Wiord Address

Iceucrtreec? E’);I‘Ste- D000 &2 [T iplay Mode +-

pienaih [16 |- T~ Select the

put Rang: | Imput Codt d IS Ia d ata's
Calls up the O - d

p \~ = 2 +/- 25 Complemer fo rm a.t
Part Shape Mavoue B S Gewse |
N ,

Browser. Part oo 1[ cwen ][ oo ] Select the data’s
Shapes can be Input Code

selected di-
rectly from here Specifies data’s Bit
Length
& Relative

Specifies data
Input Range

According to the Input Range designated for the Word Address’ data, the
datais converted and displayed as relative values.

€ Word Address

Here, enter the Word Address used for storing the Bar Graph’s data.

@ Display Modet/-

When this check box [[#| is checked, negative numeric data can also be

displayed.
& Bit Length

Specifies the Bit Length of data stored in the Word Address.

€ |Input Range
Specifies the data’'s Input Range.
€ Input Code

When No Code is selected, only positive data can be entered. To enter
negative number data, select +/-2's Complement or +/-M SB.
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B Bar Graph [Graph Settings] Attributes

Bar Graph Gettings [BA_001]
General Seftings | Graph Seting | Shape/Color [ Alam Setting | 0 Only when a
Dizplay Direction Bis Divigions /// graph Wlth
Select the U graduations
graph’s display has been _
direction . selected will
o this box
appear.
Enter the
number of
“ Flace I “ Cancel | || Help d |V| s | ons
desired here
@ Direction
The graph’s display direction can be specified as either Up, Left, Down, or
Right.

@\ If [Display Direction] is changed for a 3D part, its shadeisrotated along with
Note: that part. To let the shade displayed properly, click on the button,
and select the part again from [Shape Browser].

@ AxisDivisions

For a graph which has graduations, the number of divisions are entered here.
If the number of the divisionsis specified to 10, then 11 division lines are
used. When graduations are not necessary, specify the number of the divi-
sionsasO.

Qlkv\ote: Whether the graduations are necessary or not will differ depending on the
2] Part’sshape.

B Bar Graph [Shape/Color] Attributes

The graph’s border color, division color (Axis Color), display data color
(Graph Color), and display data patterns are selected here.

2.1 Parts B Selecting Colors

B Bar Graph [Alarm Settings] Attribute
If desired, an Alarm can be setup here by toggling the Alarm check box.
2.1 Parts B Setting Alarms
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B Placing a Bar Graph

An example of the Bar Graph’s creation and placement procedures are

shown below.
s ) ] ™,
Data stored in D00102 displays on the Bar
Graph
When the value 34 (2211\) is stored in
N D00102, the graph will look like this: )
PROCEDURE REMARKS
(1) Select the [Parts] menu - [Bar Graph] command, or
click on the ] icon.
(2)In the [General Settings] tab, input a Word Address
and select a Data For mat.
| — Enter D00102
here
—— Select BCD
[Pece [ cocel |[ mer |
(3)Select a Part Shape that has graduations from the
Browser. —
. . MBI 2.1 Parts B Se-
Here, you can enter Alarm settings and select Colors, if lecti nga Pat Shape
desired.

If the Bar Graph’s Alarm valueis
specified as Variable, a pointer
showing levels will be displayed.
This pointer’s position will move
according to the specified Alarm
value.

Shape Browser

EEERI BG_3D002U

Level pointer

BG_3D003U BG_3D004U [ Faisfie.

Curent PDE File : |c: “pragram fileshpro-facebthpdby ||
Title : [BG_apomiU I

2-34 LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



2.1 Parts

Chapter 2 - CREATING BASE SCREENS

PROCEDURE

REmMARKS

(4)In the [Graph Settings] tab, select the graph’sdis-
play direction and input the number of Axis Divi-
sions.

Bar Graph Settings [BA_D01]

— Enter 10 here

~ Select Up

(5)After all of the graph’sattributes have been entered

or selected, click on the button.

The Bar Graph’s outline will appear on the Base screen,
next to your cursor.

(6)Click on the point where the Bar Graph’stop left
corner isto be placed.

If necessary, use the Bar Graph’s handles to adjust its
size.
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The area to enter the number of the
divisions will appear only for agraph
type which has axis divisions.

To cancel the placement, click on

the icon.

To change the
Part’s size, refer to 2.3.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.

2.3.15 Changing
Attributes

The Bar Graph’ssizing handles are
located inside the graph.
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@ Pie Graphs ]

Pie Graphs create an area where a Device/PLC’'s Word Address datais
displayed as absolute values. The graph’s display will change to reflect
changes in the designated Word Address data.

B Pie Graph [General Settings] Attributes
<When displaying the data using absolute values>

Select Absolute or Relative

display

Entterhcomment Pie Graph Settings [PI_001] Enter the

atahere ( General Setings | Graph Setings | ShapeAole | Alam Selings | Word

Descrpton _—— W@ Address
The currently word Adess used to
selected Pie o | G store graph
Graph’s image . Bt data
appears here ow T ~_
o 1 Select the

Calls up the Part —T| desired
Shape Browser. [ Pace |[ comedt |[ Her Data Format

Parts can be
selected directly
from the Browser

& Absolute

Data stored in the designated Word Address is displayed in absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

& Word Address

Here, the Word Address' location data is entered to show where the desired
datais stored.

& Data Format
Select either the Bin and BCD display formats.
@ Display Mode +/-

With this check box [l#]| checked and the Bin data format is selected, a
negative numeric data can also be displayed.
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<When displaying the data using relative values>

Select Absolute or Relative

display
Enter Comment Pie Graph Settings [PI_DD1] / Enter the
data here General Settings J Giraph Settings | Shape/Calgr A\alnstmgs] Word Ad-
Description @iﬁé\éin}% dreSS '[0
The currently y—— store graph
séelecrt](,-:-d_Pm = ) FlEE O Disnbay Mode +/- data
rapn's image Bitlength l6 [ 1

appears here Lo R ot o | Select the

Mnvoie [T || | @ roco desired Data
Ca”S Up the Pal’t T N % g:ii;ssgomp\ement Format
Shape Browser. iy o
Parts can be [ree J[ cowi )b ] Specifies the
selected directly \ data Input
from the . , . Code
Browser Specifies the data’s Specifies the data

effective Bit Length Input Range
& Relative

According to the Input Range designated for the Word Address Data, the
datais converted and displayed as relative values.

€ Word Address
Here, enter the Word Address used to store Pie Graph data.
@ Display Mode +/-
When this check box [[«]| checked, negative numeric data can also be dis-
played.
@ Bit Length
Specifiesthe Bit Length of all data stored in the Word Address.
€ Input Range
Specifies the data’s Input Range.
€ Input Code

With No Code selected, only positive numeric data can be entered. To enter

negative numeric data, select either +/-2's Complement or +/-M SB.
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B Pie Graph [Graph Settings] Attributes

Pie Graph Settings [P1_D01]

General Settings | Graph Settings | Shape/Color [| Alam Settings | | Enter the

Select the Pie graph’s
y Dizplay Direction Az Divisions
Graph's (data ouEEEE | number of
display) £ Chws. From Batiom divisions
Direction
“ Place I “ Cancel | || Help
@ Display

Here, the graph’s data display start point, either Clkws. From Top or Clkws.
From Bottom, can be selected.

@\ If [Display Direction] is changed for a 3D part, its shade isrotated along with
Not

ote: that part. To let the shade displayed properly, click on the button,
X2 and sdlect the part again from [Shape Browser].

& AxisDivisions

The number of segments the Pie Graph will be divided into is entered here.
If the number of Axis Divisionsis specified as 10, 10 division lines will be
displayed. When no divisions are necessary, simply enter O.

B Pie Graph [Shape/Color] Attributes

A Pie Graph's border color, division line color (Axis Color), data display
color (Graph Color - Fg and Bg), and data display pattern can all be selected
here.

2.1 Parts B Selecting Colors

B Pie Graph [Alarm Settings] Attributes
Clicking on the Alarm Display check box will call up the Alarm Settings.
2.1Parts W Setting Alarms
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B Placing a Pie Graph

The procedure for placing a Pie Graph is shown below.

Data stored in D00102 displays on

the Pie Graph

When the value 34 (22?1\) is stored in
D00102, the graph appears like this:

PROCEDURE

REMARKS

(1) Select the [Parts] menu - [Pie Graph] command, or

click on the [ icon.

(2)Inthe[General Settings| area, input aWord Address

and select a Data Format.

Pie Graph Settings [PI_002]

Gieneral Settings | Graph Sellings | Shape/Color | Alam Seflings

Description 89 Absolute 12 Relative

:] word Address
——— @ o010z F 7] Display Made +-

Data Famat—
3 Bin _ 1
e

[ Flace H Cancel H Help

(3)Select a Part Shape from the Browser.

Enter D00102
here

Select BCD

You can aso use the Alarm Settings area to choose an

Alarm and select Colors, if desired.

Shape Browser

____________

CG_3Doo1u CG_3Doozu

CG_3D003U CG_3Do0n4u

Current FDE File : |c:: ‘program fileshpro-facettpdbh ||

Title: [C6_an001U Fll_ Hee |
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2.1 W Selecting a
Part Shape
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2.1 Parts

PROCEDURE

REMARKS

(4)In the[Graph Settings] tab, select the display direc-
tion and input the number of AxisDivisions.

Pie Graph Settings [P1_001]

— Enter 10

Display Direction

2 T, Fram Top
20 Clkans. From Bottom

" Select Clkws.
From Top

[ Ftace H| Cancel H| Help

(5)After all of the Graph’sattributes have been entered

or selected, click on the button.

A Pie Graph’s outline will appear on the Base screen,
next to the cursor.

(6)Click on the point wherethe Pie Graph’stop left cor-
ner isto be placed.

If desired, use the Pie Graph's handles to alter its size.

The area to enter the number of the
divisions will appear only for agraph
type which has axis divisions.

To cancel the placement, click on
the icon.

To change the
Part’s size, refer to 2.3.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.

2.3.15 Changing
Attributes
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@ Half Pie Graphs ]

This graph displays a Word Address numeric data (received from a Device/
PLC) as absolute or relative valuesin aHalf-Pie graph. The graph’s display
will also change to reflect Word Address data changes.

B Half Pie Graph [General Settings] Attributes
<When displaying the data in absolute values>

Select Absolute or
Relative display

Enter comment

Half Pie Graph Settings [HP_001]

data here =|_— Enter the
Word Ad-

The currently dress to
selected Half Pie store graph
Graph’s image data
appears here N

=~ Select the
Calls up the Part —| desired Data
Shape Browser. Format
Parts can be [ J[ o= ][t

selected directly
from the Browser

& Absolute

Data stored in the designated Word Address is displayed as absolute val ues,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Enter the Word Address where the data will be stored.
@ Data Format

Select the display data format from Bin and BCD.
@ Display Mode +/-

When this check box [[]| is checked and Bin data format is selected, nega-
tive numeric data can be displayed.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 2-41



Chapter 2 - CREATING BASE SCREENS

2-42

<When displaying the data in relative values>

Enter comment
data here

The currently
selected Half Pie
Graph’s image
appears here

Calls up the Part —|

Shape Browser.
Parts can be

Select Absolute
Relative display

Half Pie Graph Settings [HF_001]

Gienerel Setings | Guaph Settings |_Shape/Color | Algfn & etings |

Wword Address

&) [pooao FEE
Billengh [16 |

D Display Mode +/-

nput Plang Irput Cad

2 +7 2's Complement

=
...... Mowvabe [BEE | E]l £+ M5B

/ [Pace [ coce [ Mew |

2.1 Parts

or

Enter the
Word Ad-
dress used to
store graph
data

'™ Selects the

desired Data
Format

Specifies the

data’s Input

selected directly

from the Browser s

effective Bit Length

& Rdative

/

pecifies the data’s
Input Range

Code

Specifies the data’s

According to the Input Range designated for the Word Address Data the
datais converted and displayed as relative values.

& Word Address

Here, enter the Word Address used to store Half Pie Graph data.
@ Display Mode +/-

When this check box |l#lf checked, negative number data can be displayed.

@ Bit Length

Specifies the Bit Length of all data stored in the Word Address.

€ Input Range

Specifies the data’'s Input Range.

€ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2's Complement or +/-M SB.
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B Half Pie Graph [Graph Settings] Attributes

Half Pie Graph Settings [HP_D01]

General Gettings | Graph Settings | Shape/Color || Alarm Settings |

— Enter the

The Half Pie \‘\Disp\ayDueclinn graph’s
graph’s display 9 Ueshnie number of
direction is divisions
fixed to clock-

wise.

|| Place |” Cancel |” Help

@ Display Direction
Here, the Half Pie graph’s display direction is fixed to clockwise.
@ AxisDivisions

The data entered here determines how many pieces aHalf Pie Graph is
divided into. If the number of AxisDivisionsis specified as 10, 11 division
lines are displayed. When no divisions are necessary, specify the number of
divisions as 0.

B Half Pie Graph [Shape/Color] Attributes

Here, aHalf Pie graph’s border color, division color (Axis Color), display
data color (Graph Color - Fg & Bg), and display data pattern are all selected.

2.1 Parts B Selecting Colors

B Half Pie Graph [Alarm Settings] Attributes
If desired, Alarm settings can be set here.
2.1 Parts B Setting Alarms
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B Placing a Half Pie Graph
The procedure for placing a Half Pie Graph is as shown bel ow.

Data stored in D00102 displays on the Semicircle Graph

When data 34 (22h) is stored in D00102,
the Half Pie graph will appear as follows:

PROCEDURE REMARKS

(1) Select the[Parts] menu - [Half Pie Graph] command,
or click on the[™icon.

(2)In the[General Settings| area, input the Word Ad-
dress and Data Format.

Half Pie Graph Settings [HP_001]

General Settings | Graph Setfings | Shape/Color | Alaim Settings | 1 En ter D OO 1 0 2

Description 15 Absolte £ Relative

| wyw
Dooioz = ) Display Mode +-

EF—/—* Select BCD
@pco |

nnnnnn

[ Flace ]| Cancel H Help \

(3)Select a Part Shape from the Browser.
You can also usethe Alarm Settings areato enter Alarm
settings and select Colors, if desired.

2.1 Parts B Se-
lecting a Part Shape

Shape Browser

| HG_3D001 HG_3D002

HG_3D003 HG_3D004

Current FDB File : |c: ‘program fileshpro-faceitspdbh ||

Title: [HG_3D001 F I ek
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PROCEDURE

REmMARKS

(4)In the[Graph Settings] tab, input the number of axis
divisions.

| Bereral Settings]| Granh Setings | Shape/Color || Alarm Settings |

Display Ditection fis Divisions
& Elcmis i

= Enter 10

[ Flace H| Cancel H| Help

(5)After all of a Part’s attributes have been entered or

selected, click on the button.

The Half Pie graph’s outline will appear on the Base
screen, next to your cursor.

(6)Click on the point where the Half Pie Graph’s top
left corner isto be placed.

If desired, use the Half Pie graph’s handles to alter its
size.
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The areato enter the number of the
divisions will appear only for a
graph type which has axis divi-
sions.

To cancel the placement, click on

the[=]icon.

To change the
Part’s size, refer to 2.3.3 Scaling
Up/Down

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.

2.3.15 Changing
Attributes
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@ Meter Graphs ]

Meter Graphs create an areawhere a Device/PLC’s Word Address' numeric
datais displayed as absolute or relative valuesin a Meter Graph (i.e. a
needle moves to show the value). The graph’s display will change to reflect
Device/PLC Word Address data changes.

B Meter Graph [General Settings] Attributes
<When displaying data in absolute values>

Select Absolute or

Enter comment Relative display
data here oter Graph Sellings
" '3""5 ‘ 2 "“f““‘ r 1 | Enter the
eneral Settings | Graph Settings | Shape/Color | am Settings .
The currently Description (B dbsote T Relative ) desired Word
T o Address data

selected Meter

7] Display Mode +/-

Graph,S Image D ata Farmat=— -
appears here /| |l A — Select the
Calls up the Part — gg?;;t;? Data

Shape Browser;
Parts Shapes can
be selected |
directly from the

Browser.

" Place H Cancel H Help

& Absolute

Data stored in the designated Word Address is displayed as absolute values,
from 0 to 100 (with Display Mode +/- selected, -100 to 100).

€ Word Address

Enter the Word Address where the data will be stored.
@ Data Format

Select the display dataformat from Bin and BCD.
@ Display Mode +/-

When this check box |l is checked and Bin data format is selected, nega-
tive numeric data can be displayed.
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<When displaying data in relative values>

Select Absolute or
Relative display

Enter comment Enter the
data here Meter Graph Settings [MT_001] Word Address
h { " General Settings | Graph Settings | Shape/Color | 4fam Setings | used to store
e currently Desertion ) display data

selected Meter’s L R ; play
. B [poooo | Display Mode +/-
image appears
herg o Bt 15} I Select the

Input Riang: Input Cod desired Data

in. Vel = || %5 NoCode
Calls up the Part ., Dg ![QMZSCumplemem Format
Shape Browser, | | L BE 5 Jjo
Parts Shapes Specifies the
can be selected [ = data’s Input
directly from the L N Code
Browser Specifies the data’s Specifies the

effective Bit Length data’s Input
Range
& Relative

According to the Input Range designated for the Word Address Data, the
datais converted and displayed as relative values.

€ Word Address
Here, enter the Word Address used to store Meter data
@ Display Mode +/-
When this check box [[«]| checked, negative numeric data can also be dis-
played.
@ Bit Length
Specifies the Bit Length of all data stored in the Word Address.
€ Input Range
Specifies the data’s Input Range.
@ Input Code

With No Code selected, only positive numeric data can be entered. To enter
negative numeric data, select either +/-2's Complement or +/-M SB.
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B Meter Graph [Graph Settings] Attributes

Meter Graph Settings [MT_001]

General Settings | Graph Settings | Color/Shape || Alaim Setting | L On Iy when a
graph type
Select the which has
Meter’s (data divisions is
di_spla_y) selected, will
Direction this selection
appear

|| Place ||| Cancel |H Help

@ Display Direction

Here, the Meter’s display direction, either Clockwise or Counterclockwise
can be selected.

& AxisDivisions
Here, the Meter increments are entered. If the number of Divisionsis

specified as 10, 11 division lines are displayed. When no divisions are
necessary, smply enter “0”.

B Meter Graph [Shape/Color] Attributes

Here, aMeter’s border color, division color (Axis Color), and needle color
(Meter Color) can be selected.

2.1 Parts B Selecting Colors

B Meter Graph [Alarm Settings] Attributes
If desired, an Alarm’s settings can be set here.
2.1 Parts B Setting Alarms
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B Placing a Meter Graph
The procedure for placing a Meter Graph is as shown below.

KData stored in D00102 displays on the Tank Graph \

When data 34 (22h) is stored in D00102,
\ the Meter will appear as follows: J

PROCEDURE REMARKS

(1) Select the [Parts] menu - [Meter Graph] command,
or click on the & icon.

(2)In the [General Settings] area, input the Word Ad-
dressand Data For mat.

Meter Graph Settings [MT_001]

General Selfings | Graph Sellings | Shape/Color | Alem Setings | - Enter
[— D00102
— Select BCD
(3)Select a Part Shape from the Browser. 21 Partsm Sdlect-

You can also use the Alarm Settings areato enter Alarm | ing a Part Shape
settings and select Colors, if desired.

Shape Browser

2

MT_3D002

MT_3D003 MT_3D004 m

Current FDE File : |c:\program files\pro-facehtpdb ||

Title : [MT_ap0m ] [ v |
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2.1 Parts

PROCEDURE

REMARKS

(4)In the [Graph Settings|] area, input the number of

divisions and data display direction.

Meter Graph Settings [MT_001]

Ploce Hep

(5)After all of a Part’s attributes have been entered or

Enter 10

™ Select Clockwise

selected, click on the button.

The Meter’s outline will appear on the Base screen, next

to your cursor.

(6)Click on the point wherethe Meter’stop left corner

isto be placed.

If desired, use the Meter’'s handle to alter its size.

The Axis Divisions will appear
only when Absolute display is se-
lected.

To cancel the placement, click on

the icon.

To change the
Part’s size, refer to 2.3.3 Scaling
Up/Down.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.

2.3.15 Changing
Attributes
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@ Trend Graphs

)

This Part displays Word Address numeric data as absolute values on a Trend
(line) graph. The graph’s display will then change to reflect Word Address
data changes.

B Trend Graph [General Settings] Attributes

Enter comment
data here

The currently selected
Trend Graph Shape

Trend Graph Settings [TR_001]
[- Channel S ettings r Shape/Calor r Alarm Settings ]
General Settings Graph 5 ettings

D escription

7] Display Mode +/-

appears here

Calls up the Part
Shape Browser,
displaying a list of
pre-made Trend
Graph Shapes. Part
Shapes can be

Broweser...

Il —— Select the
desired Data
Format

|- Flace ” Cancel || Help

selected directly from
the Browser.

& Data Format

Here, the display dataformat is specified as either Bin or BCD. With the

Display Mode +/- check box [[#f] checked, and Bin data format selected,
negative numeric data can also be displayed.

B Trend Graph [Graph Settings] Attributes

Sel ect a Trend Graph Settings [TR_001]
ra h t e | General Settings|| Graph Settings | Channel Settings || Shape/Calor || Alarm Settings |
grap yp \(@ Hemat 0 PerRecorder {7 Black D\splay)
Display Direction Data Samplss Bxis S sle——

9 Up Data Samples ‘ ’( V-duis Divisions ‘ | - Enter the

£ Lekt sl i s Divisions [10_ ]
Select the Do - number of X
data display ) Figh and Y
direction divisions

|| Place ” Cancel |” Help |

Enter the No. of Samples, Scroll
value, and Sampling Time

@ Graph Settings

Using “Normal”:

The specified Word Address's data changes are dis-

played over timein aTrend Graph. Display data
aways starts at the “0” point. Aseach (time) sampling
period elapses, the latest datais added in the specified

display Direction. When the graph’s
reaches the limit of the Trend Graph,

poly(gondl) line
thegraphis

shifted in the display Direction for the number units

specified in “Scroall”.
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E.g.) Display Direction: Right, Scroll: 4

Enter screen scrolls
at this point

|

=>§\\

Begin
ity [ a] | 2] [ e | 40] 2 |

Using “ Pen-Recorder”:
A specified Word Address's data changes are displayed
over timein aTrend Graph. The data's display always
beginswith “0”. Aseach sampling period elapses, the
graph’s poly(gonal) line is shifted one division opposite
the specified display Direction. The latest datais
always displayed at the very limit (in this example, the
right side) of the Trend Graph’s display area.

E.g.) Display direction: Right

|

|

Begin Display | a0| | 25| g | 40| 20 |

B Block (Display Mode)

All the data in consecutive word addresses are sampled at the designated
time, then graphed as a single trend line. Data changes in multiple word
addresses can be monitored as a single block by the graph. Enter address
numbers to control the ON/OFF display of the graph.

T ' ' ! '
N | I ] L] | ] I
= :\/\:::’__: =] 1= ] !:>__:/A
| E | | 4 | E | E |
I ] =] I 1 I ] -] I
Il | - | - Il Il - Il
i AN i i S

0lxq 1 z z 1 K
Y o o & 3 &
0 0 0 40 40 20
26 25 25 20] 60 &0
B0 60 60 25 i &0
40 40 40 0 30 T
20 20 20 i) i 40
Status 1 Status 2 Data Status 1 Status 3
displays deletes Change displays clearsold
the graph. the graph. the graph. graph and
) ) displays
*1 Control Satus (addressfor controlling display) new one.

*2 Number of address data to display
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To perform Block Display, keep the areas for the number of addresses
specified below, beginning from the specified Word Address.

B Block Display Word Address

The LS Area (from LS0020) or the PLC Word Address is specified. There
is speed difference between when the LS Areais used and when the PLC
Word Addressisused. Refer to the following:

€ WhenusingtheLSArea

When specifying the LS Area, designate “Read Area Size”. The Read Area
constantly reads out data from the external device to the LT, regardless of
screen display status. For Block Display, “Control”, “Data Count”, and
“Data’ are required to be specified for the Read Area. Sincethis area
always reads out data, the time from Control bit turning On to graph display
will be shorter than when using the PLC Word Address. However, when the
Read Areasizeislarge, the entire screen display time will be slower than
when using the PLC Word Address. Also, the Read Areasizeislimited up
to 256 words.

€ When usingthe PLC Word Address

When the PLC Word Addressis used, “Control”, “Data Count” and “Data”
are constantly read out from the PLC to the LT, regardless of screen display.
The time from the “Control” display bit turning ON to graph display to read
out “Data” will be longer than the time when the LS Areaisused. However,
when graph display is not performed, time required to display data of the
entire screen will be shorter than when using the LS Area. Thisfunctionis
also useful when data for more than 256 wordsis required to display mul-
tiple graphs viathe Block Display function.
@V\ote: * When the PLC Word Addressisused, to increase the entire screen data
2] display speed to display multiple graphs via Block Display function, the
following method is useful.
Specify the Offset of all graphs displayed via the Block Display function,

and then designate each graph’s“ Control”, “Data Count”, and “ Offset”
with consecutive address.

Control
Data Count (n) First Data Unit

Offset

Control
Data Count (n) Second Data Unit
Offset
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€ Word Address's setting items
The Word Address setting items for Block Display is asfollows:
The Offset setting isvalid only when the PLC Word Addressis used.

Without Offset Control With Offset Control
+0 Control +0 Control

+1 Data Count (n) +1 Data Count (n)
+2 +2 Offset (m)

Data "n"(units)

+m
Data "n"(units)
+(m+n-1)
¢ Control
Therole of each bit in the Control Status word is described in the following
passages.
 To begin the graph display, turn bit 00 ON.
15 02 02 01 00

Control
Status |

* To clear the entire graph, turn bit 01 ON.

Control 15 03 02 01 00
ontro
Status SS D

* To clear the graph, then re-draw it, turn both bit 00 and bit 01 ON.

15 03 02 01 00

Control SS | |
Status

& Data Count

Defines the number of data valuesto display on the graph. To
display a graph like the one shown below, set the Data Count to 7.

Data
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A °* Todisplay the graph, delay Control Status setting by a time
] longer than the communication cycle time, after storing the data
/mp;ﬂa,,, count and data values.

» After displaying the graph, the Control Status resets to 0. To
display the graph again, store the data in the same Control
Status word. However, be sure to delay at least 50 ms after the
Control Status changes from 1 to O.

e The Scale value setup in the Graph Settings dialogue box
refers to the number of trend line segments (“6” in the Data
Count graph on the previous page), and the Data Count for the
block display trend graph refers to the number of data points.

» To display the graph with the LS area setting, delay Control
Status setting by a time longer than the communication cycle
time, after storing the data count and data values.

e To display the graph with the PLC Word Address setting,
delay Control Status setting by a time longer than the communi-
cation cycle time, after storing the data count and data values.

& Offset

The areawhere the data for atrend graph is stored isindicated. When the
PLC Word Address is used, this setting isvalid.

& Data
This area stores the data for atrend graph.

B Setting Example (when the offset setting is not used:)
€ When using only the display

Word address Display
a0 | 1 Jcortral Status
T |Data Count
20 |Data1
~ 30 |[Data 2
\ 10 |paaz  Datacd
~ 20 |Datz 4 ~
T T T T T 20 |Data & @' T T T
0 40 |Data 6 0

30 |Data 7
15 0 02 o0l 00 it The.prewous graph
remains and the current

data graph overlaysit.

Contral Status

When “1” is entered to the Control Status word, bit 00 turns ON and the
new graph overlays the previous display.
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€ When clearing the display

Woard address

Control Stabus

Data Court

Data 1

Data 2

Data 2

Data 4

Data &

Data &

Data 7

2.1 Parts

Clear

16

03 02 o

0

Control Status

[

Bit

Clears the previous
graph display. Even if
there is data, the graph
does not display.

When “2" is entered to the Control Status word, bit 01 turns ON and the

new graph display is cleared.

Word address

Cortral Status

Diata Count

Data 1

Data 2

Data 2

Data 4

Data &

Data &

Data 7

Data(q

€ When clearing then displaying the graph again

Display again

O 02 01

Qi)

Control Status

Bit

Clears the previous
graph display, then uses
the current data to
display thegraph again.

When “3” is entered to the Control Status word, both bits 00 and 01 turn
ON, and after the graph display is cleared, the current datais used to display

the graph again.

& Data Samples

Data Samples: The number of data“units’ to be displayed in asingle
Trend Graph. Up to 638 can be used.

Scroll:

The number of data units to be scrolled when the

polygonal line reaches the limit of the Trend Graph’s
display area. Thefield is enabled when the graph typeis
set to “Normal”.
Sampling Time: The dataread interval (from the host Device/PLC) is
input in seconds. The field is enabled when the graph
typeisdesignated as"Normal" or "Pen-Recorder”. This
option cannot be specified when the graph typeis

designated as "Block".
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@ Display Direction
Select the Trend Graph's display direction, either Up, Left, Down, or Right.

Z

ote: If [Display Direction] ischanged for a 3D part, its shadeisrotated along with

that part. To let the shade displayed properly, click on the[ sower. | button,
and select the part again from [Shape Browser].

@ AxisScale

Enter the number of unitsthat the X and Y axes are to be divided into.
When no divisions are necessary, input “0”.

B Trend Graph [Channel Settings] Attributes

DeSI nates Or Trend Graph Settings [TR_001] Enters the

g h General Settings || Graph Settings || Channel Settings | Shape/Color | Alam Settings | T
enters t e Wo. of Channels ‘Word Addiess Word Address
number of Epos  — B Do used to store
datalines urent Charmel the current
(channels) to e === channel’s

i f IEEJEECO @0 i
be ?;]sp_:_ayeg St display data
on the Tren
Graph

'p [Feee [ cancel ][ Heb ~ Selects th
Designates e'ects the
the channel color and type
being of line used
currently for the current
selected channel

€ Number of Channels

Enter the number of channels used in the Trend Graph. Use the “ Current
Channel” areato select which channel is being specified. Up to 20 channels
can be entered in a Project file (LTE file, including the Data sampling
frequency number).

€ Word Address

Enter the Word Address used to indicate where the Trend graph’s dataiis
stored.

B Trend Graph [Shape/Color] Attributes

The Trend Graph’s border color, division color (Axis Color), and Trend
Graph’'s display area color (Graph Area Color) can be selected.

2.1 Part B Selecting Colors

B Trend Graph [Alarm Settings] Attributes
If desired, an alarm’s settings can be set here.
2.1 Part B Setting Alarms
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B Placing a Trend Graph
An example of a Trend Graph (scrolling left to right) is shown below.

-
Data stored in D00102 is displayed on the Trend Graph

v ENES e

When 34 (22h) is stored in

Axis Seffings

* Sample 20

* Seroll 1%

* Sampling Time 10 sec

D00102 the graph will look like
*_this:

* Mg D, Mer) 10
(Hory 10 .

PROCEDURE

REMARKS

(1) Select the [Parts] menu - [Trend Graph] command,
or click on the 2] icon.

(2)After clicking on the [General Settings] tab, select
the data format.

Trend Graph Settings [TR_001]

Shape/Colar I Alam Settings I
Graph Seftings

™) Display Mod= +.-’-/

[Drata Format
#Bin — |
i3 BCD

[ Charingl Settings I
General Settings

D escription

| I

|l — Select Bin

Erowser..

(3)Select a Part Shape from the Browser.
You can also usethe Alarm Settings areato enter Alarm
settings and select Colors, if desired.

[Shopebiowsr |

TR_3D00ZR

TR_3D001R

TR_3D003R

Parts File...

Cumrent PDB File : [ram fleshpro-faceiitpdbhpdb. pdb

Fl b |

Title :[TR_30001R
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Datain the range of 0 to 100 can
be displayed on the Trend Graph.
When the datarange is from -100
to 100, check the Display Mode
+/- check box.

2.1 Parts ® Se-
lecting a Part Shape
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PROCEDURE

REmMARKS

(4)In the [Graph Settings] area, select the Graph Type
and Direction, and enter thenumber of Data Samples
and Axis Divisions.

Select Normal

= — Enter 20

L — Enter 19

| Enter 10
™~ Enter 10

™ Enter 10

Flace Help

Select Right

(5)In the Channel Setting area, enter the Number of
Channels, then enter each channel’s Word Address
and select the desired colors.

In this example, since the Number of the Channelsis
“1”, you only need to enter one Word Address.

Trend Graph Settings [TR_D01]

[' General Settings [ Graph Settings 1
Channel Settings | Shape/Color [ Alam Setiings | +—— Enter D00102
Mo. of Channels word Address
i Epe e
Current Charinel
Channel 1 Fl| ==

Fo [N ) I ) ek
N | I m] [ e

(6)After all of Part’s attributes have been entered or

selected, click on the button.

The Trend Graph’soutlinewill appear in the Base screen,
next to your cursor.

(7)Click on the point wherethe Trend Graph’stop left
corner isto be placed.

If desired, usethe Trend Graph’s handlesto alter itssize,
after placement.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

If the morethan one channel is
used, be sureto enter the Word
Address and select the Color for
each channel before placement.

u
Important

A Trend Graph’s channel
Word Addresses should not
be the same as other Part ad-
dresses, otherwise, it will
cause a LT error.

Up to 20 channels can be desig-
nated for a Project file (including
the Data Sampling frequency num-
ber).

Up to 8 Trend Graph display areas
can be placed on a single screen.

To cancel the placement, click on
the[w]icon.

To changeaPart’s
size, refer to 2.3.3 Scaling Up/
Down

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.
2.3.15 Changing
Attributes
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m Keypads ]

Here, pre-made keypads are used to enter data to a designated Word Ad-
dress. In order to input data viathe keypad, it is necessary to first create a

Keypad Input display.
2.1.14 Keypad Display

B Keypad [Description] Attributes

Keypad Settings
DiSpIayS the General Settings | Select the
CUrrently Keypad Type=// Keypad’s data
selected 1% Decimal — ] format
Keypad’s £ Hex
image
Calls up the PadEoIor |l — Select the
Part Shape IIJE]IIJ:]DEI Bl OJ Keypad's
Browser. border color
Parts can be
selected || Flace | || Cancel | || Help |

directly from
the Browser

@ Keypad Type

First, a Keypad type needs to be selected that will be suitable for the data
format specified. To select aKeypad type, simply click on the Browser and
the selection of available Keypads will be displayed.

@ Pad Color
The Keypad's border color (Pad Color) can be selected here.
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B Keypad Key Functions

The various Keypad Key functions are shown in the table below.

Decimal Hexadecimal

Keypad Specs

Common Keys

Numeric value keys (for Hex, the keys are 0 to F).
Inputs the corresponding value in the display.

Delete key
Deletes the character above the cursor.

Clear key
Clears the entire display. If the Bis pressed after clearing,
0is stored in the PLC Word Address.

Enter key
Registers the set value and writes it to the PLC Storage

Address. Then, the cursor moves to the next display and
awaits next input.

Cursor keys
Moves the cursor right and left within the display.

Jump keys
Moves to the next Key Display without entering the set value.

You can use these keys to jump to the area where you wish to
enter data.

Negative key
Only available for

Dec(imal) and +/-
format.

Dec. Only keys

Decimal Point key
Valid when Decimal
Places have been
entered for Decimal
and BCD numbers.
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B Placing a Keypad
The procedure for creating and placing a keypad is shown below.

s ™
KD_1 72 5[4]
A
o2 ]
os ]
When the Trigger KD_1to3 Input data
Bit MOO8O0 turns (Word Address D0050 from the
\ ON, ... to D0052) can receive... Keypad y

For how to create the display areafor the keypad shown
here, refer to 2.1.12 Keypad Display.

PROCEDURE REMARKS

(1) Select the[Parts] menu - [Keypad] command, or click
on the[Eg icon.

(2)Select a Keypad Data Format Type.

Keypad Settings
Keypad Type=— .
1% Decimd Select Decimal
120 Hew
Fad Colar
I I o ) B D
T
|| Flace | || Cancel ‘ ” Help |
(3)Select a Keypad Shape from the Browser. 2.1 Parts ® Select-
If desired, select a color from the Shape/Color area. ing a Part Shape

KP_3D001D KP_3D002D

Cunznt PDB File : [c\program fles\pro-face\pdbtpdbpdd |
Title - [KP_3D001D I=]| Help
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@ Keypad Display ]

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

Here, the area used to display Pop-up Keypad datais created. When the
Keypad Display is touched, a Pop-up Keypad appears, allowing you to enter
avalue.

When not using the pop-up keypad, place an additional keypad separately
from the Keypad Display.

* When the Keypad display is placed, the Pop-up Keypad will automatically
be set. You don't have to place a new keypad for entering numerical data.

* The Keypad Display cannot be set up simultaneously with the L ogging
Display.

B Keypad Display [General Settings] Attributes

Enter the
Enter comment Keypad Input Display Setlings [KD_001] = Word Address
data here General Settings | Display Fomat | Shape/Color || lam Settings || Exterd used to store
[rescription “wiord bdddress H
The currently | [ [oricoomn display data
.selected. Part's ——
image will appear e Enter the
here Trigger Bit
Calls up the Part | Tl Use Popup Keypad Address to
Shape Browser. allow you to
Parts can be perf'orm dgta
selected directly settings via
from the Browser the Keypad
Select this
option to display
a keypad when
the LT screen’s
[ Peee ][ comed [[ ek Keypad Input
Display is
touched.

€ Word Address

The Word Address is used to store the keypad display’s data.

@ Trigger Bit Address (When not using the Pop-up keypad feature.)

When this bit isturned ON, the Keypad's data entry area becomes active.

@ Use Pop-up Keypad

When this option is selected, touching the Keypad Display will automati-
cally display the pop-up keypad on the screen. When this option is selected,
the Trigger Bit Addressis disabled.

When "Text" is selected on the [Display Format] tab, the "Use pop-up
keypad" option is disabled.
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B Keypad Display [Display Format] Attributes

Keypad Input Display Settings [KD_001]
| General Settingz| Displaw Format | ShapesColor || alarm Settings || Extend |
( miksiie £ Relive 9 Orar, Sy ) Select the data to
O Code ++- Display & Write Data Format be dlsplayed.
Enter the No. O Reundittp i;f)it y ga[;t | ’
H 2. ecimal ecimal
gﬁgi);zplay g:zz g:zg Select the Data
_ & 0o i | Length and Data
The decimal 1 Bin £ Float Format here.
point is not
included in
the display
digits. — ]
N of Display Digis ) Character Size Character size
Enter the No. (" vemareen | H] ) | Bxie Fl can be selected
of Digits after here
the decimal
po int [ Pa= | || Cancel | || Help
& Absolute

Gt

16-bit or 32-bit data can be processed. Configure the "Data Display Format"
and "Code +/-" parameters. When "Dec" is selected, checking the "Code +/-
" checkbox will enable the display of data with negative values.

Select "Oct" to process only 16-hit data, and "Float" to process only 32-bit
data (IEEE754 format). Errors may occur with the "Float" mode.

When "Float" is selected, the Round Off option will round off the value
according to the No. of Display Digit setting. When "Float" is not selected,
the all digitsto theright of the specified digit will be discarded.

Example: When Decimal Placesis set to "2"
Vaue: 1.9999....
When "Round Off " is selected: 2.00
When "Round Off" is not selected: 1.99

When using a Logic Symbol to Word Addressor Trigger Bit Address, select

o\g " 32 Bit" data display format.
& Relative

32-bit data can be processed.

Configure the Bit Length, Data Display Format, Input Sign, and Code +/-
settings. When "Dec" is selected, putting a checkmark to the "Code +/-"
checkbox will enable the display of data with negative values.
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The Input Code can be selected from the following three types:

No Sign

Processes data of positive numbers only.
+/- 2'scomplement numbers

Negative values are processed with two's complement numbers.
+/- M SB sign

Negative values are processed with MSB signs.

When using Relative data, the data written to the host (PLC) is converted
automatically based on the Input Range settings.

Host LT

Irpt
range :H Output range

A data calculation program in the host (PLC) can be omitted.

The Input range (the range of data stored in the Word Address) varies
depending on the "Input Sign" setting. The "Display range” (the rangeto
which the datais converted and displayed) varies depending on the cardinal
number of the dataand "Code +/-" setting. Make sure that the Display range
will not exceed the Input range; otherwise, the entered data may not be
displayed due to an error processing the function.

<Minimum and Maximum Range Values>

Data Format Input Range Display Range
Code Input Code +/-
No Code +- 0 65535| -32768 - 32767
+ 0 - 65535
Dec| 2'scomplement +/- -32768 32767| -32768 - 32767
+ 0 - 65535
MSB +/- -32767 32767 -32768 - 32767
+ 0 - 65535
No Code 0 65535 0 FFFF (h)
Hex| 2'scomplement -32768 32767 0 FFFF (h)
MSB -32767 32767 0 FFFF (h)
No Code 0 65535 0 177777 (0)
Oct| 2'scomplement -32768 32767 0 177777 (0)
MSB -32767 32767 0 177777 (0)

The "Round Off" operation rounds off the values in decimal places that are
generated in the range conversion of relative values. When this option is not
selected, the fractions will be discarded.
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& Text

Text data can be processed. The datawill be written to the PLC in ASCI|
code or Shift JIS code. Specify the maximum length of the text to be stored.

Designate the maximum number of characters for the "No. of Display
Characters' setting. Up to 80 characters (single-byte) can be displayed. One
word of the data storage address is able to store two single-byte characters or
one double-byte character. When the No. of Display Characters exceeds 2"

, aseguence of contiguous word addresses will be automatically occupied in
the specified data storage address by the number of the words that store the
excess characters.

ote: - Thepossiblenumber of display linesand charactersis determined by the
2] LT screen sizeand orientation, and thetext size setting.

« If the number of charactersentered islessthan the number designated for
No.of Display Character, spaces (20H) which will balance the number will
be stored.

<When No.of Display Character is 6, and 4 characters are entered>

I I A

* |f the No. of Display Character cannot be divided by 2 (When PLC’sone
deviceis 16-bit length), or if the No. of Display Character cannot be di-
vided by 4 (when PL C’sone deviceis 32-bit length), NUL L (O0H) will be
stored at the end.

<When No.of Display Character is5, and 4 charactersare entered :when
PL C’sonedeviceis 16-bit length>

I I I T I T

@ No. of Display Digits

Here, the number of digits displayed, to the right of the decimal point, is
input.
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& Decimal Places
Here, the number of digitsto the right of the decimal point isinput.
Each dataformat availableis listed in the table below.

Data Format Code | DataLength | Display | Decimal
Digits Places
Dec +/- 15 0
Hex + L6 bi 14
BCD ¥ 6 bit ) 3
Data
Values Oct 1-6
Dec +/- 1-10 09
Hex + 32 bit 1-8
BCD + 18 07
Char. Col. No. of Char. 1-80

When using 32 bit data, the relationship between the top and bottom of the
Word Address will differ depending on the Device/PLC used.

Device/PLC Connection Manual

When the No. of Display Digitsisset to 5 and the Decimal Placesis set to 2,
avalue appearson the Keypad Input Display as shown below.

@Ikv\ote:
X2

€ Character Size
Thelabdl’s character size is selected here.

2.2.9 Text

B Keypad Display [Color/Shape] Attributes

The Keypad Display’s border color, data display color (Text), and interior
color (Plate) are selected here.

2.1 Parts B Selecting Colors

B Keypad Input Display [Alarm Settings| Attributes
Set up darmsif necessary.
2.1 Parts B Selecting Alarms
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B Keypad Display [Extend] Attributes

Use thistab to designate the Input Style, Display Style, and Interlock func-
tion.

2 Auta Clear & Input Check

= Dizplay Syl

gg:ﬁffﬁ' ;zzfﬁ“ﬁjs - Specify the Display Style.
= Interlack —

Ittt Addhess:

| 7 Specify the ON/OFF status
Toshiaalsblsesnslion of the Interlock function.

i (This function can be set up

only when the pop-up
keypad is used.)

|| Place |” Cancel |” Help

€ Input Style

e Auto Clear OFF

The previous input is not cleared and displayed in the input area. The new
input is appended to existing data. To clear the existing values, enter "CLR"
from the Touch Keypad.

* Auto Clear ON

The previous input is cleared when the first character (except the cursor
keys, ENT, DEL and BS keys) is entered.

* Auto Clear & Input Check

When barcode input is performed in this mode, the Auto Clear function is
enabled and the input data are monitored so that it matches the No. Display
Digit. If the data length is inappropriate, it is not written into the word
address. When datais input from the Touch Keypad, only the Auto Clear
function is enabled.

* Bar Code Input

Selecting this feature enables input from the Touch Keypad and barcode
readers. Touch Keypad input enables the entry of numeric data. Barcode
Reader input enables the entry of text strings.

Using the Bar Code reader ** connected to the LT, data can be read then
written to the data storage address setup, prohibiting data input from
barcode reader.

When inputting data using the barcode reader input...

» Dataread using the barcode reader is written automatically to the data
storage address. It is unnecessary to usethe ENT key on the touch
keyboard.
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« If you enter a change screen command during barcode input, because
the screen change priority is higher, the data being input will be
ignored, so please use with caution.

» Ending data write causes the System Area's Status 03 bit to reverse.
Using this, you can figure out the data write timing.

@ Display Style

« Shift Left
« Shift Right

Select the display style from the Shift Left and Shift Right. The data will
appear, starting from the side designated here. The Shift Right is selected by
default.

e Zero Suppress

Select this option to omit the leading zeros of display data. E.g. When the
Display Lengthis 4 and the Zero Suppressis NOT selected, 25 appears as
0025.

» Zero Display

When this option is clicked, and the host (PLC) datais 0, the value O will
not display.

@ Interlock (Only when the pop-up keypad is used)

Only when a bit designated via Interlock Addressisin a state that has been
selected via [ Touch available condition], the pop-up keypad becomes effec-
tive. Whether the pop-up keypad is effective in ON state or in OFF stateis

selectable here.

Touch Available Interlock Address Touch Available/
Condition Status Not Available
. ON Touch Available
BItON OFF Touch Not Available
. ON Touch Not Available
BItOFF OFF Touch Available
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B Placing a Keypad Display
The Keypad Display’s placement procedures are shown below.

PROCEDURE REMARKS

(1D Select the [Parts] menu - [Keypad Input Display]
command, or click on the[&]icon.

(2JM akethefollowing settingson the[General Settings] | When [Use Pop-up keypad] is se-
tab. lected, the Trigger Bit Addressis
[When using the Pop-up Keypad] disabled.

Place a check mark in the [Use Pop-up keypad] box.

General Settings | Display Format | Shape/Colar | &lam Settings || Extend |
[rescription Wword Address

| [ponoo FlE

Tiggey Bl diddinss

|| Flace |” Cancel |” Help

[When not using the Pop-up keypad]

Removethe check mark from the [Use Pop-up Key-
pad] box, and enter theword addressand trigger bit
address.

Keypad Input Display Settings [KD_001]

General Settings | Display Format |[ Shape/Color |[Alam Settings |[Estend |

Description ‘Word Address

] | e Enter DO0050
Trigger Bit Address
(%] roosee = Enter MOO80
D Use Pop-up Keypad

|| Place |H Cancel ||| Help
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PROCEDURE REMARKS
(3)Select a Part Shape from the Browser. SAEEEEK 2.1 Parts B Select-
If desired, select colors from the [Shape/Color] areaand | ing a Part Shape
input the extension settings.

L]

KD _3D005]| KD SDUUEJ Paits File...

Current PDE File |c Sprogram filespro-faceilt\pdbhpdb,

Titke :[KD_20001 Il b |

(4)In the[Display Format] area, specify the Data Dis-
play Format, No. of Display Digits, and Decimal
Places (i.e. number of the digits after the decimal
point) tobeused. If desired, select the Character Size.

Gieneral Settings || Display Format | Shape/Color || Alaim Settings || Extend |
3 WEsollis 3 Relative 3 Baay, Sing

O Code +- Display & Wit Diata Fomat

O Pl 16 Bit 32Bit
@ Decinal {23 Diecimal
£ Hex 25 Hex
3 BCD £ BCD
24 Octal 4 Bin
25 Bin 25 Flaat

No. of Display Digits [4 ‘ Lhasactes Size Enter 4
DeomalPlaces ) o AT Do not enter
anything here (i.e.
“ OH)

[ = |H Cancel |H Help

(5)After all of theKeypad Display’sattributeshavebeen | When placing the Keypad Input
entered and selected, click on the[ ree= | button. Display, do not rotate it. Doing so
will causethe Pop-up keypad to dis-

The Keypad Display’s outline will appear on the Base play in the incorrect orientation,

screen, next to your Cursor.
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PROCEDURE

REMARKS

(6)Click on the point where the Keypad Display’stop
left corner isto be placed.
If desired, use the Keypad Display’s handlesto alter its
size.
Even though the set value display areais scaled up or
down, the character size will not change. To change
the character size or position, directly select the charac-
tersinside the border.

(7)Repeat from step (1) to create Keypad Displayswith
Word Addresses “D00051" and “D00052".
Except for the addresses, all settings should be the same.

To cancel the placement, click on

the icon.

AT To change the
Part’s size, refer to 2.4.3 Scaling

Up/Down

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.

2.4.14 Changing
Attributes

If the [Ctrl |key is pressed when the
display area’s border is scaled up
or down, itsinterior characters are
also scaled.
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B Using a Keypad to Input Values

€4 \When not using the Pop-up keypad

The procedures for entering setting values viaa Keypad on the LT screen are

shown below.
- ™
MOS0
wal ]
oz ]
. KD 1to 3 i
Biooso s ModAddress  nputca
ON D0050 to D0052) from the
L can receive... Keypad p.
PROCEDURE REMARKS

(1)Here, three Keypad Display have been set to sharea
common start bit.

ID No.

(2)Then, when the PLC’s internal Trigger Bit M 0080
turns ON,

PLC
N

1.

(3)First, the Keypad Display KD_1'sdisplay reverses
(highlights) and waitsfor input.
The square box shown below represents the cursor’s po-

sition.
]
[ 1]

[ 1
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For how to create a

Keypad,

refer to 2.1.13 Keypads.

For how to create a
Keypad Display, refer to 2.1.14 Key-
pad Display B Placing a Keypad

Display.
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PROCEDURE REMARKS

(4)Pressthe Keypad’'skeystoinput thedesired value.

o512 |[A][v] <[]
9 ]18] 7] [ee]
[6]15] [4][-]
[0]L ]k

(5)Pressthe [ENT] key toregister the value.
E

(6)Theregistered valuewill then bestored in Word Ad- | Set value display areas having a
dress D050, which was designated in KD_1. Next, | common Trigger Bit will enter a
KD_2 will be highlighted and beready toreceivein- | wait statein order, from the lowest
put. ID number upwards. After thefirst

value has been registered, the next

PLC value's display areawill automati-

£ 62
-, | s .
cally be ready to receive input.
] [IE B
N

—A=m
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B \When using the Pop-up Keypad

The procedures for entering setting values via a Pop-up Keypad on the LT
screen are shown below.

KD 1 KD 1 55
Word Address
DO00050
When the Keypad A Pop-up Keypad will Input data
Display is appear and can re- from the
touched... ceive... Keypad.
PROCEDURE REMARKS
()Here, the Keypad Display KD _1 has been set on the For how to create
LT screen. aKeypad, refer to 2.1.11 Placing a
ID No. Keypad Display.

(2)When the Keypad Display KD_1 istouched,

KD 1 %

(3)A Pop-up Keyboard appears. At the sametime, the | When the Keypad display isplaced,
Keypad Display KD_1'sdisplay reverses (highlights) | the Pop-up Keyboard will auto-
and waitsfor input. matically be set.

T_h_e sguare box shown below represents the cursor's po- I the foll owing two casss, the pop-
sition. T )

up keypad will disappear with no

confirmation of the input during

datainput:
-When the active Keypad Input
Display istouched

* When another Keypad Input
Display istouched during data
input (only when the [Use Pop-
up keypad] feature is enabled for
Keypad Input Display)

The Keypad Input Display that has

been touched becomes active and

isdisplayed in reverse video, call-
ing up the pop-up keypad for dis-
play on the screen.
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PROCEDURE

REMARKS

(4)Pressthe Pop-up Keypad'skeysto input the desired
value.

(5)Pressthe[ENT] key toregister the value.

)

(6)Theregistered valuewill then bestored in Word Ad-
dress D0050, which was designated in KD_1. Then
the Pop-up Keypad disappears.

852

~ I s
ooso W [T N IT]
SN

@ Notes for using Pop-up Keypad

When [ Cancel] istouched, the Pop-
up Keypad closes without register-
ing the input value.

» Do not rotate the Keypad Input Display when you position it. Otherwise, the
Pop-up Keypad will not appear in the proper orientation.

@ Restictions for using Pop-up Keypad

 |f thetrigger bit for the Keypad Input Display is set to ON, the Pop-up Keypad

will not appear.

» The Pop-up Keypad will appear to the right of the Keypad Input Display.

If there isinsufficient space to the right of the Keypad Input Display to display
the Pop-up Keypad, the Keypad automatically appearsin a position either
above, below, or to the left of the Keypad Input Display.

 If thereisinsufficient space in each of these positions, the Keypad will appear
in the lower right corner of the screen. In this case, the Pop-up Keypad and the
Keypad Input Display may overlap so that you cannot see the input value.
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The Pop-up Keypad is displayed as alocal window. When two local windows
are already displayed on the screen, the Pop-up Keypad does not appear even if
the Keypad Input Display is touched. In this case, the Keypad Input Display
will not wait for input.

When the pop-up keypad and other windows overlap, touch the desired window
to bring it to the front.

Do not use aKeypad Input Display that uses the Pop-up Keypad for Load
Screen. Otherwise, the Pop-up Keypad may not function properly, or the Key-
pad Input Display will not wait for input.

The tag size of the Keypad Input Display that uses the Pop-up Keypad is
greater than those without the Pop-up Keypad by 60 bytes. (When the Pop-up
Keypad is used, the Keypad Input Display capacity is 276 bytes, and 216 bytes
when the Pop-up Keypad is not used.)

When the Touch Available Condition of the Interlock function is disabled, the
Pop-up Keypad is not displayed.

When the Touch Available Condition is switched to OFF while input is being
made on the Keypad Input Display, the Pop-up Keypad continues to function.
Continue the input, and confirm the entry with the Enter key as usual, or press
the Cancel key to cancel the input. However, note that touching the Keypad
Input Display will not cancel the input.
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@ Alarm Display ]

When the External Device’'s Monitor Bit has been turned ON, messages
registered in the Alarm Summary by the Alarm Editor can be displayed in a
list.

5.1 Creating and Editing Alarms

Message display order is decided according to which Monitor Bitisin the
lowest position in the Alarm Summary display area. It isrecommended that
Monitor Bit assignment begins from the message with the highest priority.
Be sure to input only one message per line. The characters of a message that
exceed one line will be truncated.

The number of the characters that can be displayed in one line will vary
depending on the character size and LT type. Whenthesizeis1x 1, the
maximum number of characters that can be displayed per linefor each LT
model is 40 single-byte characters.

B Alarm Summary [General Settings] Attributes

Enter the start

Alarm Summary Settings [AL_001]

Enter . address for

General Settings | Display Farmat || Style/Color | each messag e’'s
Com ment Description Wword Address . .
data here _ . Monitor Bit

Border Tyupe=—
S.eIeCt the \ 12 Mo Border Mo, of Manitar wiords |1 = Enter the
display area &0 number of
border O
(frame) = Words allocated
for a Monitor Bit
|| Flace | || Cancel | || Help

& Border Type

The display areaframe types are No Border, Outside, and Outside + Inside.
€ Word Address
The Monitor Bit'sfirst address for the messages specified by the Alarm

Editor isinput.

Input this address in word units.

E.g.) How to designate a Word Address using an external device:

When Word Addressis set to When Word Addressis set to

"test <O>" (Logic symboal)
3130 0100

test <0> 31 to test <0> 00
«~ High Low - LSB

In this case,"test <000>" is
designated

01/C00000
3130 0100

01/C0000031 to 01/C0000000
~ High Low - LSB

In this case,"01/C0000000"
is designated
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A When a variable (Logic symbol) is used as an address, an integer
! array must be designated. For an integer array, a size required
important for consecutive addresses needs to be allocated. Enter a value of
"2" or more to the "No. of Monitor Words" field.

€ No. of Monitor Words

Here, the number of words a Monitor Bit isassigned and entered. Up to 100
words can be monitored.

B Alarm Summary [Display Format] Attributes

Alarm Summary Settings [AL_001] Designates the No.
Designates from (‘General Setings| Display Format | Siyle/Color | - of Lines of a
which existing — 7f ' - message that can
error message Display Start Line = be displayed on
will the display M. of Display Lines [12 — = one screen
begin =

Mo, of Display Char, |40 \5\
. Designates the

maximum No. of
Characters per
line

|I Flace I| Cancel || Help

€ Display Start Line

Among the messages whose Monitor Bit isturned ON, the Start Line desig-
nates from which message the display starts.

%Ik\l\ote: When the Alarm Summary display cannot fit in a single screen, only one
2] Alarm Summary display can be placed on a screen. When the number of
messages to be displayed does not fit on one screen, create Alarm Summary
displays on multiple screens, so that the screenswill switch to display all the
messages. To display all error messages continuously, specify each screen’s
Start Line asfollows:

Thefirst screen: Thestarting line
The second screen: The number of display lineson thefirst screen + 1

Thenth screen: The number of display lineson thefirst screen x (n-1) + 1
€ No. of Display Lines

Designates the maximum number of alarm message lines that can be dis-
played on one screen. Up to 50 lines can be displayed.

€ No. of Display Char.

Designates the maximum number of characters that can be displayed on a
line. Thescreen’slimit is 100 characters per line. However, the maximum
number of charactersfor each LT unit will vary depending the model.

B Alarm [Style/Color] Attributes
The display area color when amessage is cleared (Clear Color) is selected.
2.1 Parts B Selecting Colors
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B Placing an Alarm Summary Display Area
The Alarm Summary Display Area’s setting procedure is shown below.

( N
[Giigges T Teee | ErforCode030 Unit 0D5
12 ng? §3$$::ﬁ E ErrorCode040 Unit 0D5
3 Ivos Summay ELEEL ME | ErrorCode041 Unit 0D6
100 Alarm Messages, have Appear on the screen in a
. ges, Summary Display, at 10 lines
been assigned to bits M0800 to by 30 characters per displa
MO0896 in the Alarm Editor y P play.
~ J
PROCEDURE REMARKS

(1)Select the [Parts] menu - [Alarm Display] command,
or click on the @] icon.

(2)In the [General Settings] tab, input the Word Ad- 2.1.12 Alarm
dress, No. of Monitor Words, and select one of the | Summary Display B Alarm Sum-

Show Border options. mary [Description] Attribute ¢
Here, since the Word Address range is from M0800 to | Word Address
M0896, enter “7” for the number of Monitor Words.

Alarm Summary Settings [AL_001]

 General Settings | Display Format | Style/Color | | Enter MO800

Deszcription whord Address

Border Type=——
124 No Border Mo, of Monitar wWords |7 \‘i
Q ~
u — ™ Enter 7
&5 \

| T~ Select Border type

|. Place ” Cancel H Help ]

(3)In the [Display Format] tab, input the Display Start
Line, No. of Display Lines, and No. of Characters.

In the [Style/Color] tab, select the Clear(ing of Data)
Color, if desired.

Alarm Summary Settings [AL_D01]

" General Settings _. Dizplay Format StylefCoIor] | — Enter 1

Digplay Start Line |1 =1

— Enter 10
Mo, of Display Lines [10 =
Mo, of Digplay Char. 30 \‘al\
T Enter 30

Place ” Cancel || Help
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PROCEDURE

REmMARKS

(4)After all of the Part’s attributes have been entered

and selected, click on the button.

The Alarm Summary display area’s border will appear
in the Base screen, next to your cursor.

(5)Click on the point where the Alarm Summary dis-
play area’stop left corner isto be placed.
If desired, use the Alarm Summary display handles to
alter itssize. Whenthe Alarm Summary display is scaled
up or down, the displayed character sizewill aso change,
according to the border’s size.

To cancel placement, click on the

icon.

To change the Part
size, refer to 2.3.3 Scaling Up/
Down.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s Attribute Settings dialog
box.

2.3.15 Changing
Attributes

|

u
Important
Be sure to use the Alarm
Summary’s display area only
for displaying Alarm Mes-
sages, i.e. never place, over-
lap, or overlay another Part or
object in this area.
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@ File Name Display ]

2-82

Dataregistered in the Filing Data settings is displayed.
10.1.1 Filing Data (Recipe) Function

B File Name Display [General Settings] Attributes

——S—S—S—————————————.———.————————————
Enter a descrip— File Display [FD_001]
tion if desired General Satings | Display | Sle/Color | Switch Setings | swichTyperior | _{— SPeECify
I whether or not
t =ze LS Ar
Enter the ID iﬂ ﬂmﬂsmea to use the LS
r';F;m[zer for the Top 'wiite “Word Address area
e Name 7 il
Display and its ! T T Enter the start
function SWitCh =Extemnal Device Transfer . Word address
T Use Transter Completed Bit Address of the LS area
Enter the Flle 10 Mo, [0 g Tranzfer Completed Bit Address h
o —1— Set up the
No. of filing data—{— fene g | EEIEVERo0oeAEER Device/PLC
to be displayed. Transfer
|| Place ||| Cancel ||| Help | Completed B|t
Address.

€ Description

¢

Enter a description using a maximum of 20 single-byte characters.
ID No.

The File Name Display is linked to its function switch (File Name Key).
Specify the number to identify thislink is here. This number is available up
to 255.

€ FileNo.

Enter the file number registered in the Filing Datalist (1 to 2047). The
names under this number are displayed when the file is opened.

10.1.1 Filing Data (Recipe) Function

€ UseLSArea

When Filing Dataiis transferred between backup SRAM and the Device/
PLC, it can be modified on the LT screen by routing it viathe LS area (the
datais stored temporarily inthe LS area). If datatransfer viathe LS areais
used, specify the LS ared’s start-word address where Filing Data will be
stored from. The address where the data can be stored is from LS0020 to

L S2031, and L S2096 to L S4095.

€ Device/PLC Transfer

%Ik‘v\ote

If set, this bit will turn ON when transfer of filing datato the Device/PLC is
completed. Since this Bit does not turned OFF automatically, to use the
Device/PLC Transfer Completed Bit again, turn it OFF beforehand.

When the Device/PLC Transfer Completed Bit Address has been entered, in

: the case wherefiling data cannot betransferred to the Device/PLC, theLT’s

special relay L S2032 Bit 10 will be turned ON.
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B File Name Display [Display] Attributes

Specify the name —|
selection method

Specify the
cursor position
retention

Ma. of Display Lines :I
Mo, of Display Characters mg
[T~ Direct Selection
/DI Curgor Position Control

File Display [FD_001]

| General Settings || Display I Style/Color || Switch Settings || SwitchTypex’EnInrl

[x]

|| Flace I" Cancel ||| Help

— Enter the
number of
names being
displayed

— Enter the
number of
characters
used for the
names being

displayed

€ No. of Display Lines

Specify the number of Filing Data rows displayed on the LT. A maximum of
50 rows may be specified.

€ No. of Display Characters

Specify the number of Filing Data characters used on each row. A maximum
of 100 characters may be specified.

€ Direct Selection

Select a File Name Display being placed on the LT by directly touching its
border. If [Direct Selection] is not used, select the file name using the data
scroll switches [Roll Up/Roll Down].

W Reference .4

€ Cursor Position Control

B File Name Display [Switch Settings] Attributes

Even when the screens are changed on the LT , the current screen’s cursor
position can be retained. When turning the LT’s main power switch ON or
resetting the LT, however, the cursor will appear in thefirst line.

%te:

X2)

B File Name Display [Style/Color] Attributes

Specify acolor [display color (Fg)] for characters in the Filing Data display
area, and acolor [display color (Bg)] of the Filing Data display area.

Y Reference .4

LT Editor Ver. 2.0 Operation Manual -

2.

1 W Selecting Colors

Screen Creation Guide

The cursor position will be stored for each 1D No. To retain the cursor posi-
tion, be surethat the File Name Display 1D Nos. will not be overlapped
through all the screens.
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B File Name Display [Switch Settings] Attributes
Set the function switches that are placed automatically.
2.1.3 Function Switches

File Display [FD_001]
SWIthh eSFFlo- | General Settings || Display || Style/Color]| Switch Settings | SwitchT ype/Color J_ Switches to
transter Fi Ing Automatic Switch Placement Method transfer data
Data between the \ . via the LS
backup SRAM ) SRl - L3
) . area. These
and the Device/ stemal Device > § O 15 3R i
_ switches are
PLC Rall Up O ExemalDesize L3 valid when
) / Roll Down |1 = Ol 15 - Estemal Devioe: ) “Use LS Area”
Switches to . .
is selected in
scroll and select
items [General
Settings]
|| Flace ||| Cancel ||| Help

€ SRAM -> External Device

Places the switch used to transfer Filing Data from the backup SRAM to the
Device/PLC.

€ External Device-> SRAM

Places the switch used to transfer Filing Data from the external device to the
backup SRAM.

¢ Roll Up

Places the Roll Up key used to scroll through alist of items. Touching the
Roll Up key once will roll up by the number specified here.

€ Roll Down

Places the Roll Down key used to scroll through alist of items. Touching the
Roll Down key once will roll down by the number specified here.

® SRAM ->LS

Places the switch used to transfer Filing Data from the backup SRAM to the
LSarea.

¢ LS->SRAM

Places the switch used to transfer Filing Data from the LS area to the backup
SRAM.

€ External Device->LS

Places the switch used to transfer Filing Data from the external device to the
LS area.

€ LS->External Device

Places the switch used to transfer Filing Data from the LS areato the exter-
nal device.
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B File Name Display [Switch Type/Color] Attributes

Specify colors (border colors) for the function switches which are placed
automatically.

2.1.3 Function Switches

B Place File Name Display

Shows how to call up the File Name Display.
p

N
= Registered File No. 1's filing data is displayed
~e0"s on the File Name Display with 3 display lines
1 —~3550 and 10 display characters.
6 By pressing a function key (File Name Key),
filing data can be transferred from the SRAM
sRAM DEY— to the external device, or from the external
—DEW] [ZEAM device to the SRAM.
For filing datalist and regis-
tering filing data, refer to 10.1.1 Filing Data
(Recipe) Function.
N\ J
PROCEDURE REMARKS

(1) Select the [Parts] menu - [File Name Display] com-
mand, or click on the [&] icon.

(2)In the [General Settings] tab, enter the File No. of B File Name Dis-
filing data to be transferred and the File Name | play [General Settings] Attributes
Display’s1D No.

Here, since File No. 1'sdataistransferred, enter “1” for . _
the file number. The File Name Display’sID No.is“0". | T0 transfer Filing Dataviathe LS
area, mark the check box for [Use

LSArea inthe[UseLS Areaq)].

General Settings | Display || Style/Color || Switch Settings || SwitchTypesColar |

Description =llze L5

[— =T

Top wite Word Address
4| e | ==

=Eutemal Device Transfer
O Use Transfer Completed Bit Address

1D Mo, W Tranzfer Completed Bit Address
File Mo (%] o1 7co0ao0s 7| [

|| Place ||| Cancel ||| Help |

Enter 1
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PROCEDURE REMARKS

(3)In the[Display] tab, specify the No. of Display Lines,
No. of Display Characters, Direct Selection, and Cur -
sor Position Control.

If necessary, specify thedisplay color inthe[Style/Color]
tab.

File Display [FD_001] _

General Settings|| Display | Style/Color || Switch Settings [| SwitchType/Color |

Enter 3

6

Mo of Display Lines Kl

Mo of Display Characters

oo ficre

[l Cursor Position Contral

T— Enter 10

" Place I” Cancel ||| Help |

(4)In the [Switch Settings] tab, select the function
switches which are being placed automatically, and
specify the number of linesbeing rolled up or down.

File Display [FD_001]

General Settings || Display | Styls/Calor]| Switch Settings | SwitchT ppe/Calor |

Autornatic Switch Placement Method

-+ Select
these two
Esternal Device > SRAM T 155 St switches

O FRalUp O Estermal Desizas LS
Dl si Dawn Ol 155 Entermal Benine:

” Flace | ” Cancel | || Help |

(5)Specify the border colorsfor the function switches
in the [Switch Type/Color] tab.

(6)After setting all the attributes, click on [ pace |

The frame of the File Name Display size will be dis-
played in the drawing area.
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PROCEDURE

REmMARKS

(7)Click the mouse button whereyou want to place each
attribute.

12345678900 =pRM
2 |—DEY

3 JDEY—
SHALM

(8) Select the placed File Name Display. Then, select the
[Edit] menu - [Ungroup] command, or click on the

icon to ungroup the File Name Display and alter
each item’s position and size.

1234367280
2
3
Torw | | Sew

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

To cancel the placement, click on

the [=|icon.

The File Name Displays are
grouped. To change any attribute,
first ungroup the File Name Dis-
plays, and then change the attribute.
2.3.13 Group/
ungroup

2.3.15 Changing
Attributes

If “Use LS Area’ is selected, the
address for the LS area can be
changed after ungrouping the File
Name Displays.
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@ Data Logging Display ]

Data created in the data logging settings can be displayed and edited on the
LT unit.

| After the data logging settings, place the Data Logging Display.
u
Important For registering logged data, refer to 10.2 Logging Function.

@\ - Only one Data L ogging Display can be placed on each screen.
Note:

NS The Data L ogging Display cannot be set simultaneously with Keypad I nput

Display.
- Datathat could not belogged dueto aread error isidentified with “***” in
acel.

- Datathat isnot logged is not displayed.

B Data L ogging Display [General Settings] Attributes

Enter acomment, [FErrTEEEID Using a word
if necess ary General Settings | Data Type || Color || Switch Setting || Switch Shape.-"[lpbﬂ/ address '
Drescription S pec | fy th e
Block Mumber &ddress
block number

i [ E— .
Specify whether —| 4 FE .
thpe datya edit \ O_f data being

[ Dats Edit displayed

function is

enabled or Intelr)lﬁorcgljjief;ress

disabled B[ FE—+— Using abit
address,

_ specify the
Specify whether [ Face ][ Concel [ tHer | inpterlo)::k
the interlock address
function is
enabled or
disabled

€ Block Number Address

On ablock basis, specify the data being displayed. The logged datafor the
block number stored at the word address specified here will be displayed.

The block numbers that can be entered are between 0 and 2047, but the
maximum of the effective range is[Number of Blocks| specified in [Trigger
Settings] in the data logging settings. If [Number of Blocks] specified in
[Trigger Settings] is 4, the block numbersare 0 to 3 (BIN vaues only).

@V\ote: - If any block number that does not exist is specified, no data will be dis-
2] played.

- When the loop function has been designated via [Trigger Settings| of the
datalogging settings, the Block Number Addresswill become ineffective.
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€ DataEdit

The logged data can be modified by directly touching the frame of each item
in the Data Logging Display placed onthe LT. If Data Edit is enabled,
touching the cell of datathat can be modified in the table will cause the
buzzer to sound and allow you to enter data. If Data Edit is disabled, this
touching will be invalid and the buzzer will not sound.

- Thedatathat can be modified isonly [Date] and [Value] that have been
logged.

- If ablock or logged data is selected by changing the block number during
on-screen modification of data, the data edit mode is canceled.

- If the cell ismoved beyond the display area, using the scroll keys during the
data edit mode, the data edit mode is canceled.

I nterlock

Theinterlock can only be activated when the data edit capability is enabled.
If the interlock is enabled, data can be modified only when the bit address
for theinterlock is ON. If the interlock is disabled, data can always be
modified by touching it.

@'\I\ote: If the bit addressfor theinterlock isturned OFF during on-screen modifica-

2] tion of data, the data edit mode is canceled.

B Data L ogging Display [Data Type] Attributes

Logging Display[LG_001]
SeIeCt a BOI’deI’ ['GeneraISettingsl_ Data Type |COI0r ]"Switch Setting ]"Switch Shape.-"[lolor] Enter the
Type of the Border Type=——=| Row @/ number of
display area ggéeorder Coum T ) rows for the
o items dis-
played (0 to 40)
Specify whether e
the scrolling of Enter the
the total width number of
data section is \ columns for
enabled or | Place I| Cancel H Help | the items
disabled } displayed (0 to

Enter a display interval 25)
(the number of dots) (0 to 10)

€ Border Type

Select aborder type of the display areafrom among three types, No Border,
outer border fH (1-dot lines), and outer border plusinner border f (the

outer border and item use 2-dot lines, while the inner border uses 1-dot
lines).

€® Row

Specify the number of rows used to display logged data on the LT. A maxi-
mum of 40 rows may be specified.
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€ Column

Specify the number of columns used to display logged dataon the LT. A
maximum of 25 columns may be specified.

€ Spacing

Specify spacing at which to display logged data on the LT. A maximum of
10 dots may be specified. Thisentry isonly valid when the display area
border type is specified as No. Border. Draw the border line using the
drawing tool.

@Ikv\ote' The gap equivalent to the specified display spacing is provided between the
» cell and the border line. The entire cell isfilled with the clear color specified
in the Data L ogging Display [Color] Attributes. However, the gap is not
displayed in the clear color, but its background isdisplayed. If No Border is
selected to draw an arbitrary border, ensure that the border isdrawn using
the same width asthe specified display interval without overlapping the cell.

<Display Spacing>
Border (the gap between the Draw the border so
border and the cell is not filled that it does not
with the clear color) overlap any cell.

cell - 1
I

€ Scroll Total With Data

If the scroll data areais enabled, the totaling section is scrolled together with
the data section. If the totaling section scroll is disabled, the totaling section
always appears on the screen.

B Data L ogging Display [Color] Attributes

Select a color (clear color) displayed when the border of each itemis
cleared.

2.1 W Selecting Colors
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B Data L ogging Display [Switch Settings] Attributes

The number of rows and that of columns specified in [Datatype] are dis-
played on the Data Logging Display. If any data exceeding these numbers
existsin the LT, use the function switches to scroll the data.

W Reference .4

Logging display[LG_0D01]

r General Settings T Data type T Color | Switch setting | Switch Shape/Color ]_

Select the func-
tion switch type
to be placed

Select Place Switch
Fup =]
F)|Down
l[Right
et

2.1.3 Function Switches

— Enter the
number of
rows/columns
scrolled

|I Flace ” Cancel H Help ]

B Data L ogging Display [Switch Shape/Color] Attributes

Specify acolor (border color) of each function switch.

21w

Selecting Colors

B Placing the Data L ogging Display

The procedure for setting the Data Logging Display is described below:

nated address is displayed.

VA

D0100

15

If 3is stored at DO100

The logged data for the block number stored at the block number desig-

II |::> 1st | 981016 | 09:14:00| 144
2n 10/1 114 14
d | 98/10/16 | 09 00 5 DN
0

Date | Time | Datal

UP

3rd | 98/10/16 | 09:14:01 146
4th | 98/10/16 | 09:14:01 147
5th | 98/10/16 | 09:14:01 148
TOTAL 730

The logged data in block No. 3
will be displayed.
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PROCEDURE REMARKS

(1)Select the[Parts] menu - [Data L ogging Display] com-
mand, or click on the [gg] icon.

(2)In the [General Settings] tab, specify the block num-
ber designated address, data edit, and whether the
interlock isenabled or disabled.

Specify D0100 for the block number designated address.

2.1.13 mData
Logging Display [General Set-
tings] Attributes € Block Number

Address
General Settings | Data Tups | Color | Switch Sefting | Switch Shape/Col
. ‘ ata Type oorl it elng]’ witch APE, oor] | Entel’ DOlOO
Drezc ption il
:l Block Mumber Addiess
I Data Edit
Tl tntenh:

Interlock Address

(3)In the [Data Type] tab, specify the display settings.
If necessary, select aclear color in the [Color] tab.

Logging Display[L G_001] [x]
General Setlings || Data Tupe | Color || Switch Setting || Switch Shape/Color |
Border Type—— Row | I Enter 7
g%ma o B
'@ﬁ Spacing I T Enter 4
O 8e 4

|| Place I ” Cancel I ” Help
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PROCEDURE REMARKS

(4)Inthe[Switch Settings] tab, select thefunction switch
typethat isto be placed automatically, and specify
the number of rows, columns scrolled.

If necessary, select a color for the special switch in the
[Switch Shape/Color] tab.

Logging display]LG_001]

[ General Settings | Data pe | Color \ Switch setting | §witch Shape/Color ]7

Sefect Place Switch
e =
i
] Right E]
¥ Left

|' Place ” Cancel } Help }

(5)After entering and selecting all the attributes, click | To cancel the placement, click on

onthe[ pee= |button. the [«] icon.

The border of the Data L ogging Display sizewill bedis- The Data Logging Displays are

p ?‘yed inthe dra_twi hg area _ _ ) grouped. To change any attribute,
(6)Click on the point where the function switch will be ungroup the Datal ogging Displays

pl.a(.:eq. _______________ by clicking on the[Zg] icon before-
.................. hand.

2.3.13 Group/

Ungroup

If you double-click on the function
__________________ switch placed on the screen, the ad-
.................. dress confirmation screen for parts
will appear, enabling you to change
the address.

2.3.15 Changing
Attributes
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@ Numeric Displays

This Part displays host Word Address numeric data as an absolute value.

2.1 Parts

B Numeric Display [General Settings] Attributes

Enter Comment

data here \

Displays the

currently se- |

lected Part’s
image

Calls up the Part —
Shape Browser

Humeric Display Settings [ND_001]

 Gieneral Settings | Display Fomnat | Shape/Color | Alam Settings |

Word Address

| [][ooom

Description

~F

Browser...

e |

H— Enter the Word
Address where
the display
data is stored

|. Place I | Cancel ] | Help

€ Word Address
Here, input the Word Address where the display datais to be stored.

B Numeric Display [Display Format] Attributes

Mumeric Display Settings [ND_001] Enter the total number
Gereral Settings || Display Fomat | ShapesColor | Alam Settings | of dlgItS used (n ot
N including the decimal
=[rata Dizplay Format=——= . — . . .
Select the ) Code v No.oiDipyDigts [T point) in the display
Data Format 16 Bit 42 Bit Decimal Places U%ﬂ 1
and Data @ fecimat 10 Decimal |[[Character Size Enter the number Of
Lenath OHer L He digits to be displayed
9 oo o after the decimal point
ctal
. D S . N ,
Conﬂ_gure £ ShitRigt 2] Zero Suppress Preview Select the size used for
the Display LiShitLett [ Zera Display the label’s characters
Style.
|| Flace I" Cancel ||| Help |

@ Data Display Format
Here, the Data Display Format, Code, and data length are selected. Choose
adataformat of either Decimal (base 10), BCD, Hexadecimal (base 16), or

Octal (base 8). With the Code +/- check box ||| checked, when you select
“Decimal”, negative numeric data can also be displayed.

When using a Logic Symbol to Word Addressor Trigger Bit Address, select

%Ik\l\ote:
2] "32Bit" datadisplay format.
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@ No. of Display Digits
Here, enter the total number of digits used (not including the decimal point)
in the display.

@Ikv\ote: When the No. of Display Digitsisset to 5 and the Decimal Placesisset to 2, a
2] value appearson the Numeric Display as shown below.

@ Decimal Places
Here, enter the number of digitsto be displayed after the decimal point
The types of numeric data that can be used with each dataformat are listed

below.
No. of Decimal
Data Format | Code | Data Length| Display AlarmRange
L Places
Digits
: +only| 0tob 65535
16 bit 1-5 0-4
! +I- | 3276810 32767
Decimal +/- + only [ 0 to 4294967295
32 bit 1-10 0-9 o -2147483648 to
2147483647
BCD N 16 b!t 1-4 0-3 0to 9999
32 bit 1-8 0-7 0 t0 99999999
16 bit 1-4 0to FFFF
Hex + -
32 bit 1-8 0to FFFFFFFF
Octal + | 16bitonly 1-6 0to 177777

The relationship between upper and lower position Word Addresses when
32 hit datais used will differ depending on each Device/PLC.

Device/PLC Connection Manual
& Character Size

Thelabel’s Character Size is selected here.
2.2.9 Text

@ Display Style
* Shift Left

* Shift Right

Select the display style from the Shift Left and Shift Right. The data will
appear, starting from the side designated here. The Shift Left is selected by
default.

e Zero Suppress

Select this option to omit the leading zeros of display data. E.g. When the
Display Length is 4 and the Zero Suppressis NOT selected, 25 appears as
0025.
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» Zero Display
When this option is clicked, and the host (PLC) datais 0, the value O will
not display.

B Numeric Display [Shape/Color] Attributes

Here, the Numeric Display area’s border color, value display color (Number
color), and interior color (Plate color) are selected.

2.1 W Selecting Colors

B Numeric Display [Alarm Settings] Attributes
If desired, specify avariety of Alarm settings.
2.1 W Setting Alarms

B Placing a Numeric Display
The procedure for placing a Numeric Display is shown below.

- ) — . : N
Data stored in the specified Word Address is displayed in the
designated Numeric Display.
D00100 H
b00101 1 =
When 32 bit data 65539 is The maximum number of
stored in addresses D00100 digits is 10, with 2 decimal
and D00101,... places.
S J
PROCEDURE REMARKS

(1) Select the [Parts] menu - [Numeric Display] com-
mand, or click on the icon.

(2)In the [General Settings] tab, input the Word Ad-
dressused to storethe display data.

Numeric Display Settings [ND_D0D1]

General Settings | Display Format | ShapedColor | Alaim Settings
Drescri ption ‘Word Sddress

I | [oomo FlE

T Enter D00100
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PROCEDURE REMARKS
(3)Select a Part Shape from the Browser. 2.1 Part B Select-

If desired, set an Alarm and Colorsfrom the[Alarm Set- | ing a Part Shape
tings] and [ Shape/Color] area.

Shape Browser

——————

me]UUUY || ND 3D002

ND 3D004]|| ND_3D005] ElFeere. |
Current PDE File - |c:\program files\pro-face\lt\pdh\pdb.p”
Title :[ND_3D 001 FIl_ Hep |

(4)In the [Display Format] area, specify the Data Dis-
play Format, and input the No. of Display Digitsand
the Decimal Places.

Specify the Character Size, if desired.

Numeric Display Settings [ND_001]

) Display Format i
[ General Seftings| Display Fomat | Shape/Color | Alarm Settings | i Enter 10
=D ata Display For
‘
D Code - MNo. of Display Digits m
16 Bit 328t D ecimal | Places 2 =
i Decimal | ig Decmal 1| Character Size Enter 2
2 Hex £ Hex it
LYBCO £3BOD L )
£ Octal Select 32 blt
-Dislay S Decimal

vie
1% Shift Right ) Zero Suppress
i Shitt Left ¥ Zerm Display 88383

| Place || Cancel H Help |

(5)After all of the Part’s attributes have been entered

and selected, click on the[ Face |button.

The Numeric Display’s outline will appear on the Base
screen, next to your cursor.
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PROCEDURE REMARKS

(6)Click on the point wherethe Numeric Display’stop | To cancel the placement, click on
left corner isto be placed. the[=] icon.
If necessary, use the Numeric Display’s handles to alter
its size after placement.
Regardless of whether the numeric data display areais
scaled up or down, the character size will not change.
To change the character size and position, select the char-
actersinside the border directly.

To change aPart’s
size, refer to 2.3.3 Scaling Up/
Down.

Pressing the key whilere-siz-
ing an area’'sborder will alsore-size
that area's characters.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.
2.3.15 Changing
Attributes
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@ Message

Display

)

Thisdisplay is used to show single-line alarm messages in response to
changes in External Device's Word Address data. Select the message from
Direct Text or Index Text.

B Message Display [General Settings] Attributes

Enter Comment

data here \

The currently
selected Part
Shape is dis-
played here

Calls up the Part —

Shape Browser;
Part Shapes can
be selected

Meszage Display Settings [M'w_001]

" General Seftings Messages ]

Select the
Word or Bit
Address to be

[X]

Description Address

monitored

T | [E¥]Jpoom

|- Select a Border

[

[ Barder Color

L () o] o

color

Alignment

_______

— Select the type
P of alignment
£ word desired for the

Character Size
B8 d

text of the
Display

|I Flace ” Cancel H

Help ]

Select the

directly from the
Browser

€ Address

Operation

Select a Mode

Character Size

Enter an Address to be monitored. Select either Bit Address or Word Ad-

dress according to

€ Border Color

(operation) Mode.

The Message Display’s Border color can be selected.
2.1 Parts W Selecting Colors

@ Alignment

Here, the text’s aignment can be selected.

Center

€ Mode

There are two methods to change messages displayed on the Message
Display, i.e. viaBit's turning ON/OFF and Word state changes. Here, select

either mode.

Mode: When selecting Bit
Messages will change according to the specified Bit Address

changes.
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Mode: When selecting Word

Messages will change according to the state changes of the desig-
nated bits, consecutively from the specified Address’'s 00 bit.
According to the number of the messages (either 2, 4, 8, or 16), a
bit is automatically assigned from the specified Address's 00 hit.

Numbers of [Number of
Messages |Bits Used

2 1
4 2
8 3
16 4

When the value set in
the No. of Messages is

16, bits 00 to 03 are When the value set in the

used. No. of Messages area is 4,
bits 00 and 01 are used

03 02 01 00

When the value set in the
No. of Messages area is 2,

\/ only bit 00 is used

The remaining bits can be When the value set in the No. of
used for other purposes Messages is 8, bits 00 to 02 are
used

B Message Display [M essages] Attributes
(Operation Mode example: When using Word Address)

Select the text type for Enter the message’s

Deletes the
the message entry. text here

currently selected
message, and
Enter the number specifies the

of messages message (and its

(states) here o o Do color) as unde-
Meszages Characters elected Message " Delete | fined.

= "

Enter the maxi- i 10 _
mum number Of — Message || Copy from Description H| Copy ta All {,—/CODIES a.” the
characters in

characters only B EHE
the Selected

when "Direct '
Text" is selected. Message field

0 Momal
£ Bald
120 Raized

Caolor

Tewt Colr IR s« O
Plate Color ) 8«0 I to all states
N only when
The state indica- "Direct Text" is
tion buttons appear = — —
according to the / " | Lt ] selected.
No. of Messages Select the Select the message’s éopies the char-
Character Type (display) Color acters in the

Description field
to the Selected
Message field
only when "Direct
Text" is selected.
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@ Direct

The text entered in the Selected Message field is placed directly as fixed
character strings.

The messageis displayed in asingle line. Up to 16 types of messages can be
displayed in each Message Display.
@ Index

Select or add the Index Text. Two or more lines of messages can be dis-

played.
4.5.3 mSelecting the index character string € Entering
the index character string

@ No. of Messages

The number of the messages (number of states) can be selected from 2, 4, 8, and
16.

@ Display Characters

The maximum number of characters that can be displayed in a message can
be set only when the text typeis set to “Direct”. Up to 40 characters can be
input. If the number of a message characters exceeds the specified value,
characters that do not fit in the areawill be truncated.

€ Message
According to the No. of Messages, designate a message for each state.

Operation Mode: Bit

Designate a message for each state (ON and OFF).

Operation Mode: Word m

As many buttons as the number of the specified messages will be displayed.
Designate a message for each state.

@ Sclected Message

Message can be input only when the text typeisseto “Direct”. After
entering a message, the message will be displayed in the selected color(s).
The default value setting is* Undefined”.

To select the "Index" option, refer to 4.6.3 MSelecting the
index character string € Entering the index character string.

& Color

Here, each message’'s display colors can be selected.
2.1 Parts
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B Placing a Message Display

The Message Display setting procedure is shown below. (When using a
Word Addressin "Direct Text" mode)

4 N\
Message No. O0: None
Message No. 1: Signal A Operation

Message No. 2: Signal B Operation Signal B Oper
Message No. 3: Signal A & B Operation O
A message from those listed ...displaysin response
above, allocated to the specified to changes in the Word
Word Address... Address data.
- y
PROCEDURE REMARKS

(D Select the [Parts] menu - [Message Display] com-
mand, or click on the[& icon.

(2)In the [General Settings] tab, input aWord Address. | If the messageis displayed on more
Select the message’s Border Color, Text Alignment and | than one line with the Index char-
Character Size, if desired. acter strings, the characters are al-

ways aligned to the center.

Message Display Settings [MW_001]

" General Settings Messages | | — Enter M0064
Descri phion Address

I | (28] mooss &
Border Color

EEEE®0 o0
Mode:

’[Q Bitt“
150 whord

|' Flace ” Cancel H Help |

(3)Select a Part Shape from the Browser. 2.1 Parts M Select-
] ing a Part Shape

Shape Browser

MD 3D003

MD 3D004]||MD 3D005][|[MD 3D006| Parts File...
Current FDE File : |c:: ‘program fileshpro-facettpdbhpdb.p
Titke : [MD_30001 ]

| Help
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PROCEDURE REMARKS

(4)Enter the number of Messages and number of Dis-
play Characterswith the " Direct Text" option se-
lected in the [M essage] area.

If selecting the"In-
dex Text" option, refer to 4.6.3
W Selecting the index character
string ¥ Entering theindex char-
General Geftings || Messages | | —Enter 16 aCter String.

——Enter 4

Test Colar !”:]!]E]DD E‘kﬂl
Flate Colar .J:]!]E]DD E‘kﬂl

” Place Hl Cancel Hl Help ‘

(5 Enter your Alarm M essages. A
Select the message number to be registered and enter !
the message. When displaying a border with no mes- Important
sage, be sure to delete the words “Undefined”. Select | Any characters entered that

Colors and Character Size, if necessary. are over the limit specified in
(Example) When registering the message “A Unit Op- | step (4) will be cut from the
erating” as message Number 1. LT’s display.
=T Enter A Unit . o
P o operation If the text “Undefined” is not de-
: leted, it will be registered and then
| Copy from Deseription || Coppraal | dl Spl ayed asa message'

o

Test Colar !”:]!]E]DD E‘kﬂl
Flate Colar .J:]!]E]DD E‘kﬂl

—— Select 1

[P [ canes | Hep |

(6)After all of the Part’s attributes have been entered

and selected, click on the[ race | button.
The Message Display’s outline will appear on the Base
screen, next to your cursor.
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PROCEDURE

REMARKS

(7)Click on the point where the M essage Display’stop
left corner isto be placed on the Base Screen.
If necessary, use the Message Display’s handlesto alter
its size after placement.
The message, corresponding to the message number des-
ignated in the Dialog box, is displayed on the Message
Display.
Regardless of whether the Message Display is scaled up
or down, the character size will not change. To change
the character size and position, directly select a charac-
ter inside the text box.

To cancel the placement, click on

the [=] icon.

To change the
Part’s size, refer to 2.3.3 Scaling

Up/Down.

When the Message Display is
scaled up(larger), the message char-
acters may not be displayed in the
correct position. In that case, use
the pull down menu [Edit] menu’s
[Align...] command to adjust the
position.

2.3.10 Align

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s Attribute Settings dialog
box. Also, clicking on the message
numbers allows you to view the
message’s display status.

2.3.15 Changing
Attributes

ote: - Changing the state viathe Parts State Change Tool Bar after placing a Part
X2 allows you to check each state'sLibrary display condition.

- Every timea part’s screen isopened, the Part’s state will bereset to 0.

- If a state which has not been defined is designated, the M essage Display
may show nothing. For example, when the number of messagesis 16 and
only states 0 to 3 actually have a message registered, designating states 4 to

15 displays only message frames.
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@ Date Displays ]

Date display datais created using the LT’ s internal calendar and formatted
as. February 11th, 2001, or 01/02/11; however, the date format can be
changed.

B Date Display [General Settings] Attributes

Enter Comment Date Dispaly Settings [DD_001]
data here Forera et | |- Select the Data
. Format
Iy Deseription Character Size
The currently se- T |Bx16_ [Fl|[owrmmiaa ]

lected Part’s image
is displayed here

Text Color IO ex O
Plate Coor | Il 1) I ) o 3O | Select the
Border (frame),

Text and Plate

|| Place I || Cancel | || Help (b ac kg roun d)
colors

[Burder Color E]DD Bk g

Calls up the Part ]
Shape Browser. | [Toowe]
Parts can be se-
lected directly from
the Browser

€ Data Format

Thefollowing display formats are available:

yy/mm/dd
dd/mm/yy
mm/dd/yy
20yy/mm/dd"*
dd/mm/20yy**
mm/dd/20yy"*

(yy: year, mm: month, dd: day)

¢ Color

The Date Display’s border color, character display color (Text), and interior
color (Plate) can be selected here.
2.1 Parts B Selecting Colors

@ Character Size

Thelabel’s Character Sizeis selected here.
2.2.9 Text

*1 The characters used for the display of 2000's first two characters (“ 20" ) are single-byte
characters.
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B Placing a Date Display
The Date Display placement procedure is shown below.

Used to display the date.

PROCEDURE REMARKS

(1)Select the [Parts] menu - [Date Display] command,
or click on the[ifg] icon.

(2)Inthe[General Settings| area, select a display for mat.

Description cl aracerﬁ\lz—e — Select the yy/m m/
= dd format
Border Color [ /) )] & O
E Test Color | I [ ) M)W ) B
Plate Color [T ORI )6k O
[ Bowser. |
[ Psce |H Cancel ||\ Help
(3)Select a Part Shape from the Browser. 2.1 Parts @ Select-
If desired, select Colors and Character Size. ing a Part Shape

Shape Browser

DD_3D001 DD_3D002

DD_3D004 DD_3D005 DD_3D006 | Parts File...

Current FDE File : |c:\program filezpro-facehtypdbpdb.
Title :[DD_30001 FIl Bk |

(4)After all of the Part’s attributes have been entered
and selected, click on the [Place] button.
The Date Display’soutlinewill appear in the Base screen,
next to your cursor.
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PROCEDURE

REmMARKS

(5)Click on the point where the Date Display’stop left
corner isto be placed.
If desired, usethe Date Display’s handlesto alter itssize.
Regardless of whether the Date Display is scaled up or
down, the character size will not change. To changethe
character size and position, directly select the charac-
tersinside the border.

vy s dd

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

To cancel the placement, click on
the[=]icon.

To changeaPart’'s
size, refer to 2.3.3 Scaling Up/
Down.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.
2.3.15 Changing
Attributes

When scaling up or down the dis-
play area, if the[Ctrl | key is pressed
at the sametime, the characterswill
scale in unison with the border.
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@ Time Displays ]

Time Display areas can be created, based on the LT’ s internal calendar
function. Time will be expressed in 24 hour format.

(E.g.) 2225 pm > 14:25

Only one Time Display Part can be used per screen.

B TimeDisplay [General Settings] Attributes

Select the

Time Settings [TD_001] | — .
Character Size

Enter Comment
data here

General Settings ]

Diescription Character Size

Gx16 d

Border Color [ ) [ D[ I &k O ]
Tewt Coler I ) ] ) ok O Select Border,
Plate Color ) [ 00 ) )| 1) Bk ) J Character, and

Plate colors

The currently
selected item’s
image appears
here

Calls up the Part — |
Shape Browser.
Part Shapes can be
selected directly
from the Browser

” Place | ” Cancel | || Help

¢ Color

Here, the Time Display’s Border color, character display color (Text), and
background color (Plate) can each be selected.

2.1 Parts B Selecting Colors
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M Placing a Time Display

The Time Display is placed using the following procedure.

Display the time.

PROCEDURE

(1) Select the [Parts] menu - [Time Display] command,
or click on the[&]icon.

(2)Select a Part Shape from the Browser.
If desired, select Colors and Character Size.

TD_3Do01 TD_3Do02 TD_3D003

TD_3D004 TD_3D005 TD_3D006

Curen t FDE File : |c ‘program files\pro-faceb\thpdbhp
Title:[TD_30007 FIl B |

(3)After all of the Part’s attributes have been entered

and selected, click on the button.

The Time Display Part’s outline will appear on the Base
screen, next to your cursor.

(4)Click on the point wherethe Time Display’stop left
corner isto be placed.
Change the size if necessary.
Regardless of whether the Time Display is scaled up or
down, the character size will not change. To changethe
character size and position, select the charactersdirectly.

2.1 Parts ® Select-
ing a Part Shape

To cancel the placement, click on

the icon.

To change aPart’s
size, refer to 2.3.3 Scaling Up/
Down.

When scaling up or down the dis-
play area, if the[Ctrl|key is pressed
simultaneously, the characters are
also scaled up or down together
with the border.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings.

2.3.15 Changing
Attributes
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@ Picture Displays ]

Registered Library items are displayed according to Device/PLC Word
Address changes. Parts and Tags, however, cannot be displayed in these
displays. Upto 16 different kinds of Library items can be displayed on a
single Picture Display.

24 Libraries

With the LT Type C, the Picture Displays will not be displayed on
- the LT when transferred, if the LT has not been communicating
Important . .
with the external device.

/ \\

B Picture Display [Description] Attributes

Picture Display Settings [LB_001] - Enter the
Enter Comment ) General Settings Librarylmage] Address to be
monitored
d ata here \\ Description Address h ere
\J | [E¥]Jxa000

The currently ~_

selected Part I ~ Made——
State’s image % Bi Selects the
2 word e} .
appears here peration
Mode

|I Flace ” Cancel H Help

& Address

Here, either a Bit or Word Addressis entered, after first selecting a Type
(either Bit or Word).

¢ Mode

There are two methods used to switch the Library images displayed on the
Picture Display; oneis Bit access and the other is Word access. Select either
of these.

Mode: When selecting Bit

Messages will change according to the specified Bit Address
changes.
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Mode: When selecting Word
Library will change according to the state changes of the designated
bits, consecutively from the specified Address's 00 bit. According

to the number of the messages (either 2,

4, 8, or 16), abit is auto-

matically assigned from the specified Address's 00 bit.

Numbers of [Number of
Messages | Bits Used
2 1
4 2
8 3
16 4

When the value set in
the No. of Messages is

16, bits 00 to 03 are W

used.
03 02 01 00

The remaining bits can be
used for other purposes

N

Messages
used

When the value set in the
No. of Messages area is 4,
bits 00 and 01 are used

When the value set in the
No. of Messages area is 2,
only bit 00 is used

When the value set in the No. of

is 8, bits 00 to 02 are

B Picture Display [Library Image] Attributes

Displays the —___

currently
selected
Library image

Reflects the
currently
selected item’s
designated
state

& Browser

Picture Display Settings [LB_001]

ol Setlings | Librany Image |

Calls up the
Library Browser.
Library items can
be selected

Library

Dielite:

directly from here

Deletes the
currently selected
Eraze Color; . .
=T T8l T IR Library item
) ek O
Patem [] ME = T Selects the item’s

background and

foreground colors

(used for clearing)

When clicking on the[_Eews=. ] button, the Library Browser (Library list)
will appear. Select adesired Library from thislist and drag it to the inside
of the Library image display border on the Dialog box.

W Reference .4

24 Libraries
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@ Delete
The selected Library item is deleted and the display will disappear.
@ No. of Lib.

Displays only when Type's Word is selected. The number of Library images
(number of states) to be displayed on the Picture Display can then be input.
Select any of 2, 4, 8, or 16.

@ Library

Here, the Library item used for each stateis specified. Settingswill differ
depending on the Type selection.

Mode: When selecting Bit
Specify aLibrary item’s ON and OFF states, respectively.

Mode: When selecting Word
The n.umber of buttons will match the designated number of
Library items. Specify aLibrary item for each state.

‘Note: Changing the state via the Parts State Change Tool Bar after placing a Part
X2 allows you to check each state’sLibrary display condition.

& Color

The background square colors (Clear Fg, Clear Bg)) and pattern (Pattern)
are selected. The default settings are black. The sguare colors can be
selected so as to match the Picture Display placement area background's
color.

<Back Ground Square>

The Library item to be displayed while the LT is running needs the filled
square for the background to be the rearmost, so that the items(images) do
not overlay each other when they are switched. When designating aLibrary
item, the LT Editor program will draw this colored square automatically.
Right after the Library item(s) is/are placed, the background square will match
the size of the largest Library item designated. After the items are placed, it
can be scaled larger or smaller, independently from the Library items.

For a state with no designated Library item, only a background square will
be displayed and it will become the Library’s deletion screen, i.e. it will be
overlaid on top of an existing item to “delete” that item.
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B Placing a Picture Display
The Picture Display’s creation procedure is shown below.

State 1 State 2 State 3

The 3 pictures registered as libraries, asillustrated above, will
change in response to changesin the state of Word Address D00250.

N\ J

PROCEDURE REMARKS

(1) Select the[Parts] menu - [Picture Display] command,
or click on the [2u]icon.

(2)In the [General Settings| area, enter an Addressand
select a Mode.

Picture Display Settings [LB_D01]

General Settings | Libray Image ]

Desci iption Address

| |  [¥][poszz0 i
Mode:
i B
& Wod

|. Flace I | Cancel | | Help 1

1| — Enter DO0250

—— Select Word

(3Inthe[Library Image] area, input the No. of library
items (No. of Lib.) used.

Picture Dizplay Settings [LW_002]

General Settings | Library Image ]

Mo of Lib. Bruwser
lerary DEJ?C%
[o1]2]5]

Erase Color:

o I ) Y ) e
e lEEDEE] o)
Pattern D I ——

" Place ” Cancel H Help ]
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PROCEDURE REMARKS

(4)Select a state (to register an item as), and then click

on the button.

Here, perform settings for state O.

Picture Display Settings [L'_002]
[[General Setings | Libray Image |
Erase Color
Fo [ ) ) ) Bk T
eo [ )] Bk
2]
\ | Flace I| Cancel H Help ]
Select 0

(5)Select a Library to be displayed for state O from the 2 4 Libraries
Browser.

To select aLibrary from afile dif-
= ferent from the currently displayed
one, click ontheLibrary Browser’s

icon.

Flle Edit View ‘window Help

b= (xR &

(6)Drag the selected item to the Dialog box’s black item 2.4 Libraries
display area.
Select foreground or background Colors, if desired.

Picture Display Seltings [Lw_002]

Noof Lib B =

Library
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PROCEDURE

REmMARKS

Picture Display Settings [L\W_002]

General Setlings| Library Image |

o B (oo ]
e o]

[T
Erase Color,
RO & O
o [ ) I )] e T
Fatiem [ JETHE

[ Pece |[ Cacel |[ heb |

(7)For States[1] and [z], repeat steps (4) to (6). Since
State[z]isused todeleteLibrary item from thescreen,
nothing is specified for it.

(8)After all of theitem’s attributes have been entered

and selected, click on the[ _Pae= ] button.
The Picture Display’s outline will appear on the Base
screen, next to your cursor.

(9)Click on the point where the Picture Display’s top
left corner isto be placed.
Here, the Picture Display’s border (dotted line or filled
square) and the Library item will appear. At thistime,
the Library item corresponding to the state currently se-
lected in the Dialog box is displayed on the Picture Dis-
play.
Regardless of whether the Picture Display’s border is
scaled up or down, the Library item’s size will not
change. The border sizeis common through al the Li-
braries. The Library item’s size and position can be al-
tered by clicking directly on itsinside border.

To delete a Library item, click on

the button.

To cancel the placement, click on

the [=] icon.

Double-clicking on any Part placed
on the screen automatically callsup
that Part’s attribute settings. Also,
switching the states allows you to
view the Library display status.

2.3.15 Changing
Attributes

Changing the state via the Parts
State Change Tool Bar after plac-
ing aPart alowsyou to check each
state’s Library display condition.

- Every time the screen is opened, the state will bereset to 0.
- If astatewith no Library registered is designated, nothing will be displayed

on the Picture Display. For example, when the number of messagesis 16
and only states 0 to 3 actually have a message registered, designating states
4 to 15 displays only background square frames.
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@ Window Parts ]

Enter comment
data here.

This displays
the Window
Number of the
window
registered on
the Window
Screen (V).

Select the Win-
dow Number you
want to call up
onto the Base
Screen (B).

2-116

Calls up the window onto the Base Screen (B). Register the windows to the
Window Registration viathe Window Screen (U). This operation is easier
than using the U-tag.

For the details of Window registration, refer to 3.3 Window
Display-Window Screen.

B \Window Parts Attributes

Window Parts Setting [wI1_001]
General Settings ] )
Specify the
Drescription | -
i Window Control Address Window Control
;ﬂ Address.
it OMOFF
Wwindow Number Bit1 Display Order Preview the
L window associ-
ated with the
selected Win-
dow Number in
this area.
|| Flace | || Cancel Help

€ Window Control Address
Enter the address to control the Hide/Show status of the windows.

15 02 01 00 Bits

v L Show[Q]: Hide the window
Changing the order of window layer [1]: Show the window

[Q]: Touching the window will
change the order of the layer.

[1]: Touching the window will NOT
change the order of the layer.

3.7.1 Overview of Window Display, 3.7.2 Window Registration
on the U Screen
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B Placing Window Parts

Procedure for placing Window Parts will be shown below.

- N
_—
\
D Show window
Window |2 . o Window o =
Display |F N Display | ¢ N
Place awindow (such as abar graph for Window Registration on the Window
Screen (U)) on the Base Screen (such as B2). (Call up the window.)
\\§

PROCEDURE

REMARKS

(1) Select [Window Parts] from the [Parts] menu or

click the@ icon.

(2)Select the window to be displayed on the Base
Screen (B) from the "Window Number" field.
Specify the Window Control Address aswell.

“window Control Address

Eith ON/OFF
Bit1 Displap Order

m

[ Pece [ cames | Her |

window Number 7

(3) Click the[ race | button after setting all at-
tributes.

The border of the window areais displayed on the
drawing area.

(4) Click on the point wherethe Window Part isto
be placed.

W

For Window Regis-
tration of parts on the Window
Screen (U), refer to 3.7.2 Window
Registration on the U Screen.

When the specified area is over-
lapped by objects on the Base Screen,
the object will be hidden while the
window is displayed.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 2-117



Chapter 2 - CREATING BASE SCREENS 2.2 Drawing

E Drawing

Straight lines, rectangles, and oval objects can be drawn, using drawing
tools.

An object’s attributes such as line types and colors are designated in its
dialog box. After designating the object’s attributes, move the cursor and
start to draw the object directly in the drawing area.

Usage Pattern

[Draw] R Select a drawing

— Set any attributes — Draw the object
or command

Select a desired drawing icon from the
Draw Tool Bar.

B Drawing Tools

Icons contained in the Draw Tool Bar and their corresponding drawing
objects are asfollows:

Icon Object Types Icon Object Types

Dot Filled Polygon
HE Line/Poly-line m Scale

_ Square/Rectangle Text
Circle/Oval Load Screen
H@l Arc/Pie Load Mark
[ Fill

B Selecting Line Types

10 selections are available for straight and poly-lines, and for graph divi-
sions. 6 selections are available for rectangles, circles, arcs and pie sections.

Polyline [x]
@ —

i — D Palyline

iH

] Select one of these
[——l[====]|[= = =]|[== = ]| s— patterns

fo HEEOEECO s«
Bo [ )/ )] B

B Selecting Colors

For color and blink attribute settings, use the procedure same as for Parts.
2.1 Parts B Part Attributes - Selecting Colors
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M Tiling Patterns

Nine different tiling patterns are available. These patterns can be selected
for squares, circles, filled squares and polygonal objects. When combining
foreground (Fg) and background (Bg) colors, avariety of filled patterns can

be drawn.

Line/Polygon

Fo HEECIEE O &<
Bo I W) Bk

— Select a pattern

When asquare or circleisdrawn, only the line type will be displayed ini-
tially. To display the pattern selections, check the Fill check box. (check
mark will appear)

Circle/0val [x]

] Fil

Circle/Oval [x]

||_ —— =

=)
i [:>

Fo HEECIEE O &<
B W)W 1] e

fo HEW D ENO &«
Bo [N/ 1) ex)

B o

)

Dotscan bedrawnin 1, 2, 3, and 5 dot units. To draw adot, simply click on

the desired point.

B Dot Attributes

Select the dot unit used

Dot

=Dt type=—

% 10ot

for drawing

i 2Dots
i 3Dots
7 BDots

fo HEE_ BN &k
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—— Displays the currently

selected dot’'s image

Select colors and blink-
ing, if desired
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B Creating a Dot

PROCEDURE REMARKS

(1)Select the[Draw] menu - [Dot] command, or click on

the icon.

(2)Set the attributes of a dot to be drawn.
Select adot type and colors, if desired.

Dot |
=D ot type=——x
o —
4 2Doks
2 3Dats
i 5Dats
Fo ) ) o ) ) ) )

(3Movethecursor tothedrawing area. A dot will be [ When using the keyboard to draw
drawn at the point clicked on. a dot, move the cursor to the de-

sired point and pressthe key.

To cancel/delete the dot, click on

the | w=y | icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s Attribute Set-
tings dialog box.

2.3.15 Changing
Attributes

@ Line/Poly-line ]

In order to draw aline, smply click to designate the line’'s start and end
points. A continuous straight line can also be drawn; holding down the|Ctrl]
key allowsyou to draw lines at precisely 0°, 45°, or 90° angles.

B Line/Polyline Attributes

When drawing a polyline, check this box

Selects aline type <]
(with or without —__| ::;;. - 4 Pobine | _The currently selected
arrows) & o line’s image appears
here
==

Fro AN exCf|  Select a color, and
Ba MW _Mm ) eJ)| blinking, if desired

Selects a line
type
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B Drawing a (Straight) Line

PROCEDURE

REmMARKS

(1) Select the [Draw] menu - [Line/Poly-line] command,

or click on the icon.

(2)Set the attributes of a straight lineto be drawn.
If necessary, select the color and line type.

Polyline |
15 —
£y — | Polyine -
5

||_ ey | ey e |

Fo HEECIEE O &<
Bo I W) Bk

(3Move the cursor to the drawing area, click on the
line’'s starting point and drag the mouse to the end
point.

(4)Click again; astraight lineisdrawn (registered).

d

B Drawing Polylines

If an arrow (—) is selected, the
line’s end point will become an ar-
row.

In step (4), while holding the[Ctr]
key down, astraight lineat an angle

of either O, 45, or 90 degrees can
also be drawn.

When using the keyboard to draw
astraight line, use the arrow keys
to move the cursor to the start and
end points and press the|J] key, to
start and finish the line.

To cancel the placement, click on

the icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.3.15 Changing
Attributes

When the Polyline check box is checked, Polylines can be drawn. Click on the
starting point then drag the mouse, clicking the left mouse button at each point of
the desired directional change of the line; and, click on the right mouse button at

the end point of theline.

@V\ote: - When drawing, if the Keyboard’s key ispressed instead of clicking
2] onthemouseright button, the start and end points of a polyline object will

be automatically connected.

- You can draw a line that looks hand-drawn by holding down the mouse's

left button when drawing a polyline.
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@ Square/Rectangle ]

To draw asquare, click on and designate the diagonal two points.

To draw aregular square, perform this operation while holding down the
key. By selecting a pattern before drawing, afilled square also can be
drawn. Both normal (non-filled) and filled squares can be beveled.

B Square Attributes

Check this check box when draw-
ing afilled Square/Rectangle

SquarefRectangle

1 %] Displays the

I~] Fil E// currently se-
= lected Square/

Comer[8 2

omet Rectangle type
— = =l ——j[==] |~ When selecting

Corner, this
Select a Color and || Fa 1NN NN o . ) ) ) ) number desig-
blinking, if desired By W) sk nates the num-

ber of dots used

Selects the type of |
Square/Rectangle

000}

Selects aline
(border) type

<Filled Square/Rectangle Setting Screen>

QEI ] Fil n
D D:urner-

fo HEECIEE O &<
Bo W) Bk

Select one of the
tiling patterns

€ Square Shapes and Beveling types
Square shapes and beveling types are as shown below.
[ ] Notbeveled.
(D All corners are beveled with straight lines.
()  All corners are beveled with arcs.

When selecting Beveling, input abevel dot number.

Rounded } Ling
The dot value sets up

-t T othis spacing
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B Drawing a Square/Rectangle

PROCEDURE REMARKS

(1) Select the [Draw] menu - [Squar e/Rectangle] com-
mand, or click on the icon.

(2)Set theattributes of the square/rectangleto bedrawn. 2.2.3 W Square At-
If desired, select the colors, linetypes, bevelingtypeand | tributes, €  Square Shapes and
dot. When drawing afilled square, check the Fill check | Beveling types
box, instead of selecting line types.

QI:I I Fil E
D Eorner-

fo HEECOE®EOO e
B NI Bk

@ Select a pattern

Square/Rectangle
’I}? |:| I Fil
833 coref 7

fo HEECOE®EOO e
B NI Bk

(3)Movethecursor tothedrawing areaand click onthe | Instep (4), hold down the key
first of the diagonal’s points, “a”. to draw a square.

When using the keyboard to draw a
square, use the arrow keysto move
the cursor to the rectangle’s two di-

agonal points and press the [ key
a to start and finish the rectangle.

To cancel the placement, click on

the |« |icon.

(4)Click on the diagonal’s other point “b”.
The rectangle is automatically drawn (registered).

Double-clicking on any object
a drawn on the screen automatically
calls up that object’s attribute set-
|71 tings.
b 2.3.15 Changing
Attributes
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m Circle/Oval ]

To draw acircle or an oval, click on its center point and drag the mouse to
the circumference point, and click again. Holding down the key draws
aperfect circle. To draw afilled circle or oval, select the desired pattern.

B Circle/Oval Attributes

Check this check box, if a filled Circle/
Oval is desired

Cucle/Oval

Select a Line/ ] Fin —+— Displays the
Border type currently selected
Circle/Oval image

||_ e | Y |

Select a Fg and
Bg color, and

blinking, if de- ———jtFo I Em ] &«
sired Bo )W/ ek

<Filled Circle/Oval Setting Screen>

Circle/Oval [=]

Select one of the
Tiling patterns

Fo HEN NN &<
Bo [N/ 1) ex)

B Drawing a Circle/Oval

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Circle/Oval] command, or
click on the|[{"y| icon.

(2)Set attributes of an oval to be drawn.
Select colorsand alinetype, if desired. To draw afilled
oval, check the Fill check box and select a pattern, in-
stead of selecting aline type.

Circle/0val [x]

- IEECOEE o0
o B ] e

@ Select a Pattern
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PROCEDURE REMARKS

U

Circle/0val [x]

Fo [N )] B
By NI ekr]

(3)Movethe cursor over thedrawing area, and click on | |n step (3), if the[Shift] key is held

the center point, shown hereby “a”. down, you can draw an oval which
contacts a specified area (i.e. the
side(s) of asquare). Thisfunction
isuseful when drawing an inscribed
circle and can also be used in step

(4), together with the [Ctrl] key.

(4)Asthecursor ismoved, the oval will expand or con- | To draw aregular circle, hold the

tract. key down in step (4).
Click on the point shown by b. The drawn ova will be
registered.

When using the keyboard to draw
anoval, usethearrow keysto move
the cursor to the center point and

then, to the point which definesits
) circumference (radiuspoint), press-
@ % ing the ] key each time.

To cancel adrawing action, click
on the [w=| icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.3.15 Changing
Attributes
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@ Arc/Pie ]

To draw an arc or pie, aportion of acircle must be selected. You will need
to first draw acircle, and then, click on the arc’s beginning and end points.

B Arc/Pie Attributes

Check this check box when
drawing a Pie

| Displays the
currently selected

Select one of Arc/Pie image

the line/border
types

fo HEE BN ex-) Select the Color
B ) sk and Blink set-

tings, if desired

B Drawing an Arc

PROCEDURE REMARKS

(1)Select the[Draw] menu - [Arc/Pie] command, or click

on the|{*| icon.

(2)Set the Arc's attributes.
Select Colors and line type, if desired.

Arc / Pie [x]

-

||_ —— =

fo HEECIEE O &<
Bo W) Bk

(3)Movethe cursor tothedrawing areaand click on the | Instep (3), if the key isheld
oval’s center point “a”. down, you can draw an ova which

contacts a specified area (i.e. the
side(s) of asquare). Thisfunction
isuseful when drawing an inscribed
circle and can also be used in step

(4), together with the key.
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PROCEDURE REMARKS

(4)Click on the oval’sradius point “b”. In step (4), holding down thelCtrl]
An oval will appear and the arc’s base line will bedis- | key drawsacircular arc.

played.

/
b

(5)Click onthearc'sstart point “c” or on itselongation. | When using the keyboard to draw
an arc, use the arrow keysto move
the cursor first, to its center point,

then, to another point onitscircum-
4 ference (radius point), and then, to
its start and end points. Press the

o]

key after specifying each of
these points.

(6)Click on thearc'send point “d”.
The arc will be drawn (registered). To cancel the drawing action, click

on the[«| icon.
& Double-clicking on any object

C
drawn on the screen automatically
: calls up that object’s attribute set-

b tings.

2.3.15 Changing

Attributes
B Drawing a Pie (Sector)
Follow the same steps used for the drawing of Arcs.

When using the same procedure to draw an Arc:

[e]

4

SRS

D
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@ Fill |

To use the Fill command, simply left-click your cursor on top of an object’s
enclosed area. The selected Fill pattern will then spread outward until it
reaches aboundary. A boundary can be any line or Fill that is the same
color asthat chosen for the Fill’s foreground, background, or border.

A
\

i <Cautions when Filling an Object>

] . . .
Important Be sure that the area to be filled is completely enclosed with
solid lines. Dotted lines can not be used as an enclosure.

A space of only one dot on the border of an enclosed areais
enough to allow Fill to leak into other areas of the screen. Be
especially careful when drawing polygon vertexes and filling an
object while the display is set to 50%.

DO NOT attempt to fill objects that have been designated as
blinking.

When filling an image that uses an arc, Fill may leak when that
image is actually displayed on the LT panel display. To prevent
this, use aline to connect any gaps in the image.

B Fill Attributes

Fill

[x]
Displays the
currently selected

Fill type

Select one of the
tiling patterns

Fo 1NN I o T I 1] B
eo I ] exC) Select a Color
ed WO ENTO

{Note: - To select the background color for all the screens used, use the [Option]
2] menu’s[Screen Settings] command.

2.7.2 W Settings Screen Property - [Color]

- To cancel the application of a Fill dueto a mistake, such as having desig-
nated the wrong Fill point, pressthe key.
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2.2 Drawing

B Filling an Object

Chapter 2 - CREATING BASE SCREENS

PROCEDURE

REMARKS

(1) Select the [Draw] menu - [Fill] command, or click on

the % icon.

(2)Set the attributes.

Select Colors and Tiling Patterns, if desired.

Fill [%]

Fo I M ]] ExI)
eo I ) ME][] e[
ad I ) )]

(3) Movethe cursor to the drawing area and click on

theareato befilled.

The designated areawill befilled in.

g
-

Fill spreads outward from the se-
lected point until it reaches a bor-
der with one of the colors (Fg, Bg,
Bd) selected in step (2).

Select the same color for the Bd
(border) Color and boundary Fg
(foreground) Color.

Ey

AN Line's Fg oolor, Blue
Fill's Bd color; Blus : '

Left-clicking on a line will not
causeittobefilled. Besuretoonly
click in an area enclosed by lines.

When drawing via the PC’s key-
board, press the[«d button to indi-
cateafill point. Fillsand fill points
can be specified to either display
or not display via the drawing
board.

2.7.2 Screen Envi-
ronment Settings

To cancel Fill dueto amistake, such
as designating awrong Fill point,

pressthe key.

To cancel thefilling, click on the

icon.

Double-clicking on afilling point
of any filled object drawn on the
screen automatically calls up that
filled object’s attribute settings.

2.3.15 Changing
Attributes
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2.2 Drawing

@ Filled Polygon

]

To draw a Polygon, either Left-click or pressthe key to indicate the
Polygon’s vertices. To complete the Polygon, either right-click or press the
to automatically connect the beginning and end points.

Holding down the key while drawing a Polygon will snap the
polygon’s segments to 45 degree angles.

W Polygon Attributes

Select one of
the tiling

Filled Polygon

| Displays the
currently
selected Polygon

patterns

Fo N0 &
i | ] T

Sets the Color
and blinking, if
desired

B Drawing a Polygon

PROCEDURE

REMARKS

(1) Select the [Draw] menu - [Filled Polygon] command,

or click on the [ #4| icon.

(2)Set attributes of a polygon to be drawn.
Select Colors and Tiling Pattern, if desired.

Filled Polygon

Fo IV I [ I 1 ]
Bo I ) ek

(3Movethecursor tothedrawing area and click on the

start point “a”.
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PROCEDURE REMARKS
(4)L eft-click to designate the positions of the Polygon’s | Up to 100 corners (faces) can be
vertices. created.
Repeat thisfor asmany verticesasneeded. Here, points | |, step (4), holding the key
b and c are al'so shown. causes linesto be drawn at exactly

0, 45, or 90 degree angles.

(5)After defining thefinal vertex, c, right-click or press| To cancel the drawing, click on the

to complete and fill the Polygon. icon.
Points aand c are joined and the object isfilled.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

2.3.15 Changing
Attributes

@Ik\l\ote' - About Filling a Polygon

When a polygon’s segments over lap, thefilling alter nates, so that areas next
to each other do not display the same pattern. Asaresult, areaswithout
any fill (white) may develop inside the polygon. If fill isdesired in these

areasaswell, click on the icon.
Eg
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@ Scale ]

To draw or create a Scale, input the number of divisions desired and then
left-click the mouse’s cursor to designate the scal€’'s beginning and end
points. Scales can be either horizontal or vertical, linear (straight line) or
curved (semi-circle).

B Scale Attributes

Enter the number of divisions desired

sale D ] Displays the cur-
r | Ppe=—— WIFIons
soenve [0 25 R e
Scale’s type %9 Linear E]% J g
—— (Only with straight

Select the line = — line Scale's) Qhanges
=== ll= = == - - | e the scale’s orienta-

type tion to vertical

Fo MENONN O s _ |
o [N MmO o (default is horizontal)

Select the Color and
blinking, if desired

B Drawing a Scale
PROCEDURE REMARKS

(1) Select the [Draw] menu - [Scale] command, or click

on the (.| icon.

(2) Set theattributes of the divisionsto be marked. <Number of Divisions>
Select the Scale's colors, linetype, and Scaletype, and in- | \v/hen the number of the divisions
put thenumber of scale dvisions: 1f“Linear isselectertas | & o ae 0 B L HOR
the type, select the orientation direction by clicking on the sion lives will bé displayed
Vertica check box. '

Scale |
=Type=—=) Divisions
i Curved

£ Linear ] Wertical

||_ - = o=

Fo EECIEEO &
By I Bk
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PROCEDURE

REmMARKS

The following explanation is divided into two parts; first,
when creating alinear type scale, and second, when
creating a curved type scale.

[Creating aLinear type scale- (Vertical, with 8 divi-
sions)]
Specify the area of division lines by arectangle.

(3)Use the mouse’'s cursor to create a rectanglein the
drawingarea, i.e. left-click toindicatethelinear scale's
start point, a.

7

‘ a

(4)Completetherectangle by left-clicking on the Scale’s
end point, b.
The rectangle shape will disappear, and be replaced by
division lines.

d

o

"2

o

b

[Creating a Curved type scale- (8 divisions)]
Specify the area of division lines, using double circles.

(3)Usethemouse'scursor to createacircleon the draw-
ing area, i.e. left-click to indicate the curved scale’s
start point, a.

/

‘ a

Holding down the key while
performing step (4) will draw aper-
fect square.

When using the keyboard to per-

form drawing, pressthe key to
designate the start and finish points.

To cancel the drawing, click on the

icon.
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2.2 Drawing

PROCEDURE

REMARKS

(4)Click on theradius point “b”, which is of a scale’s
outer circle.

a’ /

TN

(5)Draw another circleinside thecircle drawn in step
(4) to decide the width of the scale. Click on thisin-
ner circle’sradiuspoint “c”.

(6)Rotate the displayed segment and click on the scale
start point “d” or on its elongation.

a

dF:ﬁ’

(7)Then, rotate the segment again until you reach the
desired end point e, and click to designate the end of
the scale’sdivisions.

Division lines appear inside the area surrounded with

the double circles and the two segments. They will be
drawn clockwise from the start point to the end point.

v/
\.m./
s ~

2-134

When using the keyboard to draw
divisions, press the [ key after
moving the cursor to the division
circle’s center point, to the other
point on its circumference (radius
point), and then to the divisions’
start and end points.

To cancel the drawing, click on the

icon.

Double-clicking on any object
drawn on the screen automatically
calls up that object’s attribute set-
tings.

Attributes

2.3.15 Changing
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@ Text ]

Use your PC’'s keyboard to enter text, and then place in on the screen with
your mouse's cursor. This software has two methods of placing text on the
screen. The first method defines the placement point, and the second de-
fines the area where the text will be centered.

B Text Attributes

= Display a sample

% Direct L Index of the current
text’s attributes

Enter the text
used as \fﬂ o e
direct text. abc
Selects the

Selects the text’s Character Type

display direction presten ﬁg%*
O Vertical | Rotates the text

@t}lle 2 Momal 0 Bold i Haised)

_ in 90 degree
Specifies the __Fmts'ze increments
character width
and height
Fo I/ /) 1] e | H
eo )] s Selects the Fg
and Bg colors,
and blinking
@ Direct
The text entered in the text entry field is placed directly as a fixed text
string.
A maximum of 100 characters can be entered per line, and 100 lines per
screen.
€ Index

Select and add the Index Text.
AOTTX 4.5.3 W Selecting theindex character string 4 Entering
the index character string
& Font Size

Clicking on the font size display area, displays the current character size
(used after text is placed on the drawing area). Move the cursor to where the
X and Y axislines cross, and drag the cursor. Asthe axislines move, the

character size will change. Click on the text block again, or pr%sthe
key to register (enter) the change.

Font Size

1632
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& Style
Characters can be either Normal, Bold, or Raised.

Style
123 Mamal

{2 Bold
170 Raised

{Note: When text character background (Bg) is specified to Black + Blk (Blink),
2] transparent modeisused, thereby displaying that area astransparent. If an
object has been drawn under neath these characters, they (the characters) will
appear transparent, showing the object behind. Thisfunction isuseful when
over laying text on objects, i.e., over the face of Switchesand Lamps.

2.2 B Selecting Colors

B Changingto a New Text Lineand Line Settings

When entering characters, simply press the key to move to anew line.

When there are 2 or more lines of text, icons will appear to allow adjust-
mentsin line spacing, and justification.

Controls the

Line Spaging. T ' Spacing Justific-ation Controls the
et | Bae B b [EJEE | selecte
i text’'s
dot incre- EEEDEEOO e<0 ustification
oo I W )0) e«

& Justification

Horizontal text’s aignment can be changed to either Left, Center, or Right
justified.

Left justified — = || = | = Right justified

Centered
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W Entering Text

PROCEDURE REMARKS

(1) Select the [Draw] menu - [Text] command, or click

on the|| icon.
(2)Set the attributes of the charactersto beinput. The attributes can also be entered
Select Colors and Character Size, if desired. and selected after entering text.
Text
1) Direct 120 Indey Whm “ Ral wj” |S %I eCted fOI’
Character Type, the border color
: (Bd) will become shadowed (i.e.
s 3-D).
Direction ’ﬂ_g %) Horizortal
20 Vertical
Style @0 Momal 20 Bold 2 Raised
UIS\ZE

Fo VI m )] e
B I I O O 1 e

(3)Click on the text field to input characters, via your
PC’skeyboard.
Simply clicking on thetext field alowsyou to input char-

actersthere.
Text
#) Direct 23 Ind

(Operation Screen
abc

Direction %) Horizontal

20 Vertical
Style i Nomal 129 Bald 2 Raised
Fon Size

BE E

Fo I L I )] %0
Bo )1 sk )

Heresafter, two text alignment cases will be explained, one
not using and one using the Centering function:

<When Centering function isNOT used>
(4)Movethecursor tothedrawing area and click on any
desired point.
After clicking on apoint in the drawing area, atext box | When using your PC’s keyboard

thesize of the selected character will appear onthescreen. | 1o enter text, press the ] key to
The top left corner of the text box is the base point used designate a position.

for positioning.
/"
]
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PROCEDURE REMARKS

(5)Movethecursor tothedesired position and left-click | To cancel the placement, click on

the mouseto placeit on the screen. the [ | icon.
' \/ e Double-clicking on any object
" Operation Screen drawn on the screen automatically
T calls up that object’s attribute set-
tings.
2.3.15 Changing
<When the Centering function I S used> Attributes

(4)Movethecursor over thedesired placement areaand,
while holding down the key, click on any
desired point.

After clicking on a point in the drawing area, the text
box will appear on the screen in dotted line.

(5)Select acentering area that isthesamesizeor larger | To cancel the designated area, click
than the previoudly selected text area. the right mouse button.
The designated size's text box will appear in the center
of the selected area.

Operation 2creen
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m Load Screens

)

Graphics created on screensin a project can be loaded and used repeatedly

on otherswith LT Editor. Thus, asingle screen’s contents can be used

repeatedly elsewhere. The Load Screen function is also a good way to cut
down on your screen’s actual size, since you only need to call up itemsto

your screen, not save them onit.
B Screensthat can beloaded to other screens
The screen currently being edited cannot be loaded on to itself.

Current Screen

Loadable Screens

B (Base) screen

B (Base) screen

I Image) screen

U (Window) screen

B (Base) screen

| Image) screen

Gt

2]

oté: . Thescreen currently being edited cannot be loaded on to itself.

* |f aportion of an Image screen extends over a Base screen’sY axis border,
that portion will not be displayed on the LT screen. When the Image screen
isplaced over the Base screen laterally, however, any part that extends over
the Base screen X axis border will be squeezed onto the LT screen.(i.e. not

cut)

When using LT Editor

Example)

Drawing
Areas

When using the LT
panel display
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B Nesting

Screens can be nested up to 10 times (11 layers). However, if your PC's
system memory islow, aloaded screen/object may not be displayed. Later,
however, when the datais transferred to the LT, the display will appear

normally.
E.g.) Nesting Objects Twice (3 layers)
B100 B0 =

1

B@% L

Load Sareen BA00 Load Sareen B10

iy
iy

@Ikv\ote: Theload screen nesting condition can be viewed via the load screen nesting
2] display function.
2.7.9 Display at Screen Level Change Structure

B L oading a Screen

PROCEDURE REMARKS

(1) Select the [Draw] menu - [Load Screen] command,

or click on the||[&H| icon.

(2)Select a desired screen from the list or enter that | Only screensin the currently used
screen’snumber directly on the[Screen No.] field via | Project file can be loaded. Screens

the keyboard, and then click on the[ o« | button. | in other project files can not be
Then, the screen’s outline and center point will appear in |oaded.
the drawing area, next to your cursor.

The current (selected) Screen can-

Load Screen
Screen Type |Base E‘ QK. not be Ioajed on to It%lf
Sereen No. |11: Operation Manitor llz” @I

| 13: Trouble [[14: Keyboard In W
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PROCEDURE

REmMARKS

(3)Click on the point wherethe Screen’stop left corner | A loaded screen cannot be edited

isto be placed.

whileit isbeing used on adifferent

The image's center point isleft top corner of itsborder, | (i.e. loaded) screen. You will need
and for other objects, the screen center mark will bethe | to open the original screen to per-

placement point.

Il OPERATION MONITOR

=ETOPR WARM—ITE BT

STOF WARM—IITE RUTT

=TOoF WARM—TITE BUTT

20 W e

sSTOoP WARI— ITE RUT

STOF FIILT
| EEEEEEE

@V\ote:
2]

When calling up afilled object:

form any editing.

To cancel the loading, click on the

icon.

When the current screen’s graphics overlap loaded filled (painted) graph-
ics, depending on the color used, unfilled areas may be created. To correct
this, add afill to the current screen’sunfilled area.

MABETEEK 2.2.6 Fill

B1ao B0
Load B100
onto B10

B1

0

Ao

|
u
Important

displayed on

the LT.

Add & fill in the
unfilled area

If a background color is selected for the screen used for
screen call-up, the object placed on the screen will not be

To call up the screen for which a background color has been
selected, specify the center of the screen as the call-up posi-
tion and then place the screen.
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@ Load Mark ]

Marks (dot images) created in aMark screen can be loaded and used repeat-
edly on a Base screen.

B LoadingaMark Screen

PROCEDURE REMARKS

(1) Select the[Draw] menu - [Load Mark] command, or

click on the| & | icon.

(2)Select adesired Mark screen from thelist or enter
that screen’snumber directly on the[Screen No.] field

viathe keyboard, and then click on the[ = ] but-
ton.

The Mark’s outline will appear in the drawing area, next
to your cursor.

Designateits color and size before clicking on the [OK]
button, if desired.

= Only Mark screens in the current
Mark No.: |1 big F [ o ] H
= project can be loaded. Mark
screens in other projects are not
available.

When the screen display size is
50%, the loaded Mark may not be

displayed correctly on the LT Edi-
o ML 2 tor software.

s INEOEEDD =0 -

To cancel the loading, click on the
(3)Click on the point wherethe Mark’stop left corner is icon.

to be placed. .
If desired, use the Mark’s handles to alter its size, To change the Mark’s size, refer to
2.3.3 Scaling Up/
_ o Down
% o Double-clicking on any Mark
St L loaded on the screen automatically
calls up that Mark’s attribute set-
tings.
2.3.15 Changing
Attributes
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BE) object Editing

Parts, objects, and text previously placed or drawn (hereafter called “ Ob-
jects’), can be edited using various functions, such as Copy and Delete.

To edit an object, first, use the cursor to select the object, and then select the
type of edit operation.

Usage Pattern

Select an
Object -

[Edit]
or
Tool Bar

-

Select the type of
editing to perform -

Perform the
editing

B Typesof Editing Functions

Icons contained in the Edit Tool Bar and their corresponding edit operation
are asfollows:

Icon Edit Type Icon Edit Type
= Undo > Mirror X-axis
C Redo L][3 Mirror Y-axis
.;Ii{. Cut HE Group
Copy IE Ungroup
R Paste E Bring to Front
Command Data Paste IE Send to Back
Duplicate IE_E' Change Attribute
Delete Change Coordinates
B Align Convert Bitmap
v Rotate Left Transférlzrbgoifdreen to
33 Rotate Right Converting SFci::en to Bitmap
v Redraw Screen

‘Note: The toolsshown above can also be used from a menu by right-clicking the

mouse.
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@ Selecting Objects ]

Two methods are available for selecting objects: 1) clicking on an object
directly, or 2) dragging the mouse to enclose and select single or multiple
objects.

Also, you can select individual objects that have other objects either on top
of, or overlapping them.

When the tool bar’s icon is clicked on (active), an object can be se-
lected. To activate thisicon, click on it directly, or select the pull down
[Edit] menu’'s[Select] command. Also, while drawing objects, right-
clicking anywhere on a desired object allows you to select it.

Either all or a1 mark will be displayed on the sides of the selected object.
These square marks are called “handles”.

Handle Types

There are two types of handles, those that can be used to scale the object and
those that can not.

M : Can be used to scale the object
[J : Cannot be used to scale

When an object has been be selected, the Selection Tool box will automati-
cally appear. When multiple objects are selected, all the selection Tool
box’s functions are available.

Selects all of the After selecting a group
objects in agroup of objects, selects one
aelechion  E of that group
Al After selecting a group of

After selecting either

or || Tyee|, clicking on either

or selects the next

object or type

. f objects, selects one type
Sl ﬁ” of object (i.e. squares,

’ : circles, etc.

Tupe:| = )

1)

<

W

4

@Ikv\ote: Objects may be selected using the Screen Data List, instead of selecting them
2] onthescreen.

2.7.4 Screen Data List
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B How to Select a Single Object
Here, the procedure for selecting an object is explained.

PROCEDURE REMARKS

[Selecting an Object Directly] When selecting grouped objects,

click on any one of the objectsin a

()M ovethecursor over the object, and left-click.
group to select the group.

Handles display on the object to show that it is selected.

A Part’s Label can be selected in-
" Q dependently from the Part.

L]

[Selecting an Object by Dragging]

Click onaPart todisplay itshandles
and then on its Label to display the
Label’shandles. After selecting the
Label, it can be moved or scaled in-

(2) Position the cursor near the object and hold the but- dependently from the Part.

ton down, then drag( thisiscalled “ L eft-dragging”)
the mouse over the object. Asyou do so, a “box”
formed by a dotted line will expand to enclose the

Numeric Display and text can also
be selected using the above-men-
tioned steps.

object. When the entire object is enclosed within the
“box”, release the mouse button; handles display on
the object to show that it has been selected. You must
position the cursor relativeto the object so that when
you L eft-drag over it, the entire object will be en-
closed within the “box”; if it is not, then the object
will not be selected. Thismethod ismost useful when
selecting multiple objects, described below.

L eft-dragging over only apart of the
object will not select it. Theentire
object must be enclosed to select it.

When you wish to select another ob-
ject without de-selecting the previ-
| ous one, hold down the[shift] key
: while making the next selection.
' This can also be done continually
to select multiple objects.

[Selecting an Object from Overlapped Objects]

(2)While holding down the[ctrl] key, click on an Object
to be selected.
That Object’s handles will appear to reveal it has been
selected.
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B How to Select Multiple Objects
Use this operation to select multiple objects. All the objectsin adesignated area or
on the entire screen can be selected. Also, if necessary, some of these objects can be

de-selected.
PROCEDURE REMARKS
[Selecting Multiple Objects by Dragging] L eft-dragging over only apart of an

(1)L eft-drag over objects as described in Selecting an | object will not select it. Theentire
Object by Dragging (see above). Be sure to enclose | object must be specified to make
all of the objectsto be selected completely; if part of | selection possible.
an object isnot enclosed within the “box”, it will not
beincluded in the multiple selection. Handles will dis-

play on the objects that have been selected. When two or more objects are se-
___________ lected, the [Change Attributes]
: C\ | command cannot be used.
[
N |
[ |

The editing commands available
depend on what objects have been
selected.

[Selecting All the Objectson a Screen|

(1) Select the pull down [Edit] menu’s [Select All Ob-
jects] command. All object handleswill appear, to show
that they have been selected.

- —=Rn-= -,
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PROCEDURE REMARKS

[Excluding Objects From A Multiple Selection]

(2)When multiple objects are selected, to de-select an
obj ect while preserving the selection of the other ob-
jects, first movethecursor over theobject; then, while
holding down the[shift] key, left-click on the object.
When the object’s handles disappear, that object is no
longer selected. Repeat this process as many times as
desired.

[Adding Objects To A Multiple Selection]

(2)When multiple objects are selected, to add an object,

either left-click on the object or Left-drag over it,
while holding down the key.
The imaginary “box” that encloses the multiple selec-
tion (represented by its' own handles) will expand to in-
clude the added object , which now has handles Using
this process, you can add as many objectsto the multiple
selection as you want.
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PROCEDURE REMARKS

[Selecting One Object in a Multiple Selection]

(2)First, make a multiple selection; then, click on the

Selection Tool box’s icon. All the objectsin the
multiple selection will become de-selected, except for
one.

If you wish to re-select all the
objects originaly in the multiple
selection, click on the Selection

I [ Tool box’slT button.

(3) Usethe[«]and[[>]iconsto “scroll” through all the

objectsoriginally in the multiple selection; clicking on
these arrow keyswill change the selected item, one at

atime. Clicking on the[[>]icon will select the next

object, and clicking on the icon will select the

revions object , in the order that th ere drawn. _
Previons oy ! YW To select an Object from over-

lapped Objects.

How to Select a
Single Object
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PROCEDURE REMARKS

[Selecting Objects by Type from a Multiple

Selection] Objects are classified as follows:

) . _ . Parts. by each type,

(2)First, make a multiple selection; then, click on the Objects: by each type,
Selection Tool box's[[Tsee] icon. L oaded Screens and Marks: All as
Selection handles will appear for only onetype of object | one type, respectively.
(here, only sguare objects are selected), while an outline
remains around them all. Thiswill effectively de-select
any objectsthat are not the currently selected type.

- ®ER-E-§

Tore-sdlect dl theobjectsoriginally
in the multiple selection, click on

the Selection Tool box’s |T
S —mm- button.

(3) Usethe[«]and > iconsto select a different object

type.
Asyou press either arrow key, the selected object type
will change.
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@ Moving Objects ]

In this section, the procedures for moving objects are described.

B How to Move an Object

PROCEDURE REMARKS
(D Click on thedesired object. Theobject’shandleswill _
appear, showing that it has been selected. 2.3.1 Selecting
Objects

The keyboard's , : , and
keys can also be used when the
object’s handles are displayed.

(2)Place the cursor over the object, away from the | ¢ 5 object is too small to select
handles, and after the cursor changesto4, dragit | and move (i.e. it isonly scaled up

to thedesired location. or down), click on and drag the ob-
ject while holding down the
key.
&

Also, you can move the object by
zooming out the screen or using the
keyboard.

1.5.2 Display Area
(50%, 100%, 200%)

To cancel the movement, click on

the ||« | icon.

@Ikv\ote: . To move an object horizontally or vertically, do so while holding the[Shift]
21 key down. In this case, the object will be moved in either the horizontal or
vertical direction where the moving distanceis greater.

- To move and scale up/down an object, designating its coor dinates can be
used.

2.3.16 Changing Coordinates
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@ Scaling Up/Down ]

Scaling means changing the size and proportion of an object. This function
allowsyou to easily scale an object up (larger) or down (smaller). Be sure
the object’s handles are displayed as ().

B Scaling An Object

PROCEDURE REMARKS

(1)Click on the object to select it. The object’s handles 2.3.1 Selecting
will appear to show that it is selected. Objects

Re-sizing will depend on which

handleis dragged:
(2)Place the cursor on an object’s handle, and after the g

double arrow cursor appears, dragthe handletore- | EX. To scaleasquare up or down:
size the object. Corner Handles = proportionally
Top/Bottom handles = vertically
a4 Right/Left handles = horizontally
Place the cursor on one of the
handles of the object.
| When the cursor becomes - , use

T the keyboard's either[+ ] [-]
G or [, | key to scale the object up or

down in the unit of dot.

n
—=—1u

To cancdl there-sizing, click on the

w3 | icon.

ote: - When re-sizing an object while holding down the[Ctrl]key, lines will snap to
21 45degreeintervals, Rectangular and Scale (Linear) objects will become
square-shaped objects, and ovals will becomecircles. Also, if the[Shift| key
isheld down, all selected Lines, Rectangles, Ovals, Scales, Text and loaded
Markswill scale up or down proportionately.

When scaling a Part with a Label, holding down the[Ctrl] key causes the
Label to scale up or down together with the Part.

- When selecting an oblique line, 8 handles will be displayed. Click on the
line again and 8 handles will changeto 2 handles, one at either end. Click-
ing and then dragging on one end’s handle “fixes’ the opposite end in place,
and “releases’ the dragged end, and allowing the lineto pivot freely.

- Multiple parts may be selected and then scaled up/down. However, the
following parts are not scaled up/down, but their positions are moved:
Half-pie Graphs, Pie Graphs, Meters, Trend Graphs, Alarms, Keypads, and
Picture Displays.

- To move and scale up/down an object, designating its coor dinates can be
used.

2.3.16 Changing Coordinates
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B - |

Here, the procedure for “cutting” an object (deleting it) and placing it on
another screen, is explained. (When an object is*“cut”, it is stored in the
Clipboard™.)

B Cutting (Moving) an Object

PROCEDURE REMARKS

(1)Select an object. 2.3.1 Selecting
O Objects

(2)Select the [Edit] menu - [Cut] command, or click on | To cancel the Cutting, click on the

the icon. | icon.

Then, the selected object will be cut.

(3)Open the object’s destination screen, and select the

[Edit] menu - [Paste] command, or click on the

icon.
Then, the outline of the object cut from the previous
screen will appear.

(4)Position the cursor and click on the point wherethe| To cancel the pasting, click on the

object isto be placed. icon.
The object that had been Cut from the previous screen

will be “pasted” at the new location.

S

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “ pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be Pasted.
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ED co

)

Here, the procedure for *copying” an object (without deleting it) and placing
it elsewhere, is explained. (When an object is“copied”, it is stored in the

Clipboard™.)

B Copying an Object

PROCEDURE

REMARKS

(1)Select the desired object(s).

(2)Select the [Edit] menu - [Copy] command, or click

on the icon.

The selected object(s) will be Copied to the Clipboard.

(3)Select the [Edit] menu - [Paste] command, or click

on the icon.

Then, the outline of the object copied from the previous
screen to the Clipboard will appear.

(4)Position the cursor and click on the point wherethe
object isto be placed.
The object stored in the Clipboard will be Copied to the
specified location.

L

—3
i
u

.

Objects

2.3.1 Selecting

To cancel the Copying, click on the

A icon.

When “pasting” the Copied object
on another screen, be sure to open
that screen first.

Selecting and dragging an object to
anther screen while holding down
the key can also be used to
copy the object.

To cancel the pasting, click on the

icon.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “ pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/

Cut command can be Pasted.
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BD - )

Here, the procedure for “pasting” an object, that has been Copied (or Cut) to
the Clipboard™, is explained.

B Pasting an Object

PROCEDURE REMARKS
(DFirst, Copy (or Cut) an object. 2.3.5 Copy

(2)Select the [Edit] menu - [Paste] command, or click

onthe icon.

Then, the outline of the object copied from the previous
screen to the Clipboard will appear.

(3)Position the cursor and click on the point wherethe | Tocancel thepaste, click onthe k_‘ﬂj|
object isto be Pasted.
The object stored in the Clipboard will be Pasted to the

icon.

new location.
When an object is copied from an-
other screen, it will be automati-
7 cally placed at the same coordinates
L i - as its original ones. To place the
f. . object at different coordinates,

move it after this automatic place-
ment.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “ pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/
Cut command can be Pasted.
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@ Pasting Instruction Data ]

By copying and pasting to the Screen Editor alogic program instruction
created with the Logic Program Editor, you can place a Part corresponding
with the instruction.

In the same way, copying and pasting to alogic program a Part placed on the
screen inserts an instruction corresponding with the Part.

B Conversion between Instructions and Parts
Each instruction and part has counterparts that have been already determined.

& Conversion from Instructionsto Parts
Below isthelist of Parts to which each instruction is to be converted.

Instruction Parts
NO (a Contact) Bit'Toggle Switch
NC (b Contact) Bit'Toggle Switch
PT (Start Up Contact) Bit'Toggle Switch
NT (Start Down Confact) Bit'Toggle Switch
OUT/M (Out Coil) Lamp
NEG/NM (Reverse Coil) Lamp
SET/SM (Set Coil) Lamp
RST/RM (Reset Coil) Lamp
CTU (Up Counter) Numeric Display/Graph/Keypad Input Display
CTD (Down Counter) Numeric Display/Graph/Keypad Input Display
CTUD (Updown Counter) Numeric Display/Graph/Keypad Input Display
TON (On Delay Timer) Keypad Input Display
TOF (Off Delay Timer) Keypad Input Display
TP (Pulse Timer) Keypad Input Display

& Conversion from Partsto I nstructions
Below isthelist of Instructions to which each Part is to be converted.

Parts Instruction
. . NO (a Contact), NC (b Contact), PT (Start Up Contact), NT
BiToggle Switch (Start Down Contact)
NO (a Contact), NC (b Contact), PT (Start Up Contact), NT
Lamp (Start Down Contact), OUT/M (Out Colil), NEG/NM (Reverse

Coil), SET/SM (Set Coil), RST/RM (Reset Coil)
Numeric Display/Graph/Keypad Input  |CTU (Up Counter), CTD (Down Counter), CTUD (Updown

Display Counter)
Keypad Input Display ;(;IzrgOn Delay Timer), TOF (Off Delay Timer), TP (Pulse
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B Pasting a Logic Program Instruction to the Screen
Here, the procedure for "copying and pasting” alogic program instruction to the
screen is explained. When pasting the instruction, the type of Part to be converted to
needs to be selected from the list.

A » Before copying an instruction, you have to allocate a variable
1 to the instruction. Instructions without a variable allocated
Important  cannot be copied to the screen.

» Before pasting an instruction, be sure to save the logic pro-
gram.

PROCEDURE REMARKS

(1)23!_(? the desired instruction on the L ogic Program 1.2.3 Creating/
Itor. Editing/Saving a Logic Program

T Logic Program Editor - A Manufacturing System
Fi= Edi View Seach Help

REE] Ao e o s [To0x[-]
%] Tl [ u]ey]

%lx1.0.3

Small_pushbutton HICH
{Pt EN DN
of 4000{IM OUT|Fill_Timer PT

%0104

Wedium_pushbutton HICH
Pl

P}
off Fill_Timer. PT

|[Prograrnring Mode |

(2)Select the L ogic Program Editor [Edit] menu - [Copy] | To cancel the Copying, click on the

command, or click on the[Ba] icon. | icon.

The selected instruction will be copied to the Clipboard.

=10l x|

plion Draw_Pars Special Libay Window Help

Dd[s(maal r[poc|imals[Lnns o XRWA[E] ]

[e]=]

MOV
DI

4000(IN- OUT|Fill_Timer.PT
0

%0X1.0.4

156132 TACA_ Ready
MOV
D

Medium_pushbutton

7
oft 6000 (IN - OUT] Fill_Timer.PT
0

Copies the sslected iungls)to the Clpboard
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PROCEDURE REMARKS

(3)Select the Screen Editor [Edit] menu - [Paste Com- | To cancel the Pasting, click on the
mand Data(2)] command, or click on the icon. E icon.

(4)Select the Part to convert, and deter mine by clicking

]
Select Parts |
Bar Graph MHurnber_af_Smalls. CW
Fie Graph MHumber_of_Smallz.

Half Fie Graph MHurnber_af_Smalls. CW
teter Graph Mumber of Smalls, W

Ehmenc Dizplay — Mumber of |

A list of the Partsto which the cop-
ied instruction can be converted
will appear. If thereis only one Part
that corresponds to the instruction,
the step 4 is omitted.

au  Mumber of Smalls. Cy
Fevpad Input Dizplay MHumber_of_Sme

|' QK ” Cancel H Help ]

(5)Change the size and attributes of the Part as neces- 2 1 Parts
sary and placeit on the screen.

Mumeric Display Settings [ND_001]

 General Settings | Display Fornat | Shape/Color | Alam 5 ettings |

Dezcription wiord Addrezs
J | JNumber_of_SmaIIF i

|' Flace I | Cancel | | Help
e Lo
..... 12345. o
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W Pasting a Part placed to the screen to a Logic Program
Here, the procedure for "copying and pasting” a part placed to the screen to alogic
program is explained. When pasting the Part, the type of instruction to be converted
to must be selected from the list.

Before copying a Part, you have to allocate a variable (Logic
5 ! g symbol) to the Part. Parts without a variable allocated cannot be
Important CoOpied to a logic program.

‘Note: A variablewill beregistered with the Symbol Editor asa Logic symbol when
2] thelogic program is saved.

PROCEDURE REMARKS
(1)Select the desired Part on the Screen Editor. 1.2.3 Creating/

Editing/Saving a Logic Program

E === Lyl Nl [P = X -3 1)

[T.65__J[ T70T%] | Word SwitchlwS_001](s] (13, 53]-(153.103] sclected [} Tz |

B000|IN OUT|Fill_Timer.PT
2000
K|

>
Fung 7 [ Pragramming Modk | [ [Ti/0m | [TTypeh

(2)Select the Screen Editor [Edit] menu - [Copy] com- | To cancel the Copying, click onthe

mand, or click on the icon. )
The selected Part will be copied to the Clipboard.

icon.

(3)Select the rung where you wish to insert an instruc-
tion on the L ogic Program Editor, and then select

[Edit] menu - [Paste] command, or click on the
icon.

b1 0.7

Power_On_pushbutton  Power_Of_pushbutton
I ;

off o
%Qx1.00
Light
1

off

%QX1.0.0

Light
P

of
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PROCEDURE REMARKS

(4)Select an instruction to convert, and determine by
double-clicking on it.

The instruction will be inserted.

A list of instructions to which the
copied Part can be converted will

appear.

iew Oplion Diaw Parls Specisl Lbray Window Help

Ded[e@ad r ko[t ba|s b
N - ~000a

It L Y|
: |

P 0 cancel the Pasting, click on the
&
@ [0 [ o2 [ -
in he Power ON [Copl] ICOI’]
o pushbuttan starts the = .
" soft drink machine
%01.0.7 BI1.07
Ny
= Power_On_pushbution Power_Of_pushbuttan
a |} 1/
& off off
]
= %@xX1.00

Light

1

off

[233.180 [ 38227 Numeit Displayll]
BEK1.00
Light
4 1P Reset_Counterg<<
off
lcs is dispensed f

Edt View Seach Inset Data Contoller Help

oo o e [100%F]

The Power ON
pushbutton starts the
soft drink machine

%0¢1.0.7 %0107
Power_On_pushbutton  Power_OF_pushbutton
it it =l

Off off

%EK1.00

Light
I
of

%EK1.00

Light
Pt

Off

Reset_Courters<<

Ice is dispensed for as long as the push-button is pressed, providing a cup is present
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B Dragging and Dropping
Copying and pasting of an instruction or a Part can be performed by the drag and
‘drop operation.

m Before dragging and dropping an instruction or a Part, you have
= to allocate a variable to the instruction or the Part. Instructions
or Parts without a variable allocated cannot be dragged and
dropped.

Important

@ Dragging and dropping of a Logic Program Instruction to a Part

By dragging alogic program instruction created with the Logic Program
Editor to the Screen Editor, you can place a Part that corresponds with the
instruction.

/\

m Before dragging and dropping an instruction, be sure to save

the logic program.
Important

%4 Logic Program Editor - Soda
Fie Edt View Sewch lnset Data Lonvaller Help

----- T 2|5 v ([ [5] [aaliR) 2] A0 [2, |2 [ 58 0] [ @)
[-[#] Pl | [l e[n [ uley [v]&]

8 1Pt EN DN
% - Off 4000{IN- OUT|Fill_Timer.PT
— 2000

Medium_pushbutton MO
7 {Pt EN DM
Off BOOO{IM OUT|Fill_Timer PT
2000

Number_of_Mediums

@ Dragging and dropping of a Part to a Logic Program instruction

By dragging a Part placed on the screen to a Logic Program, you can place
an instruction that corresponds with the Part. Drag the Part while holding

[S=Tk3)

CIE

ensing machine

Ice_Maker

of

J
(owem] [ 1

Link Seleot 5] Change 0rder P
r =) P

]
3
e

EEEFEE L FL LD
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@ Duplicate ]

This command allows you to easily make multiple copies of any object. The
address of the copies can be set up so as to increment automatically from
copy to copy, or simply reuse the address of the original object.

B Duplicate Setting Dialog Box

When this command is used, the Duplicate dialog box for entering the copy
specifications, will appear as shown bel ow.

Enter the Duplicate E) When copying Parts that
number of require addresses, clicking
copies in the here will automatically assign
XandY new, incremented addresses
directions for each copy

The device comment corre-
Enter the e spo_ndmé; éo ?r? addtresst_
line spacing, £ Dieston assigned by the automatic
in dotpunitsg sasones [T Il A | address increment is reflected

e onmert in the Description field.
lias addre t mented.

€ Number of Copy

Here, how many times an object will be copied inthe X and Y directionsis
entered. When “1” is entered for either direction, copying will not be
performed in that direction.

The number of copiesisalso limited by the copied object’s location, size,
the Duplicate dialog box’s Spacing settings, and any other related settings.

@ Spacing

Enter the spacing interval of dot (screen pixel) unitsto be used when the
@\ object is copied for both the Horizontal and Vertical directions.

Note: When Duplicating an object, its positioning will be decided based on the top
X2 |eft handle of the copied (master) object. However, if a Bar Graph’s handles
arelocated in a graph display area, the object will be placed based on the
graph display area, not the graph’s border. Therefore, when setting the
spacing, be sureto not overlap any of the graphs’ borders.

& Address|Increment

To copy multiple Parts, specify the direction of the automatic addressincre-
ment. According to the automatic address increment, consecutive Addresses
will be assigned in the designated direction. When the original object’s
Addressis aBit Address, the automatic address increment is performed in
the unit of bit, and when it is a Word Address, the automatic address incre-
ment is performed in the unit of word.
If the automatic address increment is not used, Parts will be copied using the
@\ same address as their original ones.

Note: When theoriginal object's Addressisa symbol/L ogic symbol, the automatic
2] addressincrement isnot performed.
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E.g.) When duplicating with the settings shown below:

b _ oo

¥0000C Hoizontal i il
Veitcal [T =Pl

¥ “&ddress Increment

Xo0002 00003

@ Apply Device Comment

When the [Apply Device Comment] check box is marked with a check, the
device comment corresponding to an address assigned by the automatic
address increment will be reflected in the Description Field. For Parts
designating multiple Addresses, however, the device comment correspond-
ing to an Address designated as the Reflected Description Addressis re-
flected. The Reflected Description Addresses for different Parts are shown
in the table below:

<Reflected Description Address Table>

Object name Automatic input address
Bit Switch Operation bit address
Word Switch Word address
Function Switch
Lamp Bit address
Bar Graph Word address
Pie Graph Word address
Half-pie Graph Word address
Meter Graph Word address
Trend Graph Channel 0 word address
Keypad
Keypad Input Display [Word address
Alarm Word address

File Name Display
Data Logging Display |Block number designated address

Numeric Display Word address
Message Display Address

Date Display

Time Display

Graphic Display Address

Window Parts Word address
Data Sampling Sampling Address
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B Duplicating

PROCEDURE REMARKS

<When Duplicating a Switch 5 timesin both
theX and Y directions>

(1)Select the desired object.

(2)Select the pull down [Edit] menu’s [Duplicate] com-
mand.

(3)Enter the number of copiesto makein the X and Y | When duplicating an object, posi-
directions, spacing between copies. tioning will be decided based on the
If desired, click on the Address Increment check box, to | top left handle of the copied (mas-
increment addresses automatically. ter) object.

Duplicate [X]

=Murnber of Copy:

. —— Enter5
Wi E%/E—n
) Rows E%\

-5 pacinge———————————
HmizﬂntalE}% [Pixels]
Vertical [Fixels]

Enter 5

) “thddress Increment
1% W Direction
2 v Direction

acanmser [T E]| e

¥ Apply Devics Comment

*flias addresses are not incremented

(4)Click on the button to duplicate the object. | To cancel the duplication, click on

the icon.

To stop duplicating, press the

key.
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@ Delete ]

Here, the procedure for deleting an object is explained.

B Deleting an Object

PROCEDURE REMARKS

(1) Select an object.

o

(2)Select the pull down [Edit] menu’s[Delete] command, | Instead of selecting the [Delete]
or click on the icon. command, the computer

keyboard's[Delete] key can also be
used.

|~ To cancel the deletion, click on

the| =2 icon.
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@ Align

Here, the procedure for aligning and centering object(s) are explained.

B Alignment Dialog Box

]

Resets the X axis

Alignment
Shows thg @ “ii
ment settings =
A
-

Resets the Y
axis settings

- Al

settings

— Aligns above the
X axis

— Aligns on the X
axis

I Aligns below the
X axis

/
Aligns to the left
of the Y axis axis

B Aligning Object Positions

Aligns on the Y Aligns to the right
of the Y axis

PROCEDURE

REMARKS

(1) Select all thedesired objectsto be aligned.

E— — —— el — — — — -
|

| 3 :

n o e

: -

b

(2)Select the [Edit] menu - [Align] command, or click

on the icon.

(3)Select thetype of alignment from the Alignment dia-
log box.

In this example, select the'E icon (X-axis: Bottom)
and do not select any vertical (Y -axis) position.

[S] [«

mO

Alignment

(4)Click on the button to align the obj ects.

- T,

|
iFE‘ eu_scrn

B
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2.3.1 Selecting
Objects

While an individual label can be
aligned, groups of labels cannot.
(Click on an object to select its
handles and then click on its Label
to select the Label’'shandles.) Text
characterson both Numeric or other
types of Displays can bealignedin
the same manner.

To align objects, combine the se-
lections shown below:

Horizontal position: Up, Center,
Bottom

Vertical position: Left, Center,
Right

To cancel the alignment, click on

the [ | icon.
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2.3 Object Editing

@ Rotate Left/ Rotate Right

]

With this command, an object can be rotated in 90° increments. However,
loaded Screens and Marks, and grouped objects cannot be rotated.

B Rotating an Object Counterclockwise (L eft)

PROCEDURE

REMARKS

(1)Select an object.

E:EICenter

(2)Select the [Edit] menu - [Rotate L eft] command, or
click on the icon.

The object will be rotated counterclockwise 90 degrees,
relative to its center point; if necessary, repeat the com-
mand.

a0” Rotation

“‘\

B Rotating an Object Clockwise (Right)

2.3.1 Selecting
Objects

The center point of the object is
where two lines, connecting the
opposite handles (other than the
corner handles), cross.

Center
point

T

To cancel the rotation, click on the

icon. (Clicking on thef[] icon
onetimereverses one 90 degreero-
tation.)

If an object is moved outside the
drawing area by rotating, the object
will not be displayed on the LT
screen.

PROCEDURE

REMARKS

(1)Select a desired obj ect.

E:a,(}enter

(2)Select the [Edit] menu - [Rotate Right] command, or
click on thelﬁ icon.

The object will be rotated clockwise 90 degrees, relative
to its center point. If necessary, repeat the command.

90°
Rotation

/ﬁ
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2.3.1 Selecting

Objects

The center point of the object is
where two lines, connecting the
opposite handles (other than the
corner handles), cross.

Center
point

T

To cancel the rotation, click on the

icon. (Clicking onthe[w]icon
once reverses one 90 degree rota-
tion.) If an object is moved outside
the drawing areaby rotating, the ob-
ject will not be displayed onthe LT
screen.
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@ Mirror X/ Mirror Y ]

An object can be moved symmetrically around its center line with respect to
the X or Y axis. Thedisplay position of Parts, Text, Load Screens, and Load
Marks can only be moved symmetrically.

B Moving Symmetrically along the X-axis

PROCEDURE REMARKS
(1)Select an object. 2.3.1 Selecting
Center Objects
—_— __/__ The center point of the object is

where two lines , connecting the
opposite handles (other than the

(2)Select the [Edit] menu - [Mirror X-axis] command, | corner handles), cross.

— Center
. . n n
or click on the |4 icon. /ll/Line

The object will move symmetrically with respect to the - i ‘2 -

X-axis.
If an object is moved outside of the
drawing area by using the Mirror
X function, the part of the object

outside the drawing area will not
be displayed on the LT screen.

To cancel the change, click on the

icon.
B Moving Symmetrically along the Y-axis

PROCEDURE REMARKS
(1)Se|ect an ObjeCt 231 SeleCtIng
| Objects
——— Center The center point of the object is
<::| where two lines, connecting the
. opposite handles (other than the
I corner handles), cross.
" ® Center Line
(2)Select the [Edit] menu - [Mirror Y-axis] command, . i

or click on the@] icon.
The object will moves symmetrically around the Y axis.

If an object ismoved outside of the
drawing area by using the Mirror

Y function, the overflowing part of
the object will not be displayed on
the LT screen.

I
To cancel the change, click on the

icon.
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@ Group/ Ungroup ]

This function can be used to “group” multiple objects, enabling you to
manipul ate the “group” as asingle object, even after changing screens or
using adifferent editing function.

B Grouping Objects

PROCEDURE REMARKS
(1)Select the objectsto be Grouped. 2.3.1 Selecting
Objects

(2)Select the [Edit] menu - [Group] command, or click | To cancel the Grouping, click onthe

on the [ icon. icon.

@fv\ te: - When aload Screen isincluded in a group, its handles appear as[], so that
2] theobjectscannot be scaled up/down. Thus, you must first ungroup the
objectsin order to scale any individual object.

- When a Part isincluded in a group, double click on the group to bring up
the Confirm Device Address dialog box, where address changes can be
made.

2.3.15 Changing Attributes
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B Ungrouping Objects

This function changes a Group of objects to a selection of multiple objects.

PROCEDURE

REMARKS

(1)Select a group of objects.
] ] ]
()=

(2)Select the[Edit] menu - [Ungroup] command, or click

on the icon.

2.3.1 Selecting
Objects

To cancel the ungrouping, click on

the icon.
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@ Bring to Front/ Send to Back ]

When graphics and Parts overlap each other, you can change the order of the
layers with these two commands.

B Changing the Order of Overlapping Objects

PROCEDURE REMARKS

In this example, you will move the oval, partially hidden 2.3.1 Selecting
by the rectangle, to the front. Objects

[Bringing an Object Forward]
(1)Usethecursor to select thefilled oval.

'

(2)Select the [Edit] menu - [Bring to Front] command, | To cancel the movement, click on
or click onthe  icon. the icon.

[Sending an Object Behind]
(1)Usethe cursor to select the black rectangle.

(2)Select the [Edit] menu - [Send to Back] command, or | To cancel the movement, click on
click onthe  icon. the icon.
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@ Changing Attributes

)

Here, you can change any of an object’s attributes, i.e. its color, address, etc.
Also, with objects of the same type, you can change the same attribute of all

the objects of that type at the same time.

B Changing Attributes

PROCEDURE

REMARKS

(1)First, select an object to changeits attributes.
In this case, an unfilled rectangle drawn with asolid line.

|

(2)Select the[Edit] menu - [ChangeAttribute] command,
or click on the g™ ]icon.

(3)Select a new attribute from the dialog box.
Here, adotted lineis selected.

Square/Rectangle

gg T Fill
2 Eﬁm@;l Cancel
==

fo HEEOEECO s<D
Bo [ 1) B

T —_—

(4)Click onthe[ o« ]button toregister your change.

Square/Rectangle =]
@] gr

o0 (EEEN
QD @‘Bjjﬁﬁﬂl Cancel 1

S===
fo HENO OO sxO0
B EEO NN &0

T—_— —

N

|

Objects

2.3.1 Selecting

Whilethe attributes of Grouped ob-
jects generally, cannot be changed,
the same type objects can be
changed at the same time. When
Grouped Parts have been selected,
only their addresses can be
changed.

2.3.15 B Chang-
ing Attributes; Confirming Ad-
dresses

Instead of clicking on the[gF|icon,
simply double-click on the object
when selecting it, to display the At-
tribute Settings dialog box ( skip
step {2}).

To cancel the attribute changes,

click onthe button in the
dialog box.

You can reverse the attributes
changes (only for the most recent

change) by clicking onthe[ws|icon.

@[kv\ote; You can select more than one object of the same type and changethe at-
2] tributesof each, at the sametime. With all the desired objects selected, click

on the Tool box’s button; then, proceed with step (2).

2.3.1 B Selecting Objects; How to Select Multiple Objects;
Selecting Objects by Type from a Multiple Selection
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B Confirming Addresses

If aPart that requires an address has been grouped, the Confirm Device
Address dialog box shown below will appear whenever its attributes are
changed; the Part addresses are changed here.

Allows you to view either the Bit or Word Addresses of
all the Parts in the currently selected group of objects

Confirm Device Address

Bt ddess

Part Addresses are —_]

. ™| Address "Funclion "Parts Mame “Part 1D "Description
displayed here p4n0000_ | it S et[Operation Bit)| Bit Switch BS_O01
#0042 Bit Set[Dperation Bit)| Bit Switch BS_002

Check this box to
automatically
change all the
addresses of the
Parts in this group
that have the same Tk || Cancel || Help
Device Address

& Address

Each Part’s address is displayed. To change an address, click on the inside
of each cell. Asshown above, any Switches selected that have state changes
will have both their Operation Bit and their Monitor Bit addresses displayed.

€ Address Range Conversion

When an address is changed and this check box is checked, any other Part
with the same device address will be automatically changed.

e: Theaddressconversion isnot performed in the case of symbol/L ogic symbol.

In the example above, if the first bit address is changed from X 00000 to
X 00010, the following bit addresses will be changed as below.

Confirm Device Address

* Bit Address |

. . “Address “Function “Parts Name PartID “Diescription
Clicking on any | Asn0000 Bt Set{Operation Bit)|Bit Switch BS5_001
cell other than the = | |=uo04z Bit 5 et{Operation Bit)| Bit Switch BS_ 002

changed one will
show the changed
address

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



2.3 Object Editing Chapter 2 - CREATING BASE SCREENS

@ Changing Coordinates ]

Object positions and sizes can be changed by specifying their coordinates.

Check this check

box to change s e he obi
) nter the object’s
the size. (xm«s 2 g ves [ Eﬂ)—— left top COOF{Z“-
Right-Bottom n ateS .
(XAxis [ ves U E]D\ )
=] \ Enter the object’s

right bottom coordi-
nates.

B Using Coordinatesto Change an Object’s Position

PROCEDURE REMARKS
(1) Select adesired object. 2.3.1 Selecting
E:::E Objects
A
(2)Select the [Edit] menu - [Change Coor dinates] com-

mand.

To change the size, check the

(3)Enter the object’s left top and right bottom coor di-
ge Posiion Change size check box in step (3).

Fig ot To cancel the coordinates change,
e Ve click on the button.

To undo the coordinates change,
(4)Click onthe[ <] button to executethecommand. | click onthe[s] icon.

M

.
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2.3 Object Editing

@ Editing the Node of a Multi-segment Line

Creating, Editing, or deleting a node can be performed on a multi-segment

line and afilled polygon.

JMode Edit

Dk
‘Insett in Frant
‘Ingert in Back

If the node edit is selected, the selected point
in the displayed dialog is marked with a
Cross.

B Editing a Node on a Continuous Line

The [Node Edit] dialog
displays.

Deletes the selected peak.

Adds anode. The added
node is the same as the
selected node. If the screen
capacity is exceeded by the
added value, the [Insert in
Front] and [Insert in Back]
buttons are highlighted and
cannot be specified.

PROCEDURE REMARKS
(1)Select thedesired continuousline. 2.3.1 Selecting an
Object

(2)Sdlect [Node Edit(K)] from [Edit(E)].

(3)Select the coordinate value that you want to edit.

(4)Click onthe[ &t ]button.

(5 Enter the X/Y coordinate values in the coordinate
change dialogs.

Node Edit

* 183 =

™ -
v

(6)Click on the button to run the coordinate | T0 cancel the coordinate change,
change. Click on the button.
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@ Convert (Import) Image

This section describes how to convert image data (bitmap: BMP file and
JPEG: JPEG file), created from other drawing software or imported from a
scanner, for useon aLT Image (I) screen.

For Image Conversion data, refer to 3.2 Creating an

Image: the I mage Screen.

B Converting and Placing an Image

PROCEDURE

REMARKS

(1) Select the pull down [Edit] menu’s[Convert Image]
command.

(2)Set all conversion settings and click on the
button.

Import Image

Source | Effects || Destination ]

Image File

|Computar_pictu|e.bmp ” | Browse..

Source Imag

Colors

Size [bytes)

| Flaes: | Cancel | CDTvert | Help

(3)Click on the[ _s== | button.

The bit map is then saved as an Image screen.

Image Screen Preview

4 Save;g || Dizcard

Once an image has been converted,
it can be placed on a screen using
the Load Screen function.

2.2.10 Load Screen

For each setting
item, 3.5 Creating | mage Data -
I mage.

Before conversion, the image dis-
— played in the Import Image dialog
box is still compressed and may
appear different from the actua dis-
play (after conversion).

To cancel the conversion, simply

click on the button.
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PROCEDURE REMARKS

(4)Click on the[_Pac= ] button.

The Image screen’s border will appear on the current

screen.

Size [bytes]

nnnnnnnnnn

[ Face, || cancet || comer || Hen

(5)Click on the point where the Image screen isto be | To cancel the placement, click on

placed. the[&] icon.
The Image screen will appear on your screen.

i B2: Untitled] [- O[]

XNote: ° |f aportion of an Image screen extendsover a Base screen’s Y axis border,
2] that portion will not be displayed on the LT screen. When the Image screen
isplaced over the Base screen laterally, however, any part that extends over

the Base screen X axis border will be squeezed onto the LT screen.(i.e. not

cut)
Example)  When using LT Editor When using the LT
for Windows panel display
Drawing
Areas

B Pasting images with other file formats

The paste function can be used for images copied onto the Clipboard ™.
Executing the [Paste] command from screen editor while a copied imageis
in the clipboard will display the "Paste Image" dialog box on the screen. The
“Source” tab will not be displayed on the screen.When images cannot be
pasted with this procedure, convert the images into bitmap files or JPEG
fileswith other image processing software before copying and pasting it to
the screen editor.

*1 The clipboard is a storage | ocation where copied or cut data istemporarily stored. The
data stored on the clipboard can be copied or moved by pasting it.
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@ Transferring a Screen to the Clipboard ]

The current screen istransferred as an image to the clipboard™. The trans-
ferred screen can be utilized by pasting it to other drawing software. The
screen types that can be transferred to the clipboard are the Base (B) screen,

Mark (M) screen and Window (U) screen.

B Transferring a Screen to the Clipboard

PROCEDURE

REMARKS

(1) Select the [Screen to clipboard] command from the
[Edit] menu.
The current screen will be transferred to the clipboard.

(2) Paste the screen to other drawing software.

untitled - Paint

File EditlEiew Image Colorz Help

[ Unds T

7 Bizpeat Fa
Eut Bt

& gy (CHiIE:

{l? Paste Chrl+f

N Clzay Selzeton Dl
Select Al Chrl+&,

A Ciopy T,

[ Paste Fraomm...

.

*1 An area where text, graphics, or both, that have been Cut or Copied, are temporarily
stored. The contents of the Clipboard can be “ pasted” (copied from the Clipboard)
using the Paste function. However, once the Copy/Cut command is executed, the data
stored in the Clipboard is replaced; therefore, only the data from the most recent Copy/

Cut command can be Pasted.
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@ Converting a Screen to a Bitmap File ]

The current screen is converted into a bitmap file, and then saved. The
screen types that can be converted are the Base (B) screen, Mark (M) screen,
and Window (U) screen.

Usage Pattern
. Specify how to
[Edit] - ['Screen'to - .[Settln_g — save the bitmap
bitmap file] bitmap file] file.
. [Screen to [Screen to
- [EdU — imapfile] —  bitmap file]

B Designating a Bitmap's File Name

Before converting the screen to a bitmap file, specify how to save the bitmap

file.
SpeCify afile Setting bitmap file name
name and output ~
destination to \E:ﬂ Prampt for filenarme when saving
save the file. //@0 Automatically create file name B Specify how a
Automatically File Mame type file name is to
creates afile %) Type + Mumber BMP be creat_ed
name to save the i7h Tupe + Mumber + Comment BMP aUIomatlca”y-
file. /Clutput Falder

. |E:\F'F|EIGF|.-’-\.M FILESWPRO-FACENLTAD ||

Specify an output 1
destination of the | ok || Cacel || Hep |
file when a file

name is being
created automati-
cally.

@ Prompt for filename when saving

When the [Screen to bitmap file] command is executed, the Save Asdialog
box will appear, where you can specify the location and name of thefile to
be saved.

€ Automatically create file name

When the [Screen to bitmap file] command is executed, afile name will be
created automatically, and the file saved in a previously specified location.

Example: If the No. 1 screen of the Base (B) screen named “Menu” is
converted into a bitmap file:

Screen type + number.BMP —>B1.BMP
Screen type + number + screentittee BMP —> B1 Menu.BMP

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



2.3 Object Editing

B Converting a Screen into a Bitmap File

Chapter 2 - CREATING BASE SCREENS

PROCEDURE

REMARKS

(1) Select the [Setting bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.

(2) Select a method for saving the bitmap file, and es-

tablish it by clicking on the button.

Setting bitmap file name

2 Prompt for filename when saving
&) Automatically create file name
File Mame type
{2 Type + Mumber BMP
20 Type + Mumber + Comment BMP

Output Folder
[CAPROGRAM FILESYPRO-FACESLTYD | [ Braws |

|| u]4 ||| Cancel ||| Help |

(3) Select the[Screen to bitmap file] option for the [Screen
to bitmap file] command from the [Edit] menu.
When afile name is created automatically, the bitmap

fileis saved now.

(4) If [Prompt for filename when saving] was selected in
step (2), specify a file name and output destination,

and then click on the[ == | button.

Save Az )
Save in I &) database Uz” &= =
zmall.brmp
rmap.bimp
File name: I|tes t.brmp || Save
Save as ype: IB|tma|:| file(* bmp) lE” || Cancel
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2.3 Object Editing

@ Redraw Screen

This command updates the current drawing area display to reflect the latest
drawing data. When the Auto Redraw feature is not used, filling and editing
objects can cause after-images to remain on the screen. Use this function to
remove these images and show the screen asit will appear on the actual LT

display.

B Redrawing a Screen

PROCEDURE

REMARKS

Sometimes, when removing an object’sfilled color, only
the fill point area's color will be removed, resultingin a
small, non-colored square.

Point \\\\2227
where fill E>

began

Fill point is deleted

(1) Select the[Edit] menu - [Redraw] command, or click

on the[.#|icon.
The screen will automatically be refreshed and all the
fill color will be removed.
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@ Undo ]

With this function, an operation can be “undone” and the screen display
returned to the previous condition. Every timethe iconisclicked on,
depending on memory, previous operations will be undone, in succession.

] The Redraw Screen function cannot be undone.

]
Important

B Canceling an Action

PROCEDURE REMARKS

In this example, a circle has been accidentally deleted.
(1)Select the [Edit] menu - [Undo] command, or click | To cancel the Undo operation,

on the'-f.y icon. click on the icon.

Thecircle will reappear and the screen isdisplayed as it 2.3.23 Redo
was prior to the deletion.

O

@ Redo ]

With this function, an operation previously undone with the Undo command
can be “redone’, if performed immediately after the Undo command is used.

B Redoing the Previous Undo Command

PROCEDURE REMARKS

In this example, the undone circle deletion will be re-
done (i.e. deleted again).

(1) Select the [Edit] menu - [Undo] command, or click

on the[xa] icon.

The circle will reappear.

(2)Select the [Edit] menu - [Redo] command, or click on To cancel the Redo operation, click

the icon. on the ] icon.
The circle will disappear.
2.3.22 Undo

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 2-181



Chapter 2 - CREATING BASE SCREENS 2.4 Library Items

2-182

m Library Items

The objects you created can be registered. These registered objects are
called “Libraries’. You can call up and use the registered Libraries, when-
ever necessary. Like apre-made Part Shape, the objects registered in these
libraries can be viewed and selected using the Browser function.

Multiple objects can be combined and registered, and Marks created on
Mark screens can also be registered.

3.1 Creating a Mark - the Mark Screen

Theseitems are stored in a Library file (CPW file), separate from Project
(LTE) files. When library dataisaMark, it will be saved in aMark Library
(MRK) file. Moving from one Library file to the other allows objects to be
called up that were previously used in avariety of screens and Project files.

To call up anitem from aLibrary, or save an item to aLibrary, either select

one of the tool bar’sicons or use the pull down menu’s [Library]

commands.

With both Base and Mark screens open, when the Base screen where the
Library Browser isremained open is changed to the Mark screen, the Mark
Library Browser cannot be open on the Mark screen. When changing the
screen, first closethe Library Browser and changethe screen, and then open
the Library Browser on the newly opened screen.

Objectscalled up viathe[Load Screen] or [Load Mark] or [Window Parts
(W)] command, as well as D-script cannot be registered.

W Library Browser

When either or iconisclicked on, the Library Browser will appear.

Displays the currently selected item’s registration number and title;
clicking on the triangle brings up alist of the items in the current
library

Menu Bar R+ 1005 0 cow 3D templato swich parts]
~Fle Edit View window Help
Tool Bar— (2@ RE
Reverse video
indicates that Scrolls
this item is throu.gh
currently se- the Q|ffer-
lected ent items,
either left,
Displays the right, up,
item’s registra- or down
tion number
and title
Status Bar —vewngainges 7
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B Editing Library Items

Three Library Item editing functions are available.

_

cfa CutsaLibrary item (which is then moved to the Clipboard); the
- Library item can then be moved to another screen using the [Paste]
function.

Copiesthe selected Library item to the Clipboard.

E Pastes the Library item Cut or Copied, and temporarily stored in the
= Clipboard, to another screen. The Library item can aso be Pasted to
another Library file.

You can remove a Library item using the Delete function. To do so, select
the [Delete] command from the Library dialog box’s pull down [Edit]
menul.

2.4.3 Editing Library Items

B Changingthe Library’s Display

The Library’simage display size and type can be changed. Also, you can
change from one Library file to another.

@ Library Size
|, or @ iconisclicked on, or the pull down

When either the s

[View] menu’s either [Normal], [Adjust to Fit], or [Full Screen] command is
selected, and the Library display size can be changed. When Normal is
selected, each Library size will be displayed relatively, allowing you to
check the relationship between Libraries for their size. When the Adjust to
Fit function is selected, the Library item will be enlarged until it fitsinside
the Library window’s borders. When Full Screen is selected, the Library
item will be displayed in itsactual (LT) screen size.

@ Library Type

When the pull down [View] menu’s [All Objects], [Part Objects], or
[Graphic Objects] is selected, the Library type(s) shown on the Browser can

be selected.

[All Objects] Displays all the Library itemsin the selected Library
file.

[Part Objects] Displays only those items that are Parts in the

selected Library file.

[Graphic Objects] Displays only those items which are not Partsin the
selected Library file.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 2-183



Chapter 2 - CREATING BASE SCREENS 2.4 Library Items

B Switching Library Files

@ CreatingaNew Library File
When the [[71] icon is clicked on, or the pull down [File] menu's [New]
command is selected, the Dialog box shown below will appear. When a

Description isinput and the button is clicked on, anew Library
file will appear.

@ Sclecting (Calling Up) another Library File

When the icon isclicked on, or the pull down [File] menu’s [Select

File] command is selected, the Library filelist will appear. By selecting
(dragging) the desired Library file from thislist, other Library files can be
called up.

@Ikv\ote: Library filesfor GP-PRO/PBIII for Windows (Digital Electronics Corpora-
2] tion) (CPW file) cannot be used.

Shows the
Currently ~ Lookjn:J@CDw
displayed file’s —
folder [=] 0p5-abib. cpw
@ Op5-objc. cpuw
9 OpS-objd. cpw
Lists all the ] OpS-otie.com
files in the
currently
selected folder
File: name: J| | " Open |
Filez of tupe: JW’indows Library Files [*.cpw] \_|z]| \ " Cancel
Dezcription ; [
J I P
Displays the currently selected Currently selected
file’s Description data (if any) file's name (If
Currently selected file's desired, can be
entered)

format (type)
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B Modifying Library File Names (Titles)
Library filenames can also be changed. Simply select alibrary from thefile
list, then select [Property] from the [Edit] menu, and the Property screen
will appear. Typein the filename (title) that you wish to use and click on
OK.

Diescription 0K

|3$tate W word || || Cancel |

B Displaying the Browser at the Top of the Normal Screen

If the [Always on Top] option is selected from the [Window] menu, when-
ever the Library Browser is called up, it will be placed at the top of the
current window. If thisoption is not selected, selecting another screen will
place that screen over the Library screen, hiding it from view.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 2-185



Chapter 2 - CREATING BASE SCREENS
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@ Registering Library Items

)

Here, the procedure for registering aLibrary is explained.

PROCEDURE

REMARKS

(1)Select objectsto beregistered asLibrary items.

(2)Select the [Library] menu - [Register Library] com-
mand, or click on the@ icon.

<A. When registering anew Library item to
the currently open Library file:>

(3)Enter theLibrary’sregistration number and descrip-
tion.
In the Cell Number area, the smallest of the currently
open Library file's unused numbers will be automati-
cally displayed. To changeit, simply enter the desired

number.
Save Library
Cell Mumber :
ak.

Description |

|switch |

(4)Click on the button to register the number.
The registered Library will then be displayed in the
Browser.

] [100: switch ]

e |||47: Volume SW se |[|48: Volume SW cir

2.3.1 W Selecting
Objects; Registering Library Items

If the Library Browser is already
showing, click on either [Ea]| or
& | icon in the screen editor

drawing area, and the [i@] iconin
the Library Browser, which will
perform the function of step (2).

The following procedures will
differ depending on the Library
fileregistered.

» When registering anew Library
item to the currently open
Library file:

* When no Library fileisdis-
played:

» When registering a Library item
toanew Library file:

* When registering a Library item
to aLibrary file other than the
currently open one:

Up to 200 Library items can be
registered in onefile.
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PROCEDURE

REMARKS

<B. When no Library fileisdisplayed:>
(3 The“New” dialog box will appear.

When registering a Library item to anew Library file.
<C. When registering a Library to a new Library file>'s

step (5)
When registering aLibrary itemto an existing Library file:

Click on the button.

<D. When registering a Library itemto a Library file
other than the currently open one>’s step (4)

<C.When registering aLibrary item to a new
Library file:>

(3) Click on the[ cswel ] button.

Save Library |

Cell Nurmber :

N

|Untit|ed ||

Description :

(4)ViatheLibrary Browser, select the[File] menu - [New]
command, or click on the icon.

(5)Enter acomment and click on the[ o« ] button.

Descriptian :

|production

(6)Via the Screen Editor, select the [Library] menu -
[Register Library] command, or click on the@ icon.

(7)Enter a Cell Number and Description.

Save Library |
Cell Mumber :
= |
Dezcnption :
|sw1 "
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Enter the file name when the
Library fileis saved.

2.4.4 Saving Li-
braries and Quitting @ Saving a
Library FileUnder Another Name

A comment of up to 60 characters
can be entered.

Enter a description up to 60 char-
acters.

Enter the file name when the Li-
brary fileis saved.

2.4.4 Saving Li-
braries and Quitting @M Saving a
Library FileUnder Another Name
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2.4 Library Items

PROCEDURE

REMARKS

(8) Click on the button.

The newly registered Library item will appear in the
Browser.

|_;_ﬁ| [?.cpw - production]
File Edit Yiew indow Help

100: switch

<D.Whenregigeringalibraryitemtoali-
brary file other than the currently open one.>

(3)Click on the[ caeel ] button.

Save Library |
Cell Mumber :
-4
Cancel
Dezcription : A
|Uniled |

(4)ViatheLibrary Browser, select the[File] menu - [Se-
lect File] command, or click on the icon.

(5)Select thedesired Library filefrom thelist, or input
theLibrary filenamein thefile name area.

OpS-abic.cpw
Dp5-obid opr
DpS-obie. cp

File name:  [Op5-obja.cpw | [ geen |

F] [ cenea |

Files of twpe:  [Windows Libiary Files [*.cpw)

Description : |30 template switch parts

(6)Click on the[ _ae=n | button to display the selected
Library file.

w10 [Dp5-obja.cpw : 3D template switch parts]
File Edit “iew ‘Window Help

EEREEE

J1: sw_30001 OFF

| 2: Sw_3D001 ON |||3: SW_3D002 OFF
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A maximum of 200 Library items
can beregistered in each Library
file.

After creating anew Library item,
if you attempt to create or select
another Library file without first
saving theitem viathe [Save
As...] function, a prompt will
appear, asking whether the newly
created Library item should be
saved or not.

For the proce-
duresfor saving aLibrary item, re-
fer to 2.4.4 Saving Libraries and

Quitting.

2.4 Libraries ®
Switching Library Files

When selecting aLibrary filein an-
other directory, use the [Look in:]
window.

In step (5), ssimply move the cursor
tothedesired Library filenameand
double-click on it to open it. By

doing so, the[ oren | (Step 6) but-
ton does not need to be used.
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PROCEDURE REMARKS

(7)Via the Screen Editor, select the[Library] menu -

[Register Library] command, or click on the@ icon
on the Draw Tool Bar.

(8)Input a Cell Number and Description.
In the Cell Number area, the smallest of the currently
open Library file'sunused numberswill be automatically
displayed. To change it, enter the desired number.

Save Library
Cell Murnber :
0k

Description ;

|switch ||

(9)Click on the[__o_ ]buttonto register theitem. Up to 200 libraries can be regis-
The registered Library item will appear in the Browser. | teredin onefile.

] [100: switch [H|

t1]|/50: Numeric Input |

B Using the Cut, Copy, and Paste Functions

Library items can be Cut, Copied and Pasted from the screen drawing area
to Browser. First, select the desired Library item in the drawing area, and
then either Cut or Copy it; then, Paste it to the current Library Browser.
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2.4 Library Items

@ Placing Library Items

Here, itemsregistered in aLibrary file are placed on a drawing area.

PROCEDURE

REMARKS

(1)Via the Screen Editor, select the [Library] menu -

[Call Up Library] command, or click on the icon
on the Draw Tool Bar.

(2)Select aLibrary Item to beread out from the Browser.

240 [Op4-objg_cpw : Unused Plain Keypad Parts]
Eile Edit Wiew Mindow Help

(3)Drag the Library item to the desired position in the
drawing area.
The Library item can be placed on any open screens,
and will be displayed inthedrawing area. If desired use
the sizing handlesto alter the item’s size.

S

Parts  Special Library window Help

i Off State [+

artz Special Libray  window Help
?

s [on Stae F]

2-190

Library items Cut, Copied, or
Pasted between the screen and the
Browser. Simply select the desired
Library item and perform the com-
mand.

When calling up anitem from afile
different than the currently dis-

played file, click on the[] icon to
bring up afilelist.

2.4 Libraries
B Switching Library files

The Library item’s top left corner
is the placement point.

To cancel the placement, click on
the screen editor’sw] icon.

To change a Li-
brary item’s size, refer to 2.3.3

Scaling Up/Down.

Items called up are automatically
grouped. They can befreely edited
after ungrouping them by clicking
on the icon.

ungroup

2.3.13 Group/

Grouped library items containing
Parts cannot be scaled up or down.
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When aLibrary that contains Partsis called up, the Confirm Device Address
screen will appear. After entering each Part’s address, click on the

button. To cancel these settings, click on the button.

2.3.15 Changing Attributes B Address Confirmation

When the Library placed on the screen is double-clicked on, the Confirm
Device Address dialog box shown below will appear, allowing you to

change the Part’s previously entered addresses.

Bit Address |

Confirm Device Address

<]

[ Addrezs [ Furiction [ Partz Name [Part 1D [ Description
P00 0 | Bit Set [C) Bit Switch BS_012
x00042 Bit Set [C] Bit Switch BS_013
Q] Addrezs Range Conversion
|| | || Cancel | || Help |

B Using the Cut, Copy, and Paste Functions

Library items can be Cut, Copied, and Pasted from the screen drawing area
to the Browser. First, select the desired Library item in the drawing area
and Cut or Copy it; then, Paste it to the Library Browser.
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m Editing Library Items ]

Library Items can be Edited, Deleted, Copied, Cut, or Pasted.

W Editingalibrary Item
Here, aregistered Library itemis edited.

PROCEDURE REMARKS
(1)Select and double-click the Library item to be edited | In order to call up a Library item
from the Browser. fromaLibrary file which is differ-
T — ent from the currently displayed

2] [100: owich Fl file, click on the[[&] icon.

2.4 Libraries
W Switching Library Files

When double-clicking on a
Library item’stitle, theftitle
editing screen will appear. (Prop-
erty Screen)

Description :

" || Cancel |

Important ) ) )
(3)Viathe Screen Editor, select the[Screen] menu - [Save] | Once an item is edited, it

command, or click on the icon on the Main Tool | ¢@nnot be Undone.
Bar.

] [100: switch =]

: Volume SW cir

11]||50: Numeric Input |
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B DeletingalLibrary Item
Here, aregistered Library itemis deleted.

PROCEDURE REMARKS

(DSelect the Library item to be deleted from the | In order to call up aLibrary item
from aLibrary file which is differ-

Browser.
pocett ____________| ent from the currently displayed
2] [100: switch | fiIe, click on the icon.

2.4 Libraries
W Switching Library Files

(2)Select the [Delete] command from the Library

Browser’s[Edit] menu.
A dialog box appears to confirm your command.

Delete |
@ Are you zure you want to delete 7 /A \
3z
]
|| Ok | || Cancel | Important
Once an item is deleted, it

cannot be Undone.

(3)Click on the button, and the Library item
will be deleted.

pmert _____}
] [100: switch =
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W CuttingalLibrary Item (from aLibrary File) and Pasting
Here, aregistered Library item is Cut and Pasted.

PROCEDURE REMARKS
(1) Select aLibraryitemtobecut (out) fromtheBrowser. | In order to call up aLibrary item
e ________| from aLibrary file different than
5] [100: switen F the currently displayed Library file,

click on the icon.

2.4 Libraries
W Switching Library Files

(2)ViatheLibrary Browser, select the[Edit] menu - [Cut]

command, or click on the icon.
The selected Library will be cut.

] [100: switch =]

(3)Open a desired Library file and, via the Library | To register the Library item to a
Browser, select the [Edit] menu - [Paste] command, | new Library file, click on the

or click on the icon. icon.
Toregister theLibrary itemtoali-
The following steps are the same as those used for a brary file different from the cur-
Library Item registration. rently displayed one, click on the
(4)Input the ltem’s Cell Number and Description. icon.

In the Register Number area, the smallest number in the
currently open Library file's empty numberswill be au-
tomatically displayed. To change it, input the desired
number.

2.4 Libraries
B Switching Library Files

Save Library

Cell Murnber :

5 ok,
=
Drescription

|sw‘| ”
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PROCEDURE

REMARKS

(5)Click on the button to register theLibrary
[tem.

Theregistered Library will be displayed on the Browser.

B Copyingalibrary Item

Here, apreviously registered Library item will be copied.

PROCEDURE

REMARKS

()Openthedesired Library Item’sLibrary fileand se-
lect theLibrary item from the Browser.

] [100: switch |

(2)Via the Library Browser, select the [Edit] menu -

[Copy] command, or click on the icon.
The Library item will be copied to the Clipboard.

(3)Openthedestination Library fileand select the [Edit]
menu - [Paste] command, or click on the Library

Browser’s icon.

In order to call up aLibrary item
fromalLibrary filedifferent than the
currently displayed Library file,

click on the[&] icon.

2.4 Libraries
B Switching Library Files

Toregister theLibrary itemto anew
Library file, click on the [T] icon.
Toregister theLibrary itemtoali-
brary file different than the current
one, click on the icontocal up
alist of Library files.

2.4 Libraries
B Switching Library Files
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PROCEDURE REMARKS

Hereafter, steps are the same as Library Item Registra-

tion.

(4)Input the Item’s Cell Number and Description.
In the Register Number area, the smallest of the currently
open Library file'sunused numberswill be automatically
displayed. To changeit, enter the desired number.

Save Library

Cell Mumber :

D escription :

[X]

&)

|sw1

(5) Click on the button to register the Item.
The registered Item will appear in the Browser.

|_;_ﬁ| [?.cpw - production]

File Edit Yiew indow Help
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m Saving Libraries and Quitting ]

When aLibrary file's contents are changed, the changed data will automati-
cally overwrite the old data and be saved. However, if the Library file has
been newly created, when you attempt to create or select another Library
file, aprompt will appear asking if whether the new fileisto be saved or

not. When is clicked on, the [Save As...] Dialog box will appear.

B Saving a Library File Under Another Name

Here, the Library File will be saved under a different name.

PROCEDURE

REMARKS

(1) Select the [Save As...] command from the Library
Browser’s[File] menu.

(2)Thecurrently selected Library filenameand its com-
ment data, if any, will appear.
Input a new file name and change the desired settings.

Save As
Save i |@ o E] &
Op5-objb.cpw
Op5-objc.cpw

OpS-objd.cpw
po-obje.cpw
JChion, cpw

File harne:

) |
l|i” || Cancel |

|F‘r0duc:ti0n.cpw Save |

Save as type: |Windows Library Files [*. cpw]

Description:  [Production Process Libray Parts |

y

(3)Click on the[ ss»= |button to savetheLibrary.

When a project with the same name already exists, a
prompt asking whether the new name should overwrite

the old name will appear; to do so, click on the
button. When you do not want to overwrite, click on the

button.

C:AProgram FilegPro-face’ LT \cpwiProduction.cpw already exists.
Do pou weant to replace it?
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The file name can be input within
255 characters, including apath and
extension.
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B Quitting the Library Browser

PROCEDURE REMARKS

(1)Select the pull down menu [File]’s [Exit] command. | ClickingontheLibrary Browser’s
If anewly created Library file has not been saved yet, a| top right mark [[¥] can also be
prompt asking whether the new Library file should be | ysed to quit.

saved, will appear. Whenthe[ Y= ]buttonisclicked,
the “Save As..” dialog box will appear, and when the Saving a Library

button is clicked, the Library file will not be| FileUnder Another Name

saved and the Library Browser will quit. Then, aLi-
brary file creation or selection screen will appear.

Library Browser

@ Do wou want to zave changes 7

Erves f[ Mo || Cancel
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a D-Script/Global D-Script

The LT Editor provides a special feature that enables you to create a pro-
gram to execute functions, in addition to Parts. Thisfeatureis given by D-
Scripts/Global D-Scripts. The display |oad on the Device/PLC can be
reduced significantly by creating and registering a program with D-Scripts/
Global D-Scripts. D-Scripts are used on each screen and serve as programs
that are only effective on that screen. Global D-Scripts serve as programs
that are effective on all the screens.

Using D-Script, you can program (describe) separately the trigger used and
the action it performs. Then, when the trigger conditions are satisfied, the

script is performed. The procedures for writing a program with Global D-

Scripts are the same as those for writing a program with D-Scripts.

1|-START

Switch MOV
2t EN DN
Off 100{IN - OUT Ward
0

o|-Em
Trigger: Bit Rising <f_
. . . Parts of Logic

Bit gddress. Switch Program Editor’s
Action: [W:WORD10]=100 logic program can be

replaced by D-Script

commands.

=) a

Trigger: Bit Rising M0050
Bit address: M0050 . —| | MOVP | K100 [ DI0O |
Action: [W:D00100]=100 Parts of external

device's logic
program can be
replaced by D-Script
commands.

B Overview

» TouseD-Script for all of aproject’s screens, regardless of the current
screen, select Global D-Script. To use the D-Script only for the currently
displayed screen, select D-Script while creating that screen.

e D-Script alowsyou to perform Bin/BCD display format changes, text
data changes, or other functions, al previously performed by the Device/
PLC, viathelLT.

» Since D-Script is alanguage program, debugging can be performed
easily.
» D-Script can be programmed as atrigger to sense the leading or falling

edge of abit, to activate atimer, or to detect true or false of agiven
condition.
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» There are three elementsin aD-Script, Operators, Statements, and Oper-
ands, which can be used to program conditions in the Device/PLC.

* Therearefour types of commands: Drawing, Mathematical calculations,
Boolean operations, and Bit operations.

» Syntax check is available during program creation.

» Syntax auxiliary function provides a pop-up keyboard for address settings
to enhance programming efficiency.

* Programming commands can be entered viaicons.

A NEVER use the D-Script/Global D-Script function
for the control of machines or actions which have
the possibility of resulting in either operator injury

or damage to equipment.

Warning

A * D-script and Global D-script cannot be registered as Libraries.

,mp;,fan, * To select [Global D-Script], open any Base screen in advance.

E D-Script Settings ]

D-Script can be added, edited and deleted on the D-Script list. D-Script is
programmed with the D-Script Editor. For details of the D-Script's com-
mands, please refer to 2.5.2.D-Script Commands

Usage Pattern

[D-Scrlpt] Add MOdIfy or Close | or
[Special] - or [Glpbal R Dele:te ' o the [Esc
D-Script] key

An example of the D-Script dialog box (theinitial screen) is shown below.

D-Script List Adds a D-Script
D-Seript Deletes a
Script ID —T — Script
numbers and lﬁ—eee |_— Allows you to
descriptions edit the con-
’pr tents of a D-
— Script
Copies the
contents of a D-
Script
Help Pastes the
copied contents
of a D-Script
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B Registering D-Script Editor

Here, additional D-Scripts can beregistered. Whenthe[[ #ad | buttonis
clicked on, the D-Script Editor will appear.
Enter the D-Script’s ID No. (from 00000 to 99999)

Enter _a . =it D-5cript Editor : Untitled
description - i
h ere Description: # E

: [
Dlsplays the /Show Toalbox ﬂ

D-Script's Dt
comman d Formula: Functions:
tool box £

Timer Duration

_l+— Trigger
area

o
Ve

o
=
¥

— || Displays
defined
function
names

The pro-
grammed
“actions”
(commands)
of the D-

SC I‘I pt Erter an expression. Press HELP for examples.

MNews

Delete
Paste|

Message ||
area
(window) o | [ coee | [ oo ||

¢ID

Each D-Script program is uniquely identified by an ID number. Enter an 1D
number in the range of 00000 to 99999.

@ Description

Up to 20 Single-byte or 10 Double-byte characters can be entered here asa
description about the D-Script you are to create.

€ Show Toolbox

When checked, the tool box appears that contains the Operators, Statements,
and Operands used to create the D-Script program.

& Data Type
Designates the D-Script data format as either Bin or BCD.
@ DatalLength
Designates the D-Script data bit length as either 16 bits or 32 bits.
& Code+/-
Please refer to the following table when entering negative numeric data.
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Data Format Constant Entry
Min. Value Max. Value
Binl6 0 65535
Bin32 0 4294967295
Bin16+/- -32768 32767
Bin32+/- -2147483648 2147483647
BCD16 0 9999
BCD32 0 99999999

A When a D-Script’s command follows another D-Script’s com-
! mand, enter a space between these commands.

Important For example, if the “not” command follows the “and” com-

mand, spacing is needed between the commands.

“andnot” : Incorrect (The operation will not be per-
formed and an error message will display on
the software screen.)

"and not” ;: Correct

W Trigger
These selections designate the type of trigger used to activate your program.

The possible options are “Timer”, “Bit Rising”, “Bit Falling”, “Expression
becomes Non-Zero”, and “ Expression becomes Zero.”

@ Timer Settings

When the designated time elapses, the statements described in the Action
area of your program are performed. The timer duration can be set from 1 to
32767 seconds. The timer restarts its counting when the designated time
elapses.

Trigger

& E Timer Duration

.2 O O I

Tt TiteF

@ Bit Rising
When the LT detects the designated bit change from O to 1, the statements
described in the Action area are performed.

@ Bit Falling

When the LT detects the falling edge of the designated bit, the statements
described in the Action area are performed.

@ Bit Dual Operation Trigger

When the LT detects therising or the falling edge of the designated bit, the
statements described in the Action area are performed.

Triga:
29[
o D Edge Bit Address

@ o~ ox B FIE

LRt Dt
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& f - t (Expression becomes Non-Zer o)

When the LT detects true of a given condition in atriggering program, the
statements described in the Action area are performed only one time at the
detection.

& t - f (Expression becomes Zero)

When the LT detects false of a given condition in atriggering program, the
statements described in the Action area are performed only one time at the
detection.

Trigger
£ EJ Simple Edge Exprezzion

T O™ O

LR A O § 8

* The bit designated for the “Bit Rising / Falling” option must
be held ON or OFF for longer than the Part scanning time
(stored in LS2036).

e Printing or drawing operation may cause a timer delay.

» The Timer feature, when a screen change is performed, will
reset to “0” (with D-Script). When using Global D-Script, the
timer continues the current counting.

» The timer may produce “designated time” or “Part scanning
time” errors.

Device/PLC Connection Manual, 1.1.4/4.1.3 Special Relay

* Writing on the external device must be performed at an inter-
val longer than a cycle time. If writing on the external device
is frequently performed using a part scan counter of the
special relay inside the LT as a trigger, communication errors
may occur.

* The expressions specified in "f - t (Expression becomes
Non-Zero)" or "t - f (Expression becomes Zero) must be held
for longer than the Tag scanning time (stored in LS2036).
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A * When the bit used for the D-Script Trigger Condition is set for
! “touch” and that bit turns OFF during D-Script processing, the
Important timing used when pressing the touch area repeatedly can
prevent the detection of the bit’s rise.

» The D-Script trigger will compare the previously read out value
to the currently read out value to determine if the trigger is
now “True”. However, during a single scan, the value that is
stored in the bit address used during the Trigger operation is
kept the same, even if the value is changed during execution.
The new value is read out only after the next scan begins.

Ex. When Touch is used to turn trigger bit (LS010000) ON, and
D-Script turns the value OFF:
Trigger: Leading Edge of Bit ([b:LS010000])
Execute: clear ([b:LS010000])
@ D-Script Processing Timing Chart
Tag Scan Tag Scan Tag Scan
<Time ><Time ><Time >
LS010000
Condition
N_ |
Trigger Trigger Trigger
Detect Detect Cannot
Value stored Detect
during
Trigger
operation
ﬁ A V' N
Read out Read out Read out
[b:LS010000] ead ou Read out _
and store [b:LS010000]  [p: S010000] ~ [P:LS010000]
value of “1” and store and store and store
value of “0” value of “1” value of “1

M

Detects if bit

¥

Detects if bit

2-204

address value
changes from
0to 1 (OFFto
ON)

address value
changes from
1to 1 (ONto
ON), cannot
detect bit rise
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As an example, if the D-Script touch timing is not used, and only
detection is performed, the processing will be as follows.
Using an if() statement to detect a trigger
Theif statement isused to detect when the bit is set using a touch.
Prior to performing the processing, thevalueisread out and com-
pared.
Trigger: Bitrising ([b:L S203800])
Execute: if([b:LS010000]==1).
{
clear (b:L S010000])

When this type of D-Script is created, even if touch input is done
repeatedly, the tag scan is performed as shown in the following
timing chart. Here, each tag scan value is read out, the condition
is compared and, regardless of the previous value, if it agrees
with the condition, the processing is performed.

@ D-Script Processing Timing Chart
Tag Scan Tag Scan Tag Scan Tag Scan

< Time >< Time >< Time >< Time >

LS010000
Condition

Value stored
during
Trigger
operation

S S S S

[b:LS010000] [b:LS010000] [b:LS010000]
Read out value Read out value Read out value
is“1” is“1” is“0”

True Condition True Condition False Condition
(Process) [b:L.S010000] (Process) [b:LS010000] (Do not Process)
) Read out value

Read out value s e
Is “0 . True Condition
False Condition
(Process)

(Do not Process)
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B Functions

A D-Script program can be created using Functions. A program created as a
Function can be used on the same screen or on other screens. The Functions
can be used commonly for D-Script and Global D-Script.

Functiong:

& Call

Select a Function name to be loaded and then click on this button. After
clicking on the Load button, the called-up Function name will be displayed
intheformula area.

& Edit

Select a Function name to be edited and then click on this button. Usethe
D-Script Function dialog box to perform editing.

& Delete
Click on this button to delete a created Function. First, select a Function
name to be deleted and then click on the Delete button.

€ Copy
Any selected function can be copied.

& Paste

Use this command to paste a copied function.Click on this button and the
following dialog box will appear. Then, enter the name for the function to

be pasted.

Duplicate D-Seript Function Mame

Please enter a new function name:

quncti0n1 ”

" 014 I ” Cancel
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B Definition of Functions

When the [lrw| icon is clicked on in the D-Scrip Editor, the D-Script function
setting screen will appear.

Displays the D-Script command tool box

. when this check box is checked
Enter a function

D-Script Function : Untitled

B

name \
< Funetion Mame: [ Show Toolbox ﬁ
f

Formula;

Enter the D-
Script’s action
(program) to
perform

/

~Displays
defined func-
tion names

DalaType: [Bin ||| Datalengh  [168t |7 Codews I [Call |[New
T Edit ||Delete
| | [Copy][Paste]

Enter an expression. Fress HELP for examples,

]

Message area — |
(window)

Y

I oK. |\| Cancel ||\ Help

& Function Name

Enter the name of your Function here. Once a Function is created, that
Function name is displayed in the Function area. Up to 20 characters can be
used for a Function name. (Alphabet characters, numbers, and “_*)

/:\
] The following function names are reserved. DO NOT use these
]

Important names.

“rise”, “fall”, “rise_expr”, “timer”, “set”, “clear”, “toggle”,
“if”, “else”, “endif”, “b_call”, “Bcall”, “dsp_rectangle”,
“dsp_line”, “dsp_dot”, “dsp_circle”, “dsp_arc”, “Call”, “and”,
“or”, “not” “memcpy”, “memset”, “loop”, “break”,
“IO_READ”, “1IO_WRITE”, “_memcpy_EX",“ _memset_EX",
“IO_READ_EX”, “IO_WRITE_EX”, “10_READ_WAIT",
“databuf0”, “databufl”, “databuf2”, “databuf3”, “_strset”,

“ dlcopy”, “ _hexasc2bin”,* decasc2bin”, “_bin2hexasc”,

“ ” “

_strlen”, *_strcat”,

_strmid”, *_wait”, “return”

W Deleting D-Script Settings
Here, existing D-Script settings can be deleted. After selecting the D-Script
settings to be deleted from the listing, and clicking on the[ ek | button,

the Confirm Script Delete dialog box will appear. When the
button is clicked on, the D-Script settings will be deleted. When the

button is clicked on, the deletion command will be canceled.

Confirm Script Delete

Do you want to delete this script?
id: 00000

desc: warning view

(& = ]
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B Editing D-Script Settings
Here, registered D-Script settings are changed. After selecting the D-Script
settings to be changed from the D-Script list and clicking on the

button, an additional registration screen will appear. Click on the
button to change the D-Script settings. To cancel the Change command,

click on the button.

It is not possible to use the Project Manager [Utility]’s [Con-

/A
7 \

] vert Address] area to modify addresses used in a D-Script.
imporant ANy D-Script program that requires address conversion will

need to be edited manually.

If the [Save As...] function has been used to change a project
file’s Device/PLC, the D-Script program will not be able to
automatically change those addresses.

Be sure to not use D-Script to perform any life-threatening, or
possibly damaging actions!

B D-Script Settings: Copy and Paste

PROCEDURE REMARKS

(1)Select the pull down [Special] menu’s[D-Script] com-
mand.

(2)Click on the[ _tow | button.

D-Script List

D-Script

(3)When the[ Eax=_] button isclicked on, the D-Script | This D-Script can also be copied to
copied in step (2) will be added. The D-Script’s | D | @nother screen.
number will automatically be assigned to the small-
est number currently available.

D-Seript List [<]

D-Seript

00001 PumDN i
0002 Py Add
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@ D-Script Commands ]

You can enter D-Script commands, Statements and constants using D-Script
tool box.

B D-Script Tool Box

The D-Script tool box containsicons for D-Script commands and State-
ments and constant input icons.

When the tool box check box is checked, the following tool box will appear.

= Functiohs

Data Set

Bit Address
Constant
Temp. Address
Word Address

Entry
= Statements = = 0perator: =
[ | F=T%]
] | [*T7=]
Compare = |I“:“:|:":"I &
[T]A]~]

B D-Script Toolbox

& Statements

ehts =
. iFl]
iF 0 ||

[

if() if-endif
When a condition enclosed with brackets
“()” becomestrue, the process following
the“if ()” statement is executed. The As-
sign“=" character cannot be used in acon-
ditional expression.

if(elseif-else-endif
When a condition enclosed with brackets
"()"becomestrue, the processfollowing the
if "()"statement is executed. When the con-
ditionisfase, the statement after “else” is
executed. The Assign “=" cannot be used
in aconditional expression.

Note: For details about the execution path, refer to 3.1.8 Conditional
) Branches.
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Important

2.5 D-Script/Global D-Script

Statements = loop() loop-endloop

i) ||

elze

Loop (repetitive) processing is repeated

=
(e

according to the number stored in the tem-

=

porary Addresses designated in the brack-
as 1] ( )11 .

The loop() format is as follows:

E.g. loop (number of loops)<=Designates the temporary
Address where the loop repetition number is designated.

{

Mode equation

break <= Stated when escaping from the loop halfway (can be omitted)
} endloop <= Stated at the end of the loop

Only atemporary Word Address can be entered (in the paren
theses).

(e.g.: loop ([t:000]))
“loop()” cannot be used for a trigger equation.

The temporary Word Address value used to designate the
“infinite loop” will decrease every time loop operation is
performed. When the value changes to O, the loop’s operation
is finished. If the temporary Word Address value designated
for the “infinite loop” is modified, the loop will become end
less. Also, the temporary Word Address used is designated
as Global. Therefore, simultaneously using this temporary
Word Address for another item means the loop’s operation
may be performed forever.

Until loop operation finishes, screen displays of tags, etc. will
not be updated/refreshed.

loop() can also be nested. When it is nested, the inner-most
loop() will be skipped via the “break” command.
loop ([t:0000])//loop 1

{
loop ([t:0001])//loop 2

{

break// Escape from loop 2
} endloop

break// Escape from loop 1

} endloop
—>

If loop operation is finished without using the escape com
mand, the temporary Word Address value becomes 0.
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Important

E.g.

The range available for the temporary Word Address value
will differ depending on the data format (Bin, BCD), bit length,
and code +/- used. If code +/- has been designated and the
temporary Word Address becomes a negative value, the
condition is judged at the beginning of the loop and the loop
processing stops.

DO NOT use a PLC device in the loop formula. Instead, use an
address from the LT’s internal LS area’s user area device, or
a temporary Word Address. For example, the following de
scription preforms data write to the PLC many times in a
short period (100 times in the following example). This can
cause a system error since communication processing (the
time required to write to the PLC) cannot be performed at this
speed. (The addresses entered below are just a few ex
amples. The actual address entry varies depending on your
PLC type.)

[t:0000] = 100 /ILoop100 times
loop ([t:0000])
{
[w:D0200] = [w:LS0100] [I\Write data to D0200
[w:LS0100] = [w:LS0100] + 1 /Nincrement LS0100
} endloop

Change as follows:

/A

[t:0000] = 100 /ILoop100 times

loop ([t:0000])

{
[w:LS200] = [w:LS0100] IIWrites data to D0200
[w:LS0100] = [w:LS0100] + 1 /Nincrement LS0100

} endloop

[w:D0200] = [w:LS0200] [IWrites LS0200 data to D0200

* Using “loop” or “break” a variable name for a D-Script vari

|- i)
i1 :alse

able will cause an error.

Statements = break

Haltsloop operation whilethe loop() equa-

[

tion is being executed.

The “break” command can be used only in the { } section of
important 100P().
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€ Math (Operators)

= peratory =

2.5 D-Script/Global D-Script

+ (Addition)
Adds the data in two word addresses, or
the datain aword address and a constant.
Any overflowing digits resulting from the
operation are rounded.

- (Subtraction)
Performs subtraction on the data in two
word addresses, or the datain aword ad-
dressand aconstant. Any overflowing dig-
its resulting from the operation are
rounded.

% (Remainder)
Detects a remainder of a division per-
formed on the datain two word addresses,
or the data in a word address and a con-
stant. The operation result may depend on
the sign of the left and right sides.

* (Multiplication)
Multiplies the datain two word addresses,
or the data in a word address and a con-
stant. Any overflowing digits resulting
from the operation are rounded.

/ (Division)
Performs division on the datain two word
addresses, or the datain a word address
and a constant. Decimal places and over-
flowing digits resulting from the operation
are rounded.

= (Assign)
Assignstheright sidevaueintheleft side.
The left side can state a device address
only, while the right side can describe both
adevice address and a constant. Any over-
flowing digits resulting from the operation
are rounded.

<< (Shift Left)
Shifts the data on the left side to the left
by the number on theright side. Thisfea
ture supports logical shifts only.

>> (Shift Right)
Shifts the data on the left side to the right
by the number on theright side. Thisfea
ture supports logical shifts only.
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%te:

Example: Shift Left operation (Shiftsto the
left by one bit.)

Before the shift
[1]/of1]0]1[of1[of1]0[1]0[1][0[1]O]

After the shift
[0]1]of1]of1]o0f[1[0f1]0[1]0[1]0]O]

! 1
“1" isrounded off. 0

Bit-wise AND (&)
Performs logical AND of data between
word devices, or between word device data
and constant. Used to extract a specific bit
or to mask a specific string of bits.
Bit-wise OR ()
Performslogical OR of data between word
devices, or between word device dataand
constant. Used to turn ON a specific bit.
Bit-wise XOR (*)
Performs exclusive OR of data between
word devices, or between word device data
and constant.
1'scomplement (~)
Inverts the bits.

For details about overflowing digits, and errors and rounded decimal places
resulting from a remainder operation:

3.1.5 Notes on Operation Results

Priority and Associativity

The following table shows the trigger priorities. If two or more operators
have the same priority, follow the direction shown by the associativity.

Priority Operators Associativity
High | () —>
not, ~ <
* 1, % —»
t, - —>
<<, >> —»
<, <=, > >= —p
==, <> —>
& " —>
and, or —»
Low = <+
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€ Comparisons

V[AI[E]

HEBR
HHEBA

= Compare =—

2.5 D-Script/Global D-Script

and (AND: Conjunction)
ANDs the right and left sides. Value O
(zero) is regarded as OFF, and other val-
ues, as ON. “N1 and N2” istrueif both
N1 and N2 are ON, and falseif otherwise.

or (OR: Digunction)
ORstheright and left sides. Value O (zero)
is regarded as OFF, and other values, as
ON. “N21lor N2’ istrueif either N1 or N2
iIsON, and falseif otherwise.

not (NOT: Negation)
NOTstheright side. Value O (zero) isre-
garded as 1, and other values, as 0. “not
N1" isOif Nlis1,and 1if N1isO.

< (Smaller than)
Compares the data in two word addresses,
or the data in aword address and a con-
stant. The result is true if N1 is smaller
than N2 (N1 < N2).

<= (Equal to or smaller than)
Comparesthe datain two word addresses,
or the data in aword address and a con-
stant. Theresult istrueif N1 isequal to or
smaller than N2 (N1 <= N2).

<> (#) (Not equal)
Compares the datain two word addresses,
or the data in aword address and a con-
stant. Theresult istrueif N1 is not equal
to N2 (N1 <> (2) N2).

> (Greater than)
Comparesthe datain two word addresses,
or the data in aword address and a con-
stant. Theresultistrueif N1isgreater than
N2 (N1>N2).

>= (Equal to or greater than)
Comparesthe datain two word addresses,
or the data in aword address and a con-
stant. Theresult istrueif N1 isequal to or
greater than N2 (N1>=N2).

== (Equal)
Comparesthe datain two word addresses,
or the data in aword address and a con-
stant. The result istrue if N1 is equal to
N2 (N1=N2).
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Command Example
Conjunction and |if [(Arithmetic expression) and (Arithmetic expression)]
Disjunction or [if [(Arithmetic expression) or (Arithmetic expression)]
Negation not [if [not (Arithmetic expression)]
Smaller than < [<Term1><<Term2>
Equal to or smallerthan| <= |<Term1><=<Term2>
Not equal <> |<Term1><><Term2>
Greater than > [<Terml1>><Term2>
Equal to or greater than | >= |<Term1>>=<Term2>
Equal == [<Term1>==<Term2>

D
D

Note: For details about logical operations:

X2
3.1.6 Logical Operation Examples

& Constant/Address

D-Secript ToolBox Temp Address
= Functions Here, aLT internal Address is specified
Jata Se that can be used with the program. There
Bit ddress are 90 words (from 0000 to 0089) avail-
ggpnsptagtd doss able for Temporary Work Address. The
word Address Temporary Work Address'sinitial valueis
not fixed.
Bit Address
Enter a bit address.

W‘ Word Address

Enter aword address.
= Slatements = =0perators = Constant

"ﬁ@ = Select a constant.
= *[/]=]
&

%te: * Toidentify data via theinput data’s format:

2] Eg
Decimal: A numeric value without leading zeros - 100
Hexadecimal: A numeric value preceding by Ox - 0x100
Octal: A numeric value preceding by azero — 0100

» Calculation examplesin hexadecimal and BCD formats
Hexadecimal format only
0x270F & OXFFOO  Theresult is 0x2700
BCD and hexadecimal formats
9999 & OxFFOO0 The result is 0x9900
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& Draw
D-E; E:ript T|:||:||E=|:|:-: Cl I'C|e
= Functions Draws a circle at the designated point.
I~ When the Pattern check box is checked, a
Call Soreen filled circle will be drawn.
gi;f'e Select and enter the line type (or fill pat-
Line tern when selecting a pattern), color at-
Rectangle tributes, center coordinates, and radius
value.
Scrn (Load Screen)
]W] This function is used to call up a previ-
ously registered Library Item. The desig-
=Statements Elperah:urs = nated screen (Base screen) will be called
[izo [FT —” W up at the designated X,Y coordinates.
Circle
F 7 Landscape type display
(0,0) X (X,Y coordinates)
| s s e | v
Fo I I ) A ) )
Bo I ) sk
Centre: X: Radius:
= (639,399)

Portrait type display

Load Screen
Designate (X,Y CoordinatES)
Screen Mo, these (639,399)
- coordinates
Puosition =
Pasition ' \1
Y
(0,0) X
Square/Rectangle Sq uar dReCtangl e
g% LIk Draws a square at the designated position.
(o Twal = [ Ccece When the Pattern check box is checked, a
= == filled square will be drawn. When select-
-;z'@ ing abeveled square, abeveling dot can be
2 !]':]DD :';g entered. Select and enter the line type (or
d L1 Iml [ |mim fill pattern when selecting a pattern), color
X“ @ attributes, and start and end coordinates.
v 2
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Qffzet Address

Polyline
N
_’ O
&a
FoEEEOEE O e
o I ) I )] B[
wp & b &
Wi d wig
Dot
Dot type=—= ;
£ 100t .
2 30aty
Dy |k o vl S
EL L sl T Jw=EA~I
€@ Memory Control
<Offset Address>
D-Script ToolBox
=Functions
Mermomn Ops. [liﬂ
Memony Copy
b emory Set

0

Enty

=Statements =

=[lperators =

Polyline
Draws aline at the designated position.
Designate the line' s type, color attributes,
and start and end coordinates.

Dot
Draws adot at the designated point. Des-
ignate adot type, its X,Y coordinates, and
its display color. 2, 3, and 5 dot groups
cannot be selected.

Offset Addresses
Offset Addresses can be designated.
Only temporary Word Addresses can be
designated for offset value storage Ad-
dresses.
The offset Address format is as follows:
(Word Address # Offset Value Storage
Address)

Format:
[Word Address] # [Offset Value Storage
Address]
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[0 i [+][-1%

e |Freak EH?H? <Constant Data Entry Ranges>

~Compare — | [€<[>*1 & Data Format Min. \ZCI)LTS S Ii/ln(':;[)r()./Value

[z Jpooe] || [T AT~ Bin16 0 65535

[< Jk=]k>] Bin32 0| 4294967295

B Bin16+- -32768 32767
Bin32+/- -2147433648| 2147483647
BCD16 0 9999
BCD32 0 99999999
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2-218

/\
\

]
Important

E.g. Read [w:WORD20] = [w:WORD210] # [t:0000]
(Offset Word Address Read)

Write[w:WORD10] # [t:0000] = 100
(Offset Word Address Write)

This Address becomes the Word Address + Temporary Word Address value.
For the above example, when the value “2” is used for [t:000], the Address
becomes [w:0102].

< Offset Address >

* The device designated as storing the offset value is not always
read from the Device/PLC. It is read only when D-script pro-
cessing is performed. If a communication error occurs during
device read, the offset value will become 0, and the LT’s inter-
nal special relay (LS2032 bit 12 ) is turned ON. When the data
read is completed normally, this bit is turned OFF.

* Word Addresses used in the offset address format are not
counted as D-Script Addresses.

« When a variable (Logic symbol) is used as an address, an
integer array must be designated. For an integer array, an
appropriate size required for consecutive addresses needs to
be allocated.

<Memory Copy>
D-Scrpt ToolB ox M emory Copy ‘ memcpy”
= Functions Copies device memory all at once. Data
[Memery Ops. Eﬂ for the number of Addresses will be cop-
oo o ied to the copy destination Word Addresses
[Memary Set beginning from the copy original Word
Offset Address Address. The number of Addresses effec-
tiveis 1 to 640.
Format:
memcpy ([Copy destination Word Ad-
E dress], [Copy original Word Address], the
number of Addresses)
[ Statements =) =0perators = Example statement:

When copying data of WORD10 to
WORD19 to WORD20 to WORD29
memcpy ([w:WORD20], [w:WORD210],
10)
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‘ < Memory Copy (memcpy) >
! * Original copy data will be read from the PLC only once, when
Important . . . .
required. If acommunication error occurs during data read,
the GP’s internal special relay LS2032’s Bit 12 will be turned
ON. When data read is completed normally, Bit 12 will be

turned OFF.

e Although it will depend on the number of Addresses to be
copied, data will be read from the original copy data, then
divided into pieces and copied to the copy destination. There-
fore, even if acommunication error occurs during data read,
data may be partially written.

(Result of data write in the copy destination: O: Data write
completed, x: No data is written.)

<Block Memory Copy>
Copyoriginal data Result of data write in the copy destination

: Communication error >

<Divided Memory Copy>

Copy original data Result of data write in the copy destination
No communication error>

No communication erroL
Communication error

=< ><[0]0

Communication error

>

* As the number of Addresses increases, the more time is re-
quired for writing data to the PLC. Depending on the number of
Addresses, it may take from 20 seconds to several minutes.

* Unless data write is completed for the designated number of
Addresses, screen displays such as tags will not be updated
or refreshed.

 If data to be written exceeds the designated device range, a
communication error occurs. In this case, you must turn the
GP’s power OFF and then ON again to reset the GP from the
error.

* When the data are written to the LS Area with the Memory
Copy (memcpy) function, the data can be written only in the
User area. Data cannot be written into the System Data area
(LS0000 to LS0019), Special area (LS2032 to S2047), or Re-
served area (LS2048 to LS2095). However, data can be read out
from these areas.

* When the 32 bit device data is copied to a 16 bit device using
D-Script, and the bit length is designated as 16 bits, only the
data for lower 16 bits will be copied.
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E.g.: memcpy ([w:100], [w:WORD10], 3)

31 0 15 0
WORD10 (1) 1) 100
11 ) — 0 101
12 (3) ?) 102

Also, when 16 bit device data is copied to a 32 bit device, the
data for the lower 16 bits will be copied and “0” will be desig-
nated for the upper 16 bits.

E.g.: memcpy ([w:WORD10], [w:100)

31 0 15 0
100 (1) 0 1) WORD10
101 2) — 0 ) 11
102 (3) 0 (3) 12

* When 32 bit device data is copied to a 16 bit device, or when 16
bit device data is copied to a 32 bit device, if the D-Script bit
length designated in D-Script is 32, the copying will be as fol
lows:

E.g.: memcpy (100, WORD10, 2)
31

2-220

0 15 0
WORD10 (1) 100
1 7) > 1 101
102
_____ @)= 103
E.g.: memcpy (WORD10, 100, 4)
0 15 31 0
100 P (1) WORD10
101 —> 2 11
102
103 )=

e If the original and destination data ranges overlap, all overlap
ping data will be rewritten as follows:

E.g.: When copying “D101 to D104” to “D100 to D103”

(Datais copied to a smaller number Address)

Copy From Copy To
D100 (1)
D101 0 / 2)
D102l (@ 7 ®)
D103 3) ?y' (4)
D104 (4)
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E.g.: When copying “D100 to D103” to “D101 to D104”

(Datais copied to a larger number Address)
Copy From Copy To

D100
D101
D102
D103
D104

1

2

3

=

i

Py Py ey ey

4

~

==
N
== |-

E.g.: When copying “WORD11 to WORD14” to “WORD10 to

WORD13"
(Data is copied to a smaller number Address)
Copy From Copy To
WORD10 1

E.g.: When copying “WORD11 to WORD13” to “WORD11 to

WORD14”

(Datais copied to a larger number Address)

11
12
13
14

WORD10

11
12
13
14

[N

N

2

— ==~

)
= |—=|—

4

= ==

(
(
3
(

W\

Copy From

1

Copy To

2

3

=

/\/\/\/\
= |—=|—

4

N

i

||
w

~
Z|Z(E |2

¢ Although this example’s function designates 2 Addresses,
these Addresses will not be counted as D-Script Addresses.

« When using device addresses for the Assign operation, the
write values will not be assigned immediately, due to the LT to
PLC transmission time. (The addresses entered below are just
a few examples. The actual address entry varies depending on
your PLC type.)

E.g.: memcpy (Jw:D200], [w:D100], 10) //Copies “D100 to D109”
to “D200 to D209”
[w:D300] = [D200] //Assigns D200 data to D300.

In this case, D100’s value to be written to D200 as the operation
result has not yet been assigned to D300.
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2-222

<Memory Set>
[:l-Eh::ript T|:||:||EI|:|:-: M emory %t (merr]%t) .
=Functionz Thisfeatureinitializes all devices at once.
|Memary Ops. Eﬂ Setting data for the number of Addresses
is taken from the Set Word Address. The

hemary Set allowable range of Addressesisfrom 1to
Offzet Address 640.
Format:
memset ([Set Word Address], set data,
number of Addresses)
E Examples_tatement:

When “0” is set to addresses WORD10 to
WORD19 - memset ([w:WORD10], 0, 10)

rﬂat'ﬂn—ents = ||=I:I|:uerat|:|rs =]

< Memory Set (memset) >

* As the number of Addresses increases, the more the time is

required for writing data to the external device. Depending on
the number of Addresses, it may take from 20 seconds to
several minutes.

 If data to be written exceeds the designated device range, a

communication error occurs. In this case, you must turn the
LT's power OFF and then ON again to reset the LT from
the error.

e Although it will depend on the number of Addresses to be
copied, data will be read from the original copy data, then
divided into pieces and copied to the copy destination. There-
fore, even if acommunication error occurs during data read,
data may be partially written.

e Unless data write is completed for the designated number of
Addresses, screen displays such as tags will not be updated
or refreshed.

» Although this function designates Address(es), they are not
counted as D-Script Address(es).

* When writing data to the LS Area with the Memory Set
(memset) function, the data can be written only into the User
area. Data cannot be written into the System Data area (LS0000
to LS0019), Special area (LS2032 to S2047), or Reserved area
(LS2048 to LS2095).
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A « When using device addresses for the Assign operation, the
! write values will not be assigned immediately, due to the LT to
Important PLC transmission time. (The addresses entered below are just
a few examples. The actual address entry varies depending on
your PLC type.)

E.g.: memset ([w:D0100], 0, 10) [Nnitializes “D100 to D109” as 0
[w:D200] = [w:D100] /[Assigns D100 data to D200.

In this case, value 0 written to D100 as the operation result has
not been assigned to D200 yet.

* When a variable (Logic symbol) is used as an address, an
integer array must be designated. For an integer array, an
appropriate size required for consecutive addresses needs to
be allocated.

& Bit Control
<Clear Bit>

D-Script ToolBox Clear Bit: clear 0
— Functions Changes the specified bit address from 1
Bit Ops. ] to 0.

?Etﬂ“ . Example statement:
oggle Bit
clear ([b: LS010000])

In the above example, the 00th bit of LS0100
ischanged from 1 to O.

Erkry
= Staterments Operators =
oD E“ |r|¢ 1%

LIlleen it [

<Toggle Bit>
D Sciipt ToolBox Bit toggle (invert): toggle ()
- Functions Changes the specified bit address from 1
|Bit Ops. Eﬂ toOor fromOto 1.
Clear Bit

Set Bit

Toogle Example statement:
toggle ([b: LS010000])

In the above example, the 00th bit of LS0100
T Enm ] ischanged from 1 to O or from O to 1.

=~Statﬁnts Operators =
[0 ][5 =“ |PT [=]%
122 ek [l =1
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<Set Bit>

|::|-Ei|::ri|:|tT|:||:||E=|:I:-: B|t %t %t ()

=Functions Changes the specified bit address from 0
[Bi0ps | o1

Example statement:
set ([b: LS010000])

In the above example, the 00th bit of LS0100
is changed from O to 1.

I Enkry
=~5tatﬁnts O perators =
o] =“ |F|T —T%

[P | eale el =
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@ D-Script / Global D-Script Limitations ]

€ Limitationson BCD format operations

If avalue which cannot be converted into BCD format is found during
operation, the program stops running. These valuesinclude A to F in hexa-
decimal format. Do not use such values. If the program stops due to non-
BCD values, bit 7 in common relay information (LS2032) inthe LT turns
ON. This bit does not turn OFF until the LT is turned OFF or goes offline.

E.g. [w:WORD20] = (Jw:WORD30]) << 2) + 80
If WORD30 is 3, shifting two bitsto the left results in 0x000C,
which cannot be converted into BCD format interrupts program
execution.

[w:WORD20] = [w:WORD30] << 2

If WORD30 is 3, shifting two bitsto the left resultsin 0x000C.
Unlike the above example, 0x000C is the result of the operation
to be stored in the memory, and does not cause the program to
stop.

€ Limitations of zero operations

Do not divide by zero in division (/) and remainder (*) operations. If you do,
the program stops and bit 8 in common relay information (L S2032) turns
ON. Thisbit does not turn OFF until the LT isturned OFF or goes offline.

@ Noteson delay during assign oper ation

Using a device address in an assign operation may cause write delay because
the LT hasto read the address data from the external device. Consider the
following:

E.g. [w:D200] =[w:D300] +1... (1)
[w:D201] = [w:D200] + 1 ... (2)

Statement (1) assigns (D300+1) into D200. However, in statement (2), the
result of statement (1) has not been assigned in D200 because of time-
consuming communication with the host (Device/PLC). In such case,
program so that the result of statement (1) isstored in the LS areabeforeitis
executed, as shown below.

[w:LS100] = [w:D300] + 1

[w:D200] = [w:L S100]

[w:D201] =[w:LS100] + 1

» Asaguide for D-Script programming, three addresses occupy the same
amount of memory as one Parts. The maximum number of addresses
available for ascript is 255. However, try to use the fewest possible
addresses, since the more devices that are used, the slower the response.

e The Convert Address command in the Utility menu of the Project Man-
ager cannot convert addresses used in D-Script. Open the D-Script Editor
to change these addresses.

4.2.4 Converting Addresses and Device Codes

« If you have changed the external device, the addresses used by D-Script
will not be converted. Be sure to use the D-Script Editor to change these
addresses.
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AIEEETK 4.2.8 Changing Your Project’s Device/PLC

» The size of a D-Script affects the Parts scanning time. Note that using a
large number of addresses may significantly degrade the performance of
the program.

» Upto 9levelsof Functions can be called by aprogram. Do NOT create
more than that.

» Up to 254 Functions can be created.

» D-Script operations activated by atrigger after the screen changes are as

Trigger Conditions Direct Access Method Memory Link Method
Current Value or | Bit"0" | Bit"1" | FALSE [ TRUE | Bit"0" | Bit"1" [FALSE| TRUE
Condition

Bitrise X QO X X

Bit fall O X X X

Bit Dual Operation Q O X X

Timer settings X X X X X X X X

Detecting true - - X QO - - X Q

Detecting false - - O X - - Q X

Q: Operation is performed right after the screen is changed, or the power is turned ON.
X: Operation is not performed right after the screen is changed, or the power is turned ON.

* When the timer is operating, the timer starts counting right after the screen
changes.

* Whenusing Global D-Script, the operations mentioned above are performed
only when the LT’s power isturned ON. When the LT screen changes, however,
the operation mentioned above will not be performed and the monitor operates
using the trigger conditions that have been set.

*  When aGloba D-Script includes atimer, the timer starts counting right after the
LT’ s power cord is connected.

ote: Do not usethetouch panel key to set thetrigger bit or to operate the start bit
2] in aprogram because the timing of the touch input may not be correct,
resulting in the bit being improperly entered.

» When avalueisassigned to an address for switching screens while a D-
Script command is being executed, the screen switching operation is pro-
cessed after al D-Scripts have been processed.

Example:
ID: 00000
DataFormat: Bin, DatalLength: 16 bits, Code +/-: No Code
Trigger: Leading bit ([b:M000Q])

Processing [w: WORD10]=0// (1)
[w: LS0008] =30//(2) Switchesto Base screen No. 30
[w: WORD11]=1//(3)
[w: WORD212]=2 //(4)

When the above D-Script is executed, processing of the screen switching is
performed after (3) and (4) have been processed.
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B Limitations Specific to Global D-Script

When the LT’s power is turned ON, the actions shown in the table on the
previous page are performed. At the screen change, thistableis not applied,
and the trigger conditions are continuously monitored.

Globa D-Script operation is suspended during screen changes or other LT
operations.

After the LT’ s power isturned ON, Global D-Script actions are not per-
formed until all datareads are completed for the initial screen. However,
after the initial screen changes, Global-D-Script actions may be performed
before the data reads are completed.

The maximum number of addresses in Global D-Script is 255. When this
number exceeds 256, the D-Script does not function. Since these addresses
always read data regardless of the screens, be sure to use only the minimum
number of device settingsin your D-Script. Otherwise, operation perfor-
mance can be degraded.

The maximum number of Global D-Scripts availableis 32. The currently
used function also counts as one Global D-Script. When the number of the
Global D-Scripts reaches 32, any new Global D-Scripts are ignored.
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@ Notes on Operation Results ]

B Overflowing Digits

Overflowing digits resulting from operations are rounded.
E.g. When performing an operation on unsigned 16-bit data:

* 65535 + 1 = 0 (Produces overflowing digits)
» (65534 * 2) | 2 = 32766 (Produces overflowing digits)
» (65534 /2) * 2 = 65534 (Does not produce overflowing digits)

W Difference of Residual Processing

The result of aresidual processing depends on whether the left and right
sides are signed or unsigned. When aremainder is produced by adivision
operation, an error may be created due to round up operation.

Eg. *-9%5=-4
« 9%-5=4

B Rounded Decimal Places
Decimal places resulting from adivision are rounded.
E.g. «10/3*3=9
« 10*3/3=10

B Notes on Operating BCD data

A BCD-data operation which produces overflowing digits does not give the
correct result.
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@ Logical Operation Examples ]

B Bit Operation Examples
€ ((100>99) and (200 <> 100))
Result : ON
€ ((100>99) and (200 <> 200))
Result : OFF
€ ((100 > 99) or (200 <> 200))
Result : ON
¢ ((100<99) or (200<> 200))
Result : OFF
€ not(100>99)
Result : OFF
€ not(100<9)
Result : ON
¢ [w:WORD20]<10
Result : Trueif WORD20 is smaller than 10.(ON)
€ not[w:WORD20]
Result : Trueif WORD20 is 0.(ON)
€ ([w:WORD20] ==2)or ([w:WORD20] ==5)
Result : Trueif WORD20is2 or 5.(ON)
¢ ([w:WORD20] <5)and (J[w:WORD30] < 8)

Result : Trueif WORDZ20 is smaller than 5, and WORD30 is smaller than
8.(ON)

False = (OFF)
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@ Bit Operation Examples ]

B This section gives examples of bit operations.
® [WWORD20]<<4

Result: The datain WORD20 is shifted 4 bits to the | eft.
& [W.WORD20]>>4

Result: The datain WORD20 is shifted 4 bitsto the right.
€ 12 (0000Ch) isstored in D301, using the BIN for mat.

[ w.WORD20] =[w:WORD30] >>[ w:WORD31]
Result : The datain WORD30 is shifted 12 bits to the right and assigned to

WORDZ20.
€ Bit AND
0&0 Result : 0
0&1 Result : 0
1&1 Result: 1
0x1234 & OxFOFO  Result : 0x1030
€ BitOR
0|0 Result : O
0|1 Result : 1
1|1 Result : 1
0x1234 | 0x9999 Result : 0x9BBD
€ Bit XOR
on0 Result : 0
onl Result : 1
171 Result : 0
€ Bit One'scomplement (NOT) (When the data format isBin16 +.)
~0 Result : OxFFFF
~1 Result : OXFFFE
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@ Conditional Branches ]

B Control Branches Using “if-endif” and “if-else-endif”
¢ if-endif

if (condition)
{Process 1}
endif

If the condition istrue, process 1 is executed. If false, process 1 isignored.

E.Q. if ([w:WORD20] <5)
{

}

endif
If the datain WORD20 is smaller than 5, 1 isassigned in WORD10.

[w:WORD10] = 1

& if-dse-endif

if (condition)
{Process 1}
else
{Process 2}
endif

If the condition istrue, process 1 is executed. If false, process 2 is executed.
E.g. if ([w:WORD20] <5)

{
[w:WORD10] =1

else

{
}

endif
If thedatain WORD20 is smaller than 5, 1 is substituted in WORD10.
Otherwise, 0 is substituted in WORD10.

[w:WORD10] =0
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@ Application Example (1) ]

In this example, we create a program for a temperature management system,
which checks an error bit in the host (Device/PLC) to detect the temperature
70° or above and 30° or below. If an error isfound, the LT displaysaarm
messages accordingly. This system also counts the detected errors.

Error bit : M0001
Temperature information : D200
Error counter (70C° or above) : LS300
Error counter (30C° or below) : LS301

Alarm message screen number storage address : L S302
(1) From the[Special] menu, select the [D-script] option.

Special

D-Seript
Glabal D-Seript
Data Sampling

(2) When the D-Script List appears, click on the [Add] button.
The D-Script Editor will appear.

D-Script List

D-Senpt

dd
’ Delete
© Edi
Loy

' Pasts

Close

A | el |

" Help

[ e E

Fit LMap
Show Toolbox EI ©

Foimula: Functions:

Call || New
Edt |[Delete
Copy |[Pasts
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(3) Enter an 1D number and Description.

In this example, enter “00000” in the ID field, and enter “ Alarm Display” in
the Description field.

o |

Dezcription:
J Aarm Display |

(4) Select atrigger type.

In this example, select the “Bit Rising” (left side) option and designate a bit
address “M0001.”

=T rigger
£
2 Edge Bit Address

By O™ OX @ 2555

et Dhter

(5)Createaprogram in the Action area by clicking the buttonsin the Oper a-
tors, Statements, and Operands areas.

Action

if ([w:D0OZ200]>=70)

1

[w:L300302]=100
[w:L300300]=[w:L300300] +1
i
endif

A

Program Example

if((w:D200]>=70)

I1If 70C° or above
[w:LS302]=100 II70C°-or-above alarm message screen No.100 //assigned
[w:LS300]=[w:LS300]+1 //Count up errors
}
endif
if(jw:D200]<=30)
111f 30C° or below
[w:LS302]=101 1130C°-or-below alarm message screen
/IN0.101 assigned

[w:LS301]=[w:LS301]+1 //Count up errors
endif
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(6)Click on the OK button.

The ID number and description you have entered will appear in the D-Script
List window.

D-Script List

D-Script

00001 Alarm Display

In this example, we create three interlocked switches as shown below:

SETUP OK RUNNING
@ Screen
SETUP Bit switch Address: M0001, Bit operation : Set
OK Bit switch  Address: M0002, Bit operation : Set
RUNNING Lamp Address : M0003

@ Operation Example

Pressing the SETUP and OK keysin that order turns the RUNNING lamp
ON. The host (PLC) uses M0003 as the trigger bit.

€ Program Example

Trigger
[ h:M0002 | ==

Execution
if ([ b:M0001 ] & [ b:M00021])
11 bit set

{
set ([b:M0003])

}
else
I bit clear
{
clear ([ b:M0003])
clear ([ b:M00021])
}

endif
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2.6 Data Sampling

m Data Sampling

Designated address data is sampled and stored (backed up) inthe LT unit.
When using this function for agraph (Part)’s channel, Trend graph data can
also be stored (backed up).

Up to 20 sets of Data Sampling can be entered, including the number of
channels; the setting attributes can also be confirmed in the [Data Sampling
Settings] of the [View] menu.

2.7.6 Data Sampling List

B Overview

* The specified Word Address data is sampled each specified time or with
adesired time cycle and stored it into the LS Area viathe trigger bit.

» Data can be sampled per word, and data for up to 640 words can be
stored in series.

« Sampled data can now be backed up. The backed up data can be stored in

the LS Areaviathe Trigger Bit.

» Decide achannel name for each piece of sampling data.

e The number of channels that can be set is up to 20 for the entire system
including trend graph channels. When more than 20 channels are set,
channels after 20th will be disregarded according to the following rules:
- Datasampling will be given priority over trend graphs.

- Data sampling channel numbering will begin from those set previ-

oudly.

@ Data Sampling Settings

Usage Pattern

[Special]

-

[Data Sampling]

-

Add, Edit, or
Delete

the

key

An example of the Data Sampling Setting dialog box is shown bel ow.

Lists the
registered Data
Sampling
Settings’
Channel name
and description

Data Sampling Settings

Add
© Edi

" Delete

Cloze

Help

ik
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Registers additional
Data Sampling
Settings

|~ Changes the Data

Sampling Setting
attributes

Deletes the regis-
tered Data Sampling
Settings
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B Registering Data Sampling Settings

Additional Data Sampling Settings are registered.

When the[_#a_| button is clicked on, the Data Sampling Setting screen
will appear.

B Genead

The General page provides information about the current channel settings
for the Trend Graph Display.

Channel Setting Tag Name
" General | Data Fomat | Sampling | Must be no more than five Single-byte
Taghame o or two Double-byte characterslong and
Desciption ] composed of |etters and/or symbols.
Description
Up to 20 Single-byte or 10 Double-byte
characters can be entered as a descrip-

Sampling Address oooo

Trigger Bit Address 000ooo

Topwiite Address o0zo

tion.
B DataFormat
Channel Setting S&mp' I ng Add I ess
General] Data Famat | Samping | Designates the Word Address to be
Sampling Address @ ]m mpl aj.
Trigger Bit Address @]m Trlgger Blt Addre$
Towiteddess  [JEmE0 | When the bit address stored here turns
S = ON, the sampled datawill be stored into
- the LS Area.
@V\ote: Theaddressto beentered varies
2] depending on your LT and

external device. Notethat the
sample screen in thismanual is
just an example.

” akK I ” Cancel ‘ ” Help

Top Write Address
Specifies the LS Area’s data storage
start address. LS0000 to L S0019 can-
not be used since they are the system
area. The " Start address + Sampling
data count +1” must not exceed
L S2031.

No. of Sampl. Addr.
Designates the number of sampled data
(items) to be stored.

When a variable (Logic Symbol) is used as a Top Write Address,

! an integer array must be designated. For an integer array, an
Important gppropriate size required for consecutive addresses needs to be
allocated.
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A

/4

[
Important

Channel Setting

General|| Data Format | Sampling |

BackUp

2.6 Data Sampling

Sampling Address
Trigger Bit Address

Top Write Address

Mo, of Sampl. Addr. 1

BackUp.

I Data Backup

| Spnethrmmnens idadks

=

i

Egon FlEE
(¥ Ics00z0

oK

||| Cancel |”

Help

Data Backup

The sampled datawill be backed up in
the LT’s backup memory.
Synchronous Mode

With this mode selected, when the LT's
power is turned ON, data will be
sampled following that data stored be-
fore the LT’s power was turned OFF.
With this mode unselected, when the
LT’ spower isturned ON, datasampling
will start from the value “0”. For nor-
mal operation, select this mode.

Data stored in the backup SRAM is erased when:

* The memory is initialized.
¢ Screen data is transmitted.

* The LT system and protocol are set up.
* The LT self-diagnosis “Internal FEPROM (screen area)” is
performed.

@ Data Storage Example

Thefollowing is an example of data stored from the storage start address.
When the trigger bit isturned ON, the datais stored into the LS Area.

» The stored data count is stored in the storage start address.

¢ The stored data count number “n”

isin the Bin format.

* When the stored data count is less than the sampling data count, the Word

Addresses up to that number will be cleared to “0”.

Storage start

address

+1

+m

Stored data count = “n” Old
Data 1
Data 2
Datan
Data m New

m = Sampling data count
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B Sampling

Channel Setting

Chapter 2 - CREATING BASE SCREENS

Sampling Type

[General | Data Format|| Sampling |

The method to import datafrom the host

|

Sampling Tupe.
ST

(Device/PLC) is specified from the fol-
lowing: Periodic, Trigger Control, and

{2 Periodic During Trigger Trl gger Sarnpl | ng_

2 Sample Only On Trigger PerlOdlc (NO Tr|gger)
Sampling Time ]BU_—:‘E]’ The hog (Da/l CdPL C) data | S | mportaj
ward Accress 5] [500000 11 [ at the setup interval s starting from when

the LT is powered up.
Periodic During Trigger
The host (Device/PLC) dataisimported

at the setup intervals. The data import

[

||| Cancel ||| Help

start, pause, and clear commands will be

performed according to changes to the
corresponding bit in the specified Word
Address.
Sample Only On Trigger
The datais sampled at the desired tim-
ing setup. Dataimport and data clear
will be performed according to changes
to the corresponding bit in the setup
Word Address.

Sampling Time
Specifies the sampling time, in 1 sec-
ond units, for the import of host (De-
vice/PLC) data.

Word Address (When Periodic During

Trigger option is selected)
The 00 and 01 bits of the Word Address
specified here will control the dataim-
port start, pause, and clear operations.

15 01 00

[1]: Datacl ear | |_[O]: Pause
(With [0] -[1], [1]: Start
dataiscleared.)
Word Address (When Sample Only On Trig-
ger option is selected)
The 00 and 01 bits of the Word Address
settings control the Data Read Start and
Clear operations.
15 01 00

[1]: Dataclear ] |
(With [0] - [1] Change: Datalmport

. (With [0] - [1] or [1]
datas cleared) . [0], datais imported)
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Please wait until the LT confirms the status of the control bits - i.e.
whether they are “0” or “1” (For Direct Access communication, either
the communication cycle time or 50ms, whichever is longer).

A delay of up to 1 second may occur from thetime of data import start to
actual data sampling.

B Deleting Data Sampling Settings

Here, the registered Data Sampling Settings can be deleted. Select a Data

Sampling to be deleted from the list. When the button is clicked
on, adialog box will appear to confirm your command. If you click on the

button, the Data Sampling will be deleted; if you click on the
button, the deletion will be canceled.

Data Sampling Setting

@ Selected Screens will be deleted |

W Editing Data Sampling Settings

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

Here, the registered Data Sampling Setting attributes can be changed. Select

a Data Sampling to be changed from the list. When the button is
clicked on, the Add (registration) dialog box will appear. If you click on the

button, the Data Sampling setting attributes will be changed, and if
you click on the button, editing will be canceled.
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W Setting Up Data Sampling

The Data Sampling setup procedure is shown below.
Data Sampling samples data stored in D0102 and storesit in the LS0020 LS area.

PROCEDURE REMARKS

(1) Select [Data Sampling] from the[Special] pull down

menu.
(2) Click on the[_#a_| button. Up to 20 Data Sampling sets, in-
cluding Trend graph channels, can
be entered.
| o4
 Edt
_ Help
(3) Perform thedata sampling settings. After thesettings | Enter a Channel name of up to 5
are all completed, click on the button. characters.
Channel Setting |
| General mm]

Tag Mame o

Sampling Address anaa

Trigger Bit Address aooooo
Top'wiite Address anza

No. of Sampl. &ddr. 1

Graph Backup Ma
Senchronous Mode
Sampling Type Period. Mo; B0 seconds
|. ak. %l Cancel ] | Help ]

(4) Click on the[ _tles=_| button to quit the registration.

o_0000 F
— Displays the
Delete registered items

Help

N
[ he ]
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2.7 Efficient Drawing Techniques

m Efficient Drawing Techniques ]

This section explains how the use of grids, changing display states, and the
help function can all help to increase your drawing efficiency.

@ Grid/Snap

Grid Points are placed at regular intervals on your screen and divide the
drawing areainto a coordinate “grid” pattern; when the Snap to Grid func-
tion is enabled, objects that are drawn will automatically “snap” (be aligned)
on this*grid” pattern. Use the Grid Point Spacing command to adjust the
density of the Grid points, and to display the grid or not. Also, grid points
can be displayed as grid lines, not as dots. Grid Points are not shown on the

LT unit’'sdisplay.

Select the pull down menu [Option]’s [Grid/Snap] command.

B Grid/Snap Settings dialog box

Turns the display
of the Grid Points
ON or OFF

Designates the
Grid Point
display’s being
drawn on top of, or
under, screen
objects

Turns the Snap
function ON or OFF

Registers a Grid
pattern.

Registers the grid
pattern that has been
designated in Spacing
to the position high-
lighted in the Grid
Spacing List.

@ Display

Grid/5Snap Settings

NV Display

2] 403 40
J8H1E
41616
5] 32x 32

% Bottom £ Top

)j Shap
Grid Spacing List:
)

Spacing

RIEEIE I T =
viziem
[] Tauch Area

=Grid Shift Start Paoint

« B 1E

=Syl
1) Dot
i3 Line

] | ceneel |

|' Help

Designates the grid

display style, i.e. as dots

or grid lines.

Enters the
desired Grid Point
spacing

Sets up the grid
to the optimal 20
x 20 dot size

Enter the coordi-
nate for the start
point.

Set the start point
in a center area
that is to be the
start point for
calling up the
screen. (The start
point is set as the
default value.)

Sets the Grid Point display state (displayed or not displayed).
Grid pattern display can also be changed in the Grid Tool Bar’s grid pattern

selection list box.
€ Snap

When the Snap check box is checked, the cursor will “snap” to the grid,;
objects can only be drawn on points (start & end) along the grid.
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Turning the Snap function ON or OFF can also be performed via the Grid/

‘Note: e =
N Snap Tool Bar’sicons 8] and [DH[].

Glid/Snap [=]

1]120% 20 ~ _

€ Spacing

The Grid Point intervals are entered here. The unitisadot. Input the
interval value for the X and Y axes, respectively. The default valueis 20
dots.

When clicking on [Touch Area], a 20 x 20 dot spacing will be automatically
designated, which is most suitable for the touch panel.

Select adesired grid pattern in Spacing and click on the button.
Then, the selected grid pattern will be reflected to the current screen and will
also be displayed as the 6th selection of the Grid Tool Bar’s grid pattern
selection list.

@ Grid Spacing List
Clicking on the [Erense] button changes Grid Spacing List's highlighted set
value to Spacing’'s set value and registersit.

The grid patterns registered here will be displayed on the Grid Tool Bar’s
grid pattern selection list box. A grid pattern selected from the grid pattern
selection list box will be reflected to the current screen.

Grid Mo Display |

& Grid Shift Start Point

The Grid Shift Start Point is entered here. The default setting has the start
point in the center of the screen. Pressing the button returns the start

point to the center of the screen.
Girid Shift Start Point:
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& Style
Select grid pattern display style from “Dot” and “Line".

<When selecting Dot:> <When selecting Line:>
il B1: Switch 1= H=E

@ Screen Property Settings ]

Here, the screen display’s environment is set up, which effects both the
method used to draw screens and displaying the Part addresses. The user’s
work environment can be modified whenever necessary, helping to reduce
the time required for drawing.

Select the pull down menu [Option]’s [ Screen Property] command.

W Setting Screen Property - [Display]

The display state (displayed or not) of the items such as object Fill and
setting information on Parts can be selected on the screen Editor. Check the
box of the itemsto be displayed. When a box is not checked, that item will
not be displayed.

The settings on this screen will be applied to all the screens. Properties
cannot be set up for individual screens.

Screen Property

Display [ Colar |

O Fill Paint

g tultiple open with nest/prey

Diizplay in Load Screen Object
Load Screen Double Click
1) Change Attribute 2 Edit Screen

“findow Parts

Imfarmnation Cat
|( Information Data Size

O Parts 1D
g Device Address %0 Nomal 0 Smal

O Used Hailine Curzor

|| u] I || Cancel | || Help
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@Ikv\ote: Thedisplay state of ID numbersand Addresses can also be changed via the
2] [Option] tool bar icons.

®Fill

When creating a screen, the drawing can be controlled so that any Fills used
will either be displayed or not. If the “Fill” check box is not checked, all
Fills are not shown. Using this feature will help you to speed up screen
redrawing time, and thus speed up screen creation.

When the “Fill” check box is not checked, the actual screen
! shown on the LT unit may differ from the screen shown on your
important PC. To be sure the display is correct, check the “Fill” check box
ON at least once, to verify the screen, before sending screen
datato the LT.

& Fill Point

When thisfeature is selected, specified Fill points will appear with an “X”
mark, which is especially useful when selecting Fill points.
@\ If the Fill Points are not displayed, Fill cannot be performed while editing.
‘Not

e; TheX (cursor position) mark’s color can be designated in the system’s
[Color] area.

€ MultipleOpen with Next/Prev

When selecting [Previous Screen]/[Next Screen] from the [ Screen] menu, or

opening a screen with the Open Screen switch [« [ »], specify whether the
next screen is opened with the currently active screen open or after that
active screen is closed. Up to 20 screens may be opened continuously.

@ Display in Load Screen Object

You can specify whether Part addresses and ID numbers on a screen which
has been called up using the [Load Screen] command are displayed or
hidden.

@ Load Screen Double Click

Specify an edit method for editing a screen that has been called up on
another screen where the [Load Screen] command was executed, or for
editing a screen on the Screen List.

If [Change Attribute] is specified, the Load Screen dialog box will be
opened, enabling you to select a screen to be called up (screen number).

If [Edit Screen] is specified, the screen that has been called up will be
opened, allowing you to edit the data.
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€ Window Parts

Designate whether the contents of the window part placed on the Base
screen will be displayed or hidden.

®PartsID

Designates whether or not a Part’s ID number is displayed on the Base
screen.

& Device Address

Designates whether or not Part Addresses are displayed on the Base screen.
Part Addresses appear below the ID number.

@ | nformation Data Size

Selects the character size displayed from Standard (half size) and Minimized
(/4 size) for ID No. and Address.

@ Used Hairline Cursor
Changes the arrow cursor to the hairline cursor.
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W Setting Screen Property - [Color]

Select the Grid, Fill Point, and Screen Background colors here. When the
drawn image data’'s and system'’s col ors are the same, the screens will be
hard to see. Here, these colors can be changed to remedy that.

Screen Property |
Grid Color )
Fill Paint Calar ) I O O )

Secreen Backaround Pattem D

Fo INEMmC] ek
eo W] ek

Ok ” Cancel || Help

& Grid Color
Selects the grid point’s color.
& Fill Point Color

Fill Points designate the point where afill will begin; this setting determines
the color of thefill point.

@ Screen Background

Select the Base screen’s background color; the color selected hereisaso
displayed on the LT.

A - If any background color is specified for the screen to be
| loaded, no on-screen object will be displayed on the LT unit.

u
Important . T |oad a screen whose background color was specified,
specify the loading position at the center of the screen.
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@ Preview Screen ]

With this feature, you can confirm how an image will appear on the LT unit.
Thisimage will differ depending on each LT display device type.
Select the [View] menu’s [Preview] selection.

@V\o\teej: Select " B/W" (black and white) to view the monochrome LT screen image.

Preview - [B1:5witch 1]

Select the ——( 3B o

type of
display used

m Screen Data List ]

The currently displayed screen’s object locations and setting attributes are
listed in the Screen Data List.

B Screen Data List
An example of the Screen Data List is shown below.

IS Screen Data
Displays the object
placed on the
currently displayed
screen

Designates the
type of the object
to be displayed in

Qz] Parts I Dbiec@/ the Screen Data
Edits the object . : List
fﬁéegéfggr:og;ta * Change Attr ] | Delete ‘|_\\ Deletes the object
. . =1 Change Order selected from the
List | L Link Select £ Chang ot Screen Data List
Highlights an Changes the order
object selected on of drawing objects
the screen.
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B Screen Data Display

The designated type of object(s) datais displayed. If agrouped object
contains at |east one object whose type has been designated, it is displayed
as an grouped object.

The Screen Data List displays the following information:

Drawing .......cceuu... Type and coordinates of adrawing object

Part.....ccccooveneninnne ID Number and Address

Grouped object ...... Grouped object’s coordinates and each grouped object’s
information

.

Note: D-Scriptsaredisplayed all thetime. Each D-Script shows 1D and description
2] information.

B Selecting an Object

The object selected from the list will be displayed with handles (i.e. se-
lected) in the Screen Editor. To select multiple objects from the list, Left-
drag them, or hold the or key down and click on desired ones.

€ Link Select

Normally, when any object is selected with the Screen Editor, it will not be
displayed on the list. If the check box for [Link Select] is marked, an object
selected with the Screen Editor will also be selected (highlighted) on the list.

B Editing an Object
To edit an object, select it from the list and click on the button; or
simply double-click on the object.
If the object is D-Script, D-Script Editor will be actuated.
Clicking on the button deletes the selected object.
€ ChangeOrder

Objects are displayed on the list in the order where they have been drawn. If
the order of objects on thelist is changed, the overlapping order of drawn
objects and the executing order of Parts can also be changed.

€ Copying

Any object on the list can be copied by pressing the[ctrl] +[ C | key, or pasted
by pressing the[ctrl] +] Vv | keys. Multiple objects can be copied at atime by
selecting them.
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@ Part Reference List ]

The settings for each Part placed on the currently edited screen are listed
here, for each Part type. Part settings can also be changed on the Part
Reference List.

Usage Pattern When either modifying or deleting...

Select After selection, or the

[View] — [Parts List] — desired — either modify or

Part delete the Part key

An example of the Part Reference List on a screen is shown below.

Reflection of device comment

The device comment corresponding to an
entered device address overwrites the Descrip-
tion field.

Parts List

(i Changes Part’s
settings
Shho;/)vs alist Or: Deletes the
the Parts on the Ea—— =q selected Part
currently selected
screen. Simply Copies a Part
click on the
desired Part Pastes a Part
Stores the
Parts list
information as
s o) a CSV file.
Use this scroll bar Closes the current screen.
to view all the data (The key can also be
on along screen used)

@V\ote: Thetab width for each item can be adjusted by placing the mouse pointer on
the border between items and then dragging it.

B Editing Itemson the Part Reference List

Part setting data can be changed directly on the Part Reference List.

Click on the left-most number of a Part to be changed, and it will be high-
lighted; then, click on the[ ea. | button, and the Part’s Dialog box will
appear and its settings can be changed.

Setting items, such as the Description and Address areas, can be changed via
the Part Reference List. Also, items displayed in gray can be changed in the
dialog box by double-clicking on the inside of their border.

£ N

' "PartID | Description ‘Data Address | Display M. | Data Format
C— — — Joomo
! \

Can be edited directly Can be edited by
double-clicking
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@Ikv\ote: For the labels and messages of more than oneline, use “\\" asthecarriage

] return.

RESET | 4 g fee——
sUTTON] < |.rH esety\Button

B Deleting Items from the Part Reference List
Parts can be deleted directly from the Part Reference List.
Click in the middle of a Part to be deleted, and it will be highlighted. Then,
click onthe[ peet= | button, and adialog box will appear. Clicking on the
button will delete the Part from the Part Reference List. To close
the box without deleting the Part, click on the button. When
multiple Parts are selected, all the Parts will be deleted by clicking on the

button, and by clicking on the[ weai_| button, the box will be
closed.

Confirm Delete

g Are pou zure pou want o delete: BS_0017Y

[Eoves || vesan || We || Meal || Cancel

B Copying a Part on the PartsList
Any Part can be copied on the Parts list.

Select the left-most number for the Part being copied by clicking on that
number. The selected Part will be highlighted. After this selection, click on

the button and then the[__=_] button. The Part will be copied to
the bottom line of thelist.

B Reflecting a Device Comment on the Parts List

The device comment corresponding to an entered device address can be
entered on the Parts list by clicking on a specified button. This can be done
in either of the following two ways.

1. Select the address setting field and click on the [Apply De-
vice Comment] button.

The device comment corresponding to the selected address will be
reflected in the Description field.

2. Select a Part by its line and click on the [Apply Device Com-
ment] button.

If there are multiple address setting items for that Part, the descrip-
tion corresponding to the address specified in the [Address Table
for Automatic Input of Device comment] will be reflected in the
Description field.

2.3.8 ® Reflection of Device Comments
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W Exportingtoa CSV File

The Partslist information can be saved asa CSV file.

You can also select whether the currently selected page (tab)’s information
will be exported or the entire page will be exported.

Data Sampling List shows data sampling settings created in the edited
project file. You can confirm the status of each data sampling setting there.
You can also change the data sampling settings on the list.

Usage Pattern

When editing or deleting...

Cloze
Select Desired Item and -

or

[View] - [Data Sampling List] - Edit or Delete It -
the key

Thefollowing is the Data Ssampling List (local) screen example.
The edit method of thislist isthe same asthat of the Parts list.

2.7.5 Parts List

[All] tab
Opens the selected

Using Device Data Sampling

ﬁgrrr;rr;thar;tde\/ice S Setting for editing
comr’nent that Deletes the selected
corresponds to [ e Joescies T Datq Sampling

an device ad- —_ Setting

dress is auto- Gom [ i

matically written Cl?r?lege?ﬁtna Sam-
in the Descrip- - pling g

tion field.
Pastes Data Sam-

pling Setting
Click on
to close the Data
Sampling Setting

Moves Data Sampling
Setting one position
higher on the list

List screen.

Pressing the Moves Data Sampling
key will also close Settingone position
the screen lower on the list
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[Setup Channel] tub

Saves the Data
/Sampling Setting
Listin a CSV file

Scrolls the
display left, right,
up and down
when the Data
Sampling Setting
List is bigger
than the screen
size

%\te: Thetab width for each item can be adjusted by positioning the mouse pointer
on the border between items and then dragging it.

B Changing the Data Sampling Setting Order

The Data Samplings will function in the order that they have been set up
(the order displayed on all the pagesof the Data Sampling List) ontheLT
screen. To change this order, click on either the | Meveur | Or [Move Down| Key.
When multiple Data Sampling are grouped, that group will be moved up or
down.

B Exportinga CSV File
The Data Sampling Setting list information can be saved asa CSV file.
2.7.5 PartsList B Exporting a CSV File
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@ Cross Reference List ]

@IR\I\ote:

2]

The Cross Reference List feature is useful when displaying the current
address condition of Parts and other items. Here, the exact address used for
each Part can be checked.

Cross reference will be displayed for local settings (each screen’s Parts and
D-scripts), and data sampling and global D-scripts registered for al the
screens. For the global cross reference, setting display will not be sorted for
each functions and screens, but the address designation conditions will be
displayed for the entire Project File.

- Since, to display the global crossreference, addressinformation for all the
screen will be acquired, it can take along period of time.

- Theglobal crossreference does not display the condition of addresses that
have been designated via [LT System Settings].

B Cross Reference (L ocal, Data Sampling, Global D-script)

Usage Pattern Locall
[Cross Refer- or Select either
[View] - . - - Word or Bit - Confirm - or
ence List Data :
! [Sampling] units the [Esc|key
or [Global
D-script]

An example of the Cross Reference List dialog box (in the case of Local) is
as shown below.

Select whether to display by Bit
Address or Word Address

Cross Reference List [ Local ] _

BitAddress [word Address | Click to change the
—— T T Display Start Ad-
000000 [La_nm La_onz2 | dress

Selects the Address

Display condition

Addresses=
# Used
Al
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B Global Cross Reference

The global cross reference has two display methods, i.e. list display same as
the standard cross reference and address map display.

This feature enables you to go to the screen that uses the address you want to
edit, to convert addresses in one operation, and to make areference to an
address.

- Limitations exist regarding the display of the following addresses with the
global crossreference that was designated when the LT System was set up.
(To set up the LT system settings, select from the Project
Manager menu, and configurethe settingsin the [LT System Settings]
dialog box.)

- The[Watch Dog] address designated on the [Extended Settings] tab will not
be displayed when the" Time" isset to " 0" seconds.

- Asfor the[System Start Address] designated on the [M ode Settings] tab,
only the designated System Start Addresswill be displayed regardless of the
total number of wordsused in the system area and the reading area size.

Usage Pattern

[List]
- or —  Start address search.

e

Select either Word or .
- — Confirm

or
Bit Address. 1" the key

edit address

— || Convert Addresses... to

change addresses

[Global Cross

[utility] - Reference]

14

Thefollowing is the overview for the global cross reference screens.
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€ List Display

2.7 Efficient Drawing Techniques

For local settings, which screen is used, and for global settings, function
type will be displayed, respectively.

Selects whether setting conditions are dis-
played for Bit Addresses or for Word Addresses.

\

Global Cross Reference List
Bit Addi=ss |'w/ord Adiioss | Changes the display
start address to be
[Address [Screen M= “ Sbtess. . .
00000 Logaing Fling.Data S amping B1 | displayed.
#0000 B1B284 — Addiesses = |
HO0004 Global Dscript, B1,62.54 ’
X00100 B Used Selects the range of
00101 e Addresses to be
AO0102 .
X00103 displayed.
X00104 ” Open Screen...
X015 —— ;
Il ” Convert Addresses... C“Ck tO SeleCt the
— screen in which the
Help address you want

to edit is used, or

go directly to the
desired screen.

Click to convert the addresses in

one operation. MEIEAEK 4.2.4
Converting Addresses and Device Codes

€ Address Map Display
When selecting Word Address, the table cells from Word Address Bits 0 to

15 (for 32 bit device, from 0 to 32) will al befilled. When selecting Bit
Address, only bit cells currently used will befilled.

Selects whether ——|
setting condi-
tions are dis-
played for Bit
Addresses or for
Word Addresses.

| o]

TAddress
'D00000
Dooon
D002
D000
DO00D4
D005
D0000G
DO0007
D008
D000
o000

[Dooa

Do0012

Ued 1

[oowors

D004

Unased [

Click to convert the addresses in

one operation. MEIEAEK 4.2.4
Converting Addresses and Device
Codes
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_ Displays the Bit

location.

Click to select
the screen in
which the ad-
dress you want
to edit is used, or
go directly to the
desired screen.
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€ Changing Addresses

You may move to the drawing screen of the specified address from the
global crossreference, or change addresses.

On the global cross reference list, double-click on the column of the address

you wish to change. Or, click on the[ senseeen | button to open the [Start
Address| dialog box, specify the address before the change, and click on the

|T button.

Global Cross Reference List

Bit Address [‘word Address |

[Address [Screen
®Kooooo— . B1
g

| dablass.

Addresses=
|7 {9 Used

2

Open Screen...

Co§ ért Addreszes

=1 |\
LA

Address

00000 TEEH

%@ When selecting an address designated on the Base screen, Trend Graph
screen, Keypad screen, Video screen or Window screen, open the screen by

double-clicking on the address or by clicking on the [ ownseen | button

after selecting the desired address.

When the specified address is used only on one screen, the screen will be
displayed directly. When the specified address is used on two or more
screens, the [Open Screen] dialog box appears. Select the desired screen
(two or more screens can be selected) and click on the button.

Open Screen [Address:X00101)

pen
L
loze

o
—

Screen Type:

]Base Screen I~ | Help

4

The Global Cross Reference dialog box closes when the drawing screen
opens.
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€ AddressBlock Conversion

The addresses listed on the Global Cross Reference dialog box (all ad-
dresses in the Project and GP system addresses, excluding the addresses
registered as symbols) can be converted into different addresses in one

operation simply by clicking on the [cowetases=s_| button.
SEEOTTTIK 4.2.3 Converting Addresses and Device Codes

The Global Cross Reference display is automatically updated after the
Address Block Conversion operation.

+ » Among thetags and parts, the ones corresponding to both bit addresses and

wor d addresses are cross-r eferenced with both of those addresses on the
Cross Reference List even if they were placed by specifying their bit ad-
dresses.

Example: A tag (part) placed at bit address, X0000F is displayed asword
address, X00000.

» The addresses displayed in the sample screen are an example. Note that the
address actually displayed on your screen varies depending on your LT and
PLC type.
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B Changing Display Addresses

For cross reference and global cross reference list display, when selecting
[Used], addresses that have been used for the Parts and other itemsused in
the currently open screen or Project will be displayed. When selecting “All
Addresses’, all the addresses beginning with the Start Address will be
displayed. To change the Start Address, click on the [ #sa=s_._| button, and
the Dialog box shown below will appear. Set the Start Address and click on
the button, and the display will show from that address on.

Start Address ]

Start Address

Enter the Start —{— 00007

Address

Cancel

I I L

 Help

For the global cross reference’s address map display, the map display start
address can be designated when toggling Bit and Word display.

When clicking on [ward Address | OF | Bit Address |, the following dialog box will
appear. After selecting Bit or Word, designate the start address. Then, click
on the button and the cross reference display will start from the
designated start address.

Start Address

[x]

.................................

1% word 12 Bit K

Start dddress

Cancel
Enter an ——-DEIEIEIEIEI -
Address
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2.7 Efficient Drawing Techniques

m Load Screen List

)

The Load Screen List will be displayed on the currently edited screen. With
thislist, you can check the setting attributes of a screen to be loaded and
also can change its loading location.

Usage Pattern

[Load Screen

[View] — sy

When editing or deleting...

-

Select a screen
to be loaded

-

or

General Load Screen Summary List

Lists all the screens loaded on the currently open screen. Select the

desired screen to show its setting attributes.

Click on to close
the Load Screen

List screen. |
Pressing the|Esc

[Scr

[ Position [ Position v

[ Title

Statistics &

key will also

FEE
EED

05
IES

]
[182

‘Alalm A

close the screen

Changes Load
Screen List
Settings

'™ Deletes a Load

Screen List

B Editing viathe Load Screen List

Screen settings can be changed using the Load Screen List.

Clicking on the left-most number of a screen to be changed will select
(highlight) it. Then, clicking on the [Edit] button will bring up the [Load
Screen| dialog box or the currently called-up screen, allowing you to edit the
screen. The procedure for calling up and then editing a screen varies de-
pending on the settings in the [Load Screen Double Click].

2.7.2 W Screen Property Settings [Display Settings]
Any coordinate setting can be changed directly viathe Load Screen List.
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B Deleting from the Load Screen List
Screens can be deleted from the Load Screen List.

Clicking on the left-most number of a screen to be changed will select
(highlight) it. To delete multiple Load Screen Lists simultaneously, simply

drag the cursor to select the screen numbers. Then, click on the
button, and the dialog box will appear to confirm the command. If you click

on button, the screen will be deleted. To cancel the request, click
on the button. When selecting multiple screens, click on the

[ V=& |todeleteall of them, and click on[ngar_|to cancel any dele-

tions.

Confirm Delete

Mo || Mol || Cancel

m Display of Screen Level Change Structure ]

The nesting of Load Screens that have been set up on the currently edited
screen is displayed. In this way, a multiple nesting condition can be viewed.

2.2.10 Nesting
Select the [View] menu - [Load Screen Nesting Display] command.

Load Screen Mesting [x]

Each screen will be displayed viathe following symbols:

Screen Type Symbol
Base screen B
Mark screen M

Image screen I

Window screen U
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b DXF Conversion

Thisfeature allows you to convert DXF (Drawing Interchange File) file data
into Base screen data, and to convert Base screen datainto DXF file data.
(A DXFfileison Auto Cad® drawing file)

4 :\\ °
|
]

Important

DXF filenames must be alphanumeric.

DXF can be used for the Release 12 program. If a newer
version’s data is used, that data will not be converted.

When each object’s coordinates are converted, errors may
occur, thereby slightly changing them.

Once a DXF file data is converted into Base screen data, even
if the Base screen is again converted back into the original
DXF file, or vice-versa, the resulting data my be unusable.

When converting data, be sure that the screen’s width and
height ratio will be the same for both the Base screen and the
DXF file (Screen size settings: $LIMMAX, $LIMMIN). If this
ratio is different, after data is converted, object locations or
shapes will also be different from the original.

m Conversion from DXF File to Base Screen (DXF — Screen)]

DXF file datais converted into Base screen data.

FDXF file |:> |:> Base
\.screen

T Editor

Convert

B Requirements and Restrictions when Converting Data
(DXF - Screen)

Grouped objects (Blocks) can be nested up to 10 layers (levels deep).

The DXF file dataformat isASCII. Both“CR LF” and “LF’ can be used
as line feed characters and will be converted correctly.

During conversion, when the resulting output file’'s size reaches
16K bytes, the conversion will quit, and subsequent data will not be
converted.

Three dimensional data cannot be converted.

If the X,Y coordinate screen boundaries ($LIMMIN, $LIMMAX) are not
set up correctly in the DXF file, after the data created in the DXF fileis
converted into Base screen data, it may go beyond the Base screen’s
display area.
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+ After DXF file datais converted into Base screen data, the DXF file
name is used as the Base screen’s description.

* When alayer’s attribute has been turned OFF, that layer’s data will not be
converted, and only ON layer datawill be converted into Base screen
data.

* Fill and Oval/Arc data cannot be converted.

B Option (DXF - Screen)

Here, select and enter the color and size used when converting data. Ac-
cording to the specified DXF and Base screen size, datawill be relatively
magnified or minimized when converted.

Option [ D%F -> Screen ] | DXF size _
Convert Color SelectsaDXF file
o o O ¥ Corvet ol size

Datais converted as

colored =Convert 0XF Size

£33 Use SLIMMIN $LIMM&
£ Use $EXTMIN SEXTMAX

| =Corwvert Screen Size
Screen Size — |

_ £ F40x480
Designates the >< £ B0
screen size uged y £ 3204240
after conversion £ B00E00

" 1] 4 I | Cancel ] | Help ]

& Convert Color

When this box is checked, DXF file datais converted as colored. When this
box is not checked, DXF file data is converted as monochrome.

W Color Conversion (DXF — Screen)

& Convert DXF Size

The DXF file data conversion range is selected.

When “Use SLIMMIN, $SLIMMAX?” is selected, datain the DXF file's
maximum screen area (X,Y coordinate screen boundaries) will be converted.
When “Use SEXTMIN, $SEXTMAX” is selected, only datain the DXFfile's
object areawill be converted.

& Convert LT Size

The Project File screen size (LT screen size) used after conversion is Speci-
fied.
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2.8 DXF Conversion

B Color Conversion (DXF — Screen)

When the [Option] dialog box’s [Convert Color Data] check box is checked,
the DXF file's color datawill be converted asfollows:

DXF File Color No.

Base Screen

1 (red), 1X (red-based)

Red

2 (yellow), 5X (yellow-based)

Yellow

3 (green), 9X (green-based)

Green

4 (light blue), 13X (light blue-based)

Light blue

5 (blue), 17X (blue-based)

Blue

6 (purple), 21X (purple-based)

Purple

7 (white)

White

Other colors

White

The background color will be converted into Black.

B Line Type Conversion (DXF - Screen)

Each DXF file'sline type will be converted as follows:

DXF File Base Screen
CONTINUOUS Solid line
DASHED -—-- Broken line
HIDDEN -—-- Broken line
CENTER — = Adot-dash-line
PHANTOM — -+ Two dot-dash-line
Other —_— Solid line

The user defined line types will be converted into solid lines.
B Object Conversion (DXF — Screen)

The DXF file's objects will be converted as follows.
Colors and line types will be converted as shown above. Tiling patterns will

be converted into solid Fill.

DXF File Base Screen
LINE Straight line
POINT (dot) Straight line (T he startand end are the same point)
CIRCLE Regular circle
ARC Arc
TRACE (thick line) Filled polygon
SOLID (filled object) Filled polygon
TEXT (characters and signs) Text
DIMENSION (dimension indicator) Straightline

INSERT (inserting object)

Conversion breaks down complex objects into
component parts (objects)

ATTRIB (attribute)

Conversion breaks down complex objects into
component parts (objects)

POLYLINE(polyline/donut-shaped/
oval/polygon/rectangle)

Continuous straight line

VERTEX

Vertex coordinates of a continuous straight line

Objects other than the above will not be converted.
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Chapter 2 - CREATING BASE SCREENS

Each object’s elements, other than colors and line types, will be converted as
follows:

@ POINT (dot)

A dot’s pattern will be converted into “0” (point), and its display size will
be converted into “0,0”.

A dot will be converted to a straight line, with the start and end coordi-
nates at the same point.

@ TEXT (charactersand signs)

A rotation angle will be converted into an angle closer to 90°, 180°, 270°,
or 360°. (in 90° units)

The character size will be converted into a size closer to either 1, 2, 4, or
8 x magnification.

Specia charactersthat will be converted are %%d (°), %%c (¢), and
%%p (£).

When text contains more than 100 characters, it will be divided every
100 charactersinto records of data and then converted.

When more than 100 character text is divided into records of data, groups
of overflowing characters after the first 100 characters will be dislocated
toward the right bottom for afew dots.

Tilting angles, character fonts, and character spacing will not be con-
verted.

Text will be converted based on the ASCII code; therefore, the character
style (Standard, Bigfont, etc.) or font file settings will be ignored.

When text with half-sized and full-sized characters mixed in vertical
linesis converted, the half-sized characters will be centered.

€ DIMENSION (Dimension Indicator)

During conversion, the breaking down of a grouped object (Block) is
performed by referring to the Block’s sections, which indicate the Block’s
component Part (objects). However, dots will not be converted.

€ INSERT (Inserting Object)

A grouped object defined in the Block section will be broken down into
each drawing object and converted.

Up to 10 layers of nested data will be converted. However, since all the
datawill be converted into asingle layer on a single screen, the objects
over the limit (file capacity) will not be converted.

Although the rotating angles, and the number of lines and columns can be
converted (lines and columns of the objects over the limit will not be
converted), their ratio (scaling) will not be converted.

The grouped object created in Layer “0” will be converted based on the
inserted layer’s colors and line types, however, a grouped object created
in an other layer level will not be converted based on the inserted layer’s
colorsand linetypes. Inthiscase, if BYBLOCK is specified to the
grouped object, the inserted layer’s colors and line types will be used.
Simulated object sectioning (hatching) data cannot be converted, since,
when the Block section’s hatching data pattern is converted into each
drawing object, that data size can exceed the LT file capacity.

If another file's grouped object has been inserted or another fileisre-
ferred, that grouped object will not be converted.

€ ATTRIB (attribute)
ATTRIB (attribute) datais part of INSERT data.

Attribute data will be converted in the same manner as TEXT conversion.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



Chapter 2 - CREATING BASE SCREENS 2.8 DXF Conversion

€@ POLYLINE (polyline/donut-shaped/oval/polygon/rectangle)

*POLY LINE datawill be converted connecting the following VERTEX's
coordinates with a continuous straight line. Only datawhose polyline flag
iseither “0O (default)”, “1 (closed polyline)”, “ 2 (adding the fit curve ver-
tex)”, or “4 (adding the spline curve vertex)” will be converted.

*When the number of vertices exceeds 100, data will be divided every 100
vertices and converted.

*When the converted data’s coordinates are repeated at the same point, the
following coordinates will be omitted.

*When a polyline has curved sections, they will not be converted. There-
fore, donut-shaped lines and curved polylines will be converted into con-
tinuous straight lines, connecting each coordinate point.

€ VERTEX

Top coordinates of apolyline.
* A polyline’swidth will not be converted.

B Converting DXF File Data to Base Screen Data

PROCEDURE REMARKS

(1) Select the pull down menu [Utility]’s[Convert DXF
] command.

(2) Click on the| 0b=F-FRW |putton.

# DXF<->Screen Converter 4|

(3) Designate the source (DXF file) and the destination| To designate a folder, click on the
(Project File), and enter the Base screen number. button

File Convert [ DXF -> Screen | |

Fram:
[DF File: |E:\F'rogram Filez'\Pro-facetLT4datab ”" Select |

To

: Project File: |C:'\ngram Files'Pro-faceiLThdatab |||| Select |

Sereen Mo B |'ID X ”

|| Convert | || Cancel | || Help
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PROCEDURE REMARKS

(4) Click on the button and enter the conver-

sion conditions.

File Convert [ DXF -> Scieen |

From:

DiF File: |C:\Program Files'Pro-face\L T datab ||| Select

.
Project File: |C:\Program Files' ProfaceL Thdatab || S glect
T

T

IEEEREEER

(5) After all the attributes have been entered, click on 2.8.1 W Option
the button to registered the entered data. (DXF — Screen)

Option [ DXF -> Screen ) |

) {Carver Color

= Comvert DXF Size
& Use SLIMMIN $LIMMARX
3 Use SEXTMIN SEXTMax

~Comvert Soreen Size:
£ BADwE0

# 12 640400
v £ 320240

£ 8004600

N

(6) Click on the button to start conversion. If the designated screen number al-

e Z ready exists, a prompt will appear,

vt e e Tt asking whether the new number

Pt e [£ o Pt T o] should overwrite the old number.

e Whenthe[ o ]buttonisclicked

on, the new number will overwrite

the old one, and when the

— T buttoh is clicked on, the new num-
ber will not overwrite the old one.

(7) After the conversion is completed, click on the | [
button. The[DXF<->LTE Converter] dia-
log box will reappear.

Thiz screen already exists!

Do you want to overaite?

File Convert [ DXF -> Scieen ]
From:
DiXF File: ‘E\ngvamFiles\F‘m-tace\LT\datah ‘H Se‘e‘:‘l | | Cancel |
f Praiect File: [ \Program Files'\Pro-facehLThdatab: m
Complete
Eeadmg_ D><1F n[g}Uhr\e] .
i 1%]
[ To convert another DXF file, DO
omplete
— NOT cancel here; rather, start from

step (3) again.

(8) Click on the button to quit.
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@ Conversion from Base Screen to DXF File (Screen — DXF)]

Base screen datais converted into DXF file (Drawing Interchange File) data.

"

fﬁ’(
LT Edit
ﬁase > > FDXF file
\.screen .

Convert

Can be used for

CAD software for a
personal computer,
such as AUTO-CAD

B Requirements and Restrictions when Converting Data
(Screen - DXF)

* Only Base screens can be converted.

» Image screens called up on the Base screen will not be converted.

» Tag datawill not be converted, so for example, M-tag’'s Marks will not be
displayed after conversion.

* When text is converted, the character size and position may differ from
the original due to font type difference and errors created during conver-
sion.

» Since Load Mark will be converted into a simple straight line (i.e. no
width), if it has been magnified, it will be displayed differently from the
original after it is converted.

/A
! If you try to convert afilled polygon that has four peaks, one of

[
Important \hich introverts, into a DXF file, this polygon will not be con-
verted properly.
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B Option (Screen — DXF)

Here, select and enter color and size data used when performing data con-

version.
Screen Size -

Designates the LT I :
screen size after conver- x
sion !
=Convert t D¥F Size —————————————
| B S arts State
DXF size , © amatn Selects and enters the Part
Designates the DXF £ 004600 State when converted
screen size when Base [Foe e
screen daFa is converted gg: |
into DXF file data
[ax [ concel |[ Helo |

@ Convert Screen Size
The screen size of aLT unit specified in the Project File.

& Convert DXF Size

The DXF file size used after datais converted using data conversion is
selected. The default values are the same as the Screen Size values men-
tioned above.

& Parts State

Bit ....... When Part display states (ON/OFF) are specified, that Part will be
converted for each display state.

Word .. Picture Display and Message Display will be converted with the
display state specified here.

B Color Conversion (Screen — DXF)

Base screen’s drawing data colors will be converted as follows:

Base Screen DXF File Color No.
Black 250 (gray)
Blue 5 (blue)
Green 3 (green)

Light blue 4 (light blue)
Red 1 (red)
Purple 6 (purple)
Yellow 2 (yellow)
White 7 (white)
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M Line Type Conversion (Screen - DXF)

Base screen’s line types will be converted as follows:

Base Screen DXF File
1-dot solid line CONTINUOUS
— — — - 1-dot broken line DASHED
— - — .- 1-dot one-dot-dash line CENTER
— . - — 1-dot two-dot-dash line PHANTOM
— 2-dot solid line CONTINUOUS
- == = 2-00tbroken line DASHED
= « == 2-dotone-dot-dash line CENTER
— « 1 2-d0t two-dot-dash line PHANTOM
—  3-dot solid line CONTINUOUS
e 5-doOt solid line CONTINUOUS

The line thickness will be converted in the same thickness for all the lines,
regardless of the line types.

B Object Conversion (Screen — DXF)

Base screen’s drawing data will be converted as follows.

Colorsand line types will be converted as shown in the previous page’'s
table. The background colorswill not be converted. Tiling patterns will be
converted into solid Fill.

Base Screen DXF File
ﬁrt]r:lght line/Continuous straight LINE/POLYLINE
Square/Filled Square POLYLINE/SOLID

Regular Circle/Filled

- CIRCLE/CIRCLE +SOLID
Regular Circle

Oval/Filled Oval POLYLINE/POLYLINE +SOLID
Arc/Pie ARC/ARC + POLYLINE
Division Collection of lines

Filled Polygon SOLID or POLYLINE

Broken down into each Part object

Load Screen
and converted

Text TEXT
Load Mark POLYLINE

Broken down into each part and
Part

converted

Data other than the above will not be converted.

@ Straight line/Continuous straight line

* When the number of coordinatesis*“2”, astraight line or continuous
straight line will be converted into LINE. If this number is other than 2, it
will be converted into POLY LINE.

* When aline has an arrow at one end, a solid filled triangle will be drawn
at the end coordinates, and when aline has arrows at both ends, solid
filled triangles will be drawn at both ends.

@ Square/Filled Square

* Any linewill be converted into POLY LINE.
* Any Fill will be converted into SOLID.
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@ Regular Circle/Filled Regular Circle

» Filled regular circle’'s border will be converted into CIRCLE and its
filling will be converted into SOLID.

@ Oval/Filled Oval
* Any lineswill be converted into POLY LINE.
* Filled oval’s border will be converted into CIRCLE and itsfilling will be
converted into SOLID.

& Arc/Pie
* Pie'sstraight line section will be converted into POLY LINE.
& Divisions
* When the divisions are marked on a straight axis, their coordinates will
be calculated based on their start and end coordinates, direction, and the
number of divisions, and will be converted into LINE.
¢ When the divisions are marked on an arc axis, their coordinates will be
calculated based on their start and end angles, external circle’sradius,

internal circle's radius, number of divisions, and will be converted into
LINE.

@ Filled Polygon
e Fill will be converted into SOLID. However, if the number of verticesis
more than 5, Fill will not be converted and only its trace will be con-
verted into POLYLINE (CONTINUOUS).

@ Load Screen
» The screen will be retrieved from its attributes, and screen number and if
it exists, and each drawing datawill be converted.
* Thecalled up screen’s datawill be converted in the same layer as other
drawing data.
* Only Base screen will be converted.

& TEXT

» Characters written horizontally will be converted into BIGFONT. Those
written vertically will be converted into TATEGAKI (vertical type of
BIGFONT).

e 1/4-sized characters will be all converted into half-sized characters.

» Half-sized (1/4-sized) characters written horizontally will be converted
with arelative scale of 1/2 in the X direction, and other size characters
will be converted with arelative scale of 1.

e Both half and full-sized characters written vertically will be converted
with ascale of 1 for their height and width. Therefore, the half-sized
characters will become the same size as the full-sized characters.

e Character types of “Bold” and “Raised” will not be converted.

* Dueto font difference and other elements, text will be different from the
Base screen, after conversion.

& Load Mark
¢ TheMark screen will beretrieved from the screen number, if that screen
exists, the dot pattern will be converted into POLYLINE (CONTINUOUYS).

@ Part
e Each Part’sdatawill be converted into drawing data.
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2.8 DXF Conversion

B Converting Base Screen Data to DXF File Data

PROCEDURE

REMARKS

(1) Select the pull down menu [Utility]’s[DXF Conver -

sion] command.

(2)Click on the| FRw->DxF | button.

*4 DXF<->Screen Converter |

. DF -» Screen

|' Evit || Help |

(3)Designate the source (Project File) and Base screen
number and designate the destination (DXF file).

File Convert [ Screen -» DXXF ]
Fror:
Project File: | Files'Pro-facetL Thdatabasehtest Ite "" Select |
Screen Mo B |1 "
To
DF File: [D5F1 [52ket]
[ Corvert | || Cancel | || Help

(4)Click on the button and enter the conver-

sion conditions.

File Convert [ Screen -» DXF )

Frorm:
Project File: | Filez'Pro-faceiL Thdatabazehtest te "" Select |

Screen Mo B |1 "

T

DF File: [DXF1 |[5etect]
o
I Convert | || Cancel | || Help

To designate a folder, click on the

button.
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PROCEDURE

REMARKS

(5)After all the attributes have been entered, click on

the button to registered the entered data.

Option [ Screen > DXF )

= Convert Screen Size:
-
]
= Canvert DXF Sigem——
£ BADRE0
£ B40k400
£ 3204240

£ 3004600

®
v

= Parts
Bit “wford

= 0if
R

===

(6)Click on the button to start conversion.

File Convert [ Screen -> DXF ]

Fram:
Praject File: ‘ FileshProface\ L Thdatabasehtest e "|| Select |

Screentlo: B |1 "

T

DF File: |DXFT I[52ket]

[ Convert F| || Cancel | u Help |

(7)After the conversion is completed, click on the

button. The File Convert (DXF - Screen)
dialog box will reappear.

—
File Convert [ Screen -> DXF ]
Frorm:
Project File: | Files\Pro-facetL Thdatabazehtest te "" Select |
Screen Mo B |'I "
T
D File: [DRF1 DRF [52kect]
Complete
Converting (100%) [«
Ywriting DiF [5300ne)]
Number Of Not Canvert Fill = 1 |’
Complete
I~
|| Careert I || Cancel |\| || Help |

(8)Click on the[ Est__| button to quit.

< DXF<->Screen Converter |

. DAF - Sereen
. Screen -» DRF

2-272

(Screen - DXF)

2.8.2 W Option

If the designated DXF file name
already exists, a prompt will
appear, asking whether the new
name should overwrite the old

name. When the button

is clicked on, the new name will
overwrite the old one, and when

the button is clicked on,

the new name will not overwrite
the old one.

Thiz DF file slready exists!

Do you want to ovenwrite?

o =0

To convert another Base screen,
DO NOT stop here; rather, start
again from step (3).
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B DRAWING APPLICATIONS - CREATING and USING SCREENS

L T Editor provides various screens for specific purposes
(for example: for creating marks and images), in addition to the

Base screens which are the fundamental screen used for all drawing modes.

Other screens can then be loaded onto Base screens as libraries.
This chapter describes the procedure for creating these screens and their

applications.
31l CreatingaMark: theMark Screen
32 Creating an Image: the Image Screen

3.3 Window Display: Window (U) Screen and Base (B) Screen
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Chapter 3 - DRAWING APPLICATIONS

m Creating a Mark: the Mark Screen

Create amark (dot pattern) on a“Mark” screen. Using the [Draw] menu -
[Load Mark] command, you can load the created Mark onto a Base screen.

Usage Pattern

Draw a Mark
by turning on/
off each dot.

Save the Mark

[Screen] -
or screen.

[New]
Click on to open a Mark screen.

General description of the Mark screen:

Editing
Tool Bar PRI EE k
_ [emwmni ] ~ Mark
Drawing = drawing
Tool Bar il area of 48 x
_ Origin | 48dots.
Indicates the g This area is
size of the o
=] composed
mark loaded a i
] of 6 (verti-
on the base |
e  cal)x 6
screen (1 x 1) = (horizontal)
vl blocks
(Each
block: 8 x 8
Displays the dots)
current
[2[Clo [a[E[6 [G[9[I KTk L[ LIWN[A]6 [ R]S [TTLI0G IV WIX]
cursor — T T Ee T

coordinates,
based on the

origin (0, 0) Screen capacity

B Drawing Tools

The Drawing Tool Bar icons and their corresponding drawing objects are as

follows:
Icon Drawing Tool Description
Dot Specifythe ON/OFF status of each dot by clicking on
0
each dot or dragging the mouse within a specified area.
L Specifythe start and end points of a line and draw a line
ne

by clicking on desired points.

Square (Rectangle)

Filled square
(Filled rectangle)

Draw a square or rectangle by clicking and dragging to
the desired size on a diagonal axis.

Circle/Oval

Filled circle
(Filled oval)

glielcliElislia

Draw a circle or oval by clicking and dragging to the
desired size on a diagonal axis.

3-2
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3.1 Creating a Mark: the Mark Screen

lcon

Drawing Tool

Description

Fill in an area with a desired color by clicking in the area

@ Fill o

. (enclosed within lines and shapes).

E Text Enter the text to be displayed in the mark drawing area.
Ca'iigfa':gark Select a Mark from the Mark Library

Register Mark
Library

Register a created Mark as a Mark Library.

W Editing Tools

The Editing Tool Bar icons and their corresponding functions are as follows:

Icon Editing Tool Description
Used to delete an entire Mark screen and store itin the
Cut clipboard. Using the [Paste] command, you can then
paste the Mark screen onto another screen.
. Used to copythe data of the selected Mark screen in the
Copy .
clipboard.
— Used to paste the data temporarily stored in the
E Paste ) )
= clipboard onto a desired place.
4 Duplicate Used to duplicate a Mark screen’s specified area.
@ Delete Used to delete a mark.
— Und Used to cancel the command executed immediately
nao . .
ks before, and return to the previous condition. (Undo)
p— Used to redo the command canceled with the [Undo]
) Redo
. command. (Redo)
Used to mowve the dot pattern symmetrically relative to
,ZF Mirror X the vertical axis. The synmetry axis is the vertical line
that divides the screen into two equal sections.
Used to mowe the dot pattern symmedtrically relative to
Tp Mirror Y the horizontal axis. The synmetry axis is the horizontal
line that divides the screen into two equal sections.
Turn

counterclockwise

Used to turn the Mark counterclockwise by 90°.

Turn clockwise

Used to turn the Mark clockwise 90°.

Reverse

Used to reverse the white/black area of a Mark.

ERIENEE

Transparent/
Background color

If no dots are turned ON in a block (8 x 8 dots), this block
becomes transparent.
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B Mark Drawing Area Structure

The mark drawing area has the following structure. When you edit a Mark,
you can use thisfor your reference.

—— |+ Rotation Center Point
Orlgln\\-\. % :
\+/' T
+
Mirror ¥ Axis
Mirror X Axis

@ Drawing a Mark ]

When drawing amark you can use LT Editor’s standard drawing functions.
Here, the procedures for using each function are described.

B Drawing with Dots

You can draw aMark by turning ON/OFF each dot. When you click the left
mouse button in the Mark drawing area, each dot turns ON (white). When
you click the right mouse button in the Mark drawing area, each dot turns
OFF (black).

A Mark is created with dots, and displayed in ablock (8 x 8 dots). If at least
one dot isturned ON in a block, the whole block is displayed when the
Mark screen isloaded onto a Base screen. In this status, the ON dots are
displayed in the current display color (Fg), and the OFF dots are displayed in
the background color (Bg).

- N
< This dot is ON.
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B Freechand Drawing

PROCEDURE

REMARKS

(1) Select the[Draw] menu - [Dot] command, or click on

the icon.

(2)Draw aMark by clicking on each dot or by dragging
the mousein the Mark drawing area.
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B Drawingaline

PROCEDURE REMARKS

(1) Select the [Draw] menu - [Line] command, or click

on the icon.

(2) Click on a start point in the mMark drawing area
and drag the mouse.

(3) Click the end point in the Mark drawing area. If you pressand hold the key
A lineis defined. in step (2), you can draw aline at

an angle of 0°, 45°, and 90°.
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Creating a Mark: the Mark Screen

B Drawing a Square (Rectangle) or Filled Square (Filled Rect-

angle)

PROCEDURE

REMARKS

(1) Select the [Draw] menu - [Square/Rectangle] or
[Filled Square/Rectangle] command, or click on the

or icon.

(2) Click on a point (a) and drag the mouse on a diago-
nal axisin the Mark drawing area.

:
H

(3) Click on theend point (b).
A square or rectangle is defined.

IENEE NN EEEEEEE NN

:,]II\.JIIIIIIIIIIIIIIIII

(=3
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B Drawing Circle (Oval) or Filled Circle (Filled Oval)

PROCEDURE REMARKS

(1) Select the [Draw] menu - [Circle/Oval] or [Filled
Circle/Filled Oval] command, or click on the[o] or

icon.

(2) Click on a point (a) and drag the mouse on a diago-
nal axisin the Mark drawing area.

Y
ta
(3) Click on the end point (b). If you pressand hold thelCtrl]key in
A circle or oval is defined. step (2), you can draw acircle.
a F ey
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B FillingaMark

3.1 Creating a Mark: the Mark Screen

PROCEDURE

REMARKS

(1) Select the [Draw] menu - [Fill] command, or click on

the icon.

(2)Click insdethe areato befilled.
The specified areawill befilled.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

If you click on aline, the filling
mode cannot be executed. Be sure
to click inside a completely en-
closed areq, if you do not, the en-
tire Mark screen may befilled.
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B Entering Text

The " Text” mode allows you to enter text on aMark screen.

PROCEDURE REMARKS

(1)Select the [Draw] menu - [Text] command, or click

on the icon.

(2)Enter character(s) and select either 8 x 16 dot font or
Windows font.

Text

B

£ windaws Font

K, H Cancel H Help ]

(3)To usethe Windows font, click on the and
click on the button.

Font: Font style:
Brial Black Regular

=\ | Italic
Bold
Bold [talic

B Bookshelf Spmbal 3
B Comic: 5ans M5 E

= 5 ample

AaBbYyZz

Script:
Western id

(4)Click onthe[ _ok__]button.

An outline corresponding to the entered character(s) will

Text |
O st
Josial Black |

mk | Cancel || Help
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PROCEDURE REMARKS
(5Y)Movethebox tothedesired position wherethechar- | If you move the character pattern
acter pattern will be displayed. to a position where another char-
The character patternisdisplayed in the position where | acter pattern has already been cre-
you click. A Mark can be created using this pattern. ated, the new pattern will overwrite

the existing pattern, and the exist-
ing pattern will be deleted.
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@ Editing a Mark ]

To edit aMark, you can use the following editing functions. This section
describes the operating procedure for each function.

B CuttingaMark

The “Cut” command del etes the data of the selected screen and storesit in
the clipboard™. (The deleted screen can be moved to another screen, but
cannot be moved to the original screen.) The “Cut” command can be ex-
ecuted for the entire screen.

PROCEDURE REMARKS

(1) Select theoriginal Mark screen to be cut.
This description assumes that several screens have al-
ready been opened.

(2) Select the[Edit] menu - [Cut] command, or click on | 15 qaletethe Mark screen, perform

the[#]icon to storetheMark datain the Clipboard. | seps (1) and (2) only.
Data of the original data screen will be cut.

[WRM?: Untitled1

*1 When the [ Copy] or [Cut] command is executed, the copied or cut data are temporarily
stored in the clipboard.
When you execute the [ Paste] command, the data stored in the clipboard will be pasted
to the selected position.
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PROCEDURE REMARKS

(3) Select themark screen (destination) to which the se-
lected Mark screen will be pasted.

(4) Select the [Edit] menu - [Paste] command, or click

on the[@]icon.
Data of the Mark screen will be pasted.

] [0l x|
B|
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B Copying a Screen

The selected screen data are copied in the clipboard. Unlike the [Cut] com-
mand, the original screen datawill not be del eted.

A
! To copy a Mark into the original screen, usethe [Duplicate] command.
Important

PROCEDURE REMARKS

(1) Select the original Mark screen to be copied.
This description assumes that several screens have al-
ready been opened.

(2) Select the[Edit] menu - [Copy] command, or click on
the icon to storethe mark in the Clipboard.

(3) Select the Mark screen (destination) to which the se-
lected Mark screen will be copied.

(4) Select the [Edit] menu - [Paste] command, or click

on the icon.

Datawill be copied from the original Mark screen and
pasted onto the destination Mark screen.
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B Copying a Specified Range : Duplication
A specified range in the Mark drawing area can be duplicated by dots.

PROCEDURE REMARKS

(1) Select the [Edit] menu - [Duplicate] command, or

click on the icon.

(2) Specify the copy rangein the same manner asdraw-
ing a square/rectangle.
A box appears, indicating the specified copy range.

Important
(3) Movethebox to adesired position wherethedatain | If you copy a mark into the
the specified range will be copied. position where another Mark
Datain the specified range will be copied to the position | has already been created, the
where you click. new data will overwrite the

existing data, and the exist-
ing data will be deleted.

You can continue the copy mode
until you click the right mouse but-
ton.

(4) To quit the copy mode, click the right mouse button.

e
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B DeletingaMark
Delete the Mark, or a partion of it.

PROCEDURE REMARKS

(1) Select the [Edit] menu - [Delete] command, or click

on the icon.

The procedures for deleting part of aMark or deleting a
whole mark are separately described:

[Deleting Part of a Mark]

(2) Select [Partial Clear] and click onthe| ok [but-
ton.

Clear Mark Screen

3*) Patial Clear
2 Clear All

ak. % Cancel

(3) Specify therangeto be deleted in the same manner
asdrawing a squar e/rectangle.
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PROCEDURE REMARKS

(4) Click in therangeto be deleted.
The specified range will be deleted.

[Deleting the Entire Mark]
(2) Select [Clear All].

(3) Click onthe[ ok |button to delete the entire

Mark.
The entire Mark will be deleted.
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B Mirror X, Mirror Y

The“Mirror X” and “Mirror Y” functions move a Mark symmetrically
relative to the vertical and horizontal axis, respectively.

To execute the “Mirror X” and “Mirror Y” functions, click on the
icon, respectively.

Example) Mirror X

il M?: Untitled1 []M2: Untitled1
[ 1
Example) Mirror Y
I M2 Untitled] o [M?: Untitled1
[=]
m|

B Turn Counterclockwise [O], Turn Clockwise [N]

The “Turn Counterclockwise’, “Turn Clockwise” functions turn the mark
counterclockwise and clockwise 90°, respectively.
To execute the “Turn Counterclockwise” and “ Turn Clockwise” functions,

click on their respctive the icons respectively.
Example) Turn Counterclockwise

[ M2: Untitied! o [ WM Untitied
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B Reverse

This function reverses the white and black areas. In the reverse display
mode, al ON dots are turned OFF, and all OFF-dots are turned ON.

To execute this function, click on the(j«[| icon.

Example)
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B Transparent/Background Color

If no dots are turned ON in a block, this block becomes transparent. When
thisfunction is set to “Background color”, a block without any ON dotsis
displayed in the background color (Bg).

PROCEDURE REMARKS

(1) Select the [Edit] menu - [Background Color] com-
mand, or click on the[H]icon.

(2) Click in theblock to bedisplayed in the background
color.
The border line of the specified block is changed. Every
timeyou click in the block, the color setting is switched.

(3) Click theright mouse button to register the above
setting.

B Display When Called Up to a B (Base) Screen

When thisfunction is set to “ Transparent”:
If at least one dotis ON in a
block, this block is dis-

These blocks
contain no played in the background
ON-dots. color.
[> The block with no ON dots
becomes transparent, and

you can see the objects on
the base screen.

When thisfunction isset to “Background color”:

i

- The block with no ON
|:“> dots is displayed in the

background color.

i

i

i
i B
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B Canceling a Command: Undo

3.1 Creating a Mark: the Mark Screen

Thisfunction is used to cancel acommand and return to the previous condi-

tion immediately before the command

was made.

[Undo] is only effective for the command immediately beforeit.

PROCEDURE

REmMARKS

After deleting acircle unintentionally:

(1)Select the[w]icon.
The deleted circleis restored, and the screen returns to
the previous condition.

B Redo Command

Thisfunction is used to redo the command canceled with the [Undo] com-

mand.

The [Redo] command is effective only for the command immediately before

it.

PROCEDURE

REmMARKS

After deleting acircle, you have selected the icon to
return to the previous condition, but you realize that ac-
tually, the circle must be deleted:

(1)Select the[[e#] icon.
The screen returns to the condition where the circle has
been deleted and harmony is restored.
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@ Registering and Placing a Mark Library Item ]

You can register amark created in the mark drawing area and the registered
Mark can be loaded whenever required. The Mark Library Item (mark list)
can be saved asaMark library file (MRK file). The LT Editor enables you to
manage MRK files independent of project (LTE) files. Thisfunction alows
you to use the sameMmark for several projects, since you can select a
desired Mark while checking the image displayed in the browser.
Registration, placement, and other editing operations of Mark Library are
performed in the same manners as those of the standard Libraries.

2.4 Libraries

%Ikv\ote: LT Editor has preemade MRK filesin correspondence with the 1 SO7000
2] SeriesMarksand symbols.

Parts List Manual

Drawing symbol

number MRK file name Title
0001-0200 IS07-1 0001-0200
0201-0400 1S07-2 0201-0400
0401-0600 IS07-3 0401-0600
0601-0800 IS07-4 0601-0800
0801-1000 IS07-5 0801-1000
1001-1140 IS07-6 1001-1140
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E Creating an Image: the Image Screen

When you convert image data (bitmap = BMP file and JPEG: JPG file) read
with an image scanner into an Image screen for the LT series, the image data
can be displayed on the LT series panel. Even though your original image
file can be up to 256 colors, since the LT can only display in 64 colors, the
file's colors will be converted to the LT’s 64 colors.

You can load an Image screen onto a Base screen, Trend Graph screen, or
Keyboard screen by selecting the [Draw] menu - [Load Screen] command.

2.2.10 Load Screens

To convert image datainto Image screen datafor the LT series, use the
[Utility] menu - [Convert Image] command.

* Thelmage Screen cannot be opened with the Screen Editor.
* You can also perform the conversion in the screen editor by selecting the
[Draw] menu - [Convert/lmage] command.

2.3.18 Convert (Import) I mage

* Image screens cannot be edited. To edit the image data, you must use the
original file, and then convert thisfile into lmage screen data.
The Image screens can be checked on the screen list.

4.1.1 Listing/Copying/Deleting Screens
e Thiscommand can convert image data of up to 800 x 600 dots. Note that

any portion that does not fit into the LT screen will be cut off before conver -
sion.

@ Image Conversion ]

Convert image data (bitmap: BMP file and JPEG: JPG file) created with
other editor software or read with an image scanner into an Image (1) screen
for the LT series.

1 bit 4 bits 8 hits
Number of colors 2 colors 16-level 256-level| 16-bit | 24-bit | 32-bit
(black & |16 colors| gray |[256 color| gray color color color
white) scale scale
Windows BMP/DIB O O O O ) @) ) )
Windows
@] @]
BMP/DIB(RLE4) |*.BMP
Windows BMP/DIB o o
(RLES)
JPEG *JPG - - - - O - O

With a color Image screen, when the data volume becomes large the LT
series’ display speed isincreased. With a monochrome Image screen, the LT
series display speed is dlightly lowered, but the data volume can be re-
duced. Select a color or monochrome Image screen according to your pur-
pose.

If the data volume istoo large to be displayed on one screen, the converted
datawill be divided into several screens (up to nine screens) of 50 Kbytes
each.
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A - Compressed BMP files cannot be converted.

] - Make surethat the original image data’slongitudinal dimension (* X”
for the horizontal type, and “Y” for thevertical typein thefigure
below) isa multiple of “4” for color data, or a multiple of “8” for
monochrome data. Otherwise the fractional data will be deleted from
theright edge of the screen after conversion.

]
Important

) LT T
L S
5 T LT
> - = > 0
X (Horizontal) X (Horizontal)

- If thelongitudinal dimension of the original image data islessthan
“4” for color data, or lessthan “8” for monochrome data, theimage
data cannot be converted.

B Converting/Placing an Image: [Sour ce]

Specify the image file to be converted. The information on the specified
bitmap file will be displayed.

Enter the name of Used to select

the image file to Convert Images to Image Screens B

be Convert-ed, or Sowrce | Effects [ Destination | I)heeclgnna\./geel’tglde to

select the image Image File

file from the file I | | Browse..

list by clicking on  Soures Imag

the [Browse] Colors

button E |_—Displays the

Displays informa Size [bytes] /// image of the

tion on data No image Icncq)ﬁ?/gr?(la?j to be

colors (e.g. 16 —_— L

Co|0|’s'(2596 Dimensions _Howevgr, t.hIS

colors) image is different
from the image

Displays the size that will be

of the image file [ cese |[ gwwer |[ wee ||  displayed onthe
LT series

Displays the

dimensions Used to register the above settings to execute the

(horizontal x Image conversion. If you save the converted Image

vertical) of the data, the Image screen of the screen number specified

image data in [Screen Setting] will be created
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B Converting/Placing an Image: [Effects]

Specify the brightness, resolution, blinking, compression, and mirror func-
tions for the converted image data.

Used to set the Convert Images to Image Screens

brlghtness and Source|| Effect estinat\on]

display quality o L Used tO_ man-u ally

automatically - Special Efec set the individual
Il Brightness options of the

brightness and

Diitheriry Dither Method Mirrar . .
Hoireing - FIRE - display quality

When 256-colors {2 Simple £ Vetical

are selected 0 Complex £3 Horzontal

“ B||nk” Cannot \Q]Blink g][:ompless

be selected

IEEEIEEEEE

@ Use Default Effects

When you specify Use Default Effects, the original data will be automati-
cally converted into the image data with the optimum brightness and display
quality.

@ Brightness

Used to convert bitmap data according to the brightness level. The reference
value can be changed between levels“0” and “15”. A larger value indicates
abrighter image, and a smaller value indicates a darker image.

@ Dithering
Used to set the converted data’s display quality.

€ Blink
Used to make the converted data blink.

& Compress
Used to compress the original image data during conversion.

€ Mirror
Used to replace the original image data symmetrically relative to the X-axis
or Y-axis during conversion.
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B Converting/Placing an Image: [Destination]

Import Image

Select the number Source] Effectz | Destination |
of colors of the ~ Image Color—— S - Enter the title of
converted image o4 : j the Image screen
file o]

£ oy Size

0 256 Caly

= Screen Layout

First Screen T~ _. .
Enter the screen // Displays the size
number of the | of the converted
Image screen screen
Select a destion
to save the
image screen [ Peee [ cowd |[ cowen [ Hew

@ Screen Color
Select the type of the converted image file: Monochrome or 8-colors. The
screen size and the number of screen divisions vary depending on the se-
lected type.

@ First Screen
Enter the screen number of the Image screen. If no screen number is speci-
fied, an Image screen of the currently displayed screen number will be
created.

@ Screen Title
Enter the title of the Image screen. Even if the converted data are divided
into several screens, only one title can be specified for one original file.
@ Size
Displaysthe size of the converted screen.
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B Converting an Image

Convert an image file into Image screen data.

PROCEDURE

REmMARKS

(1)Select the[Utility] menu - [Convert Image] command
of the Project Manager.

(2)Click on the button, and select aimagefileto

be converted.
The color type, data volume, screen size and image data
of the image file will be displayed.

Convert Images to Image Screens

Source | Effects || Destination |

Image File

|E0mputer_picture.bmp || I Hrowse... i

=5ource Imag

Calars
[ =
Size [bytes)

Dimenszions

|| Cloze ||| Corvvert ||| Help |

(3)Specify the conversion parameters.
If the data volume is too large to be displayed in one
screen, the image data will be divided into several Im-
age screens.

Convert Images to Image Screens

| Sowrce]| Effects | Destination |

Diithering Dither bethod Mirrar
%0 Crude %) None
i Simple i Vertical
20 Complex 20 Harizontal

g Elirik: Q] Compress

|| Cloze

| || Corvwert | || Help

If the original data are mono-
chrome, these conversion param-
eters cannot be specified.
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PROCEDURE

REMARKS

(4)Enter the screen number and title of a new Image,
and designate Screen Type.
If you do not set atitle, thetitle of the original BMPfile
will be specified.

Conveit Images to Image Screens

Souce | Effects]| Destination |

=ImageEuI0r= Screen Title
20 onochrome
o a[obr vome
3 ATl Size
b 285 Tunloy
=S5creen Lapout
First Screen
=

il

|| Clase

(5)Click on the button to perform data con-

version.
The image data conversion starts. Then, the converted
image will be displayed.

||| Conwert ||| Help |

Convert Images to Image Screens

Source | Effects]| Destination 1

=Image Color:

Screen Title

Computer_picture. bm|

8 Monachiome

#2008 Color
0 B Enlay Size
12 256 Ealy
= Screen Layoul
First Screen
IE

” Close | ” Eunvell\J ” Help |
%

(6)If thedisplayed imageiscorrect, click onthe| S |
button.
An Image screen is created.

Image Screen Preview

(7) Click on the button to quit the conver-

sion mode.

Image Convert

@

Image -» Image Screen conwverzion
corpleted successfully

3-28

The number of colors specified for
[Screen Color] must be equal to the
number of display colors supported
by your LT series.

- If the number of colorsisdiffer-
ent, the display speed will below-
ered.

- Any colorsthat are not supported
withyour LT seriescannot bedis-

played.

If the same screen number already
exists, the system asksif you want
to replace the existing screen with
the one you are attempting to save.

If so, select ; otherwise,
)

Image Screen Conflict

Do pou wizh bo ovenarite
exizting Screens?

To cancel conversion, click on the

button.

When an image is converted by se-
lecting the [Convert Image] com-
mand from the [Draw] menu on the
Screen Editor, pressing the [Place]
button allows the converted image
screen to be placed.

2.4.18 Convert (Im-
port) Image

Select the [Load Screen] command
from the [Draw] menu to place the
converted image.

2.2.10 Load

Screens
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Chapter 3 - DRAWING APPLICATIONS 3.2 Creating an Image: the Image Screen

@ Compressing/Decompressing an Image Screen ]

If the size of the Image screen islarge, you can compressit to reduce the
data size. The data is compressed to one-fifth the size of the source data.
The compressed Image screen data can then be displayed directly to the LT
series. With the compressed Image screen, however, the LT series’ display

speed will be slower.

PROCEDURE

REMARKS

(1) Select the[Utility] menu - [Compress I mage] com-
mand of the Project Manager.

(2) Select thescreen to be compressed or decompressed
from thelist.

The compression and decompression procedures are
separately described as follows:

[Compression]

(3)Click on the button to execute data com-
pression.
The process is finished when the word *“ Compressed”
appears.

No. Title.

Se  Stalus
1 4562 Clompressed > LTEdiorbmp Compasy
e

[Decompression]
(3)Click on the button to perform data decom-

pression.
The processis finished when the word “Norma” appears.

Mo See St Title

T 29350@ LTEdtor.bmp Eompiess

To compress an Image screen (bit
map data) of another project, select
the project.

1.2.2 m Selecting
an Existing Project

To select several screens, click on
the screen numbers while press-
ing the[shift] key.

To select a specified screen, click
on the screen number while
pressing the[Ctrl] key.
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3.3 Window Display: Window (U) Screen Chapter 3 - DRAWING APPLICATIONS
and Base (B) Screen

E Window Display: Window (U) Screen and Base (B) Screen

@ Overview of Window Display

Call up the windows registered on the Window Screen (U) or Base Screen
(B) and display them on the Base Screen (B).

Additional windows can be displayed on the LT screen when necessary.

Example: Make the settings for displaying abar graph by turning ON the
window display switch.

<LT Screen>
Turn ON the
switch
- " |
. . 0 , - 0 0
Window Display |[F <_ﬁ Turn OFF the Window Display E —= N
F switch
B2 B2
<LT Editor Screen Editor>
1)Registering awindow on the U Screen
Turn ON the
777777777777777777777777777 switch S
e N
il \}1\
777777777777777777777777777 Call up the bar A
0 h from U300 to
) ) 0 graph fro
Window Display E N B2 using a window
part.

B2 U300
Window Registration can be performed on the Window Screen (U) .

Specify the Window Parts to call up the windows registered on the Window
Screen (U) onto the Base Screen (B).

2.1.20 Window Parts, 3.3.2 Window Registration on the
U Screen

@ Global Window Display

Displays asingle window on all Base Screens (B) as agloba window. To
call up the window, make the "Global Window" settings on the OFFLINE
settings of the LT unit or on the [ System Setup] of the Program Manager in
LT Editor.

Each LT series User Manual, Global Window Setup

Trend graphs (T Screen and parts), Keypad Input Display and

,mp;ﬂa;, Logging Display will not function from the registered window.
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Chapter 3 - DRAWING APPLICATIONS 3.3 Wndow Display: Window (U) Screen
and Base (B) Screen

@ Window Registration on the U Screen ]

Call up awindow that has been registered on the Window Screen (U) onto
the Base Screen (B)

The window can be easily called up with the window part placed on the
Base Screen pasted to the Base Screen.

B \Window Screen

Usage Pattern |

[Screen] - [New Screen] - OK _ Create awindow.

[Part] — [Window Part] —  Specify the window. — Place.
or

=l

This section describes the procedure for calling up awindow display of a
bar graph onto B2, following the example in the section Overview of Win-
dow Display in 3.3.1.

PROCEDURE REMARKS

(1) Select [New] from the [Screen] menu, or click [ to
select [Window Screen]. The Window Screen (U)
opensand awindow areawith asquareframeisdis-

played.
MNew
Screen Type: ak
Baze Screen
oy S creer .

(2) Draw the bar graph tobecalled up totheB2 screen. | Click the border of the window
areaand eight @ will appear on the

Soeen Edit View Opion Diew Tegs Pars Special Liey Window Help

[oerlslzRIaa|r[e]-[sba][223BsoREW Sscreen. W|th the mouse, drag | tO

ﬂmwwDO@%MM%@@EWUM@EHME“Wmﬁ_ﬁﬂ

changethesize of thewindow area.

INEEPEBNMIOSFOELET |
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3.3 Window Display: Window (U) Screen

and Base (B) Screen

Chapter 3 - DRAWING APPLICATIONS

PROCEDURE

REMARKS

(3) Adjust thewindow area so that it surroundsthebar

graph.

Screen | Edit Wiew Opfion Draw Tags Pats Special Library Window Help

IEEEIN RN BRI T PR A Y

IDEEPHENMIOS§FOEEA0E |

(4) Savethe Window Screen (U).

Enter the " Screen Number" and " Title." Click the

Select the [Save As| command from the [Screen]
menu, or click [

o
Screen Type: YWindow Screen
Screen 200

Description JBﬁVGTBph |

button.

(5) Open the Base Screen (such asB2) to be used for the

window display.

(6) Select [Window Parts] from the[Parts] menu, or click

E.

3-32

ugymuoe%mmw@@HWUMH@mmmummu =
il U?: Untitled1*

The x coordinates for the window
display can only be set up in 8 dot
intervals, i.e. the cursor will snap
from one 8 dot unit to another. You
can set up the Y coordinates any-
where you wish.
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Chapter 3 - DRAWING APPLICATIONS 3.3 Wndow Display: Window (U) Screen

and Base (B) Screen

PROCEDURE

REmMARKS

(7) Select the window to be displayed from the " Win-

dow Number" field.

Specify the Window Control Address aswell.

Window Parts Setting [wil_001]

General Settingz ]

Description

“iindow Control Address

BityOM /OFF

. =~
Wwindow Numper |1 = pit1 Display Order

1 2R0k200

/“/ Place | || Cancel | ” Help |

2

(8)Click the [Place] button after setting all attributes.
The border of the window areais displayed on the draw-

ing area.

(9) Click on the position where the window is to be

placed.

Note: The addressto be entered varies depending on
2] your LT and PLC type. Note that the sample
screen in thismanual isjust one example.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

[Window Control Address|
15 02 01 00 Bits

|| L]
JSlhow

Changing the

order of window [O]: Hide the
layers window

[0]: Touching the [1]: Show the
window will change ~ window

the order of the
layer.

[1]: Touching the
window will NOT
change the order of
the layer.

A maximum of one global window
and two local windows can be dis-
played ssimultaneously on asingle
Base screen.

If the specified position overlaps
the objects on the Base Screen, the
objects are hidden while the win-
dow is displayed.
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» SCREEN AND PROJECT MANAGEMENT

A syou usethe LT Editor, file management work such as copying and
deleting created screens and projects will increase, thereby improv-
ing your work efficiency. This chapter covers “Information Management of

your data.”

A3 Project Compression/Decompression
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Screen Editing
Project Editing

Information Display
A5 . Table Editor Character Strings



4.1 Screen Editing

Chapter 4 - SCREEN AND PROJECT MANAGEMENT

m Screen Editing

This section describes the commands used to edit a screen, such aslisting
screens, and copying/del eting a specified screen.

@ Listing/Copying/Deleting Screens ]

You can list the number, size and title of all existing screens for each screen
type. You can also print out this screen list.

9.1 Print Settings

W Reference .4

Usage Pattern | _
Select a Screen list
[Screen] -  [Open Screen] - -  appears.
Screen Type. Copy or delete a
or desired screen.
Click on .

W Listing Screens

Thisfeature lists screens for the current project.

PROCEDURE REMARKS

(1) Viathe Screen Editor, select the [Screen] menu -

[Open Screen] command, or click on the =

icon.

(2)Select the type of screensto belisted.
The screens will be automatically listed.

By checking the [Preview] check
box, the selected screen image can

T be viewed in the dialog box.
Project File: Factory A e T
Screen: &
e
JMalk Screen |L|
B3z Screen Y

b ark Screen
Image Screen W

By changing the[Open Screen|] dia-
log box's size, the screen list dis-
play area can be enlarged so that
more screens can be displayed.

L

Factory & ke

Soreen M

o
=

| Pl

Copy

Change

To print the screen
list, refer to 9.1.1 M Printing -
[Project Information] Tab.

i

Delete:

o
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Chapter 4 - SCREEN AND PROJECT MANAGEMENT 4.1 Screen Editing

B Copying Screens

This feature copies a screen from the current project file.

PROCEDURE REMARKS

(1) Viathe Screen Editor, select the [Screen] menu -
[Open Screen] command, or click on the icon.

(2) Select a screen to be copied from thelist, and click

on the button.

Project File: Factory & Ite
Scieen: B |1 i
—
2 Alarml T
3 Switch? - k
Screen Tupe:
#

(3) Specify the Start Screen Number of the copy desti- | To select several screens simulta-
nation and copy count. Then, click onthe| oK neously, drag the mouse down the
button list, or click on the target screens

: . . while pressing your PC's key
The screen will be copied for the designated number, or Key.

consecutively from the Start Screen No.

Screen Copy

When selecting multiple screens si-
multaneously, copy will be per-
formed only onetime.

Start Screen Number:
1 =

Copy Count

A
/A
|

Imp:rtant

Once the [Copy] command is
performed, it cannot be un-
done.
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4.1 Screen Editing Chapter 4 - SCREEN AND PROJECT MANAGEMENT

W Deleting Screens
This feature deletes a screen from the current project file.

PROCEDURE REMARKS

(1) Viathe Screen Editor, select the [Screen] menu -
[Open Screen] command, or click on the|[|icon.

(2) Select a screen to be deleted from thelist, and click

on the button.

[OpenSeeon | _
Poisci Fie:  Fatay Ale To select several screens simulta-
e Swi:hfz neously, drag the mouse down the
2 list, or click on the target screens
Sl while pressing your PC's key

or [cui] key .

Z] Preview
Screen Type:
Base Screen d

o /mp:rtant
& Selected Screens will be deleted | Once the [Delete] Command iS
lm performed, it cannot be un-
done.

Open Screen

Project File: Factary & ke

3 Switch2 oY
e
Screen Type:

EBase Screen d
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Chapter 4 - SCREEN AND PROJECT MANAGEMENT 4.1 Screen Editing

B Changing Screen Numbersand Titles
Thisfeature dlows you to change screen numbers and titlesin the current project file.

PROCEDURE REMARKS

[Changing only One Screen]
(1) Viathe Screen Editor, select the [Screen] menu -

[Open Screen] command, or click on the|[E|icon.

(2) Select a screen to be changed from thelist, and click

on the|[ Change |button.
Prajact File Factary & ks
Screen ]
1 Swatch 1
2 Alarnl
3 Switch?
I Preview
Screen Typs
Base Screen F
(3)Change the screen number and title, and then click A
onthe[ oK | button to delete the screen. m
Important
fename ] If any existing screen num-
Project File: Diigital Plant m . . . .
: K ber is specified, it will be
Screen Type: Base Screen ancel ]
Screer: @ H
overwritten.
Drescription:
1 ator 1
7 Flart Graph
The currently open screen cannot
be changed.

2 Alarm1
3 Switch2
4 Praduction Alarm2
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4.1 Screen Editing Chapter 4 - SCREEN AND PROJECT MANAGEMENT

PROCEDURE REMARKS

[Changing Multiple Screens at a Time]
(1) Viathe Screen Editor, select the [Screen] menu -

[Open Screen] command, or click on the icon.

(2) Select multiple screensto be changed from thelist, | To select multiple screensat atime,

and click on the[[ Change | button. drag the mouse through the desired
screenson thelist, or click on those

screens while holding the[shift| or
key down.
The currently open screen cannot
be changed.
&

(3) Specify the start screen number at the destination,

and then click onthe[ ok | button.

“13" is specified here. The difference between the start
The specified number comes to the top, and the subsequent | screen number at the destination

numbers are changed automatically with increments of off- | gnd that at the source istaken asan

set values. offset value. Since the start screen
Fp—r— [<] number, 1 isto be changed to 13
Start Soreen Number: N here, the offset valueis 12. This
[caneel | offset value is added to the subse-
quent screen number 2 and 5, which

is then changed to 14 and 17.

U

Project File, Factoy & lte

Screen B

Ope

13 Switch 1
15 Switch2
16 Praduction Alarm2

Copy

i

Delete

Cl

w
=150
I
2
=z
bl
= !
==
E
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Chapter 4 - SCREEN AND PROJECT MANAGEMENT 4.1 Screen Editing

@ Copying Screens from Other Projects ]

Screens created in any project file other than the currently open one, and
other settings can be copied to the currently open screen.

%Ikv:)te: » To copy alogic program from other project files, import alogic program
X file (*.will) with the L ogic Program Editor.

Logic Programming Operation Manual
¢ The contents of Alarm Editor and Text Editor tables can be shared between

Projects by importing/exporting ALA (alarm data only) or CSV files.
4.5.2 B Importing/Exporting CSV files, 5.1.4 Alarm Import/
Export

W Specifying Itemsto Be Copied

After selecting aproject file as the copying source, specify the items you want to copy,
such asthe screen areato be copied and other settings, and a copying method.

]

Screen Copy

= Sour D estinatior
SpeCIfy the screen |B Manufacturing System H" Select | |A Manufacturing System_"
i W _ T .
areato be cqpled_ oo B Staifrom [T =] Specify the start
from the project file —| Fan [ :
) T o [ screen number in
at the copying T o
cource Saaen e Coe | the project file at the
urce. Al 2 Mo copying destination.
13 Internal Settings The Spec'ﬂed data
=Intemal Setting - Wl” be COpIEd tO thIS
Specify the settings ?st‘e:'”fj_’“‘a"m B e and subsequent
other than the B @aua\,;,:n,ﬁemgg Mege 1) Dot Loging Settings screens.
screen to be copied — | = oseiptFuncions F Tt Table et
from the project file 9 Quemte 1 Merce
. Global D-Seript
21:Otr:‘iecopylng 125 Ovennrite 9 Merge
urce.
€ Source

The project file selected as the copying source is displayed. Specify the
screen area to be copied and a screen type. If you are not copying a screen,
but other settings only, select [Internal Settings].

& Destination

The current project fileis displayed. When copying a screen from another
project file, specify the start screen number in the project file at the copying
destination to start copying the screen.
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4.1 Screen Editing Chapter 4 - SCREEN AND PROJECT MANAGEMENT

@ Internal Settings

Select the items to be copied among the global settings for each project file,
which are not dependent on any screen. Also specify whether the settings
existing in the current project file are deleted by overwriting them or merged
(added) with additional settings without deleting them. If "Overwrite" is
specified, the settings at the copying destination will be deleted and all the
settings at the copying source will be copied. If "Merge" is specified, the
settings at the copying source will be copied while those at the copying
destination are |eft as far as possible.

When such amerge is made using [Window Registry], [D-Script Functions],
or [Filing Data], you will be prompted to confirm whether any identical
existing number or function name is to be overwritten. When the combina-
tion is made using [ Data Sampling] or [Global D-Script] al the settings will
be merged.

B Copying Screensfrom Other Projects

PROCEDURE REMARKS

First, open the copy designation project.

(1) Select the Project Manager’s[Utility] menu - [Screen
Copy] command.

(2) Select the project fileto be copied (original project | To select a screen located in a dif-
file) from the screen list, or enter the target project | ferent folder, you must change to

name, then click on the button. that folder.
1.2.2 W Selecting
Lok, [ 66 dwsse FlE] an Existing Project

The currently opened project can-
not be selected.

Filename:  [B Manutacturing System e | T gpeny. |

Pl [Windows et s e ) [ coen ] When you double-click on the
Dheseription © ‘AManulacluling System " proj ect name %I ected i n Step (2),

—— ! ou can skip the[ Gren ] com
Dievice/PLE Type: [ OMRON THERMAL NED SERIES | y p =PeEn

mand.
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Chapter 4 - SCREEN AND PROJECT MANAGEMENT

4.1 Screen Editing

PROCEDURE

REmMARKS

(3) Enter the screen type and screen number of theorigi-

If you select [All], al screensfrom

nal screen. the current project will be copied.

Those screens corresponding to the specified initial
screen number through the final screen number will be
copied.

Screen Copy

]

Sourc estination

B Manufacturing System_”" Select |

A M anufacturing Swstem. "

Lol
= Start From ' =
%) Screens From (1 ~—}

=

Screen Type:

Copy

Cloze

Help

i

Mark Screen =
Image Screen

SE
“Window Screen

Sytem TRfamatan Fy g Data
] it b4
Data Sampling o \-'erw.n = g £ige
15 Ovenwite 7 Merge [rata Loging Settings
D-Script Functions Text Table data

&) Ovenvrite 123 Merge
Global D-Seript
%5 Ovenarite 9 Merge

(4) Enter the screen type and screen number of the des-
tination screen.
The screens will be copied to the Destination project,
starting from the specified initial screen number onwards.

= Source Destinatior

[E Manufacturing System || Select | || [ Manufacturing System |
2l

Start Fram |1
%) Screens  From |
s
To Co |
P
Screen Type, 'E
: | o |

IMalk Sé:raan
_ mage Screen
iy Hrivotas
Data Sampling 12 Overarite 120 Merge
183 Overprite  £20 Merge Data Loging Settings
D-Seript Functions Test Table data
18 Overvrite £25 Merge
Global D-Script

8 Overwrite 19 Merge
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4.1 Screen Editing Chapter 4 - SCREEN AND PROJECT MANAGEMENT

PROCEDURE REMARKS

(5) Select theinternal settingsto be copied, and specify
a copying method (overwrite or merge).

Screen Copy
=Souic Destinatior
|E Manufacturing System, |H| Selact | ‘A Manufacturing Sustemn, ||

[

24l _
Start From |1 i
iEh Soreens From

Ta Copy
‘ Close

[1

Screen Type:

:

120 [Base Soreen
Mark Screen —
SyEtEm TArarmation Filing Drata

D sta Sampling 18 Overvrite £ Merge
) Dverwrite 23 Merge Data Loging Settings

D-Seript Functions Text Table data
0 Ovenwrite 23 Merge
Gﬁua\ D-Seript
i) Ovenwite 9 Merge )

TMage 5 Creen
wdindow Goreen

(6) After confirming your selection and designation,

click on the button.

If there is any screen of an identical number or function
name, you will be prompted to conform whether or not to

overwriteit. Selecting Yes will overwrite such a
screen or function name, and selecting Mo will
proceed to the next question. If Yes gl IS selected,

all the screens or settings will be overwritten. If

Mo Al is selected, only the screens or settings that

do not exist at the copying destination will be copied.

Screen Copy
=Sourc Destinatio
[E Manufaciuing System || Seleet | || [ Manufactuing System |
28l
_ Start From [1 JiZ
) Sermens From -
i
i =
Sereen Type L
Close
Al ]
0 [Base Sereen
Mark Sereen -
Image Sereen
=Intem
Window Soreen -
System Tfomaton [ Fiing Data
5 Ovenwit M
Data Samplng £ Ovenwite 4 Meige
) Dvermiite 9 Merge Data Loging Settings
D-Script Functions Text Table data

) Oveite £ Merge
Global D-Seript
1) Overniite 4 Merge

@ Destination Image screen number 1 existe. Do you want to overwrite 7

|x85| | Vel ,i| Mo I | Nal ] ‘ P ]
n

4-10 LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



Chapter 4 - SCREEN AND PROJECT MANAGEMENT

4.1 Screen Editing

PROCEDURE REMARKS
(7) Click onthe[_oK__|button toexit the screen copy A
mode. 1
The number of screens copied will be displayed inthe |  jmporant

dialog box.

Screen Copy

Bagze Screens Copied: 0

Mark Screens Copied: 0

Image Screens Copied: 0

Window Screens Copied: 0
Syztem Information Copied: 1

[ ata Sampling Information Copied:0
D-Scipt Functions Copied:0
Global D-Secript Copied: 0

[ata Logging Settings Copied.0
Data Text Table Setting: Copied.0
Filing Information Copied,0

(8) Click onthe|[ Tis== |button.

Screen Copy
= 5 oL Drestinatior
|B M anutactuing System_"” Select | |A M anufacturing System "
Dl Start From }
%) Screens  From |1 I~
To =
- Copy
Screen Type: i o
o
Help
Mark Screen =

Image Screen
“iindow Screen
EE

= Intem

sy

Filing D ata

D ata Sampling % Overwite  #2) Merge
1) Overwrite 9 Merge Diata Laging Settings

D-Seript Functions Text Table data
%) Ovenwrite 123 Merge

Global D-Seript
% Ovenvrite ) Merge
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After replacing the screens,
you must re-enter all Parts de-
vice addresses.

To subsequently copy any other
screen in the same project file, re-
peat the procedures starting with

step (3).
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4.2 Project Editing Chapter 4 - SCREEN AND PROJECT MANAGEMENT

Thisfeature allows you to delete a project file.

PROCEDURE REMARKS

(1) Viathe Project Manager, select the [Project] menu -
[Delete] command.

(2) Select the project to be deleted from the screen list, | To select a project located in a dif-
or enter the desired project'sfile name. Then, click | ferent folder, change the directory

on the button. to that folder.

1.2.2 ® Selecting

Delete Bll . . «
an Existing Project

Look i J@ database JZ” . ' 1

When you double-click on the
project name selected in step (2),

you can skip the[[ Delet=D]_] com-

mand.

File narne: JA tanufacturing e

| " Delete(D)
Files of type: JWindnws Project Files [~ It) E| Cancel

Drescription : J Factory & |

Dizplay Type: J Typeh |

Device/PLC Type: J |

(3) Click onthe[[_¥ss | button todeletethe project. '

Imp;ﬂant
Oncethe [Delete] command is

performed, it cannot be un-
done.
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Chapter 4 - SCREEN AND PROJECT MANAGEMENT

4.2 Project Editing

@ Backing up Project Files

)

When a Project fileis saved, a backup file (* .bak) of the most recently saved
Project file datais created. The backup file is created in the same folder in
which the selected Project Manager is stored.

To open and edit Backup files as Project files, change the filename extension

to "lte".

PROCEDURE

REmMARKS

(1) IntheProject Manager (such asA PLANT SYSTEM.
Ite), select the [Project] menu's [Backup Settings]
command.

(2) Put a check mark in the "Backup Project File"

checkbox and click on the button.

Backup Setting

| Backup Project Fila

o]

(3) SaveaProject file.
The backup file [A PLANT SY STEM. bak] is created
in the same folder in which the selected Project Man-
ager (Example: A PLANT SYSTEM.lIte) is stored.

The option isenabled in the initia
Settings.

To open and edit Backup files via
the Project Manger, change the
filename extension from "bak" to
"lte".
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4.2 Project Editing

Chapter 4 - SCREEN AND PROJECT MANAGEMENT

Rebuilding A Project (Rebuild) |

The “Rebuild” tool is used to both check the contents of the LTE files, CPW
filesand MRK files created with LT Editor, as well as to rebuild these files
if they are damaged.

In the following cases, use the “Rebuild” command to restore file data.

1.

o s~ WD

Your personal computer is either reset or shut down while you are
saving data.

The system crashed while you were saving data.

Your floppy disk or hard disk is damaged.

Your personal computer’s disk drive is defective.

A system error (an error not specified in the error message list, such as
a partition or checksum error) occurs while a screen is being opened or
transferred.

The desired project file does not display asaLTE file during project
selection, or an existing screen’s number is not displayed when you try
to open that screen.

You cannot select a project file when you try to perform the [ Select
Project] command. (i.e. the LT Editor program cannot recognize the
project fileasaLTEfile)

When you try to open afile, an error message appears, indicating that
the fileis damaged.

File Open Error
& System file is corupt
(.

Parts placed on the LT Editor program screen cannot be displayed on
the LT unit, or, adifferent screen than desired is displayed on the LT
unit. (i.e. the relationship between the screen data and Parts data is not
correct)

If this error message is displayed, LT Editor program cannot read the target
file until thisfileisrebuilt.

If afile's data cannot be completely restored with the “Rebuild” tool, the
system treats this data as abnormal data and deletesit. In this case, you must
edit thisLTE fileusing LT Editor program after the “Rebuild” command is
performed.

G

ote: FileRebuilding requiresapproximately threetimesthe hard disk space

2] occupied by the Project file.

4-14
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Chapter 4 - SCREEN AND PROJECT MANAGEMENT 4.2 Project Editing

B Rebuilding

General description of the “Rebuild” screen is asfollows:

7 Rebuild
Menu Bar\"file Actions  Help
Tool Bar @]]@@
Retuild File:|[D:\ProPBwin'dat ahase Process. pr —t—H— Dis p | ays the
Statusg: selected file's
name
Displays the status
of the rebuild
TotalJob: | Operation
o Displays the progress
of the rebuild opera-
tion
PROCEDURE REMARKS

(1) Torebuild afile, click on the Windows main menu’s
[Start] button. Point to the [Program] - [Pro-face] -
[LT Editor] menu, and select the[Rebuild] command.

Accessories

- StartUp
Favorites M| Ms-DOS Frampt
3 MicrosoftWord

@ Dacuments &9 ‘Windows Explorer
% Setings M
Eined ¥
& e

& Bun...
ﬁ Shut Down...

il Start

(2) Select the [File] menu - [Open] command, or click

on the icon.

(3) Select thefileto berebuilt, or enter the file name.

Then, click on the[[ Teen | button.

Open

Look | &7 database

ﬁA M anufacturing System. e
Manufacturing System ke
ction P .

@ Schedule Contral. e

File name: |F'r0duction Process. ke || || DOpen

Files of tppe: |ProiectFiIes[".Ite] E| " Cancel ly
i
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PROCEDURE REMARKS

(4) After confirming that the file nameiscorrect, select
the [Actions] menu - [Start] command, or click on

the icon.

The selected file will then be rebuilt.

#* Rebuild

File  Actions Help

Riehuild File: [[2:\Program Files' Pro-face’\L T YdatahaseProduction Process lte]|

Status:

Total Jok: |

3., [ [

#* Rebuild To cancel file rebuilding, click on
File  Actions  Help .
the [#] icon.

Riebuild File:JIC:\Progiam Files'Pro-face\L T \databaseProduction Process |

Status: Deletirg 510007

Frocessing...
Finizhing.............. Ok!
Reforming .................. 0k
File iz Febuilt

TotalJob:  [NAANNARNARANAARNARNARRNNARNARRNARN

G- R T

(5) Select the[File] menu - [Exit] command, or click on
the||jgk| icon and finish therebuild operation.

@ﬁ}te;When Partsor Tags set up onthe LT Editor screensare not displayed on the LT
2] screen, or displayed in shapes different from the designated shapes (the screen data
and part data are not related properly), rebuilt the data, and then transfer the data

again. Click on é@ and select [Transfer] - [Prepare] to display the Transfer Settings
dialog box. Then, select " Send All Screens’ option from the Transfer Method field.
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4.2 Project Editing

@ Converting Addresses and Device Codes ]

Thisfeature allows you to change a Part’s addresses. This address conver-
sion can be performed on either word or bit addresses. This command is
useful for changing both addresses or an address' device code.

@V\ote: When assigning a variable (L ogic symbol) to the address, do not perform the
2] AddressBlock conversion; otherwise, the operation will fail.

PROCEDURE

REMARKS

(1) Viathe Project Manager, select the [Utility] menu -
[Convert Addresses] command.

(2) Select thetype of the address conversion to perform:
Word Addressor Bit Address.

Addiess Conversion
’rDevica Type: Convert |
@E\wjurd Address i Bit Address -
g = Clase
Bef
Start Address Start Address
01/C00000 | [ 01/Co0000_| 2
End Address
o1/coooo0 | [
= Sreen Typee————— = rrzen Flangs—————
Base Goreen FO]
Window Screen 1) Selection
Alarm Massage Screens  From
Sarnpling Data Ta
Eiling [t
inases Line Mo Frnm
D1ata Logging Settings
s
Global D-Script
D-Seript Function
=]

(3) Enter the address conversion range and the updated
initial address.
Before this step is performed, be sure that the first and
last device codes used are the same. You cannot specify
an address conversion range for adifferent device.

Address Conversion
Device Typpmm——ouou Convert
piWorddddiess 4 B Address [ oee |

=Befor
Start Address Start Address
[P | 72 o1/co00n | [
End Address
01/Coo000 || |22
nnnnnn T CTEer Fiang
Base Screen foFa |
Window Screen {20 Selection
Alaim Massage Screens  From
Sampling Data To
Filing Data —
Hina Ling Mo From
Data Loaging Settings : '
° I
=]
Global D-Seript
D-Script Function
o]

In word address conversion mode,
Part addresses specified by abit ad-
dress can also be changed, within
aspecified range.

When using any of the following
External Devices, specify the De-
vice/PLC number, as well:
FACTORY ACE, 1:n communica
tion (Yokogawa Electric Corp.)
SDC Series (Yamatake Electric
Corp.)

THERMAC NEO series
(OMRON)

When converting addresses, be
sure that the address settings meet
the following condition:

“Final address before conver -
sion” - “Initial address before
converson” <“Final addressaf-
ter conversion” - “Initial ad-
dress after conversion”

If the left side is larger than the
right sidein the above formula, the
Parts corresponding to the surplus
addresses will be assigned to the
final address of the same device.
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Chapter 4 - SCREEN AND PROJECT MANAGEMENT

PROCEDURE

REMARKS

(4) Select thetype of screen to bereplaced.

Address Conversion

Device Type:
’F@ wiord Address 20 Bit Address

Corwert
[ e

=Eefo

D ata Logaing Seftings
Global D-Seript

D-5ciipt Function

Start Addhess Start Adress
[ =

End Address

Tareen o Soreen Fiang

Base Soreen M@ Al

Window Screen {3 Selection

Alaim Massage Screens Frum

Sampling Data TD
iling Data

Line Mo From

-

[

o

Help

:

(5) Enter the screen number to be changed. (Enter theline \
numbersused in the Alarm Editor) |
All the addresses between the initid screen number and the
find screen number (or the addresses between theinitid line
number and thefind line number), will now be changed.

Address Conversion

Device Type:
i word Addiess i3 Bit Address

(6) After confirming that all the settings are correct,

click on the button.

4-18

B

Convert
[ ciose

Start Address Start Address
O1/ca000 m/cni |2
End Addiess
o1/coo00: || B
—Sreen Typ —Soreen Rar
Base Screen FOT
Window Screen ﬁie'ﬁ“m
Al Mssage Screens  From
Samgling Dats To
Eiling Dt
Ll gingata LMo Fom [T =
Data Logging Settings —
ol =
Glabal D-Seript
-5 cript Function

=)

Address Conversion

Data Logging Settings

Global D-Geript
D-Seript Function

Line Mo From

Device Type [ N
) word dddiess 49 Bit Address = 1
7 E Close
=Belo
Start Address Statt Address
m/cooooo | B o/coono | [
End Address
m/cooo0z |
= Screen Typ =5 creen Fiang
Base Soreen # el
Window Screen L Selaction
Alaim Massage Screens Frum
Sampling Data Ta
[ Filing Data _

-

o

:

Help

u
Important

Do not convert addresses on
2,000 screens or more at a
time. Otherwise, the memory
capacity might run short af-

ter this conversion. If this
memory shortage occurs, re-
start the LT Editor.
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PROCEDURE REMARKS

(7)Click on the button.
The progress of the address conversion will be displayed.

Converted Screens m%
B (=
Cancel

(8)To stop the address conversion prior to normal

completion, click on the|  Close button.

Comverted Screens Stant ]

Thisfeature allows you to convert the currently loaded screensto different ones
viathe [Load Screen] command, al at once.

B | oad Screen and Search Screen Settings

Here, specify the screensto be converted. Enter the numbers of the Search
Screens on which Load Screens have been called up and called up Load
Screens.

Specify the

range of Load
Screens before T
conversion.

Specify the Top
Screen number
of the Load
screens after
conversion.

Specify the
range of the —

Search Screens
on which Load

Load Screen Conversion

=Load Screen Mo.
= Befor

Start Mo, 1 =

End Ma.

=After

I Top Screen Mo —

Convert

=5creen Tup

Base
O Mark
O Image

R |

=S creen Search Result

= Screet

A Start Mo 1

T

End Ma.

ﬁ
2
gl

Specify the
— Load Screen
Type.

Screens have
been called up.
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PROCEDURE REMARKS

Example; Load Screens B100 to B105 currently loaded
on Base screens B1 to B30 are converted to B200 to
B205.

(1) Viathe Project Manager, select the [Utility] menu -
[Convert Load Screens|] command.

(2) Specify the type and numbers of the L oad Screens
to be converted and the Top Screen number of the

L oad Screens after conversion.
Base screen

Start No. (100)
End No. (105)

Top Screen No.
(200)

(3) Specify the range of the Search Screens and their
type.
The Load Screen numbers specified in step (2) will be
converted and called up on Search Screens specified by
the Start and End numbers, here.

Screen Search Fesul
Screer

Start No. (1) antte

End No. (30) Erdho. |0 &

(4) After confirming all the settingsare correct, click on

the button.
(5) Click on the button to start conversion.

The conversion status will continuously be displayed.

Conversion Status

Correrted Screens %
B (T
Cancel

(6) Click on the|[ Cloze button to close the dialog.

Corverted Screens Stark ]
BS
g6 W@
- Campleted -~
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@ Symbol Editor ]

.

The Symbol Editor enables you to assign an address to a symbol and then
register that symbol and to assign a device comment to an address and then
register it.

The “Symbol” isthe registered name used to indicate the address of any
Part. Thus, when you change the address corresponding to a symbol, you
will automatically change a Part's address(es) without having to re-setting
the Part. The “device comment” indicates a comment assigned (attached) to
each address. When setting a Part's address(es), simply clicking on ]
([Apply Device Comment]) reflects the registered device comment to the
Part's comment field.

2.1 Parts B Part Attributes - Entering a Comment

In al the address entry fields, such as of Parts, addresses registered viathe
Symbol Editor will be displayed in a pull-down list together with the sym-
bols or device comments. Addresses can also be specified here by selecting
them from thislist.

2.1 Parts B Part Attributes - Entering Addresses

The symbol and device comment data can be shared between multiple
Projects by import and export.

Note: Theregistered symbol and device comment information can be printed asa

2] symbol list.

9.1.1 Printing

Usage Pattern |

Select “Word Enter a Save the
[Screen/ | [Symbol — symbol"or “Bit — symbol — symbol
Setup] Editor] symbol”. name. data.

B Symbol Editor
Select a desired Ele Edt Vew Hep
symbol or com- & Pop-up Keypad
ment.

Enter a symbol
name of up to
twenty characters

wiord Symbolz id |

Symbol Hame [ word Address

it— Enter the
address(es) corre-
sponding to the
symbol’s or
description’s name

[

mmﬂmmhws\—t

Fieady [ JNum 2
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B Symbol Editor Types

There are five types of symbols: the Word symbol corresponding to aword
address, the Bit symbol corresponding to a bit address, the Logic Integer sym-
bol, the Logic Discrete symbol and the Logic Real symbol which areusedina

logic program.
Word Symbol Logic Logic
Integer Real
Symbol __~ gy mpol

e | e [ e

Bit Symbol | ogic Discrete Symbol

@ Logic symbol

Logic symbol means variables used in alogic program. A new logic sym-

bol cannot be registered with the Symbol Editor. When alogic programis
saved, global variables registered on the variable list will automatically be
registered with the Symbol Editor.

Only global variables are registered as logic symbols.

Variables are registered as one of the following three logic symbols de-
pending on the variable type: L ogic I nteger symbol, L ogic Discrete
symbol, L ogic Real symbol.

Asfor an array variable, each element isregistered as asymbol. An array of
size 5isregistered asfive logic symbols. [Element Number] representing
elementsin an array will be <Element Number> as a Logic symbol, and an
array of size5, ALLM, will be represented as bel ow.

Array variable | Logic symbol
ALLMI0] ALLM<0>
ALLM[1] ALLM<1>
ALLM[2] ALLM<2>
ALLM]3] ALLM<3>

E'Note: For details of variables, pleaserefer to the" Logic Programming Operation
2] Manual" or "online help".

B Device Comment Types

There are two types of bit device comments. the word device comment
corresponding to aword address and the bit device comment corresponding
to abit address.

Word Device Comment

|
EE]

Bit Device Comment
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B Edit Commands

To edit symbols, you can use the following commands:

A& Used to delete a symbol’s line of data and store it on the clip-

board. The Paste command allows you to then move that symbol
to another line.

(Bl..... Used to copy a selected line of datato the clipboard.

=] - Used to insert the line of datatemporarily stored on the clip-

board into the desired row, after the Cut/Copy command has
been performed.

o =T P Used to cancel the command previously performed and return to

the previous condition. However, an edited symbol character
cannot be restored.

B Using the Cut/Copy/Paste Commands

Cut/Copy/Paste commands can be used to move data between different
Symbol Editor files. To do this, simply open another LBE file and select a
desired line. Then, use the [Cut] or [Copy] command, and then the Symbol
Editor’s [Paste] command.

/A

\

]
Important )

Do not register the same symbol name for both a word sym-
bol and a bit symbol.

If alphanumeric numerals are used at the end of a symbol
name, executing the [Copy] and [Paste] command will auto-
matically change the symbol’s name.

- When Chinese characters and numbers are used in a symbol

name:

All the Arabic numbers to the right of the Chinese
character(s) will be deleted. Sequence numbers starting from
“2” will be assigned after the Chinese characters.

- When Roman characters and Arabic numbers are used in a symbol

name:
Example) ABC123

All the Arabic numerals to the right of Roman character(s) will
be deleted and replaced by a sequence number.

‘When only Arabic numbers are used in a symbol name:

Only the first number is retained, and all other digits are
truncated and replaced with a sequence number.
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B Registering Symbols and Device Comments

PROCEDURE REMARKS

(1)Viathe Project Manager, select the [Screen/Setup]
menu - [Symbol Editor] command.

(2)Select symbol or device comment type.
In this example, please select “Word Symbols’.

B3 Symbol Editor
Fil= Edit “iew Help
i[5 (B]=] (29 (2] [+ [%=[a)]
< ‘wiord Syrbols ~ 1D ;
) © Symbol Name © word Addiess
1 [ |
2
3
4
5
B
7
]
]
10
1
12
13
14
15
16
17
18
19
20
A
22
Fieady — .2
(3) Enter symbol names and addr esses. To enter a symbol name, you can
— use up to twenty alphanumeric
B3 Symbol Editor | ; .
Fie Edt View Help characters, or up to ten Chinese
E =l B [F[9) =] [+ =] characters.
‘wiord Symbolz i :
: T = The entered charactersare not case-
1 Line [1 to &), Word TNOooo Sensitive
2 Line (6 to 10], Word TNOOODZ '
3 Line (11 ta ), Word TEJ_DQD_D_S ________
S (re(ifd wad . You can perform the [Delete] or
2 [Copy] and [Paste] commands af-
8 ter selecting multiple messages.
9
10 /A
il ﬂ
12 !
2 Important
= | The symbols [],\, ?, and the
Ready _ [INumfl__ | Aﬁ

key cannot be used in

(4) After all the necessary items are registered, select the Symbol Editor.

the [File] menu - [Save] command, or click on the

icon.
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B | mporting Symbols and Device Comments

The previously saved Symbol Editor data can be imported to and shared
with the currently open Symbol Editor. Files with the extension of "*.LBE"
or "*.CSV" can be imported.

CSV filesthat have been created via atext editor, Microsoft Excel, or other
applications can be used as symbol or device comment data via the Symbol
Editor after imported.

ote: Logic symbolscannot beimported with the Symbol Editor.

Symbol data and device comment's CSV file formats are as follows:
<Symbol Data CSV For mat>

"GP_SYMBOL"
"Symbol Name", "Word Address®

<Give one line feed between aword address and a bit address>
"Symbol Name", "Bit Address"

Example

"GP_SYMBOL"

"Line A (1to5): Word","D00100"
"Line A (6 to 10): Word","D00101" >
Onelinefeed

"Line A (1to5): Bit","X00100"
"Line A (6 to 10): Bit","X00101"

<Device Comment Data CSV For mat>

"GP_COMMENT"
"Word Address’, "Device Comment Name"

<Give one line feed between aword address and a bit address>
"Bit Address’, "Device Comment Name"

Example

"GP_COMMENT"
"D00100","Machine A stops’
"D00101","Machine A is now operating”
> Onelinefeed

"X 00100"," Pump B"
"X00101"," Pump B"

A - "GP_SYMBOL" and "GP_COMMENT" are identifiers indicating

! they are Symbol and Device Comment Data, respectively.

fmportant . Give a line feed only between a word symbol and a bit symbol.

If an unnecessary line feed is given in any other place, data
cannot be imported.
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PROCEDURE

REMARKS

Import symbol data.
(1) Select the[File] menu - [Import Symbol] command,

or click on the icon.
(2) Select afile(*.LBE or *.CSV) to beimported or en-
ter thefilename, and click on the button.

Import spmbol |
Look jr: J = database
Flant Praject LEE

File name: JPIant Project

Files of type: JLBE Files [* LBE)

If the same symbol name already exists, the system asks
if you wish to replace the symbol name.

[mport as|

Enter the symbol name to be replaced.

If no symbol nameis entered, the original symbol name
plus sequence numbers will be imported.

[Replace]

The same symbol name will be overwritten.

[Do not import]
The same symbol name will not be imported.

(3)Select an import method and executeit.
To import the specified symbol according to the current

settings, click onthe[ ok | button. To import the cur-

rent Project file's all the symbols according to the cur-
rent settings, click on the button. To cancel
the import, click on the button.

Symbol Import |
"wéord symbol ILine[1‘|-1 Shwford?’ iz already defined
whord spmbol | Line[11-15kword2 '
% Import s [Line{1115/word2 |
2 Replace
2 Da not import
(& (o]

To import a device comment, se-
lect the [Import Device Comment]
command.

u
Important

To import a device com-
ment, select the [Import
Device Comment] com-
mand.

If the same symbol name exists as
aLogic symbol name, [Import as]
command importsthe symbol name
with a number added. The symbol
name cannot be overwritten.

%lkv\ote; * Amount of the Symbol data created or imported viathe Symbol Editor is
2] not limited. However, the number of device comment charactersisup to

20.

e Itemswith an inappropriate device name are not imported.
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B Exporting Symbols and Device Comments

Data registered viathe Symbol Editor is exported and saved as an LBE or
CSV file. By importing this data, the Symbol Editor data can be shared
among Projects.

@Ik\l\o\tg L ogic symbols cannot be imported with the Symbol Editor.

PROCEDURE REMARKS

Export symbol data. To export adevice comment, select
the [Export Device Comment]
(1)Viathe Symbol Editor, select the [File] menu - [Ex- [ command.

port Symbol] command, or click on the icon.

(2)Specify the name and type (*.LBE or *.CSV) of the
file to save the exported data with, and click on the
button.

If the same file name already exists, the system asks if
the existing file must be overwritten. If it must be over-

written, select . If you do not wish to over write

it select[ s .
Export as
Save jn |@ Database l|i” &

Lirel ward LEE

File name: |Line3 ward " Save

>
Save as lype: |LBE Filez [* LBE] ui” | Cancell B
Export spmbol

@ File already exists.
r') Okay to replace?
Yes
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B Calling up Device Comments

All the comments that have already been registered with Parts can be called
up on the Symbol Editor as device comments. For addresses corresponding
to each Part's comment, refer to the Input Description Address Table.

2.3.8 Duplication

PROCEDURE REMARKS
(1) Select the[File] menu - [Get Device Comment From A
Project]. |
Important
(2) Select adevice comment calling up method and click | Multiple addresses may be
onthelT ok | button. given to a Part depending
: on its type. In this case,

[Overwrite] ... The device comment is called up after
the already assigned address is del eted.
[Merge] ... The device comment is called up in addition

device comments will be
called up for all the as-
signed addresses.

to the already assigned address.
Get Comment File From Project
S v Otions To call up an alarm message from
%) Qrermite the Alarm Editor, mark the[Include
) Merge Alarm Files] check box.

D Inchude glarm Files

o,
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@ Changing a Project’s LT Type ]

@\ You can change the LT type of your current project.

Note: After changingthelLT type, you can savethe current project using the
2] [Project] menu - [Save As] command.

1.2.2 @ Saving a Project Under a Different Name

PROCEDURE REMARKS

(2)Viathe Project Manager, select the [Project] menu -
[Change Display Type] command.

di Tor Ver. 2.0

@
5

Proface
[Tpets Il J

(2)To changetheLT type, click on thedesired LT type. /'\

u
Change Display Type Important

Dizplay Type:

The drawing area, com-
mands and memory used by
this change will vary de-
TP Poat pending on the selected LT
et Fotat type. Be sure to check these
items before changing the
(3)Click on the[_0Kk__| button. LT type to be sure that your

change(s) will be compatible

Change Display Type . L !
_ with your existing project’s
Diizplay Type:
data.
[Typet ]
[ %” Cancel | | Help |

N

A When a vertical type LT unit is replaced with a horizontal type or
! vice- versa, the displayed screen is rotated 90° . Therefore, you

Important must also edit the screen using the [Rotate] command. After

editing, be sure to check that the displayed data is as desired.

Example)
ABC I [
>
m
<
Horizontal type Vertical type
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@ Changing Your Project's Device/PLC Type and Addresses ]

The PLC type selected in the current project and the available addresses can
be changed. Thisfunction is enabled only when using LT Type C.

ﬁé}e: To change the Device/PL C type, save the Device/PL C type you have changed
via the [Project] menu-[Save As| command.

1.1.2 B Saving a Project File under a Different File Name

B Changing the Device/PL C type
The PLC type can be changed in the following dialog box.

Ch Device/PLC T =
Add a check mark ange Device ype =

to display a screen Devica/PLC Type:
that allows you to

. MITSUEISHI MELSECAna(LINK, il Select the de-
configure the J L) | sired PLC type
conversion pattern from the drop-
of available de- D Convert Address down list.
vices. 8] [ Caeel | [ Heb |

B Setting the Device Conversion Pattern

The conversion operation of available devicesis executed when the PLC
typeis changed.

The "Conversion Pattern” should be registered in order to convert the avail-
able device.

ﬁé}e: For efficient setup operations, arrange the following items beforehand.
» Tables of available devices/PL Cs both before and after the device/PLC
types have been changed.

Device/PLC Connection Manual, Device Memory Map of
the PLC, etc.
 Printed result of global crossreference

Click this button to execute the conversion accord-

Address Table ing to the data shown in the Address Table.
Displays detailed A e : :
infoprm);tion on the CorveilFiom  OMRON THERMAC NEO SERIES / Click this button tq
conversion patterns Conver To MITSUBISHI FREQROL SERIES _Cancel al_l co.nverS|on
(address type range Deevice Type || Start Address(Before] | End Address(B efore] [ Sten Addressiy W information in the
. ' \ = Address Table.
of available ad- IEEN \
dresses before the [Cesramn., \  Click this button to
PLC type is changed, register an additional
and start address of ] conversion pattern.
the available address [ o . .
after the change). e smreer ]\ - Click this button to
= — = T modify the ;ettmgs of
the conversion pat-

tern.

Click thi_s button to load the  jick this button to Click this button to
conversion pattern; from the ¢5ve the conversion '
CSV file data and display the delete a conversion

, patterns in a CSV
datain the Address Table. pattern.

file.
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4.2 Project Editing

PROCEDURE

REmMARKS

(1) Via the Project Manager, click on the icon, or
select the[Project] menu - [Change Device/PL C Type]

command.

(2) To changethe Device/PL C type, click on the desired

external device.

Change Device/PLC Type
Device/PLE Tppe:
OMROM THERMALC MED SERIES “zﬂ
YOKOGAWS FACTORY ACE 1:1 Comnn. N

YOROGAWS FACTORY ACE 1:n Comm.
EMITSUBISHI FREQROL SERIES
FLUI INWERTER

FUJI TEMPERATURE PR
MEMORY LIME SI0 Type

[When no Device conversion patterns are set]

(3)Click onthe[ ok | button.

Change Device/PLC Type
Device/PLC Type:
[MITSUBISHI FREQROL SERIES ]

IOl Conver Address

5] oo | [ Hee

(4)Click onthe[_OK__| button to exit the setting dia-

log box.

PLC tppes are different

&

Save- Az Pl Type different from previous

inwalid addresses

twpe. Address conversion may have produced
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Do not open screens other than the
Project Manager. Doing sowill dis-
able the selection of the Device/
PLC Type.

The conversion operation appliesto
all addressesin the selected Project
(except for addressesthat have been
registered as symbols).

Once you change a project’s De-
vice/PLC type, you must re-enter
that project’s device addresses for
Tags, D-script and alarms. Save
each screen separately again when
the Function Switch set up with the
"Change Screen” function is used
on the screen.
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PROCEDURE

REMARKS

[When Device conversion patterns are set]
(3)Put acheck mark inthe" Convert Address' checkbox

and click on the IT button.

Change Device/PLC Type
Device/PLE Tppe:
[MITSUBISHI FREQROL SERIES [Eﬂ

Cornvert &ddress

|| Cancel | || Help |

(4)Click on the|”&ddFaiem | button to set up the con-

version pattern for the Device.

PLC Type Change

i Add Pattern..

Ceara |
Dk Patizm,..

Carrvert Fram OMROM THERMALC NED SERIES
MITSUBISHI FREQROL SERIES

StartAddress[Eafnra]l End Address(Befare] ‘ StartAddlessz){

Correert To

Device Type

| SawePaliang..,
| Load Pattems...

[ Help

l

J

Select the" Address Type" option and designate the
available" Start Address' and " End Address' of the
PL C before the conversion, as well asthe available
" Start Address' of the PL C after the conversion, and

click on the ]T button.

Edit Address Convertion Pattern
Ok

=Address Type

1 Bit Address & whord Address

= Convert From=——— Convert T o

Start Addiess

R | =

End Addiess

oi/coonio |||

Start Addiess

0/0003 [

>

J
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The conversion operation appliesto
all addressesin the selected Project
(except for the addresses that have
registered as symbols).

Refer tothelist of available devices
of your PLC.
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4.2 Project Editing

PROCEDURE

REmMARKS

The new conversion pattern is added to the Address
Table.

PLC Type Change

Conved From  OMRON THERMAC NEO SERIES
Conven To MITSUIBISHI FREGROL SERIES

T

Edl Patierm..
Dl Pattem..

%]

“wiord Address | 01/C00000 01/C00010 00/0002

Save Pattens
Load Pattemns.

Help

KA ]

Added conversion pattern

<Editing a conversion pattern>
Select the conver sion pattern you want to edit from the

Address Tableand click on the| Edtpatem | button.

PLC Type Change

ConvenFiom  OMAON THERMAC NED SERIES
Conven To MITSUBISHI FREDROL SERIES

Device Type || Start Addiess(Before] || End AddresslBefore] || Start Addressl
[word Address01/000000 017000010 00/0003 Add Patter.
I Edit Pattem. ,\1

| Delet Pattern... ]

[

Save Pattens...
Load Patterns

Help

[l

J

Designate the conversion pattern with the procedure
described in Step (4) of [When Device conversion pat-
ternsare set].

Edit Addressz Convertion Pattern
=dddrezs Tup u] R
20 Bit Address ) word Address
= Canvert From=———— Corvert To
Start Address Start Address
o/conn || 2 00/0005 iz
End Address
o1/coo0t0 || [
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PROCEDURE

REMARKS

The edited information is displayed in the Address Table

of the conversion pattern.

PLC Type Change

Corrvert From OMRON THERMAC NED SERIES

Corrveert To MITSUBISHI FREQROL SERIES

Device Type StartAddress[Esfurs]l End &ddress[Belors] ‘ Slarmddlessé

‘wiord Address

01000000

01./c0oo0 0

000005

o Comet

Add Pattern,

[ EstPuem. |
Dl Patter.

| Save Pattens...
Load Pattemns.

Help

Il

:

<Deleting a conversion pattern>
Select the conversion pattern you want to delete from

the Address Table and click on the [ pestPat=m | but-

ton.

PLC Type Change

OMROM THERMAC MED SERIES Convert
Corvert Ta MITSUBISHI FREGROL SERIES Cancel

Corrvert From

Device Tyne || Start Addess(Before) || End Address(Before] | Start Addressy
[wWord Address _01/C00000 01/C00070 0070005

Add Pattern,

Edit Patte...
| Delet Pattem :}J

Save Pattens...
Load Pattems...

Help

)

l

:

<Saving a conversion pattern asa CSV file>
Select the conver sion pattern you want to save from the

Address Table, and click on the| saveratens | button.

PLC Type Change

Corrvert From

Corveert To

OMRON THERMAC NEQ SERIES
MITSUBISHI FREQROL SERIES

Device Tupe || Start AddressiBefore) || End AddressiBetore] || Ghant fddress|
[uiord Address T AC00N000 [EEIGN] 0TS

Corvvert

Cancsl

fdd Pattemn,

Edit Pattemn.

I

Delet Pattern.

| Save Paftens. ,}J
1.

Load Pattems...

[l

il

Help
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4.2 Project Editing

PROCEDURE

REmMARKS

Designatethefile name.
In the "File name" field, enter the name of the CSV fileto
which the data will be saved.

J

Click on the W button to confirm the destina-

tion file to which the conversion pattern will be saved.

<L oading a conversion pattern from a CSV file>

Click on the Load Patterns button.

PLC Type Change
Converl From OMROM THERMAC NEO SERIES Convert
Convert Ta MITSUBISHI FREGROL SERIES Carcel
Device Type || Start AddvessiBefore] | End AddressiBefore) || Stan Address|
[word Address01/C00000 01/C00010 00/0005 Add Pattem...

Edit Pattern
Delet Pattern,
‘ Save Pattens
i~ Load Fattems D
Kl [ Heln

J

Select the CSV file to be loaded, and click on the

button to confirm the selection.

The content of the CSV fileisdisplayed in thelist of con-
version patterns.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

When the combination of the PLCs
indicated in "Convert From" and
"Convert To" specified in [PLC
Type Change] differs from the data
onthe CSV file, the conversion pat-
tern stored in the CSV file cannot
be loaded. Selecting the CSV file
and clicking on the but-
ton will not display any datain the
Address Table.
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PROCEDURE REMARKS

(5)After setting up the conversion pattern, click the

button to perform address conversion.

PLC Type Change
Convert From OMRON THERMAC NED SERIES
Convert Ta MITSUBISHI FREQROL SERIES
Device Type || Stat Addiess(Before] || End AddiessiBefore] | Start Addressid]
word Address | D1/C00000 01/C00010 00/0005 #4dd Pattern
Exdly Patterm,.,

| Save Pattens.

| Losd Patters
[ | Help

Conversion Example (time)

[Conditions] (Contents of project
@ file)
No. of screens: 1
e No. of Tags/Parts placed: 50
E=h No. of specified conversion pat-
terns: 10
[Conversion time]
About 10 seconds
aﬁ”%ﬁﬁ The conversion time increases/de-
creasesin proportion with the num-
ber of screens.
[If no conversion error occurs] It may also vary according to
(6)Click onthe[ oK ]button toexit thesettingdia- | changes in the settings of other
log box. items.

PLC types are different

Save- &z Plc Type different from previous
type. Address conwversion may have produced

irrealid addresses

[If aconversion error occur S|

(6)Detailed information on the conversion error isdis-
played.
T T

e T G D OO [ oc |

A you suie to use this conversian? T

Device address

B screen:
Screen No. 0

<Completing " Convert Address' >

Click onthe[ ok |button.

J

4-36 LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide




Chapter 4 - SCREEN AND PROJECT MANAGEMENT 4.2 Project Editing

PROCEDURE REMARKS
Click the[_0K__|button to exit the dialog box.
PLC types are different

Save- Ag Ple Type different from previous
ype. Address conversion may have produced

irvvalid addresses

<Maintaining a history of conversion errors as text
data>

Select the conversion error, and click on the [Export
Error AddressList] button.

Change PLC Type

or_Cannnot Convert Device : [B: | |
The abowe conwerted enors were found,
Are you sure ko use this conversion™
Export
Errar
Address
List.

Designate thefile name.
In the "File name" field, enter the name of the text file to
which the datawill be saved.

U

Click on the button to confirm the destina-

tion fileto which the conversion error will be saved.

Click the[_ok__]button to exit the dialog box.
PLC types are different

Save- Ag Ple Type different from previous
ype. Address conversion may have produced

irvvalid addresses

<Canceling the PLC and Address Change>

Click on the|[ cancel | button.
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PROCEDURE REMARKS

The [PLC Type Change] dialog box appears on the screen
and the settings are reset to the conversion pattern settings
that existed before the conversion.

J

Click on the [ cancel | button to close all setting screens for
changing the PLC.
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m Project Compression/Decompression

Compressing a project file reduces the size of its data to accomodate a
standard floppy disk’s limited capacity. A compressed project file and its
screens however, cannot be edited. To edit the screens, you must first de-
compress the project file.

Usage Pattern

Start - Programs — Pro-face - LT Editor - Pack Tool -

[Action] _, [Compress Project File]/ _, Designate a Project — Click on the
[Decompress Project File]  file to be compressed or ok
decompressed. Ok

button.

or
Click on or .

A general description of the compression tool is as follows:

3 Pack Tool
Action  Help
Displays the file
name of the project
to be compressed/ File Name | ||
decompressed Slatus

Displays the status
of the project file
compression/decom-
pression

Displays the overall

progress of the ~
project file compres- \w
sion/decompression Progress ||
| Feady WMl
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@ Compressing a Project File ]

A Project file can be compressed to asmaller size. At thistime, alarge sized file can be
dividedinto smdller filesautomatically according to the specified capacity. After aproject
fileisdivided into several files during compression, serial numbers are assigned to the
first character of each file extension (or assigned to the first and second charactersif the
file number hastwo digits).

Example) *0lt, *.2lt..* 9It, *.10¢t, *.11t

Enter the filg name of Pack Project File Used tq Iocqte
the project file to be the project file
compressed, or selecta [ fje Name | |||| Braowse.. | to be com-
desired file name from pressed

he i licking on -

the list by clic go O Separate File |

the [Browse] button
— Used to select

the file size
The compressed project L= | [ Cercel | limit
file is automatically
divided into several
files according to the
specified file size
PROCEDURE REMARKS

(1) Firgt, click the Windows [Start] button. Then, click
on the [Programs]-[Pro-face] - [LT Editor] menu and
click the[3. Pack Tool] menu item. You can also se-
lect [3.Pack Toal...] from the Utility pull-down menu.

& B Bl

- Accessories
StartUp
M| S-D0S Prampt
Microsoft Word
Documents B windows Explarer

Favorites

Settings 4

Eind 4

i Shut Down...

o Jal
o SSES. -
: Ot Creen Number.
Projaci E 3

Pack Taol.

ogi ' . 5| |4
Prlgxg%lgm

Transfer

Pro-face
[ TypeC Portrait \ MEMOR'Y LINK SI0 Type A
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PROCEDURE REMARKS

(2)Select the [Action] menu - [Compress Project File]
command, or click on the icon.

Progisss | I

[Ready I

(3)Select the folder and project fileto be compressed, | To call up amenu of all the avail-

or e thefile name ablefolders, click on the [ Trame.
Thefile name of the desired project file will be displayed button S

in the “Pack” screen.

Pack Project File

File Hame |C:\F'rogram FiIes\Prn-face'\LT'\database| || Browsze. |

O Separate File 144 ME |

|| ak. | || Cancel |

(4)To divide the project file during compression, click | \when [Separate File] is selected
on the [Separ ate File] check box, and select thede- | gndthefilesizeisset to "1.44 MB"
sired file size limit. as shown in the left, the data will

be divided and stored on two or

more floppy disks.

Pack Project File

File Namelﬁ:\F’rngram FiIes\F’ro-face'\LT'\database|||| Browsze. |

éepa'ateF"& 1440 &
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PROCEDURE REMARKS

(5)Click on the[ 9% |button.
If the same file name already exists, the system asksif | The compressed project filewill be
the existing file must be overwritten. If you select | stored in the same folder as the

, the existing file will be overwritten. If you | original project file.
select , the existing file will not be overwrit-

ten, and you will return to the previous dialog box.

Pack Project File

File Mame |C:\F‘rogram Files'Pro-facetL T databaze "|| Browse... |

Separate File 1.44 ME d

(BTSN [ concel

& File 'C:%Pragram Files\Pro-facetLT\databasesa Manufacturing System. OLT" alieady exists. Okay to avenwrite this file?

(6) Select the[Action] menu - [Exit] command, or click

on the'E icon.
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Decompressing a Project File

A compressed project file (OLT file) cannot be edited. To edit the com-
pressed project file, you must first decompressiit.

UnPack Packed Fil =
Enter the file name of e ] Use_d to !ocate the
the project file to be Sfoler%t fr”e to ge
decompressed, or EileNamE| “ Bromeo.. ‘ ecompresse
select the desired file
name from the list by
clicking on the
[Browse] button

==
PROCEDURE REMARKS

(D Click on the Windowsdesktop’s[Start] button. Then,
point to the [Programs] - [Pro-face] - [LT Editor]

menu and click on the [4. Pack Tool] menu.

Accessories
E Stanlp

- I8 hs-D0S Prompt
N MicrosoftWard
B wWindows Explorer

(2)Select the [Action] menu-[Decompress Project File]

command, or click on the icon.

2 Pack Tool
Action  Help

File Marne ||

Statug

Progress ||

Ready
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PROCEDURE

REMARKS

(3) Select afolder and Project file to be decompressed

To select a folder, click on the

or enter the file name, and click on the|' ok, }

|| Browse... |button.

button.
If the same file name already exists, the system asks if
the existing file must be overwritten. If you select

, the existing file will be overwritten. If you
select , the existing file will not be over-

written, and you will return to the previous dialog box.

UnPack Packed File [<]

==

File NameJFactor_l,J B0k

" Cancel

Pack Tool

& File 'Factom B.lte' already exists, Dkay to ovensnite this file?

|0Kk|| Cancel ]

(4) Select the [Action] menu - [Exit] command, or click
on the'E icon.

4-44

/A

u
Important

To decompress a com-
pressed project file that has
been divided into several
files, make sure that all
divided files are available.

However, when you specify
the file name to be decom-
pressed, the system dis-
plays the first file name
(*.0LT) only.

The decompressed project file will
be stored in the same folder asthe
compressed file.
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m Information Display ]

This section describes the types of screen and project information available.

m Project Information ]

[Project Information] displays both the commands used to edit the current
project, and the date and time of its last revision. To use this command,
select the [Project] menu - [Project Information] command.

B Project Information

Project Info

Project | Sereen || Rk Information |

Currenl t Praject: |A b anufacturing System. ke ||

Descriplior: [Flant B |

Device/PLL Type: [OMRON THERMAC NED SERIES |

Ol Tope [Tl
Project Size: 35879 Eytes

Date & Time: [1wed Dot 09 10.08:56 2002 |

Size of Screen To Be Sent To dispaly unit:
‘with Uplaad Info - [11328 | ytes [19 |
Without Uplad Info.. — [1072 | Bwes  J1en |

Extended Screen Count;

@ Current Project
Displays the file name of the currently selected project file.

@ Description
Displays a comment about the current project.

@ Device/PLC Type
Displaysthe Device/PLC selected in the currently opened project file.

@ Display Type
Displaysthe LT type selected in the current project file.

@ Project Size
Displays the data volume of the current project file.
If any Parts are placed in thisfile, the file volume will be increased.

& Date & Time
Displays the date and time when this file was saved last.

@ Sizeof Screen ToBeSent ToLT
Displaysthe total data volume that will be occupied inthe LT unit pand,
relative to the current project file. Thisitem indicates the case where upload
information is sent to the LT panel, and the case where upload information is
not sent to the LT unit, separately.
Theratio of the current total data volume to the LT unit’s total memory
capacity isdisplayed in %. Referring to the LT unit’s total memory capacity,
you can cal cul ate the approximate number of screensthat can be accepted
by the LT panel.
When the data volume isindicated as “ ????’, select the [Project]’s - [ Trans-
fer] menu, and then select the [Prepare] command.

7.2.3 Transfer Preparation
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Usethisvalue only as a guideline. Depending on the size of the memory
stored in the LT, a screen of alowable size may not be entirely transferred.

@ Extended Screen Count
Displays the number of screens that will be created in the LT unit, relative to
the current project file. Since this value includes the LT unit’sinternal
screens, it islarger than the number of screens that have been created with
LT Editor for Windows 95. To display thisinformation, set up the current
project filein the “ Transfer Preparation” mode. If the project fileisnot in

the “Transfer Preparation” mode, the number of screensisindicated as
113 ??Wl

B Screen Information

This screen shows the number of screen types, alarm messages and channels
contained in the current project.

Project Info |

[ F'ruiecl‘_ Sereen | SRAM \nfurmaliun]

Murnber of Screens:

Total Screens 1

Mumber of B asic Alaim Meszages:

Murnber of Channels:

IN|

The number of channels
and the screen number
that are used in the
project are displayed

e

B SRAM Information

The situation with the use of the backup SRAM in the current project is
displayed on afunction basis.

Project Info

[Froject [ Screen]} SRAM Tnformatian |

Available SRAM Size

[rata Sampling/Trend Graph
LS Backup Bytes

Filing D ata

Fiemaining SAAM Size 2176 Bytes
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@ Screen Information ]

The [Screen Information] screen displays the settings for the currently open
screen, as well as the date and time of itslast revision. To use this command,
select the [Project] menu’s - [ Screen Information] command.

Screen Information |
" Soreen ]

Praject Mame: Factary B

External Device Tupe: OMROM THERMAC MED SERIES

Current Screen:

[ ezcription: Jtest |

Size: 170 | Butes

Cew ]

@ Project Name
Displays the file name of the currently selected project file.

@ External Device Type
Displays the external device selected in the current project file.

@ Current Screen
Displays the screen type and screen number of the current screen.

@ Description
Displays the title of the current screen.

&®Size
Displays the data volume of the current screen. If any Parts are placed on
this screen, the screen data volume will be increased.

m Version Information ]

[Version Information] displaysthe LT Editor Project Manager and Editor’s
version information. To see this data, select the [Help] menu - [About]
command.

<Project Manager Version Information>

About

| KX eaitor

Serial Ma: 11111111111
“Wersion 2.0
Build No. 2002.1030.2247

[

Copyright [C] 2001-2002 Digital Electionics Corp.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 4-47



4.5 Table Editor Character Strings Chapter 4 - SCREEN AND PROJECT MANAGEMENT

B Table Editor Character Strings

The Character Strings Settings and the Multi-language Display Feature are
described in this section.

/\
m * Image fonts cannot be used in the table editor character
[

strings.
Important

E Overview: Multi-language Display Feature ]

Using Index Text for the text objects and part’s labels allow you to easily
switch the language and information displayed on the screen during opera-
tion (the diagram below describes the steps for switching the display lan-
guage.) Switching between tables is performed with the Control Address
(two or more tables cannot be specified at one time). Thus, you can easily
switch the display language or displayed text items on the screen. Character
strings are switched by selecting tables (a group of character strings). Regis-
tration of the Index Text and setting the Control Address can be performed
with the Text Table Editor.

Example: Switching the display language for the label of a part

Table 1 Table 2 Table 1 Table 2
Use the Text
1| BAta 1| START |Table Editorto | 1| FBith 1| START
2| =1k 2| STOP |createthelndex|2| =it 2| STOP
3| ;A 3| NEXT |Textintwo 3| &mA 3| NEXT
P languages. P
When Table 1 When Table 2
&] is selected is selected Vg
Table is switched
Gp with the Control GP
Address

then a screen’s

text String is STOP
changed.
Index No. 1 Index No. 2 Index No. 1 Index No. 2
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/A

« Switching tables uses the same process as switching
! screens. Therefore, some screen displays drawn with tags
Important may not be able to be refreshed.

* The following character strings cannot be changed even when
the tables are switched.

— [X-tag] character strings
— Filing Feature
—Logging Feature

€ Precautionsfor switching tableswith the Alarm function

* When atableis switched while an alarm message (Flow display) is
displayed, the switched table is not used until the next message is issued.

LT

(Direction of the
Japanese to @ display flow)
English .

Switch the tables

ENGLISH ENGLISH ENGLISH
A PRESSURE ERROR BT T TANK A PRESS B R B
€-------- «--- “--- €-----------

(Direction of the display flow)

* When the print setting is enabled for the Alarm Message Function (Flow
display), the alarm message of the table (language) displayed at the
moment when the alarm is triggered or reset will print.

* When atableis switched while real-time printing is set to print the alarm
summary (a-tag) or log alarms (Q-tags), the switched table will be used
starting from the next print job.

LT LT
Japanese to
English
ALARM A <I:j Ty
ALARM B . W C
ALARM C Switch the Wi g
tables
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4-50

* When atableis switched while log alarms (Q-tags) are being written into
the CF Card asa CSV file, the switched table is used immediately.

» The stepsfor switching tables are similar to those for switching screens.
Therefore, the Sub Display, Cursor Display and Scroll Display that were
displayed before the switching with the Log Alarm (Q-tag) will not be
reproduced.

@ Table Editor Index Character Strings ]

The Table Editor is used to create atable's index character strings.

Table Editor Index Character Strings can be exported in CSV format. You
can also import a CSV file to use as an index character string.

Operation procedures |

[Text Table..] — [Put a check mark in the "Text

Start — [Screen/Setu
[ Pl = Table(ON/OFF)" checkbox.]

-

Assign Control Address. —  Select font from [Font Setting] menu. —

Enter index character string. — Save table data.

W Table Editor Features

Put a check mark _
here tO enter the ff, Text Table Editor - A Manufacturing System.lte After Settlng up

mode in which Text the text, specify
Table Editor is the line and click

enabled. the [Go to] button
M. s = T to jump to the
Click here to 1:Tablel F| Fon,, [2500 Coce Page50) [ specified line.
specify the [ T [ [wose
Control Address Lo 1 Set the font
ER T L (language) for the
s | w 1 selected table
Select a table to T :
enter character T .
strings. Up to 16 Lo o !
tables can be R L
registered T : Double-click on
v T h this area to call up
Index No. TR : a message dialog
Up to 3,000 TR, L box (Up to 1,200
character strings z | b L characters)
can be registered 6w L
Ready [ o 4
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B Using the Text Table Editor

» When acheck mark is placed in the "Text Table(ON/OFF)" checkbox
(ON mode), the Table Editor is switched to input mode, enabling addi-
tional settings such as Table setting and Index Text registration.

*  When the check mark is removed from the checkbox (OFF mode), the
following warning message dial og box appears. Clicking the
button deletes all Text Table data registered in the project. Click the
[ Canedl | button to retain the data.

Warning

@ All the table meszages will be deleted. Do vou sl want to continue?

B Entering ControlAddress Settings
Specify the Control Addressto switch the tables.

Text TablejOM/OFF
= Jumps to the =
[ IDDDD D| ] dezignated line =

|1:Table1 =] Fert . [45CIl [Code Pag= 850 |7

—

Jump

Settin

||| [charac... Lines [[Message ||:|||

In the Control Address, store the Table No. you want to display.

The default text table is displayed when "0" is stored. To set up the default
text table, select [Default Table Setup] from the [File] menu on the "Text
Table Editor" dialog screen.

<Values stored in the Word Address>

Value in one Control Address Table No.
0 Inifial character string table
1 Table 1
2 Table 2
16 Table 16

@Ikv\ote: * A tablewill not appear when you specify a table number for which nothing is set.
X2)
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M Table Name
Up to 16 tables can be registered.

To change atable name, display the table whose name isto be changed onto
the "Text Table Editor" screen. Next, click [ Table Name Change] on the
[File] menu.

Enter the desired table name and click the [OK] button to change the table
name.

B Font Settings

Specify one font (language) for each table (atable cannot contain more than
one font [language]).

B Entering Messages

On the Text Table Editor, double-click the column of the Index No. you
want to set up. The screen below appears on the screen. Enter the Index Text
for each Index Number.

Specify the message size [Characters] x [Lines] for each Index No.

— Specify the number of charac-
tersin aline. (1 to 100 single-
byte characters)

0K | H Cancel | || Help |

4 Specify the number of lines.

| .
1to 40lines
Character Entry Area ( )

%Ikv\ote: e The number of charactersused in theindex character string is determined
S by [Characters] x [Lines]. (Max. 1,200)

[Characters] x [Lines] < 1,200

* Multipledisplay lines can be used for [Character string] and Parts[L abel]
only. For other features, do not specify an index number for which multiple
display linesare set. If such an index number is specified, only thefirst line
will be displayed.

/\

'\ The index characters for each index number [Characters] x

. [Lines] are available in all tables.
Important
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4.5 Table Editor Character Strings

B Index Character String Registration

PROCEDURE

REMARKS

(2) I'n the Project Manager, select the [Screen/Setup]
menu - [Text Table...] command.

(2) Put a check mark in the " Text Table Editor"
checkbox in the [Text Table(ON/OFF)] dialog box.

(3) Click on the |
dress].

icon and enter the [Control Ad-

(4) Select afont from the [Font Setting] menu .

Select atable from [T] on the right of the "Table 1"
field and select afont (language) from [~]o n theright
of the "Font Settings" field.

(5) Double-click the index character string entry area.

Jumps tothe 4 [=
dezighated line I=

o [ASCI (Code Page 350) ]

DD.DD [ |

[1:Tablet ]| Fert

Settiry

Jumnp

[ [charac... |[Lines
10
10
10
10

[Message

B |ra |-

(6) Enter the desired [Characters] and [Lines| accor d-
ing to theindex character string.

AT | Chatacters

02

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

The table name can be modified by
selecting [File] menu - [Table
Name Change].

You can choose from the follow-
ing five selections.

» ASCII (Code Page 850)

« CHINA (GB2312)

« JAPAN(JIS)

* KOREA (KS-C5601)

« TAIWAN (Big5)

The number of characters used in
the index character string is deter-
mined by [Characters] x [Lines].
(Max. 1,200)

[Characters] x [Lines] < 1,200

Multiple display lines can be used
for [Character string] and Parts[La
bel] only. For other features, do not
specify an index number for which
multiple display lines are set. If
such an index number is specified,
only thefirst linewill be displayed.
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PROCEDURE REMARKS

(7) Enter theindex character string.

T...... ... T E s

WI[TANK A PRESSURE | oot ﬁ

0z|ERROR
Lines

(8) Click the button to confirm the charac-
ters.

(9) Repeat the same steps to set the index character
stringsfor the other index numbers.

(10)Repeat the same stepsto create other tables.

(11)Select the[File] menu - [Save] command or click on | Up to 16 tables can be registered.
the[[d |icon to save the setting.
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B | mporting/Exporting CSV files

You can export the contents of atable created using the Table Editor asa
CSV file, or you can import a CSV file created using another table editor
software into the Table Editor.

To edit data exported into a CSV file, or edit data that has been

! previously exported, use an operating system that supports
Important  the font specified in [Font setting] of Table Editor Character
Strings.

@ Importing CSV files
Select the [File] menu - [Import] command.
Use the following dialog box to select the desired file.

Open HE|

Loak jn: J My Documents E‘ E‘"-

File name: J | ’TI

Files of ypﬂ csv) Jz” " Carcel

W) Characters/Lines y
'\ * When a CSV file is imported, the existing index character
= string is overwritten.

Important
 When [Characters/Lines] is selected
If the imported [Characters] x [Lines] of the CSV file setting
values are lower/less than the index character string values
set in the [Table Editor], any excess/remaining characters in
the [Table Editor] will be deleted during import.

* When [Characters/Lines] is not selected
If the imported CSV file’s setting values are higher/greater
than the index character string values set in the [Table Editor],
any excess characters in the imported data will be deleted
during import.

@ CSV fileformat for character string tables
CSV fileformat

Header (Required for importing the file data)

Table Data
Table Table 1 Table Name
1 15 1 4 Abnormal pressure in tank A Index Charac-
2, 15 | 2 I 4 Abnormal pressure in tank B ter String
Index No. Number of Number of  Font (Language)
characters lines 0: Japanese

1: Chinese
2: Taiwanese
3: Korean
4. ASCII
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@ Entering Settings via the Screen Editor ]

B Selecting the drawing table

From the menu bar in the Screen Editor, select the table to use for drawing.
When atable is changed, the character strings used in the Screen Editor also

change.

w_Help |
1825 ¢ HE W

B Selecting theindex character string

@ Entering theindex character string

Click on the [Index] to switch the screen to the one used to enter the index
character string.

Select the desired index character string from those shown in the [Table
Editor]. To add a new index character string, click the button to
start the [ Table Editor].

4.5.2 Table Editor Index Character Strings B I ndex Char-
acter String Registration

Text

i) Direct {2 Index

J'I:.-’-‘«Iarm |F|
AddIndex | O] Sort
Direction {2} Horizontal
2 Vertical
Sl ) Nomsl {j;::a ) Rissd Place a check mark here to sort
15 -, .
it i 2 s the Index character strings

Font Size displayed in the pull-down menu
Ax1h || in the order character code.

(Single-byte and double-byte
characters are discriminated.)

Fo I W W ook 7] |
Bo I I/ ) O L | W] o B I

‘Note: The size of any text object placed on the drawing area automatically changes
S according to the size specified in the Table Editor ([Characters] x [Lineg]).
Switching tables does not change the text size.
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@ Designating Part’s label
Select [Index] in the Part’s [Label] areato change to the index character

string entry screen.

4.5 Table Editor Character Strings

Select the desired [Index] from those specified in the [Table Editor]. To add

anew [Index], click the button to start the [ Table Editor].
SO 4.5.2 Table Editor Index Character Strings ® Index Char-

acter String Registration

[

AddIndex | [ 5o

Character Size
[16x16 Fl
§ Text Color
peomn Y T inT 1 '] ol el

one | o ENEEEEECNF

{3 Raised

I Fancel || Help

Place a check mark here to sort
the Index character strings
displayed in the pull-down menu
in the order character code.
(Single-byte and double-byte
characters are discriminated.)

‘Note: Thesize of any text placed on the drawing area automatically changes ac-
cording to the size specified in the Table Editor ([Characters] x [Linesg]).
Switching tables does not change the text size.

@ Designating messages for the M essage Display
In the Message Display Settings, select the "Index™ option in the [M essages]

ot

area.

Select the desired Index character strings (Index No.) from those specified in
the Table Editor. To add new Index character strings, click on the

button to activate the Table Editor.

4.5.2 Table Editor Index Character Strings BIndex Character

String Registration

Messzage Display Settings [MW_001]

_
General Settings || Messages 1

B

9 i el
Mo, of Display
Messages Characters Selected Message

FE e |- =]

Ire]
—
(| Addindex | [ Sort

Place a check mark here to sort

Message Style
0 Wﬁ % Normal
[ZFTr {Q

{3 Raised

Colar

Test Color 18] 0 0 0] 1O o B[]
Pete Color 8 B 0 1 0 1 T oo B

|| Flace ||| Cancel ||| Help |

the Index character strings
displayed in the pull-down menu
in the order character code.
(Single-byte and double-byte
characters are discriminated.)

e: Theframesize of the Part will be displayed according to the Index char acter
string (Number of charactersx Number of lines) of the specified Index No.
Theframesize of a Part remainsthe same even if the Tableis switched.
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@ Selecting Alarm Editor M essages

First, select [ Text Method] in [Alarm] in the [Alarm Editor] and change the
character string setting mode to [Index].

Text Method Place a check mark here
to sort the character

£ Ll sor strings in the order of
[1:Tatlet IF| character code. (Single-
byte and double-byte
oK | [ cercel | [ Hep | characters are discrimi-
nated.)

2 Diirect

/|\ When the character string setting mode is changed, all previ-
,,,,p;,,a,,, ously registered alarm messages are deleted.

Then, click [7] in [Message/Summary Text] to view the list of [Index char-
acter strings| specified in the [Table Editor]. Select the desired Index Text
from the Index Texts registered on the Text Table Editor.

"ﬁ‘}'Basic Alarm Settings - A Manufacturing System.lte
Alarm  Edit ¥iew Help

_ Fir : Fo I T O 1] e o0 | Automatic Address Increment
2 B or Doeores [ QR FREHD 0 5

Jumps to the designated line
.. | Type Message/ Summary Texdt

Summary ﬂ ;"v

summary

summary

summary

summary

summary

summary
summary

Feady [ RO ].4)|

[Index character strings] can also be selected by choosing [Add Alarm(s)] in

[Edit].
Add Basic Alarm [ ]
Start Address F4unaoa 2t Alarm Type
Mumber of Bits to Add 16 = g i:arm ilurnmarsJ
- arm Meszage O
Aeld Dffset =
Wl Message  [21LTANKT Fl
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If you want to add a new [Index], click the button to start the
[Table Editor].

4.5.2 Table Editor Index Character Strings B | ndex
Character String Registration

:“.i"‘w'Basic Alarm Settings - A Manufacturing System.lte
Blam Edit View Help

I —)
_ Pt G ] o ) mress\nmement
[ v Qs [ SRR D

Jumps ta the designated line Jump

Messages/Summary Text
mmmmm I T

mmmmm

mmmmm

. * When messages are registered with the Alarm Editor, Direct
i Text and Index Text cannot be mixed.

]
Important + DO not set up an Index Text with two or more lines. Only the

first line will be displayed, even if two or more lines have been
set up.
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BCREATING AND EDITING ALARMS

I hisfeature allowsyou to register text datato be displayed asdarm
mesages. This chapter describes how to create and edit these darm

MEeSSAgES.

5.1 Alarm Creation and Editing
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5-2

E Alarm Creation and Editing

With this feature you can register the messages to be displayed in the
“Alarm Summary” (Part menu’'s “Alarm Display”) and “ Alarm Message”
(right to left scrolling display). You can also set up amonitor bit for each
message. According to the monitor bit’s ON/OFF status, the specified
messages are then displayed in the “Alarm Summary” or “Alarm Message’
mode.

The "Alarm Summary" lists messages in the Alarm Display Part.

2.1.12 Alarm Display

With “Alarm Message” text, the horizontal and vertical size of thetext is
specified in the [Setup Area's (Initial Setup screen)] menu or inthe LT unit’s
[Setup] mode. Character sizes can be set to either “x 17, “x 2", or “x 4”.

When the horizontal and vertical sizesare set to “1 x 17, an alphanumeric
character occupies 16 x 8 dots, and a Chinese character occupies 16 x 16
dots.

The“Alarm Display” and “Alarm Message” will display on the LT unit’s
panel screen as shown below:

Alarm Summary Alarm Message Display
(“Alarm Display” Part)

Vale? Alarm
Yahed Alam
Yalve Alarm

p‘-'-. |:E| il H 0.

< _1Right to left scrolling display

Usage Pattern
Select the alarm type:
[Screen/ - [Alarm Editor] - [Alarm Message/Sum-
Setup] or mary] -
Click on | (& .
Enter a Set up [Alarm Save the Alarm
message. ~  Message/Summary]. ~  Editor.

@ Alarm Editor |

Gt

ote:

X2)

Viathe Alarm Editor, messages and monitor bits are registered for each
alarm type. An example of an Alarm Message screen used for entering a
message is as follows.

Thetab width for each item in the Alarm Editor (messages) can be adjusted
by positioning the mouse pointer on the border between items and then
draggingit. Thechanged sizewill be saved, and used on the subsequently
opened screens.
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B Alarm Message/Summary Screen

Here, you can register the messages to be displayed as either “ Alarm Sum-
mary” (“Alarm Display” Part) or as“Alarm Message” (right to left scrolling
display). The message can be registered up to 8999 lines.

Pop_up ﬁi'Basic Alarm Settings - A Manufacturing System_lte | — CheCkS If
Keypad Mlam  Edit Wiew Help the Auto-
(EEER ] e matic
". ’ETM T [ Riezmwar Tin "m MESCEECO g oo pacress
AlarmPrint |2 F — P P oo I o Increment
. Jumps ta the designated line m@ funCtlon |S
Bit = bei d
= ,— eing use
Address m : TB1t S[xga Message/ Summary Text
| = |summary
Alarm Type z | Sumary Message
: sunnary Color
£l Summary
Message s sunnary
P sunnary Jump to
¥ Sunmary the
e sunnary specified
Ready el J.4 line
€ Bit Address

Specifies the monitor bit. To specify the bit address for the “ Alarm Sum-
mary” mode, select a device that can be specified in Word units.

Device/PLC Connection Manual

& Alarm Type
The Alarm Editor provides two types of alarms. [Alarm Summary] and
[Alarm Message].
The [Alarm Summary] mode lists messages specified by the Alarm Part.
The [Alarm Message] mode displays a scrolling message at the bottom of
the LT's screen.
Up to 128 messages can be entered into the Alarm Editor. Any message
beyond this setting range will not operate on the LT unit’s panel screen.

€ Message
Enter your message here. Up to 160 a phanumeric characters can be entered
for one message. Index Text can be used to switch messages.

SO 4.5.3 Entering Settings via the Screen Editor 4 Selecting
Alarm Editor Messages

@ Pop-up Keypad
A pop-up keypad is displayed, allowing you to enter the bit address using
the mouse.

@ Message Color
Designates message’s color. Select the display color (Fg) and background
color (Bg), and specify whether to blinking (BIK) is used or not.

€ Automatic Address I ncrement
After entering and registering a message in a line and moving to the next
line, an address that is one bit larger will be automatically entered for the
new line.
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5-4

/,
/A
n

Important

When a variable (Logic symbol) is used as an address, the
automatic address increment function must be turned off. Other-
wise, the correct addition will not be performed.

€ Jump to the designated line.

Specify aline and click to jump to theline.

& Print

/A

u
Important

An Alarm Message (like a bulletin board) can be printed out when the alarm
istriggered and when recovered. Specify if the Alarm Message is printed out
at the triggering of the alarm and at the recovery from the alarm, respec-
tively. When [Summary] is selected, this setting becomes ineffective.

Trigger Time:  Prints out the time when the Alarm M essage started.
Recovery Time: Prints out the time when the Alarm Message is finished.

Printing Example

Trigger 10/15 16:07 No.1 error
Recovery 10/15 16:30 No.1 error
Trigger 10/21 11:25 No.1 error
Trigger 10/21 11:28 No.3 error

Recovery 10/21 15:45 No.1 error

« Up to 1,000 Alarm Message triggering and recovery events
can be stored in the LT. When the LT is not connected to a
printer, up to 1,000 events will be stored in the LT, which
enters a printing stand-by mode. When the number of the
events exceeds 1,000, the excessive events will not be stored.

* When a printer becomes offline mode due to the running out
of printing paper during printing, DO NOT turn the LT's power
OFF. Refill the paper and return the printer to online mode.
Event information stored in the LT in the printer offline mode
will be output to the printer when the printer mode returns to
online.

e |f the printer's power is turned OFF during printing, event
information transferred from the LT to the printer while the
printer's power is OFF will not be printed.
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@ Creating an Alarm

)

This section describes how to create and register alarm messages using

Alarm Editor.

PROCEDURE

REMARKS

(1) Viathe Project Manager, select the [Screen/Setup]

menu - [Alarm Editor] command, or click on the...

icon to open the Alarm Editor.

§¥ Basic Alarm Settings - A Manufacturing System_lte
Alarm Edit Wiew Help

o Fo IO I e L Awsomatic Address Incremen t
Ed T Tk Frzemuen) Ty H
= I&] o T Dl Pessvy e Ji; I ) e
Jumps to the designated fins s

Message/Summary Text

Ready [ IMoM___J.4

(2)Specify the bit address (monitor bit).

Bit A... | Type
1 00010 1| ~ [ Summary
z k Summary
g o

Message/Summary Text

(3)Enter a message.
Enter the message to be displayed on the LT unit panel
during alarm output.
Select amessage color, if desired.

- —————m e e ww

i Bit A... |Type
1 0010 Summar; Y
2 Summar ¥

‘Message/Surmary Text
[Tank & temperature increase %

Entering data in the Alarm Editor
only does not activate the “ Alarm
Summary” mode. To activate the
"Alarm Summary" mode, you must
place the Message Display on the
Base screen where the message is

displayed.

|

u
Important
When designating an Alarm
summary’s bit address, be
sure to select a device that
can use word designated
units.

Device/PLC
Connection Manual, 3 * 3/
4 * 3 Supported Devices

@V\ote: Theaddressto be entered
X2 varies depending on your
LT and PLC type. Note
that the sample screen in
thismanual isjust one
example.

Up to 160 a phanumeric characters
can be entered for oneBasic Alarm

message.

After selecting severa messageshby
dragging the mouse, you can use
the [Copy] and [Paste] commands
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REMARKS

PROCEDURE
(4)Select the alarm type: Alarm “Message” or Alarm
“Summary”.
Type ‘Message/Sunmary Text
1 AN00L0

Summary N [Tank & temperafure increase

Summary >

‘H Bt A...

(5) After entering all the necessary items, select the
[Alarm] menu - [Save] command, or click on the
icon.

The specified alarm data will be stored in the currently
opened project file.

Up to 512 alarm messages can be
registered. However, set the moni-
tor bits within 128 words.

If amessage has not been entered, the
Alarm Editor data cannot be saved,
even if the bit addresses have been

specified.

@ Editing Alarm Data

This section describes how to use the Alarm Editor’s editing commands.

B Cut/Move
Here, you can delete the selected line of dlarm data and store it on the
clipboard.
PROCEDURE REMARKS

(1) Select theline of alarm datato be moved.
I I;Qn_o_w“
: 0051

(2)Select the [Edit] menu - [Cut] command, or click on
the[g]icon toimport alarm data to the Clipboard.
The selected alarm data will be deleted and stored.

[ R

Eulletin

Sumnary

| | Gitc Address || Type | izzzage
i HOo1o Bull=itin Tank L temperature UP
2 XOoos0o SRS Y Tank B tewperature UPR
3 """""-":Surrmarv
4 0052 Swmmnsry
E ZO0E53 Sumnsic y

(3)Select theinsertion line.

|Bit Address |Type
Z0oo10

| Meszage
Tank L

EBulletin

temperature UP

1

Z o050 Surmnary Tank B temperature UP
3 Surmnar y

4 XOos52 Surnar y

5 SR

& 0054 Surtnary

7 XOoss Summar v

If a message has not been entered,
Alarm Editor data cannot be saved,
even if bit addresses have been
specified.

To select several lines, drag the
mouse between the target lines, or
click on the target line while
holding down the shift] or [ Ctrl |
key.

To delete the selected line(s), per-
form steps (1) and (2) only.
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PROCEDURE REMARKS

(4) Select the [Edit] menu - [Paste] command, or click
on the @) icon to paste alarm data to the destination

from the Clipboard.
If the same number already exists, the system asks if

each file must be overwritten. If you select |}

the desired data will be overwritten. If you sel ect

. the desired file will not be overwritten, and

the system will ask the same question for the next alarm.
If youselect| vestoan |, al existingaarmswill beover-

written. If you select , you will return to the
menu screen.

Confirm Alarm Replace

Alarm Mo 5 already existsl Dvenwrite?

J

The selected alarm data is moved to the specified line.

| | Bit Address | Tyoe | nassags
i Xoo1ao Iwmnsr Y
2 xoosao Iwmnsr Y
3 Iwmnsr Y
4 xoosz Iwmnsr Y
s [xoosi |Swmeery
[ X0054 Iwmnsr Y
7 X0o0oss Iwmnsr Y
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W Copy
Copies the selected line of alarm data, and stores it on the clipboard.

PROCEDURE REMARKS

(1)Select the alarm line to be copied. Even if bit addresses have been

[ Bit Address

[ Type

[ Message

A000a

Bulletin

Tank & temperature P

XDDDED

Surnrnary
Summary

Tank C temperature UP

% 200052

Surnrnary

(2)Select the [Edit] menu - [Copy] command, or click
on the[Eg]icon toimport alarm datato the Clipboard.
The selected alarm data will be copied to the clipboard.

U1-h|@;@m—t

=00053 Summary

[ [ Eit &ddress [ Type [ Meszage
1 =00010 Summary
2 =00050 Summary
3 00051 Bulletin
4 #0005 Summary
5 00051 Bulletin

(3)Select the destination line.

| [ Eit &ddress [ Tupe [ Message
1 XOoono Surnrnary B
2 00050 Summary
3 00051 Bulletin
4 =005z Summary
5 00051 Bulletin
E XEIEIEIE4 Summary
i 00055 Surnmary
g XDDDEE Summary
9 HOO0oe? Surnrnary

specified, if message data has not
been entered, the Alarm Editor data
cannot be saved.

To select several lines, drag the
mouse between the target lines, or
click on the target line while
holding down the[shift] or
key.

(4) Select the [Edit] menu - [Paste] command, or click
on the@ icon to paste alarm data to the destination
from t@CIipboard
If the same data already exists, the system asks if each
file (item) must be overwritten. If you select || !
the desired file will be overwritten. If you select
_ , the desired file will not be overwritten, and
the system will ask the same question for the next alarm.
If youselect| veswonn |, @l existing larmswill be over-
written. If you select , you will return to the
menu screen.
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PROCEDURE REMARKS

Alarm No 5 already exists! Ovensrite?

The selected dlarm datais copied to the specified ling(s).

| | = e e i Q] | e i e

i |¥0010 Bullavin  |Temk & g
z |xooso SumnaT [Tenile & sops
3 |%oosi Swmmary fremk € stopg
& Xoos: SRS Y
5 ¥0o53 Summner y
o 0052 SRS Y
7 [ koost T sumeary Temiz © g
=1 X0oose Summner y
o X005 SRS Y
hin] hanipi=4=] S v vy
B Undo

This feature allows you to cancel the previously performed command, and
return to the previous condition.

PROCEDURE REMARKS

When an alarm has been unintentionally deleted:

(1) Select the [Edit] menu - [Undo] command, or click | Edited message characters cannot

on the||icon. be restored with the [Undo] com-
o mand.
| [ Bit &ddress [ Type [ Meszage

w=000a0 Summary
______ Summary
4 won0a2 Summary
5} w00a3 Surnmary

Tank C temperature P

1 w0010 Bulletin
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B Adding Alarm Data

Here, you can add alarms for the specified number of bits or words from the
line whose item is enclosed with dotted lines. Addresses are automatically
assigned to each alarm from the start address in series, according to the
designated address adding increment. In addition, when messages have been
entered, they are copied for all the alarms to be added.

When a variable (Logic symbol) is used as a start address, set
] the add offset to 0. Otherwise, the correct addition will not be

Important erformed.

Add Basic Alarm

Start Address 00000 Alarmn Type i3

& Alarm Summary 'm

2 Alarm Message ;I
[ hee ]

Murnber of Bits to Add

Add Offeet Help

];ﬂ Meszsage | "

Mezsage Caolor Frint

Fo )0 B0 I Tiiagen Tiines Pl
ro B O exd O Pt Przene Tines

PROCEDURE REMARKS

(1) Select the address line where the specified number
of addresses will be added. (Shown here with a dot-
ted linearound its border)

1 | DAL ALl | Ly
| 1 |¥oo10 Bullstin
T T

e
(2)Select the [Edit] menu - [Add Alarm] command, or
click on the[gs]icon.

(3)After entering the necessary settings, click on the | If asymbol isspecified for the start
[ ox ]button. address, the added addresses will

If the same number aready exists, the system asks if each | bedisplayed asfollows:
file must be overwritten. If you select | Example: Assume that the start ad-

dressisTEST (.~ Symbol), and that
sired file will be overwritten. If you select , the the number of dded bits s 4. The
desired filewill not be overwritten, and theg/stem will ask

addresses are consecutively added
about the next . If you select [ Tetoar |, all eXISting | oo oo pegos Y

alarms will be overwritten. If you select [ wowar |, you | TEST

will return to the menu screen. TEST +1
TEST + 2
TEST + 3

3
k3 EO0O3 SRS Y
5 FNnna ST

Add Basic Alarm

StatAddress  [01/00000000 = ||

Alarm Type k
Wurnber of Bits to Add 16 - £ dlam Summary [ Cancel
- # dlarm Message =
Add Offset 0 =
D Message J ‘

Mezzage Color

Fe NN NV 1 VO ) T
g [ O ][] B ]
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PROCEDURE REMARKS

U

Confirm Alarm Replace E

Alarm Mo 5 already exists! Ovensrite?

B Changing Alarm Attributes
You can easily change any alarm’s attributes.

Change Alarm

Alarm Type

%) Alarm Surnmarny
£ Alarm Message

Meszane Color

Fo ) ) IV L ) e
pa [ ) O ) 1

PROCEDURE REMARKS
(1) Select theline of the alarm to be changed. If several lines are selected, the at-
In this example, we will change an attribute of anitem | tributes of the selected lines can al
in the alarm message/alarm summary area. be s multaneoudy changed.
| [ Eit &ddress [ Tupe [ Message Tosdect severd lln&’ dr@ themouse
1 |xoomin Bulletin between the desired lines, or click on
2 [A00050 Surmmar : ; ; o
;@ HO0051 5 urnrn.ar Tank C temperature LIF the dﬁ raj l Ine Whl I e pr ng the
+ ¥ 00s; Summary [shift|or key.
] XOoos3 Surnrnary

(2) Select the[Edit] menu - [Change Attributes] com-
mand, or click on the [g&|icon.

(3) After entering the necessary items, click on the

button.

Change Alarm |

Alarm Type
2 Alarm Sumimary " Cancel
23 Alam Mezzage :

Mezzane Color

Fo I I o ) ) 1] e )
ea [ O O O 1) i
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5.1 Alarm Creation and Editing Chapter 5 -CREATING AND EDITING ALARMS

B Reflecting Device Comments

Thisfeature is used to reflect all the comment information corresponding to a se-
lected device in the Message field.

PROCEDURE REMARKS

(1) Select an alarm for which comment information is
to bereflected, on arow basis.
Here, reflect the comment in the device for the alarm
message/alarm summary.

[Me==age; Summary Text

Trannn

(2) Select the [Edit] menu - [Apply Device Comment]
command, or click on thel@ icon.

(3) A confirmation dialog box appears. Click on the
button to execute the command

Alarm Editor

The selected Address(es] will be uszed to search for a related Device Comment{z).
If found, the comment will be inzerted into message field.
Are you OK?

(4) The device comment corresponding to the address
will beincluded in the messages.

T [[Bit 2d4... |[TvEe= [M===age; Swmmary Text
X00100 Me=s=age
z X00lal Summazy
2 Xooloz Summazyr

[,
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Chapter 5 - CREATING AND EDITING ALARMS 5.1 Alarm Creation and Editing

m Alarm Import/Export

)

The created Alarm data can be exported to and saved asan ALA or CSV
file. Then, by importing the saved alarm data, it can be shared among
Projects. CSV files created viaatext editor or Microsoft Excel can be
imported and used on the Alarm Editor.Alarm datal's CSV file formats are as

follows:
“Block”, “0" Reserved 1
“Blockl”, “0" Reserved 2
“Block2”, “0” Reserved 3
“Block3”, “0" Reserved 4
Basic Alarm Message/Summary settings “Bit Address”,
“M0064”, “ Function A in suspension”, “0”, “0”, “7”,“0",“0", “0" “Message” “Re-
13 il “ H H - tl " ” “ ” " ” 13 ” 13 77 “ n Served 5“ L : Fg” 1
M0065”, “Function B in suspension”, “1", “1”,“1”,“17,“2",“1 “BIk”, “Bg”, “BIK’
“M0066", “Function C in suspension”, “2", “0", “3", “0", “5", “1”
Reserved 1 0 fixed
Reserved 2to 4 |0 fixed
Reserved 5 0 fixed
Foreground color (Fg), 0to7
Message Colors [Background color (Bg)
Blink (BIk) 0: Notblink 1:Blink 2: Notblink 3: Blink

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide
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5.1 Alarm Creation and Editing Chapter 5 -CREATING AND EDITING ALARMS

B Alarm Export
Alarm datais saved as ALA or CSV files.

PROCEDURE REMARKS

(1) Select the Alarm Editor’s[Alarm] menu - [Export]
command.

(2) Click onthe[ ves |button.

Alarm Editor

Thiz operation may take a wery long time for a large number of messages
Contirwe?

(3) Specify thefilenameand filetype (*.ALA or *.CSV)
with which theexported alarm dataissaved, and click

onthe[ sae |button.

Enter acomment, if desired.
If the same ALA file name already exists, the system
asksif the existing file must be overwritten. If it must be

overwritten, select . If it should not be over-
written, select .

Save As

Sawe in: |@ Databaze E|

Balaim 1 4LA,
Name.ALA

File narne: |A\arm product 1

Save as bype: |[" ala)

Alarm Editor

The zource iz of a different PLC type than the current praject!
Imported addresses may be invalid.
Do wou want to continue?

(5) Click on the .
export mode.
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Chapter 5 - CREATING AND EDITING ALARMS 5.1 Alarm Creation and Editing

B Alarm Import

Alarm data saved as afile isimported to the currently open Alarm Editor.
Files with the extension of “*.ALA” or “*.CSV” can be imported.

To import alarm datafrom a CSV file, only the specified type of alarm can
be imported from all the registered alarm.

PROCEDURE

REMARKS

(1) Select the Alarm Editor’s[Alarm] menu - [Import]
command.

(2)Click on the[ ¥es |button.

Alarm Editor

Thiz operation may take a wery long time for a large number of messages
Continue?

@

(3) Select a file (*.ALA or *.CSV) to beimported, or
enter thefilename. Then, specify an import method.

Open

[71x]

Look jn J My Documents

F&] @

File name:

Jtest.ala

| [ ok |
Jz” Cancel
‘ 12 Oiverwiite
% &dd to End
y

(4)When sdlecting CSV fileasimported filetype, specify
thetype of alarm to beimported.
Only the type of alarm specified here will be imported.

Files of twpe: J [*.ala)

Description: J

Open Il
Loak, jr J Iy Documents .E”
i3
File harne: Jtest.csv | ’TI
Files of bipe: J[".csv] Jﬂ| " Cancel
Description: J ‘ i Owenwiite
%) &dd to End
&
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[Overwrite]

All current alarm registration num-
bers (1 to 8999) will be overwrit-
ten.

[Add to End]

Imported messageswill be added &f-
ter thelast messageline. If thereare
any gaps between the current regis-
tration numbers, the sequence num-
bers will be re-assigned to fit into
all existing lines, and the imported
messageswill be added after the last
line.

When selecting ALA file asim-
ported file type, skip step (4).
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5.1 Alarm Creation and Editing Chapter 5 -CREATING AND EDITING ALARMS

PROCEDURE REMARKS
(5)After entering all the necessary items, click on the
button. m
If the selected Device/PLC is different betweenthecur- | jnoorant

rently open project and theimported ALA file, the system Once vou complete the
asksiif the preset addresses should be overwritten. If the you P

: _ [Import] command, it cannot
preset addresses must be overwritten, sdlect| v |.If | pa indone.
they must not be overwritten, select .

Open E{
Look in: [ {3 database E|| =
Filename: [iestlala | [ o lk
Files of type J[x_a\a] Ell Cancel |
Description; J ‘ 23 Oveni te
% hdd to End

The zource iz of a different External Device tpe than the current praject!
Imported addresses may be inwalid.
['o you want ta continue’?

(6)Click on thef | button to quit import mode.
Sinceyou selected [Add to End] in this example, theim-
ported messages were added after the last line.

Processing Alarm Messages

Frocessing larm Meszages Done.
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Chapter 5 - CREATING AND EDITING ALARMS 5.1 Alarm Creation and Editing
A - When alarm data does not have an identifier "Block*" for the
! first 4 lines which indicate Reserved 1 to 4, the alarm will not
Important he imported.
- If the address(es) registered in the alarm data to be imported
are incorrect, set correct addresses via the Symbol Editor.

4.2.6 Symbol Editor

-When the number of message characters exceeds the limit, the
message is imported only for the effective number of charac-
ters.

-When data is imported from a file in which only a message is
registered, the initial value is used as an address.
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LT INITIAL AND SYSTEM SETTINGS

Y ou can select many of the LT unit’sinitial settings through the

LT Editor for Windows program. This program areais called
“System Settings’. When “ System Settings’ datais sent to the LT unit, you
will not need to manually perform the initial setup of the LT unit.
A description of each LT unit setting item is provided in your “LT Series
User’'sManual” (sold separately). For details, refer to that manual.

6.1 Menu Setting Items: LT Setup
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6.1 Menu Setting Items: LT Setup Chapter 6 - LT INITIAL AND SYSTEM SETTINGS

m Menu Setting Items: LT Setup

In the [System Settings] mode, you can easily select the LT unit’sinitial
settings. By doing this, you don’t need to manually set up the LT panel,
since the [System Settings] datais sent to the LT panel automatically. After
the [ System Settings] datais sent to the LT panel, you can also change those
settingsviathe LT unit itself.

LT SeriesUser’sManual (sold separately),
Chapter 6: INITIALIZE

Usage Pattern |

[Screen/ [LT Setup] — Entereach — Click onthe
Setup] o parameter button
to register the LT
click on |(&z=m). system settings.

Some setting commands are supported by the LT unit but not by LT Editor
for Windows, or vice versa, i.e. are supported by LT Editor for Windows but
not supported by the LT unit. This section describes only the commands
supported by LT Editor for Windows. For a description of other commands,
refer to your “LT Editor User’s Manual” (sold separately). For individual
settings of each external communication device network, refer to the De-
vice/PLC Connection Manual.

€ Setting commands Supported by Only the LT Unit:
- Setting Date/Time
- Self-diagnosis command
- Font settings (English, Korean, etc.)™*

€ Commands Supported by Only LT Editor:
- LT Settings: [Checksum]
Enables checksum verification.
- LT Settings: [Screen Level Change Flow]
Used to switch screensin the hierarchical display mode.

- LT Settings: [Change to Screen No.]
Specify the number of the screen used to replace the current one after
the preset standby time has passed. If you enter “0”, no screen will be
displayed.

- 1/0O Settings: [Offline M ode]
Specify how to change from on-line mode to off-line mode.

- 1/O Settings[Printer Type]
Specify whether to use the LT's Tool Connector to perform print
operations. If you select "Yes" (using the LT's Tool Connector), con-
figure the printer type and detailed print settings.

*1 If any font setting other than "Japanese” is selected, "Font Setting” requires specifying
whether alphanumeric characters and symbols are to be displayed at the high quality
level.
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Chapter 6 - LT INITIAL AND SYSTEM SETTINGS 6.1 Menu Setting Items: LT Setup

- Mode Settings: [Device/PLC]
Displays the name of the host (Device/PLC) connected to the LT
panel.

- Mode Settings: [Option]
Device/PLC Connection Manual
- Extended Settings: [Keypad Display Priority]
Designates the Keypad Display processing mode. " Standard” mode

executes the processing of the Keypad Display once per scan time, and
"Twice" mode executes the processing two times per scan time.

- Extended Settings: [Backup Settings]

Used to back up the LT panel's LS area data. Specify theinitial address
of the backup range, and the number of words used.

- Extended Settings. [Delete Error Display](Only for programlesstype)
Displays an error message when an communication error occurs with
the LT unit panel, and deletes the error message when the communica-
tion error isreset. System errors however cannot be reset, regardless of
this setting.

- Extended Settings: [Watch Dog]
Monitors the communication status between the LT panel and Device/
PLC. The LT unit sends “00FF" to the External Device's word address
at a specified timeinterval. The Device/PLC (ladder program, etc.)
checks whether the communication is performed normally by confirm-
ing the “O00FF” command at the specified timeinterval.
The data that is checked should then be cleared to “0”, in order to
detect new data writes from the LT unit. However, if the LT sinternal
common relay (special relay) data (LS2032)’s bit 2is ON, the LT will
be unable to write.

- Communication Settings: [Send Wait]
If the LT unit sends a command to the Device/PLC immediately after
receiving aresponse from the Device/PLC, the Device/PLC cannot
receive the command, which will cause a communication error, de-
pending on the Device/PLC. In this case, enter avalue for the trans-
mission wait time. If atransmission wait time has been entered, the LT
unit waits for the preset time duration after receiving the External
Device's response, and then sends the next command to the Device/
PLC.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 6-3



6.1 Menu Setting Items: LT Setup Chapter 6 - LT INITIAL AND SYSTEM SETTINGS

W Tab Setting Items
Each tab's setting items are described here.

@V\ote: The setting items may differ depending on the LT type or Device/PL C being
2 used.

€ LT Settings

System Setup - A Manufacturing System_lte

Initial G oreen S etings | Extended Settings | Communication 5 ettings |

System Setup | 1/0 Settings | Mode Settings

B Check )
Touch Buzzer /—/ SyStem Set“ng

Screen Ma. Data Type 25 Bin i BCD |temS
O 5creen Level Changs Flow

Password Setings J— Designate the arbitrarily

Standby Mode Time 0 =1 Minuies specified password (0-9999)
Change To Sereen No. [0 = or select the ON/OFF setting

Com Port Start Up Delay H s for the common password

setting (1101).

|| ak I || Cancel | || Defaults | || Help
€ /0O Sattings
Syztem Setup - A Manufacturing System.lte
\ Initial Screen Settings ] Extended Settings Il Communication Settings |
Syztem Setup || 1/0 Settings | Mode Settings |
Offline Mode Top Left Comer Forced Reset Mode |
Cortast Adiustment | Touch Panel Settings
N . Brightniess Adjustrment
LCD Settlngs | Reverse Display

Touch Input Mode: 220 1 Paint Touck
9 2 Paint Touch [Same Time)
20 Dizable Shide [Outside of Tag)

Elzﬁqgstuch Fanel After Backlight 9 Yes 1) Mo
Riefresh Rate _
= Printer

Frint From Tool Connector

Printer Settings

#2 Unused = U cE
Keyboard 510 Speed 9600bps -
Tupe PR201 ~

Print bethod % Monachrome 7 Colar
Frint Direction 1% Horizontal 20 Wertical

Fieverse Color Frint

“ ok I“ Cancel ||| Drefaults ||| Help
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Chapter 6 - LT INITIAL AND SYSTEM SETTINGS

€ ModeSettings

6.1 Menu Setting Items: LT Setup

System Setup - A Manufacturing System.lte . i
— . . —— Operating Environment
| Iritial Screen Settings || Extended Settings || Communication 5 ettings J .
| Spstem Setup || 1/0 Settings || Mode Settings Sett' n g S
Device/PLC [OMRON THERMAC NED SERIES |

Syztem Start Address

e

Transmiszion Status

[ ] )

Ciustaizs:...

tachine Mumber '
Read Area Size _ '
Link Protocal Type #0101 20 e
Maode Setup /’
Mode Number o

L — Node Information Settings

Customizing command

(n:1)

[T——Operating Environment
Options

|| 0k I [f Cancel | ” Diefauls | || Help
€ |nitial Screen Settings
System Setup - A Manufacturing System_lte
[ System Setup | 1/0 Settings || Mode Settings | | — In |t|a| SC reen Sett| n gS

Initial Screen Settings

Estended 5ettings

Communication Setings— |

Initial Baze Screen Mumber

Alarm Character Size

—J

4u4

~

ok

I || Cancel

||| Drefaults |||

Help

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide
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€ Extended Settings

System Setup - A Manufacturing System_lte
. System Setup I 1/0 Sellings I Mode Setlings
FO nt Sett' n g S \ Iriitial Screen Settings Extended Settings Communication 5 ettings ]
L :g': Selting Online Error Display

Keypad Dlsplay o Kore:n g:::[i’s’;;?liﬁ:?ﬂn Data“write Ermor | Error Handllng Settl ngs
Priority Settings ggziwaﬂese I ) _ _

L= J| Daibode ) String Data Settings

=Keypad Display Priority: Fort Jualty——

& Standard 12 Standard
St ’F@ o, ) _ System Area Bgckup
L sweie. | ¥f| Command Settings
= Wwatch Dog C Systemdies. .
Watchdog Ward Addh. CIC_Tebarwrdon_
Monitoring Tine = LT Internal Memory Data
Address and Area Settings
Time Settings
Global Window Settings
” [u].4 | || Cancel | ” Defaults | “ Help
€ Communication SettingsMenu
System Setup - A Manufacturing System.lte
System Setup || 1/0 Settings [ tdode Setlings |

Initial Screen Settings | Extended Settings

| Communication Setings

= AS5-232C / R5-422 —=

Transmission Speed | 9600 [

Communication Param-

12 RS-2320 H
4t eter Settings
B Lnd
= Data Length Pariy B Stop Bit
1 7 Bits 2 None & 2 Bit
£ 8 Bits £ 0dd 01 Bt
1% Even
= Busy Ready Control =—
100 %-OM J OFF
B TR/ ER Advanced . Communication Monitor

Time Settings

Ok ||| Cancel |” Diefaults H| Help
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B LT System Settings

6.1 Menu Setting Items: LT Setup

PROCEDURE

REMARKS

(1) Viathe Project Manager, select the [ Screen/Setup]

menu - [System Setup] command, or click on the

icon.

(2) Click on a desired menu tab.
Each tab’s setting items will be displayed.

[Eystem]

{ Menu

Tabs

Initial Scieen Seftings | Ewlended Seftings | Communication Setings
Spstem Setup Iy | 1/0 Settings I Mode Settings

Theck, 2
Touch Buzzer
Scresn Mo Data Type 480 Bin 3 BCD
[l Sereen Level Change Flow
Fasaword Seltings
Standby Made Time g% Minutss

Change To Seigen No, ];[E
Com Part Start Up Dielay T s

[ o [ cancel ][ etaas |[ be |

(3) After entering all the necessary items, click on the

button.

System Selup - A Manufacturing System.lte

Initial Goreen Gettings ||

E rlended Setings

|| Communisation 5etings

|

i RJ [ cam

System Setup 1/0 Settings Mode Settings
Check Sum
Touch Buzzer
ScreenNo.Data Type 40 Bin 124 BCD
[l Sereen Level Change Flow
Passwiord Settings
Standby Modes Time Minutes
Change To Screen No =
Com Port Start Up Dslay Sec
[ el | H Defaults | H Help

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

Toreset each itemto itsdefault value,

click on the button.
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TRANSFERRING SCREENS

T o display screens created with the LT Editor on the LT unit, or to
run the created logic program on the LT unit, you must first transfer
datato the LT. Conversely, you can aso transfer the data stored in the LT
unit back to the LT Editor.

This chapter describes how to transfer datato and from the LT unit.

TL Prior to Transferring Data
72 e Transferring Data and L ogic Programs
73— Options
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7.1 Prior to Transferring Data Chapter 7 - TRANSFERRING SCREENS

m Prior to Transferring Data ]

m LT Screen Transfer Cable ]

You must first connect the Data Transfer Cable to the LT unit and your
personal computer before you can transfer screen data.

Personal Computer (PC)
(or Lap-top)

Screen transfer cable
(Dsub 9-pin socket) LT

To PC’s serial _—€= 5
)\

port

Mouse To LT's Tool Connector

/\
\

e To transfer LT Editor data to the LT unit, the optional screen

! transfer cable (GPW-CBO02) is required. This cable does not
Important  come with any interface conversion adapter for the personal
computer. Supply a connector conversion adapter compatible
with the interface of your personal computer.

* File Transfer requires approximately three times the hard disk
space occupied by the Project file.
@Ikv\ote: e Use apin adapter that fitsyour personal computer’s serial port.

)

e |[f aserial mouseisused, be sureto connect the cable from the LT unit to a
different serial port on your PC.
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Chapter 7 - TRANSFERRING SCREENS 7.2 Transferring Data and Logic Programs

E Transferring Data and Logic Programs

This section describes how to transfer screen data created with the LT Editor
program to and from the LT unit.

Usage Pattern |

Project
Manager

Specify the Setup
— and Communica-
tion parameters.

[Transfer

[Project] — [Transfer] — Settings]

or

Click on .
=

[Transfer]

[Setup]
or

Click on .

Compile the LT Click on the [fa] or

— Editor data LT unit —, icon to transfer
data. screen data.

To display a screen (window) to perform data transfer, select the Project

[Prepare]

-

Manager's [Project] menu - [ Transfer] command, or click on the icon.
=

Or, select the Screen Editor's [ Screen] menu - [ Transfer] command, or click

on the | icon. An example of this screen (window) is as follows:

Cancels Data Displays the [Transfer

Transfers screen Transfer mode Settings] dialog box

data and logic

programs from Quits [Transfer]

Transfer Setup Wiew Dptiog Help mode
LT Editor to the ==
LT unit ~Displays the
Project File: JSoda.Ite current project file
Tra!’ISfel‘S Only / /- System Setup: name
logic programs Degftiption [5oda ,
/ Send To:
Tranzfer Status: / Frepare Status: \ \ \\Displays the
Receives screen / Currently-specified
data and logic transfer mode
programs from .
the LT unit to the / / S&?fgii’f :{Qeeci-
LT Editor. . y-sp
7 ] | fied setup mode
I / / | | | J
Uver?(F'rogress: / / DiSplayS the
[/ / | «___| | currently-specified
/ [ | AN destination type
Readf / | [ JHUMK yp
7 T N
Displays the current Displays the Displays the Displays the
status of the data current project’s transfer prepara- progress of the data
transfer operation comment data tion status transfer operation

The tool bar icons provide the following functions:

Send screen data Cancel _
and logic pro- | Transfer Quit Transfer Tool

gram |§ - ] |@] |‘@)] |EE ] | ! ]
i i — ]
Send logic  Receive screen Transfer Setting
program only data from LT unit

Do not turn OFF the PC or the LT unit, nor disconnect the trans-
A Y4 fer cable during the transfer of screen data. This can cause an
Important error when the LT is started.
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@ Transfer Settings ]

This section describes the parameter settings necessary for screen data
transfer between your personal computer and the LT unit. These parameters
must be reset if your personal computer has been disconnected from the LT
unit, if the LT unit has been shut down, or if a nonstandard system or proto-
col program has been used with the LT unit.

B Transfer Settings

Select the [Setup] menu - [ Transfer Settings] command, or click on the [
icon. Then, adialog box to perform data transfer settings will appear.

Specify the kind of

informatio.n to Select the PC serial
transfer with the port that will be used
screen data. i (-] with the data transfer
System Screen Baud Rate {bps) cable
i ConielDats ey Coun [ ] T—Select a transfer
=Ttansfer Methad S peed '
Select the transfer 2 Send Al Sorsens i
mode R
I y— lse Extord Program Sends the simulation
£ Ferce Syotem Setp D Simiaton protocol to the LT
Select the setup mode | | =Le=N0T Perfom Senp unit.
Setup CFG file: 8'1 Over-
Locate the setup ——| | ¥Enain view
information file géj::.:: [ \PROGRAN FILESPRD FACELTvprctocl [ Brawss.. |
ok ] | concet | [ b |

@ Transferring Information

Send Infarmation

Upload Infarmation
Spstermn Screen
Control D ata

Upload Information

Check this box if you wish to send upload information to receive data
from the LT unit.

Upload parameter data must be included to Receive data from
1 . the LT unit. If the LT unit’s memory is insufficient to include the
Important \1nload parameter data, data can still be transferred from your
personal computer to the LT unit. However, if the upload pa-
rameter data is omitted, your personal computer cannot re-
ceive data from the LT unit.

System Screen

Check thisbox if you wish to transfer LT system settings information
along with other datato the LT unit.
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Control Data

Check thisbox if you wish to send logic programs along with other data
to the LT unit. When transferring system programs or protocol programs,

however, logic programs are always transferred regardless of the setting
of this screen.

€ Communication Port

Select a seria port to which the transfer cable is connected, and atransfer
Speed.

& Transfer Method

Tranzfer kethod

i Send &)l Screens
%) Automatically Send Changed Screens
i Send User Selected Screens

Send All Screens
Transfers all screen datain a Project Fileto the LT unit.

Automatically Send Changed Screens

Any screen data that have been updated in the current Project File are

automatically transferred to the LT unit. Thistransfer mode isonly
@\ effective when screens have been previously transferred to the LT unit.

Note: When “Automatically Send Changed Screens’ isused, screensthat have been
2] deleted (not just updated) from the Project Filein the LT Editor program will
not be automatically deleted from the Project File stored in the LT unit. To

completely replace all screens of the Project File stored in the LT unit, besure
to use“Send All Screens”.

Send User Selected Screens
When transferring a screen to a Project File stored in the LT unit, you

must specify the screen type.
%Ik\l\ote: No Filing Data and logged data can be specified to transfer them.
\a
To select screens, click on the names of desired screens while holding
down the key.
Select Screens to Send B
Select Screens To Transfer
Type 1 Mumber ] Title
[rata Sampling
Baze 2 Alarrnl
Base 13 Switch 1
Baze 15 Switch?
Baze 16 Production Ala
Mark Screen 1 Untitled
Image 1 Logilogo. bmp
MessageSummary 1 Alamm File
I e
" Cancel ] | Help ]
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@ Setup

= Setup
&) Automatic Setup Use Extended Program :

1 Foree System Setup O Siulation
123 Do NOT Perform Setup

Setup CFG file :
#) English
1 Japanese

19 Selection  [CAPROGRAM FILES\FRO FACE\LT \protocal || Browse.,

Automatic setup :
Set up operation is performed if necessary, according to the LT’s status.
Normally, select this setup mode.

Force system setup :
Setup operation is performed every time screen data are transferred,
regardless of the LT’s status.

Do not setup :
Setup operation is not performed, and only screen data and logic pro-
grams are transferred.

Setup CFG file:

Thisisthefile storing the setup information. Normally, you need not use
this setup mode.

If you select "English" and perform setup, the OFFLINE screen onthe LT
unit will be displayed in English.

If you have changed from Japanese to English or vice versa, be
sure to force the system setup.

Use Extended Program
When using the Simulation Function with the LT Type-C, you need to
transfer a ssmulation protocol in advance.

8.1 Overview
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@ Passwords ]

B Registering a Password

You can enter a password to restrict user access to the data transfer function.

A _ .Besureto keep a copy of the password in a safe place. If you
14 forget the password, the “Transfer” function cannot be executed.

* The password is limited to 24 characters and only alphanu-
meric data (no symbols) can be used.

/U
Important

PROCEDURE REMARKS
(1) ViatheProject Manager, select the[Project] menu -

[Transfer] command, or click on the m@ icon. Or,

via the Screen Editor, select the [Screen] menu -
[Transfer] command, or click on the icon.

(2) Select the [Setup] menu - [Passwor d] command.
(3) Enter a password.

Register Password

[x]

Please Enter Password:

Please Confirm Password:

] |

‘wiarning:
Pleaze remember ta write down your pazsword!

I wou forget your passward, screen transfer cannot
be performed.

(4) Enter thesame password again for confirmation,and | If apassword has already been reg-

then, click onthe[ o« ] button. istered, the [Change Password] dia-
Register Password | | og box wi | I appear
Pleaze Enter Passwaord: Change Password |
J xxxxxxxxxx | Please Enter Password:
Please Confirm Password: J |
Wiarning;

Please Erter Mew Password:
Pleaze remember to write down your password!

I wou forget your password, screen transfer cannot J |
be performed.

Pleaze Re-enter New Password:

| Cancel | | Help J |

|. ] 4 I| Cancel || Help |
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B Changing a Password
The registered password can be changed or canceled.

PROCEDURE REMARKS

(1) ViatheProject Manager, select the[Project] menu -

[Transfer] command, or click on the icon. Or,

via the Screen Editor, select the [Screen] menu -
[Transfer] command, or click on the [Fig]icon.

(2) Select the [Setup] menu - [Passwor d] command.

(3) In order to changea password, you must first en-
ter the currently registered password.

|I [n]:8 ]| Cancel ]| Help ]

(4) Enter a new password. To cancel the password, after en-
tering the currently registered pass-
word in step (2), DO NOT enter a
[ | new password in step (3) and sim-

ply clickonthe[ ok |button.

J xxxxxxxxxx | Change Password

Please Enter Password

(5) Enter thesame password again for confirmation, and | |

then, click on the button. | ”
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@ Transfer Preparation ]

The Project File (LTE file) data created with the LT Editor program isfirst
compiled beforeit istransferred to the LT unit.

Select the [Project] menu - [Prepare] command to compile your data.

1E Transfer
Tranzfer Setup Yiew Options Help
Project File: JFactDr_l,J & ke ] Transfer Method:
Description: JFactory A ] :
| st
Tranzfer Status: Frepare Status:
- End Prepare -
ol ] =
| ] | |
Ovwerall Progress:
| |
Ready | |[HUM]]

‘Note: « To preparethetransfer, about the 3 timesthe project filesizeisrequired in
your computer’shard disk.

« After the[Prepare] command isfinished, you can check the LT unit’s
current memory capacity with the [Project I nformation] feature.

X 4-4.1 Project Information

e Onceyou use the[Prepare] command, you do not need to use it again for
the same data, unlessthe data has been updated.

e If theProject Fileto betransferred isstored on your PC’s floppy disk, copy
it toyour PC’shard disk prior to using “Prepare” to reduce transfer time.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 7-9
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m When Sending Screens and Logic Programs Together To the LT ]

To display screen created with LT Editor and to run created logic programs
onthe LT panel, you must first transfer datafrom the LT Editor tothe LT

unit.

The [All Send] command transfers the screen data and logic programs at the
sametime. You can also send logic programs aone.

7.2.5 When Sending Logic Programs
' In the case of LT Type C, if the LT is not connected to the exter-

u
Important

nal device when the screen data are transferred to the LT and

the "Change State" function is set to "Yes", bit switches, toggle
switches, lamps, and objects will not be displayed on the LT

panel after data transfer.

PROCEDURE

REMARKS

(1) ViatheProject Manager, select the[Project] menu -

[Transfer] command, or click on the icon. Oth-

erwise, viathe Screen Editor, select the [Screen] menu
- [Transfer] command, or click on the[fig]icon.

(2) Select the [Transfer] menu - [Send] command, or

click ontheicon.

If the currently open Project File has not been prepared
for datatransfer (the Project File has not been compiled),
then the system automatically compilesthe Project File
before transferring it to the LT unit.

To transfer ascreen to the LT unit for the first time, set
up the LT unit™* first, and then transfer the screen data.
The number of screenstransferred isdisplayed in [ Trans-
fer Status).

If the external device designated in the project file to be
transferred is different from the LT's existing internal
data, the following message will appear. When you click

on the button, the system starts setup opera-
tion, and then transfers the screen data.

protocol pourioad ———— IES

External Device type is Different, OK to Continue?

LT's Project File is DiffeReng)

Sending All Files

Cancel | Cancel |

After set upiscompleted, the LT pandl screen is automati-
cally switched to the OFF-LINE mode. Confirm theinitial
setting onthe LT pand, and adjust the settings asrequired.

Make sure that the LT unitisin the
“Transfer Screen Data” mode or
“RUN" mode.

LT Series User’s
Manual (sold separately): CHAP-
TERG6INITIALIZE

When transferring logic programs,
you must first select [Control Data]
in the [Transfer Settings] dialog
box.

7.2.1 Transfer
Settings

To cancel the data transfer mode,

click on the icon.

Data transfer mode will automati-
caly quit when the LT unit’sinter-
nal memory capacity becomes in-
sufficient.

*1 " LT setup” meansto download the system program and protocol program from LT Edi-
tor to the LT unit so that the LT unit can operate in the specified environment.

7-10
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PROCEDURE

REMARKS

(3) After screen data transfer is completed, select the
[Transfer] menu - [Exit] command, or click on the

icon.

B Transferring a Screen Using a Password
If apassword has been registered, you must enter it to transfer datato the LT

unit.

PROCEDURE

REmMARKS

(1)Viathe Project Manager, select the [Project] menu -

[Transfer] command, or click on the icon. Or,

via the Screen Editor, select the [Screen] menu -
[Transfer] command, or click on the icon. icon.

(2)Select the[Transfer] menu - [Send] command, or click

on the icon.

(3 Enter the registered password, and click on the

button to confirm it.

The data transfer operation will start.

Password Entry

Enter Password:

| xxxxx 1 "
|| Cancel | || Help |

(4)After screen data transfer is completed, select the
[Transferring Data and L ogic Programs| menu -

[Exit] command, or click on the [gk]icon.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide

If you enter an incorrect password
threetimesor more, datatransfer can-
not be performed. In thiscase, repesat
the transfer procedure from step (2).

Invalid Password!

Please Retype pazzword

To cancel datatransfer mode, click

on the 4] icon.
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@ When Sending Logic Programs

)

You can also send logic programs alone to the LT that has been aready set

up.

Logic programs can be transferred from the Logic Program Editor as well.

7.2.7 Sending Programs with the Logic Program Editor

] Before sending logic programs alone, be sure to select the [All

imporant S€Nd] command.

7.2.4 When Sending Screens and Logic Programs Together

TothelLT

PROCEDURE

REMARKS

(1) Viathe Project Manager, select the [Project] menu -

[Transfer] command, or click on the e@ icon. Oth-

erwise, viathe Screen Editor, select the[Screen] menu
- [Transfer] command, or click on the[Fg]icon.

(2)Select the [Only Control Send] command, or click
on the | #g|icon.

If a password has been registered, enter the password.

Password Entiy

Enter Password:
| xxxxx >1 ||

oK % || Cancel ||| Help |

(3)After thetransfer iscompleted, select the [Transfer]
menu - [Exit] command, or click on the(g]icon.

7-12

The LT unit must be set to [Screen
Transfer mode] or [Running mode].

LT SeriesUser’s

Manual (sold separately): CHAP-
TERGINITIALIZE

7.2.2. Passwords
If you enter an incorrect password
threetimesor more, datatransfer can-

not be performed. In this case, repeat
the transfer procedure from step (2).

Invalid Password!

Please Retype pazzword

To cancel datatransfer mode, click

on the icon.
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@ When Receiving Data From the LT ]

Datastored in the LT unit can be received on a project file basisby the LT

Editor.

To receive transferred data with the password registered, password entry is

required when receiving the data.

Unless [Upload Information] is selected in the [Transfer Set-
! . tings] dialog box when any data is transferred to the LT unit, the
Important dgta cannot be received from the LT unit.

PROCEDURE

REmMARKS

(2)Viathe Project Manager, select the [Project] menu -

[Transfer] command, or click on the w@ icon. Or,

via the Screen Editor, select the [Screen] menu -
[Transfer] command, or click on the[Fg]icon.

(2) Sdect the[ Transfer] menu - [Receive] command, or dick

on the icon.

If apassword has been registered, enter the password.

Password Entry

Enter Password:

|| Cancel ||| Help |

(3)Specify alocation (directory) and Project fileto store

the received data. Then, click on the but-
ton.

If the same Project File name already exists, the system

asks if you wish to replace it; if so, select :
otherwise select :
Save File []x]

(4)After thedatatransfer iscompleted, select the[Trans
fer] menu - [Exit] command, or click on the icon.
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7.2.2. Passwords

If you enter an incorrect password
threetimesor more, datatransfer can-
not be performed. In this case, repesat
the transfer procedure from step (2).

Invalid Password!

Pleaze Retype pazswaord

|| ak. ||| Cahicel |

To cancel datatransfer mode, click

on the icon.
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@ Sending Programs with the Logic Program Editor ]

The Logic Program Editor allows you to send (write) logic programs alone
to the LT that has been already set up. You can also receive (read) logic

programs from the LT.

Before sending logic programs alone, be sure to select [Send

| |
Important Together] command.

7.2.4 When Sending Screens and Logic Programs Together

TothelLT

B Sending L ogic Programs

PROCEDURE

REMARKS

(2)ViatheProject Manager, select [Control] menu - [Edi-

tor] command, or click on the..| icon to start the

L ogic Program Editor.

The Light remains on until the Power_Ofi_pushbutton is pressed

ine
%IX1.07 %107 %Cx1.00

Power_On_pushbutton — Power_Off_pushbution Light
f } 1t
Off off off

R1.0.0

Light
IR
i

0

(2)Select the [Controller] menu - [Writeto Controller]

command, or click on the icon to send logic pro-

grams.
If a password has been registered, enter the password.

- Pazsword Confirmation

Enter pazsword:

|I Ok I | Cancel ]

Logic programs alone are sent.

1.2.3 Creating/

Editing/Saving a Logic Program

7.2.2 Passwords
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W Receiving Logic Programs

PROCEDURE REMARKS

(1)ViatheProject Manager, select [Control] menu - [Edi- 1.2.3 Creating/

) _ Editing/Saving a Logic Program
tor] command, or click on the icon to start the
L ogic Program Editor.

(2)Select the [Controller] menu - [Read from Control-
ler] command, or click on the[fig] icon toreceivelogic

programs. MEEETEK 7.2.2 Passwords
If a password has been registered, enter the password.

4 Password Confirmation

Enter password:

|I Ok I | Cancel ]

Logic programs aone are received.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 7-15
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m Options

In addition to transferring/receiving screen data, you can check the screen
information on the connected LT Unit using the LT Editor program.

Usage Pattern |
[Project Select a Click on the
- N i — desired _ [
Manger] [Transfer] [Option] iten’ll
or ’ button.
Click on .
=
@ LT Internal Screen Data Information ]

LT internal information will be displayed, here. Functions such as [Screen
List], [Memory Info] and [LT Version] are included.

B List Screens

The screen name, data volume and title of the screens stored in the LT unit
are listed by screen type.

PROCEDURE REMARKS

(1) Select the [Options] menu - [ScreensList] command.
Screens of the current project will be listed.

(2)After confirming the displayed information, click on

the button to closethe screen list.
[Upload Information]: .. Indicatesif the upload infor-
mation has been transferred to the LT unit or not.

Screen List

Base |Image | Spstem |

[Screen Name [Size [Title
E1 200 Test Bits
B2 a6 Untitled?

D] Upload Infarmation

‘ Help
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B Memory Information
The LT unit's current memory capacity for a specified memory area (bank) is dis-
played. Its maximum internal memory capacity is also displayed.

PROCEDURE REMARKS

(1) Select the[Optiong] menu - [Memory Info] command. | Number of banks provided in the
The receiving of memory information begins. LT is32.

The capacity for each bank is59526

(2)After confirming the displayed information, click on bytes.

the button to close the memory informa- | A singlescreen file cannot be stored

tion window. in several banks.
[Max Block Size] .......... Displaysthe LT unit'salow- | Therefore, the sum of the remain-
able memory capacity. ing memory capacity for each bank
(LS =0 | IR Displaysthe datavolumecur- | isnot always equal to the transfer-
rently used in the LT unit. rable screen data volume.
[Free] e, Displaysthe amount of “Free”
or remaining memory.
Memory Information
[ Memary Bank || Free [bytes] [
I 24108
1 5526
2 5526
3 5526
4 5526
5 53526
B 53526
7 53626
tax Block Size:
EEa—
Free
Help
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B LT Version Information
Thisfeature displaysthe LT unit version information.

PROCEDURE REMARKS

(1) Select the [Options] menu - [LT Version] command.
The receiving of version information begins.

(2)After confirming the displayed information, click on

the[ ok ]button to closethe version information

window.

Check Yersion

Display Type . GLC150
Yersion :

[ate

LT's Project File: A Manufacturing System. Ite

Date: 020925 - 9:32
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SIMULATION

B efore transferring screen datato the LT unit and connecting the LT
unit to the Device/PLC, you can check the LT panel operation by
running a simulation of your LT Editor program.

This chapter describes the program simulation procedure.

B e Overview
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8.1 Overview Chapter 8 - SIMULATION

E Overview

Connect the LT unit to your personal computer viathe transfer cable. Turn
ON/OFF bitson the LT Editor program’s Simulation screen, and change the
data corresponding to the specified word address. Even if no external device
is connected, you can check the operation in the LT unit and the data
changes resulting from the Part functions.

{Note: The Simulation function can be used only when the LT is Type-C.

A__ The Simulation feature is provided for simulating Device/PLC
1 operations on a PC. For this is only a simulation, its perfor-

Important mance such as processing speed may differ from the actual one
which is performed when the LT unit is connected with a Device/
PLC.

Connecting method between your personal computer and the LT isthe same
asthe one for data transfer.

7.1 Prior to Transferring Data

Personal Computer (PC)

Screen transfer cable
(Dsub 9-pin socket)

O

To the Tool Connector

To the PC’s
serial port

B Precautions

When using the Simulation function keep in mind the following restrictions:
* The Simulation function can be used only when the LT is Type-C.

* When the external deviceis either THERMAC NEO Series (Omron) or
Memory Link SIO Type", the ssmulation cannot be performed.

» Simulations of logic program'’s variables (L ogic symbol) cannot be per-
formed.

* To carry out asimulation, you need to transfer a simulation protocol at the
LT set-up.

8.1.2 Transferring Simulation Protocol

* With a device specified in [System Setup], the simulation cannot be
performed.

« |f the backup function for the LS areais selected, or if a D-Script uses an
LS areaspecial relay for its start bit, no LS device can be ssmulated.
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« If the LS deviceisfrequently written using the D-script during the LS
device simulation, actions such as a dlide transition will be slow.

* DO NOT specify [System Setup]-[ Extended Settings] tab-[Reset LT On
Data Write Error].

» The screen on the LT panel cannot be changed.

» The simulation cannot be performed for any address greater than 32,768
(8000h). To perform a simulation for such an address, temporarily change
the address to 32,767 or lower.

* Do not press any touch panel switch on the LT unit before the simulation
has begun. Otherwise, a system error will occur.
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m General Description of the Simulation Screen ]

To perform asimulation, first transfer the screen data created with the LT
Editor program and the “ simulation protocol” to the LT unit.

7.2 Transferring Screens

Usage Pattern ‘
Click on the Click on the Click on the
[Project] - [Simulation] - | button — | button — ||k |button to
to start the to stop the quit the
simulation. simulation. simulation.

General description of the Simulation screen:

Enter the Base Screen number
where device information is to

Displays negative values
with a minus sign

Select a function to dis-
play device information.

be displayed
Select which to screen to be Selects the format of the
displayed on the LT panel display and input data
Starts/Stops during the simulation

the simulation

=S
i
Register an ——{{m|®]{i] & / /
o ] 7] =
ad d ress f'; E E’ Chg.Ser Format D +- H i
. . 1 T T
Qu its the simu- Marme/Description Function Address Status aler |[= | Mo || Spstem Area HE'
Iatlon functlon Jws_oat ord Set |[pooact . a
Jws_00z ord Set oz | o
JBS_Dm | JB\t Set{0peration Bit] _}mum |QFF
Ao Jata adess D000 ]
[ | ERanner |pooos [ =
. . B4_002 | [Data Address |Je00000 . 21
Blinks while JBA_DDS _ JData Badiess _ JDunnos T
the simula- Je_o001 | Monitorwiord Address|jpooooD | 21
: . . J&_oom | Pata Storage Addiess | DO00O0 21
tion is being JE_003 | Jerd Gat pmmE | 7
executed A FtSe0pmaton By | o000z [aFF
i JBS_DU3 | JB\t Set{0peration Bit] _}(DDUD3 |QFF
| I I
Displays the J J J
device informa- || ] i
tion of Parts Fealy

placed on each

screen Changes the

device status

Changes the
system status

Displays the current
status of the system

The toolbar icons have the following functions:

Starts a simulation _ Registers the address

IR IEI

Stops a simulation

N

Quits the simulation function
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@ Chg. <.
When the Check Box is marked, the LT panel screen is changed accord-

ing to the Simulation screen. When this Check Box is[[|, the LT panel
screen can be separately changed, independent of the Simulation screen.

@ Displayed Function Selection
The function used to display the simulation can be changed. In addition to
the settings of each screen, the devices show in the following figure that
have been set with the screen-independent global functions can slso be
displayed.

[indow Screen
Alarm

[rata Sampling
Global D-Script
Filirg

[rata Logaging
Registered Addresy

@ Format
The data format of the device status (displayed in the “ Status’ cell) and the
device data (displayed in the “Change” cell) can be selected for “Dec”
(decimal), “Hex” (hexadecimal), or “Oct” (octadecimal) format.

®+/-
Marking the “+/-" check box addsa*- (minus)” sign to the displayed
values, if the word address settings displayed in the “ Status’ cell are nega-
tive values.

€ Name/Comment

ID number of aPart or any comment is displayed. To switch the ID number
or comment display mode, select [Name] of [Comment] from the [View]

menu.

@ Function
A generd description of the device function for each specified Part isdigplayed.

€ Address
The device specified for each Part is displayed and you can change their
word address settings.

& Status
The current status of each device (bit ON/OFF status or word address
setting) is displayed, and you can change their word address settings.

@ Alter
You can change each device status (bit ON/OFF) or the word address settings.
Every time you click on the icon, the bit ON/OFF statusis switched.
When you click on the icon, the following Keypad will appear, en-
abling you to change the data.

‘Word Number Entry |

[ Back |+ Cr
[4]8]c|[7]s]s

[elelr [4]5]s

[a]ent
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B Selecting a Display Type

Select the types of Parts used to display device information.
Select the [Options] menu - [Display Type Settings] command.

Specify the Parts to be displayed.
When you select “All Type”, information on all Parts will be displayed.

Dizplay Type Setlings
] &l type 7] Trend Graph
7] Bit Switeh "] keypad Display
D Whord Switch D &larrn Dizplay
EI Function Switch B Murmeric Display
]:l Lamp D Meszage Dizplay
]:l Bar Graph J:] Ficture Dizplay
"] Pie Graph 7] Filing Dizplay
"] Half Fie Graph "] Logging Display
] Metes T wwhindaw Parts

TECTT] [ Canest | [ Hel

B Setting up the Device Memory

Even after the simulation function has been closed, device information can
be saved to the Project File.
Select the [Options] menu - [Device Memory Settings| command.

When the “Backup” check box is marked [l#]| , device information is auto-
matically saved when the simulation function is quit. When the simulation
starts up again, the same device status will be displayed.

Clicking on the button resets all device settingsto “0".

Device Memory Settings

|I QK. ] | Cancel ] | Help ]
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B Movement Settings

L S devices can also be simulated in the range from L S0020 to L S2031
(excluding the read-in area). Select the [Movement Settings] command from
the [Option] menu.

If the [LS Device] check box is marked, the Parts that use LS devices will
be displayed when a simulation is executed.

Movement Settings

T 05 Breyize.

] | Cancel ] | Help ]

B Address Registration

Simulation can be performed for any registered address, not for each screen
or function.

The ssimulation result is displayed by selecting the registered address from
the display function pull-down list's [Address Registration].

To register/edit an address, select the [Simulation] menu - [Address Regis-

tration] command, or click on the icon.

Add
- Delete
 Edi
. Com

' Raste

 Help

o
s

.

Note: Theaddressto beentered variesdepending on your LT and PLC type. Note
2] that the sample screen in this manual isjust one example.
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@ Adding aregistered address
You can add a new address. Click on the button, and the following

dialog box will appear. Then, enter an address and the number of addresses
to be added, and specify Bit or Word.

After entering a number of addresses to be added, addresses are added from
the designated number in series.

You can enter adesired name as a function name with up to 20 half-sized

characters.
Input Address |
Address »00000 i
% Bit o waond

Address Count [4 .5

Function J "

|' ak. ] | Cancel |

@ Editing aregistered address
You can change the registered address settings. Select an address to be

edited and click on the button. Then, a dialog box that is the same
as for the adding of aregistered address will appear.

@ Deleting aregistered address
You can delete aregistered address. Select an address to be deleted and click

on the button. Then, a dialog box will appear to confirm the
command. If you execute the del ete command, click on the but-

ton, and if you cancel it, click on the button.

€ Copying and pasting aregistered address
Select an address to be copied and click on the button. Then, click
on the button to add the copied address at the end of the list.
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m Transferring Simulation Protocol ]

To simulate the LT panel’s actual operation using the LT Editor program,
transfer the screen data created with the LT Editor program aong with the
“simulation protocol” to the LT unit.

7.2 Transferring Screens

Usage Pattern | __
Check the
[Project Manager] - [Transfer] o [Setup] - [Transfer - “Use Extended
or or Settings] Program’area’s
i “Simulation”
Click on . Click on - Check Box.
=
Compile the Project Click on the icon
File with the LT Editor to transfer the screen
- [Transfer] - [Prepare] — programsothatitis — data and simulation
formatted for the LT protocol to the LT
unit used for the unit.
simulation.

B Simulation Protocol

Before executing the simulation, you must first transfer the ssimulation
protocol to the LT unit, regardiess of the Device/PL C specified for the
project file.

Check the “Use Extended Program” area's “ Simulation” Check Box in the
[Transfer Settings] dialog box so that when screens are transferred, the
simulation protocol will be transferred to the LT unit.

7.2.1 Transfer Settings

@Ik'\l\t)te: When a simulation is executed , you need to transfer the simulation protocol
) only for thefirst screen transfer.
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m Performing a Simulation ]

To perform asimulation, first connect the LT unit to your personal computer

using the Data Transfer Cable.
A » Before performing a simulation, you must transfer the simula-
! tion protocol to the LT unit.
Important

8.1.2 Transferring Simulation Protocol

» Be sure not to press the touch panel switch of the LT main
unit before the simulation starts. Especially, be sure not to
change the screen of the LT unit. Otherwise, a system error

will occur.
PROCEDURE REMARKS
Connect the LT unit to your personal computer with the | Prior to starting smulation, set the
Data Transfer Cable. LT unit to the RUN mode.
(1)Viathe Project Manager, select the [Project] menu - | If the simulation protocol has not
[Simulation] command. been transferred to the LT unit in

step (1), the following dialog box
(2)Click on the button to begin communication with will appear, and the simulation can-

. not be started.
theLT unit.
The device information on the current LT panel screen
Is displayed. B\ Bt s s bt

it the screen transfer menu.

Bl Simulation
Simulation View Option Help

LEIEIE
| o BDt— ) ChoSer [T

[ Mame/Desciiption | Function

During communication, the
icon blinks, like this[gT7] -

Fieady Il

You can check the LT panel operation by switching 8.1.1 General De-
screens or changing the device settings using the scription of the Simulation Screen

or icon displayed in the [Alter] cell. Also, you can
check the device status changes viathe LT’ s touch keys.

(3)Click on the button to quit the simulation. During simulation, screen data can-
not betransferred. Click on the

icon and stop simulation before
transferring screen data.

(4)Click on the| &k [ button to quit the simulation mode.
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b PRINTING

A

printed copy of created screens and Part setting conditionsis often
useful when debugging. This chapter describes the printing proce-

dure and print settings.

0. e ———————— Print Settings
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Print Settings

This section describes the procedure for printing created screens or alist of
designated Parts, and options available when printing.

Usage Pattern |

Project . Select the Select the data to
Manager - [Print] - appropriate items —  be printed from
in the dialog box. the dialog box.

Specify the printing Click on the

- range, dependingon - button to

the selected function. start printing.

m Printing
When you select the [Project] menu - [Print] command, the [Print] screen
will be displayed.

B Printing - [Print] Tab

Specify the printer type and other print settings on your personal computer.
Only Windows-compatible printers that can be connected to your personal
computer can be used to print with LT Editor for Windows.

Displays the printing-related

Displays the
print.e[j name [Property] dialog box \ If this box is
Specme? o lﬁﬁg checked, instead
Bsrt‘z?na com W|Prmecllnlolmation” Screen | of prlntlng a
e \ hard-copy, the
Click on this Hame:  [Losmar Opira § 1520 =] ”\‘ Propeget.. | datais saved as
button to diSplay Toper  Lesmark Opira § 1620 fint To File a RTF text file
the Cover Page Where:  prS1935pr_lnt1 (***_RTF), and
dialog box E°°“‘”:”" _ can be edited
:\ * ” _ ﬁ with other text
Comments on the B CoverPage [ Dewil | Humber Of Ciopias: = editing software
data printed can 3 Comnent o [_9ak,_| T
be entered to be ™ Enter the
printed out along TeaTatle [l id number of

with the data. To copies to be

print comments, printed; the

check this box default setting

Click on this T e = e N

:Jhuttcg ttc.) display A cover page with atitle, company name, Sel?ct the Text

d'el[ pblons] date/time, name, and a bit map can be Table to be
lalog box included with the document. printer

2[\!0te: « The printing setting information can be saved by clicking on the[ &b |
X2 putton.

e Theprinting orientation is“ Vertical” (Portrait).
* Only “A3",“B4”, or “A4” paper can beused for printing.
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Chapter 9 - PRINTING

@ Cover Page Dialog Box

Check this box to
print a title on the —

Cover Page

9.1 Print Settings

— Check this box to

cover page

Enter atitle or a 4

company name of up
to 3 lines (40 charac-

ters per line) | Date & Time

print a company
name on the
cover page

// Check this box to
O Wame print a name on

| | the cover page

Check this box to |
include the date and L Bitmap

time of printing on |

| | Brmwse || Layows |

Enter the name

here

the cover page =

| Cancel |||

Help |

Check this box to
include a Bit-map on
the cover page

/

Click on this button to preview the cover page
layout. When Bit-map printing is selected, the

placement of the Bit-map on the cover page can be
changed.

€ Comment Information Dialog Box

Comment Information

Enter a comment |
of up to 40 lines
(80 characters
per line)

[ oK

Cancel | ||

Help

@ Options Dialog Box

Settings in the Options dialog box allow you to format the pages of the
document to be printed. You can specify the range of page numbersto be
printed, the screen color, and margin size.

Options
Prints the black/ Enter the initial
white-reversed page number to
screen color be printed on the
Check this box to — | Pate first page of the
print the page document
number on each
page of the docu- =M arging
ment Top et [I0Tmn o] | | S

. — Specify the upper,

When printing page Bmm Pl lower, right and
numbers, specify if left margin sizes
the cover page is to [ ox ]| camcel || Hep |
be numbered
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9.1 Print Settings Chapter 9 - PRINTING

B Printing - [Project Information] Tab

You can check the created screens and Part designation status through
printer output.

Prints a project Print Displays the
|nf0rmatlon Project Infarmation ‘m] | Currently_
summary list ' selected item
. . [ Dol
Prints the list L e L
Of Settl nas Of ] Swstem Setup List
th e |tem g Q] Drata Sampling Settings List
) ) Filing Data List

mar ked Wi t h a Jj [rata Logging Settings List
check. 1 Global D-Seript List

) 0-Seript Function List

) Symbol List

[ Global Crass Reference List

[ u Cancel \ u Apply \ u Help

@ Details
Click on the button to specify detailed information of printing.

Screen List

Select the screen type to be printed.

Screen List [x]
Contents

]:1 Mark Screen
] Image Screen
D YWindow Screen

|- ] ] | Cancel | | Help |

Date Sampling Settings List
Select whether to print the summary or
details of the data sampling settings.

15 Bepeal 1%) Dratal

7] Cross Reference List

|' ak. I| Cancel || Help
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Chapter 9 - PRINTING

B Printing - [Screen] Tab

Select the screen type and contents to be printed.

Print

Select the screen
type to be printed

Specify the
printing range
using individual
screen numbers.
When you select
[All], all screens
will be printed.

Print_|| Praject Information ‘SmEEn]

=Screen Typ Base Screen
ExnEoam | Detail. Screen Hard Copy
T Mark Sereen
1 Image Sereen ™ ™~
O windaw Sereen [
=Screen Rang
A
) Sereens Fram Ta

[ ox

9.1 Print Settings

™~ Displays the
currently-
selected item

H| Cancel H| Apply

Help

@ Details

Click on the button to specify detailed information of printing.

Base Screen

Specify the printing items related to a Base Screen.

Prints a list of the
screens loaded
onto a specified
screen

Prints alist of the —
Parts placed on

the Base Screen.
Select whether to
print the sum-

mary or details of

the Part list

Prints the address
designation for
Parts.

Only the “preset
addresses” can be

printed

2.1.7
Cross Reference/Global

Cross Reference List

.

Base Screen OUtpUtS
Contents screen hard
Screen Hard Copy COpIeS_. .
_ . The printing
| Parts List Infiarmation charactor items can be
) Geperall 10 Betall - e
_ Il Object 1D No. specified
g Cross Reference List D Device Address
I D-Seript
Infarmation charactar size Se|eCt |nf0l’—
. —
150 bhomnal 100 Swmall — | mation
Border cahacter's
O window Parts printing size.
I Grid When select-
e £90n 0 mg'[SmaII], 1/
T 4-sized char-
tate acters are
used
|| QK. I || Cancel | || Help |
When making
Prints the D-Script ascreen hard
copy, The

settings

Parts’ ON/OFF
status can be
specified. The
same status is
specified for
all screens to
be printed

Note: When thesummary of the Part list is printed, itsright edge may get outside

X2 the paper. In thiscase, open the Option dialog box by clicking on
button in the [Print] tab, and then reduce the left margin.
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Window Screen
Specify the printing items related to a Window screen.

Window Screen
Contents
Q] Load Sereen List 5
Ol Parts List Information charcator
1) Benerl 1 Detsl) Il Obiect 1D Mo,
O Cross Reference List O Device sddress

Infarmation charactar size

B Nomal 12 Smal

Border
O Giid
State L9 On 320 0K
Statel ~
|| QK | || Cancel | || Help |
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Chapter 9 - PRINTING 9.1 Print Settings

m Print Preview ]

By selecting the [Project] menu - [Print Preview], you can preview the
screen image to be printed.

Setting items are the same as those of printing. Instead of clicking on the

button, click on the button.

B Print Preview Screen

Starts Previews Previews Toggles between Scales up/
printing thenext theprevi- previewing one page down the
page ous page per screen and preview
previewing two
pages per screen Closes the
prlnt
- F‘miect Hanager/ preview
Zoonga] gwe ] | Screen
Print date
and project
file name
Systerm Setup List A0zA0021547 AMs
1. System Setup
Chesk Sum oh
Touch Buzzer o
Soreen Mo Date Type Ein
5 sreen Level Change Flow ff
Fassward Mok
Standby Mode Time 0
Change To Screen Mo, 1}
Zom Port Stert up Display 1}
2 1M Settings
GOffline Mode Top Left Comer  On Forced B
Cortrast Mdjustment G
Brighiress Dadju st ment in
Reverse Display off
Touch Inpout Mode 2 Point
Use Touch Panel Sfter.. Mo
Fefresh Rate 1]
Frint From Tool Conne stor Mot Use
3. MWode Settings
System Start Dddress 04 k00000
M &t hike Mumber i
Feading frea Size 0

Link Protosol T ype 11

4 Initial % creen 5 ettings
Initial Base Soreen Mo, i
Blarm Character Size et

eady pel
Fiead Typel [[OMRON THERMAC NED SERIES ]| 4
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» ADVANCED FEATURES

I he filing data (recipe) and logging functions are advanced features
that increase the performance of your LT unit.

101 Filing Data (Recipe)
LO.2 e Logging
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10.1 Filing Data (Recipe) Chapter 10 - ADVANCED FEATURES

@ Filing Data (Recipe)

10-2

Setting data that you have created and stored on the LT can be easily trans-
ferred to the Device/PL C whenever necessary, using LT touch keys or by
specifying bit addresses in the Device/PLC. Also, Filing (Recipe) Data that
has been transferred to the Device/PLC can be then sent back to the LT,
edited, and then transferred again to the Device/PLC.

LT Device/PLC
- —
= -
0100 Designated 0100
0050 > Word Address | 0050
0030 Copy the Filing data 0030
0005 to the External 0005
Device
B Overview

There are two methods of transmitting filing datato the Device/PLC. Oneis
automatic transmission, where filing data is sent to the Device/PLC viaa
Device/PLC trigger. The other is manual transmission, where data selected
on the LT screen is sent to the Device/PLC.

When using manual data transmission, select the Filing Data Display from
the Tool Box or [Parts] menus.

Filing data can be controlled by file numbers for each project file.
Filing data can be stored in the LT’ s internal memory.
Filing datais stored in the Device/PLC in a series of addresses.

Setting up filing data so that it is transmitted viaan LS Area alowsfiling
datato be edited on the LT panel and then written to the Device/PLC.
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

m Filing Data (Recipe) Function ]

B Filing Data Transfer Flow

Filing dataisfirst written from the LT’ s internal memory, thentothe LT’s
backup SRAM and then istransferred to the Device/PLC, either directly or
viathe LS area.

LT

—» | LSArea |—
Backup SRAM | «— <+

External
Device

Internal memory
(Filing data)

v

A

B Managing Filing Data in Group

Filing data is organized into folders, files, blocks, and data. Also, to use as
much filing data as possible, multiple folders can be used in the LT’ s inter-
nal memory to register multiple filing dataitems.

You can register multiple folders by selecting [Use Multiple Folders] from
the [Filing Settings] menu.

Folder 1 Folder 2
File 0 File 0
Block 0 Block 1 Block 0 Block 1
Data 1 Data 1 Data 1 Data 1
Data 2 Data 2 Data 2 Data 2
Data 3 Data 3 Data 3 Dafa 3
Data 4 Data 4 Data 4 Data 4
File 1 File 1
Block 0 Block 1 Block 0 Block 1
Data 1 Data 1 Data 1 Dafa 1
Data 2 Data 2 Data 2 Data 2
Data 3 Dafa 3 Data 3 Data 3
Data 4 Data 4 Data 4 Data 4

€ When multiplefoldersare not used

Only 1 folder isregistered. In this case, the folder number is usually not
designated, however, whenever it is necessary, the number is designated as 1.

€ When multiplefoldersare used

Multiple filing data folders can be registered. In the LT, the folder numbers
need to be designated to transfer datato the LT’ sinternal memory and
backup SRAM. Since only one filing data folder can be used on the LT at
one time, select which folder will be used.

* Multiple folders can be registered in both the LT’ s internal memory.
» Up to 64 folders can be registered in the LT’ s internal memory.

» Select afolder to be used on the LT.

» Only onefolder of data can be transferred to the LT’s backup SRAM.
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10-4

Chapter 10 - ADVANCED FEATURES

B Filing Data Registration Capacity

When saving filing data, up to 2,048 filing data files can be registered, with
up to 1,650 data blocks in each file, and up to 10,000 pieces of datain each
block. (However, when the dataformat is 32 Bits, only 5,000 data items can
be registered.)

Registration capacity, however, varies depending on the use of the backup
SRAM or other settings.

Up to 59520 bytes of filing data can be stored in one folder inthe LT’s
internal memory. (when storing only filing data to the backup SRAM).

€ SRAM Storage Capacity Calculation

1file=96 (Fixed value) + (32 + 2 _or 4 x number of data pieces) x number
of data blocks

Total capacity of all files < 59520

Use “2” for 16 Bit devices, and use “4”
for 32 Bit device file calculation.

The following shows Storage Capacity when using 16 Bit Device Data

Format.
No.of | No.ofdata | No.ofdata | Total capacity
files pieces blocks of all files
1 2 1650 59496
1 640 45 59136
1 10000 2 40160

@ Usage priority of backup SRAM

1) Datasampling

2) Trend graph

3) LSAreabackup

4) Logging data
5) Filing data
SRAM Memory is used starting from item 1).

To check the LT’ s available usage capacity,
4.4.1 Project Information

» Datain backup SRAM is erased when:

* The LT's memory is initialized.
» Datais transmitted.
* The LT system and protocol are set up.
* LT's self-diagnosis “Internal FEPROM (screen area)” is
performed.
* As the number of Addresses increases, the more time is
required for writing data to the Device/PLC. Depending on the
number of Addresses, it may take from 20 seconds to several
minutes.
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

« When datais being written, screen displays, such as for
Parts, may not be updated/refreshed or may appear slowly.
Screen changes may also be performed slowly. If screens are
changed at this time, screen data such as for Parts will also
be read out, and data writing to the Device/PLC will be per-
formed at a slower than normal speed.

* DO NOT perform any of the following operations at the same
time.
 Data transfer between the LS area and the Device/PLC

* Data transfer between SRAM and the Device/PLC: via the
File Name Display

+ Data transfer between SRAM and the Device/PLC: via the
Control Word Address using Transfer Settings

Be sure to perform data transfer after the current data trans-
fer is completed.

e During the current data write, the succeeding data write op-
eration cannot be accepted/received.

B LS AreaFiling Data Structure

Designated address

+0 —
+1
: Block Names (32 characters)
+14
+15 —
+16 -
+17
: Data
: : m: 15+number of data pieces (16 Bit length)
+(m-1) 15+number of data piecesx2 (32 Bit length)
+m _

Data transmitted between the backup SRAM and LS Areawill overwrite the
existing Block Name and Block data.

Data transmitted from the Device/PLC to the LS Area overwrites only file
data and preserves the Block Name.
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10.1 Filing Data (Recipe) Chapter 10 - ADVANCED FEATURES

Backup SRAM LS Area External Device
Block Name Block Name
—>
<—
Data Data Data
<—

* When adeviceisused with a 32 Bit system start Address, filing data
cannot betransmitted to the Device/PLC viathe LS Area.

* Block Nametext charactersarestored in order of the character input.
LT SeriesUser’'sManual 6.3.2 Text Data Settings

B Filing Data Transmission Methods

& Automatic Transmission

Filing datais transmitted from the LT to the Device/PLC viaaDevice/PLC
trigger. Use the Control Word Address instead of using the Filing Data
Display to transfer data between the LT and the Device/PLC (LT - Device/
PLC, Device/PLC-LT.)

LT

\ 4

Internal memory 1) Backup SRAM External
(Filing data) Device

A

(1) Device/PLC Trigger

10.1.2 Filing Data Setting € Control Word Address (Filing
Data - SRAM)

(2) Device/PLC Trigger

10.1.2 Filing Data Setting ¢ Control Word Address
(SRAM « - Device/PLC)

A * When asingle folder is used, designate the folder number as
] 1.
important® 1f the designated number’s folder does not exist, data will
not be transferred to backup SRAM. Also, the Write Com-
pleted Bit Address will not be turned ON.
* When data is not transferred to backup SRAM, the LT internal
special relay (LS2032)’'s bit 9 will turn ON.
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

€ Manual Transmission - type 1

Filing datais transmitted to the Device/PLC by touching a LT screen touch
key. Use the Filing Data Display to transfer data to/from the Device/PLC,
using the “SRAM - Device/PLC” touch key and the “Device/PLC - SRAM”

touch key.
¥ LT
@ .
Interpgl memory 1) Backup SRAM External
(Filing data) P Device
v

(1) Device/PLC Trigger
10.1.2 Filing Data Setting € Control Word Address (Filing
Data - SRAM)
(2 )Screen Touch Keys

10.1.5 Manual Filing Data Transmission Example 1/
B Filing Data Transmission Flow

When filing data is sent back to the Device/PL C from backup SRAM, the
newly sent data will overwritetheold. In order to prevent this, beforehand
create another data block for thereturn value data (See the figure below) to
send thefiling data to and designate that block via the Control Word Ad-

Note:
2]

dress.
File 0
A B A Return Value | B Return Value
50 40 0 0
60 30 0 0

€ Manual Transmission - type 2

Select the desired filing data via the screen’s touch keys, perform any data
changes, and then transmit the edited data to the Device/PLC. Usethe Filing
Data Display to transfer data to/from the Device/PLC, using the

“LS- Device/PLC” touch key and the “Device/PLC - LS’ touch key.

LT

@ @)
—» | LSArea [———»
| “—1—
nterpgl memory (1) Backup SRAM | ¢— External
(Filing data) Device

(1) Device/PLC Trigger

10.1.2 Filing Data Setting € Control Word Address (Filing
Data - SRAM)

(2) Screen touch keys
10.1.6 Manual Filing Data Transmission Example 2 (1)
Writing filling data to SRAM
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(3) Screen touch keys

10.1.6 Manual Filing Data Transmission Example 2 (5) LS
Areato Device/PLC

B Filing Data Setup Procedure

(1) Filing data registration

(2) Enter Write Settings
(for sending Filing Data to
SRAM)

(3) Enter External Device &
SRAM Direct Data
Transmission Settings

»| (4) Setup Filing Data Display and

their Screen Placement

| (5) Setup Keypad Display and
its Screen Placement

J

Automatic Data Transmission
Completed

Manual Data Transmission 1
Completed

4

Manual Data Transmission 2
Completed

(D)Filing Data Registration via[Filing Data]/[Filing List]

(2)Setup of [Write Settings (Send Filing Datato SRAM)] via[Filing Data]/
[Filing Setting]
(3)When performing automatic data transmission, setup the [Device/PLC &

SRAM Direct Data Transmission Settings| via the same dialog box.
Automatic Data Transmission is completed here.

(49)When performing manual data transmission - type 1, setup the Filing
Data Display and designate its placement.

Manual Data Transmission - type 1 is completed here.

(5)When performing manual data transmission - Type 2, setup the Keypad
Display and designate its placement.
Manual Data Transmission - Type 2 setting is completed here.
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@ Filing Data Setting ]

Use the following setting items to create multiple folders and atrigger for
transferring data.

Select [Filing Setting] from the [ Screen/Setup] - [Filing Data] menu.

Filing {OM/0FF)
O Use Muliple Falders
="write 5ettings{Fram Filing Data To SRAR)

Control Word Address 01/C00000 FI [
‘wiite Completed Bit Address {01,C0000000 |:I ]

= Device/PLC & SRAM Direct D ata Transmiszsion Settings———
DevicesPLE Controlled Transfer

Control word Address 01/C00000 |7I =
Transmit Completed Bit Address [37,C0000000 |7| g

|| u] 4 | ” Cancel | || Help |

@ Filing (ON/OFF)

Check this check box in order to use the filing data.
€ Use Multiple Folders

Check this check box in order to register 2 or more folders.
@ Write Settings (From Filing Data To SRAM)

In responseto atrigger, filing data stored in the LT’ sinternd memory (screen
data) iswritten to backup SRAM. This preparesfor filing datatransfer. In order
to tranfer datato the Device/PLC, you need to first write data to backup SRAM.
Only 1item of filing data can be written to backup SRAM.

@I)\I\ote: When using filing data, be sureto enter the“Write Settings’ data.
X2
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@ Control Word Address (Filing Data - SRAM)

Designate a Word Address to use as atrigger, or designate the mode to use
when writing to backup SRAM. Thistrigger controls the data write timing.

When using multiple filing data items, designate the folder numbers.

The Control Word Address will be asfollows:

When Using Multiple Folders When Not Using Multiple Folders

+0 Trigger, Mode +0 Trigger, Mode
+1 Folder No. 11064

<Trigger, Mode>

15 0
+0 Reservation
Al OFF

|
L Trigger (ON: Write  OFF: Not write)

€ Write Completed Bit Address (Filing Data - SRAM )

Designate a specific Bit Address to be turned ON when the datawriteto LT
backup SRAM is completed.

%Ikv\ote: If data cannot be transmitted to backup SRAM dueto insufficient memory,
2] | S2032'sBit 9 will beturned ON. When data istransmitted to backup
SRAM again, use either the designated communication cycle time or 150ms,
whichever islonger, asthetrigger’s OFF time.

For communication cycle time details,
Device/PLC Connection Manual, 1.1.4/2.1.3 Special Relays

Write Completed Bit Address| LS2032 Bit9
Normal data transmission ON OFF

Data transmission error - ON
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€ Device/lPLC & SRAM Data Transmission Settings
Here, select the method used to transmit filing data either from backup SRAM
to the Device/PLC, or from the Device/PLC to backup SRAM. Sdlect this
setting when performing automatic data transmission using the Contorl Word
Addressfeature.

€ Device/PLC Controlled Transfer (SRAM «~ — Device/PLC)
When this check box is selected, automatic data transmission via the Exter-

nal Device'strigger isset up. If thisbox is not checked, data must be
transmitted manually using the Editor area Toolbox’s Filing Data Display.

€ Control Word Address (SRAM « — Device/PLC)
Designates a Word Address where the filing data transmission trigger and

mode data are stored.
Control Word Address
15 10987 10
+0 | Reservation Resenvation
All OFF All OFF ||
L Trigger (ON: Transmit ~ OFF: Not transmitted)
Transmission| 9 8 Mode
+1 File No. OFF | OFF | SRAM —External Device
+2 Block No. OFF | ON | External Device—+ SRAM

€ Transmit Completed Bit Address (SRAM « - Device/PLC)
Designates the Bit Address that will be turned ON when filing data trans-

mission is compl eted.

QI)\I\ote: e Use binary numbersto designate file and block numbers.

S « |If data transmission cannot be performed, L S2032's Bit 10 isturned ON.
To transmit data to the Device/PL C, use either your standard communica-
tion cycletimeor 150ms, whichever islonger, asthetrigger OFF time.

For Communication cycletime details,
Device/PLC Connection Manual 1.1.4/2.1.3 Special Relay

Transmit Completed Bit Address| LS2032 Bit 10
Normal data transmission ON OFF
Data transmission error - ON
10-11
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@ Filing Data List ]

Filing Settings can be added, edited and deleted on the [Filing Data List]

Screen.
Usage Pattern |
Screen/ . o : ADD or [Close]
[Setup] - [Filing Data] - [FilingList] - pyor o or [Esc
Delete

B Filing Data List
Below isthe overview of the screen on which you can make filing settings.

€ When using asinglefolder

Adds folder and file settings.

Ad
[ e T Edits folder and file contents.

[_ew 71— Copies folder and files.

HEB d
e | Pastes copied folders and files.

Deletes folders and files.

Close

ol

| Hep

Lists registered filing settings.

€ When using multiplefolders

“Internal Memory” indicates the screen data stored in the internal memory.
“1-Filing Data’ folder indicates the File Settings.

Filing Data List

Foder Adds folder and file settings.

E-@ Intermal
L.&n[ +ing Dats

Edits the contents of folder and
file settings.

Copies folder and file settings.

Pastes copied folder and file
settings.

Jal I Help

Deletes folder and file settings.

Lists registered Lists registered filing
folders and files. settings.

B Registering Filing Data
Here, the procedure of adding Filing Data Setting is explained.
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@ Registering Folders

When multiple folders are used, select [Internal Memory] and click on/Add|
to display the screen for creating a new folder.

Save As

Faolder Tupe

Folder Mo 1

Filing Datallrternal]

=]

=

FolderTile |

Cancel

i

@ Registering Filing Data

10.1 Filing Data (Recipe)

Folder No. (= Filing data number)
A value between 1 and 64 can be set.
Folder Title
Enter atitle. (Commas’,” are not al-
lowed.)

When multiple folders are not used, the filing data setting screen isdis-
played. When multiple folders are used, you can display the filing data
setting screen by selecting [1-filing Data] and click on the button.

(Fing 0ot ]

File Mo E =

Data Storage Stat Address

Mo of Data Blocks

Deseription; Mo, of Data ltems

[ Blocko

okt =]
|

i

T

=

Data Farmat

[T

Block Hame

[alelelolole]

Doooo1

Display Format
Dec [

IZJ Codess-

Dooon3

Clear |

DOO004

Doooas

DOCODA

Copy

1

Paste

;

o
DO0002 o
o

o

o

o
DO0007 o
o

DOOODE

NN EEE N

Impuit...

Export

|
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File No.
Filing data is controlled in individual
file units. Here, designate the file num-
bers of filing data to be registered. Up
to 2,048 files can be registered.

Data Storage Start Address
Enter thefirst Addresswhere the trans-
ferred filing data is stored. Data stor-
age areas will be saved in series, start-
ing from the Start Address for the num-
ber of filing dataitems.

.

Note: Theaddressto beentered varies
2] depending on your LT and PLC
type. Note that the sample
screen in thismanual isjust one
example.

No. of Data Blocks
Designate the number of blocks to be
registered in one file. A maximum of
1,650 blocks can be designated. (The
maximum number will change depend-
ing on the number of data blocks.)

No. of Data Items
Designates the number of data items
registered in one block. A maximum of
9,999 dataitems can beregistered. (The
maximum number will change depend-
ing on the number of data blocks)
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10.1 Filing Data (Recipe) Chapter 10 - ADVANCED FEATURES
A When avariable (Logic Symbol) is used as a data storage start
! address, an integer array must be designated. For an integer
Important array, an appropriate size required for consecutive addresses
needs to be allocated.

Data Format
Select either 16 or 32 bit data.
Display For mat
Select afiling data display format.
Code +/-
“- (minus)” display becomes effective
when this check box is checked.
Import
Other filedata (CSV format) can beim-
ported and used asfiling data.
Export
Filing data can be exported and saved
inthe CSV format.

<Qutput Example using CSV Format>

"Fiing Data" ¢ Filing CSV data's Header.
"Description” "Filing Data" (This is necessary for data import)
“No of Data Blocks" "3"
"No of Data ltems" 5
"Address" "D0200"
"Data Format' o o 16 Bit 0, 328Bit 1
"Display Format" "0" P Dec: 0, Hex:1, BCD:2
"Code" 0" P +0, ;-1
"Block0" "BlockI" Block?2'
"Datal" "Data2" Da@a3"
"0" "10" "1000"
"2t "20" "2000"
4" "30" "3000"
"6" "40" "4000"
"8" "50" "5000" If this data is incorrect,

CSV data cannot be imported.

B Setingup Filing Data
Entering File No., Description, No. of Data Blocks, No. of Data Items and

10-14

Data Storage Start Address.
FileNo.: 1
Feto. B o e ovaesesks 7o | DesCription: Heat Control
Description:  [Heat Control Mo. of Data lbems 10 :E NO Of Data BlOCkS 3
[rata Starage Start Address ]m D ata Format No Of Data. |temS 10
sk e | eeee]  em ) | Data Storage Start Address:
Black Name =207 2L~ 387 36T ~ Display Format Dooloo
DoO000 a o 0
e 7]
DoO001 a 0 Q =
o000z ) o ] | Code+/
ooooo: (O o a [ Cear |
DOO004 a 0 Q
Coy
DoooaS a a 0 N
poooos (O a 0 &]
poooor  |© 4 0 [ tmport
poooos (O a 0 ]7& o ]
kB e
“ ak I ” Cancel ‘ “
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

€ FilingList Display

<When using multiple folders> <When using a single folder>
Folder
VF”ing .. 1 Temperature Settings 1 Temperature Settings
D —
@ Automatic Filing Data Transmission ]

Here, data transmission viathe external device'strigger (automatic data
transmission) is explained.

Previously entered filing data is transmitted to the Device/PLC as shown

below.
Filing Data
File No. 7 =] No. of DataBlocks |3 =]
Diescri iptior:  |Heat Contral Mo. of Data ltem 3 E
Diata Starage Start Address Doo100 EEEE] Diata Farmat
Blockn Biockd || Bl=] e ]
T
Block Mame [[~20°C 21~35°C 387 play Format
Dooioo  |200 30 55 Joee 7]
ooo1o1 202 30 a6
Dooioz 208 28 52 Elear

B DataTransmisson viaDevice/PLC Trigger (Automatic Data Trans-

misson)
Block 1's datais transmitted when the Control Word Address changes.
Write Settings (From Filing Data to
¥l SRAM)
e Soni oo Fling Dt To SRAM Control Word Address: D00200

ContolWord Acress = Write Completed Bit Address: M00001
Device/PLC & SRAM Direct Data

wite Completed Bit Address e o -
Transmission Settings

=External Device & SRAM Direct Data Transmission Setting ContrOI Word Addre$ D00201

D Extermal Device Controlled Transfer T ranSm I t Com pl et ed B I t A dd ress
Contral *word Address W 515;;; M 00002

Trarsrit Completed Bit Address [goaonoo0n ~ |2

| Q. ] | Cancel ] | Help ]

@\ When using multiple folders, the Control Word Addresses will be D00200 to
Note: D00201, which overlap with the following Device/PLC & SRAM Direct Data
2] Transmission Settings, Control Word Address (D00201).
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10-16

B Filing Data Data Transfer
LT

Internal memory
(Filing data) [=—»| Back up SRAM —— | External Device

€ Filingdata - SRAM

When the “0” Bit of adatatransmission’s Control Word Address (D00200)
isturned ON, al the filing datais written to SRAM.

Trigger Bit Address ON |
1 to D00200 ﬁ!

ON ! :
Write Completed Bit Address ;
MO0001 OFF |
Data processing writs Filing data to SRAW

€ SRAM = Device/lPLC

When the “0” Bit of the data transmission’s Control Word Address

(D00201) isturned ON, the designated filing data is written to the Device/
PLC.

To designate filing data, prior to transferring filing dataafile number is
stored in D00202 and a block number is stored in DO0203, directly follow-
ing the Control Word Address. ! !

Trigger Bit Address o

1to D00201 OFF !

Write Completed Bit Address .
M0002 OFF |

Data processing L/

1
SRAM to PLC i

Yritten into PLC's DOO100 to DO0O102

D00201 0001 Control Word Address

D00202 0001 ﬁ
D00203

0001 _
File Number 1
Block 1 Block 2 Block 3
200 30 55
202 30 56
D00100 200 205 28 62
D00101 202 Jransfer |
D00102 205
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

m Manual Filing Data Transmission Example 1 ]

The following explains how to transfer data by selecting the desired screen
setting (Manual Transmission 1).

The samefiling dataasin "10.1.4. Automatic Filing Data Transmission” is
used.

B Screen Example
In this example, datafrom File No. 1's Block No. 3 is sent by touching the
LT screen.

30
2 ~35T
389~

—DEV |SRAM

B Filing Setting Example
When [Device/PLC Controlled Transfer] is not checked, manual transfer is

performed.
Write Setting (From Filing Data To
: SRAM)
—\u/ite Settings(From Fiing Data To SRAMj—o Control Word Address; D00200
Contl Word s Write Completed Bit Address: M00001
Wite Complted Bit Addiss Device/PLC & SRAM Direct Data
Transmission Setting
=Device/PLE & SRaM Direct Data Transmizsion Settings——— .
| Device/PLE Controlled Transfer Da/l Cd PL C ContrOI I ed Trar]srer: N Ot
Control Word Addhess or/cooonn ||| selected
Transmit Completed Bit &ddress
“ [u] 4 I || Cancel ‘ || Help |
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10.1 Filing Data (Recipe) Chapter 10 - ADVANCED FEATURES

B Filing Data Display Settings

When manual data transmission is performed, you must place the Filing
Name Display.

2.1.12 File Name Display
@ General Settings

File Display [FD_001] Descri pt| on: Heat Control
General Settings | Display | Stele/Color | Switch Sellings || SwitchT ype/Color | U% L S A rea
Deescription :US LS U% L S A I’ ea N Ot g a:ted
_ Use LS Area . . . . .
oo ot s Since, inthisexample, datais transmit-

[ T | ted from SRAM to the Device/PLC, it
23?:; ?;\:g;fémltem — isnot transmitted viathe LS Area. Keep
1D M Transfer Completed Bit Address the defaU|t Settl ng-
e i | Bl Top Write Word Address: Not se-
lected
[Fece [ oo [[ B | Not designated. Since this example
does not use the LS area, this Address
does not need to be designated. When
using the LS area, designate the Top
Address of the LS area where data is
stored.

Device/PLC Transfer
UseTransfer Completed Bit Address:
Not selected
The example does not turn the Device/
PLC Transfer Completed Bit Address
ON when the datatransfer is completed
between the LS area and Device/PLC,
and SRAM and Device/PLC. (No in-
formation is sent when data transfer is
completed.)
When using the Transfer Compl eted Bit
Address, after the Bit ON condition is
detected, turn the corresponding Bit
OFF on the Device/PLC. Also, when
the Transfer Completed Bit Addressis
used, the special relay (LS2032)’s bit
10 will turn ON when data transfer is
not completed normally, between the
Device/PLC and LS area, or between
the Device/PLC and SRAM.
Device/PLC Connec-
tion Manual; Chapter 1

Device/PLC Transfer Completed Bit
Address: Not designated
Sincethisexampledoesnot usethe Trans-
fer Completed Bit Address, this Address
doesnot need to be designated. When us-
ing the Transfer Completed Bit Address,
designate an Address that will be turned
ON when datatransfer is completed.
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

ID No.: 0
In this example, where only one Filing
DataDisplay isplaced, the ID No. does
not need to be entered. Keep the de-
fault setting. When placing two or more
Filing Data Displays on the currently
displayed screen, be sure not to use the
same ID No. for multiple Filing Data

Displays.
FileNo.: 1
Enter the previoudly entered filing data
number.
@ Display
. 'F"—"" No. of Display Lines: 3
e e et s e No. of Display Characters: 10
o obipeytres [ Direct Selection: Selected
Mo ofDiy Chsscies 1025 Cursor Position Control: Selected

¥ Direct Selsction

|| Place ||| Cancel |” Help ‘

<Cursor Position Control>

» Even when the screens are changed on the LT monitor, the current File
Name Display’s cursor position can be preserved.

* Cursor Position Control can be designated when setting up the File Name
Display.

* When the LT'smain power isturned ON or the LT isreset, the cursor will
appear on thefirst line.

 The cursor position will be stored for each ID No. (The storage area of an
ID No. and its cursor position correspond to each other.) To retain the
cursor position, be sure that the File Name Display ID Nos. do not overlap
each other on any of the screens. For more detailed information about the
File Name Display,

2.1.12 File Name Display

€ Style/Color
Fil Display IFD_001) Border Type: Outer and inner borders
\Gegelj S?It\ngﬂDi;plag:H 5‘5:|ef50|0f | Switch Gettings |[ SwitchType Color | DI $I ay COl or: %I &t deS| raj COI ors.
Fo WD JEEOONE [R5 F] Select the desired colors for Fg (fore-
" MBODEED0RE e F ground), Bg (background), and Blk
Erase Color . ! !
[ (Il ] (] fd (blink).

Erase Color: Select the desired color.
Select the display areacolor to usewhen
aFiling Data Display iscleared. When

e [t using amonochromeLT, select “Black”.
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10.1 Filing Data (Recipe) Chapter 10 - ADVANCED FEATURES

€ Switch Settings

File Display [FD._001] Send To Device/PL C From SRAM: Se-
[ General Settings | Display [ Style/Colar]| Switch Settings | SwichType/Color | | eCt ed
st Sukcn Facenent et Send To SRAM From Device/PLC: Se-
SR ected
Ry e[ Roll Up: Not selected
iFifain DIt Brmmalvaviss Roll Down: Not selected
Send To LS From SRAM: Not selected
Send To SRAM From L S: Not selected
[Feee [ cowed |[1er Send To LS From Device/PLC: Not se-
lected
Sending To Device/PLC From LS. Not
selected
€ Switch Type/Color
File Display [FD_0011 : Border Color: Select the desired color.
CEREETE e e e R Select the desired color for the Filing
F T ey Name Display’s border.

H Place Hl Cancel ||| Help

B Place

Click on the [Place] button to display the Filing Name Display. |If desired,
change the Part’s size viaits sizing handles.

1234567390 5w 1234567390
2 |—DEW '
| | DEY— 2
SHLM
3
ERAM DEY—
—[EY SREAM

‘Note: To change the Filing Name Display’s layout or attributes, first ungroup it.

B Filing Data Transmission Flow
LT

Internal memory External
(Filing data) |—» SRAM e Device
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

€ FilingDatato SRAM
All thefiling datais written into the SRAM when the Trigger Bit is turned

ON. : :
Control Word Address ON '
1 to D00200 OFF !

ONE —

Write Completed Bit Address :
M0001 oFF!

1 1
1 1
Data processing —_Filing data to SRAM

¢ SRAM - Device/lPLC

Filing data selected by the LT’s touch key is written to the Device/PLC.
W Actual Process

1) Select an item. (Here, select Block 3 “36°C -”.)

2) Touch “SRAM - PLC” key.

SRAM

g > PLC

3) Filing data istransmitted from SRAM to the Device/PLC.

Himn®
I
LT
File Number 1
Block 1 Block 2 Block 3
200 30 . 55
202 30 : 56 :
205 8 T g2 Device/PLC
b=t D00100 55
L DO00101 56
D00102 62
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@ Manual Filing Data Transmission Example 2 ]

Here, select an item using the File Name Display from a screen and fine-
tune (minutely adjust) the dataviathe LS area, and then transfer the data
(manual transfer: 2).

B Screen Example

B Filing Setting Example

When the check box of [Device/PLC Controlled Transfer] is off, manual
datatransmission is performed.

Write Setting (From Filing Data To
SRAM)
Control Word Address: D00200
Write Completed Bit Address: M00001

ers
="rite Settings(From Filing Data To SRAM)

Control Word Address 01000000 I~ 1|2
it Completed Bit Address o1 /co000000 [+ | ]

o LM e —— Device/PLC & SRAM Direct Data
Control Ward Address = Transmission Setti ng

Device/PLC Controlled Transfer: Not
selected

Transmit Completed Bit Address [o7co000000 = b

|| Ok | || Cancel | || Help |
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10.1 Filing Data (Recipe)

B Filing Name Display Settings
When manual datatransmission is performed, you must place the Filing
Name Display.

2.1.12 Filing Name Display

@ General Settings

File Display [FD_001]

General Settings | Display || Style/Color | Switch Settings || SwitchT ypesColar |

Description

=Usels

Top 'wiite Word Address
= Extemal Device Transfer
Q] Use Transter Completed Bit Address
1D Mo, [0 g Transfer Completed Bit Address
Fieto [T ] 01000000 [
” Place | “ Cancel ‘ “ Help ‘
@ Digplay

File Display [FD_001]

[General Settings]| Display | Stule/Color |[ Switch Settings || SwitchType/Color |

Mo. of Display Lines

¥
¥ s

Mo, of Displap Charanters

il

=
=
15 =

[ Flace

||| Cancel ||| Help

Description: Heat Control

UseLSArea
UseLSArea: Selected
Filing dataisfirs transferred tothe LT's
LS area before being transferred to the
Device/PLC.
While filing data is being transferred
from SRAM to LS, and LSto SRAM,
the LT internal special relay (LS2032)'s
bit 11 will be turned ON.

Device/PL C Transfer
UseTransfer Completed Bit Address:
Not Selected
Enables/disables the Transfer Com-
pleted Bit setting.

ID No.: 0
In this example, where only one Filing
Name Display isplaced, the ID No. does
not need to be entered. Keep the defaullt
setting. When placing two or more Fil-
ing Name Displays on the currently dis-
played screen, be sure not to usethe same
ID No. for multiple Filing Name Displays.

FileNo.: 1
Enter the previoudly entered filing data
number.

No. of Display Lines: 8

No. of Display Characters: 15
Direct Selection: Selected

Cursor Position Control: Selected
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& Cursor Position Control

» Even when the screens are changed on the LT monitor, the current File
Name Display’s cursor position can be retained.

* Cursor Position Control can be designated when setting up the File Name
Display.

* When turning the LT’s main power switch ON or resetting the LT, the
cursor will appear on thefirst line.

 The cursor position will be stored for each ID No. (The storage area of an
ID No. and a cursor position are in correspondence with each other.) To
retain the cursor position, be sure that the File Name Display ID Nos. do
not overlap each other on any of the screens. For more detailed informa-
tion about the File Name Display,

2.1.12 File Name Display

@ Switch Settings

Fie Diplay [FD_UU1) Send To Device/PLC From SRAM: Not
[ General Settings [ Display | Style/Color]| Switch Settings | SwitchTypesColor | Sel eCt ed
‘*;:;f;f‘:::j:;j*t“”d . Send To SRAM From Device/PLC: Not
eendberoes st 115 » S Selected
) ralup Bl el Device > 15 Roll Up: Selected
) Roll Down HHE S EemalDevied Roll Down: Selected
Send To LS From SRAM: Selected
Send To SRAM From L S: Selected
| Send To L SFrom Device/PL C: Selected
Sending To Device/PLC From LS. Se-
lected
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Chapter 10 - ADVANCED FEATURES 10.1 Filing Data (Recipe)

H Place

Click on the Place button to display the Filing Name Data Display. Change
the size of placed Part, if desired. Settings Display must be placed to corre-
spond with the storing address of the filing data.

123493672000 2343 | s/
P

I
3_ ________

A— — P | oo
— E

g' ________ L3 Release Grouping _>
3‘ ________

Qlk\l\ote: To change the Filing Name Display’s layout or attributes, first ungroup it.
2]

1) Writing filing data to SRAM
All filing datais written to SRAM when the Trigger Bit isturned ON.

Trigger Bit Address oM
D00200001 41

OFF |
Write Completed Bit Address ON
MO0001 OFF |

1 1
Data processin : i
P 9 —-< \Write Filing data to SRAM
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2) Selecting afile name

Select the desired setting by
touching Block 2's LT screen
data.

3) Backup SRAM - LSArea

Touching the“SRAM - LS’
key will transmit data from
SRAM totheLS Area

4) Data Editing

Touch the Keypad Display to
display the Pop-up Keypad.
Adjust the data using the Pop-
up Keypad.

5) LSAreato Device/PLC

The edited data is transmitted to
the Device/PLC by touching the
“LS - DEV” key.
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| 2070

36C

LE-=
SRAM

up |DOHﬂ

SRAM
9‘ =15

Device/PLC
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Chapter 10 - ADVANCED FEATURES 10.2 Logging

@ Logging

The Device/PLC dataisloaded to the LT's backup area (SRAM) at bit-based
or time-specified timings to display it in atabular form on the screen or print
it on the printer.

Logging data can be displayed viaa L ogging Display.

2.1.13 Logging Display

L ogging data can be displayed with its Total, Average, Max., and Min.
values, which can be set viathe Data Calculation Settings.

Logging data can be entered into a database for data analysis.

—/
B - =

- = a

0024 < Designated 0064
0010 Sampling  word Addresses 0024

@ Logging Function ]

W Data L ogging Flow

Thisflow chart shows the logging data flow and each trigger condition.

LT
Backup - 1) External
SRAM Device
® / l T @
LS Area Logging
Display

(1)Logging by the Device/PLC Trigger Bit Address or at designated timing
10.2.3 Data Logging Settings @ Trigger Settings

(2)Data display and edit viathe Logging Display

10.2.4 Display Settings

(3)Datatransmission to LS Area viathe Control Word Address

10.2.3 Data Logging Settings M Writeto LS

LT Editor \er. 2.0 Operation Manual - Screen Creation Guide 10-27



10.2 Logging Chapter 10 - ADVANCED FEATURES

B Managing Groups of Logging Data
Logging datais grouped into files and blocks.

Up to 32 words can be logged in onetime. These logged words are called
“data’.

A group of datais called a“block” and a group of blocks are called a“file’.
Be aware that the number of pieces of datain each block is considered to be

the same.
File 1
Block 1 Block 2
Data 1 Data 1
Data 2 Data 2
Data 3 Data 3
Data 4 Data 4

B Backup SRAM's capacity

Backup SRAM’s capacity islimited (Approximately 95KB) and all blocks
and records set up must be within these limits.

The capacity of Backup SRAM to be used for logging setting is calculated
by the following formulas. The formula varies depending on whether loop
operation is performed or not.

10.2.1 Logging Function ® Loop Operation

€ Without L oop Operation
Used backup SRAM capacity (byte)

=128 + 20 + { (12 + 2 X Number of logging data pieces?) X Frequency of
datalogging} X Number of blocks

€ With Loop Operation
Used backup SRAM capacity (byte)

=128+ 20+ {(12+2 X Number of logging data pieces) X Frequency of
datalogging} X Number of blocks + (12 + 2 X Number of logging data
pieces)

For example, when loop operation is not selected, the number of block is1,
and the number of logging is 2048, the capacity available is approximately
32 KB, assuming that the logging data consists of 2 words. If the number of
pieces of datais 32 (the maximum) the memory required becomes approxi-
mately 153 KB, which istoo high.

*1 Regardless whether loop operation is designated or not, when the number of logging
data items is an odd number, add 1 to the above calculation. For example, when the
number of logging data itemsis 7, it is considered as 8 Words.
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@ Backup SRAM usagepriority order

1) Data sampling

2) Trend graph

3) LS Area backup

4) Logging data

5) Filing data

Memory areais used starting from 1).

To check the amount of memory available,
4.4.1 Project I nformation

Data stored in backup SRAM is erased at the following times:

! * When initializing LT memory
Important  « \Nhen transmitting screen data from your PC to the LT.
* When setting up the LT system and protocol
* When performing LT's self-diagnosis “Internal FEPROM
(screen area)”

B L oop Operation

L oop operation can be designated in logging mode. With loop operation
selected, when data logging capacity becomes full, logging data will repeat-
edly be overwritten from the 1st (top) data area (loop operation). Also, the
LT’ s backup SRAM (storage area) becomes one large storage areathat has a
linked, buffer-like structure.

<Without L oop Operation>

Block 0 Logging Data 1 Each logging data item uses the same
Logging Data 2 number of Words.
The range of the number of Words is

from 1 to 32.

Logging Data n

Block 1 Logging Data 1
Logging Data 2

Logging Data n

Block m-1 Logging Data 1
Logging Data 2

Logging Data n

Qlkv:)te: * When data logging is performed for the designated number of blocks, the
21 LT will turn the File Full Bit Address ON and data logging will stop.

e Toresume data logging, turn the Data Clear Bit Address ON from the
Device/PLC. The LT then clearsall logging data and will start data logging
from the beginning.
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€ \With Loop operation

10.2 Logging
!
Important
10-30

When data logging is performed to the end of aloop cycle, datalogging
repeats from the beginning, and overwrites the existing data.

Only one block is used, which has alinked, buffer-like structure. and is

similar to the link buffer.

After datalogging is completed (and control jumps from the end of the
block to the beginning), the LT will turn the File Full Bit Address ON.
Turning this Address ON simply indicates that data logging has been per-
formed from the beginning to the end one time and that data logging will

continue.

—
Logging Data 1

Block Logging Data 2

(Single) Logging Data 3
Logging Data n

Using loop operation, each logging
data item also uses from 1 to 32
words.

» After the Device/PLC detects the File Full Bit's turning ON,

turn the Bit OFF.

* When the Data Clear Bit Address turns ON from the Device/
PLC, the LT clears logging data and repeats data logging from
the beginning. When logging data is cleared, the LT turns the

Data Clear Bit Address OFF.
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@ Logging Data Read Timing ]

elkv\ote:  All the charts shown above are the basic image of LT’slogging data read
2] timing. They do not show the exact timeintervals of logging data read.

 |f acommunication error occursduringlogging data read, “**” isdisplayed
on the L ogging Display, representing that thereisno data.

B \When designating a Bit Address
Logging datais read only one time for each trigger.

When designating a Bit, logging datais read out if the Device/PLC Trigger
Bit has been turned ON when the main power isturned ON.

Trigger Bit Address (|2
(External Device to LT) / \
LT ACK Bit Address dS |

(LT to External Device)

Data Read ——  Logging dataread |

(External Device to LT)

1) Datais set to the Device/PLC Word Address.

2) The Device/PLC Trigger Bit Addressisturned ON.
3) Thelogging datais read out (one time).

4) TheLT_ACK Bit Addressisturned ON.

5) Device/PLC detectsthe LT _ACK Bit Addressisturned ON and the
Device/PLC Trigger Bit Addressisturned OFF.

6) LT detects the Device/PLC Trigger Bit Addressis turned OFF and the
LT_ACK Bit Addressisturned OFF.

7) The Device/PLC confirmsthat the LT _ACK Bit Addressisturned OFF.

Prior to performing steps 1) and 2) with the Device/PLC, be sure to confirm
that the LT_ACK Bit Address has been turned OFF. Also, assuming that the
main power may be turned OFF for some reason, be sure to take appropriate
countermeasures such as turning the Device/PLC Trigger Bitand LT_ACK
Bit OFF when starting operation.
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B When designating time

Logging dataisread only onetime at the designated timing.

When designating time without using loop operation, a Block's Finish Bit
Addressisturned ON when a block's data logging is completed, in order to
start dataread at the read start time. Logging datain the Device/PLC Word
Addressis cleared by the external device.

Data Logging Auth. Bit Address
(External Device to LT)

Designated time @

(Inside of LT) \

Data read | Logging dataread out |———
(External Device to LT)

@ Data Logging Settings ]

Set up itemsin the [Trigger Setting], [Display], and [Write Settings] tabs.

Select the Project Manager's [ Screen/Edit] menu - [Logging Setting] com-
mand.

B Trigger Settings
@ Trigger Settings (Bit M ethod)

Data Logging Settings

L ogging (ON/OFF)
Check this check box when perform-
ing data logging.

Bit Method
Select this option when using a Trigger
Bit to start datalogging.

Tiigaer Settings | Display | Wwite Settings |
¥ Logaingit FATFFE
%3 Bit Method

£ Time Method

Diata Logging Start Address 000000 ~]| =

Mo. of Words

Fiead Count [ Counts/Block |

Block Court
Trigger Bit Address
ACK Bit Address
File Full Bit Address

Data Clear Bit Address

o0/000000 7|
00/000000 ||

00000000 el

00000000 =\

o [ cewd |[ b |

Data Logging Start Address
Designate the Start Address of the De-
vice/PLC device where data to be
logged is stored.

No. of Words
Designate the desired number of words
from the Start Address. Up to 32 words
can be designated.

[ ] When a variable (Logic Symbol) is used as alogging start ad-
/,,,p:,ta,,t dress, an integer array must be designated. For an integer array,

an appropriate size required for consecutive addresses needs to
be allocated.

Read Count

Designate the frequency of data log-
ging. Dataislogged at the frequency
designated here and then handled as a
block.
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@ Trigger Settings (Time Method)

Data Logging Settings

" Triager Settings | Display | wiite Seltings |
] LoaginglDN/TIFF]
2 Bit Method

#iTime Method

000000 =

Start Time H Mo FrnTie I K[ M
Duration H M 5 HeadCount

Daata Logging &uth. Bit Address

Data Logging Start Addiess

Mo. of Wards

Block Court
00000000 ™| [
Black's Finish Bit Address 00000000 ™| [

File Full Bit &ddress 00/000000 | s

Data Clear Bit Address 00/000000 Sl

o ][ ceneal H H
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Block Count
Designate the number of data blocks.
Dataislogged for the number of blocks
designated here and then handled as a
file.
1 <Timesx Blocks < 2048

Trigger Bit Address
Designate a Bit Address to be used as
External Device' strigger. (Device/PLC
toLT)

LT_ACK Bit Address
Designate the Device/PLC Bit Address.
When data logging is completed one
time, LT turns ON the Bit Address des-
ignated here. (LT to Device/PLC)

File Full Bit Address
Designatethe Externa Device'sBit Ad-
dress. When datalogging is performed
for the designated number of blocks, the
Bit Address designated here is turned
ON. (LT to Device/PLC) After the
Device/PLC detects the Bit Addressis
turned ON, turn it OFF.

Data Clear Bit Address
Designatethe Externa Device'sBit Ad-
dress. WhentheBit Addressdesignated
here is turned ON, data stored in the
backup SRAM is deleted. After the
backup SRAM dataisdeleted, LT turns
OFF this Bit Address.
(Device/PLCtoO LT, LT to Device/PLC)

L oop
Selecting this feature means when data
loggingiscompleted, it will beginagain
from the top-most data address and
overwrite the existing data.

= Time Method

Select this option when performing data
logging by triggering logging start at the
designated timing.

Data Logging Start Address
Designate the Start Address of the De-
vice/PLC device where data to be
logged is stored.

No. of Words
Designate the desired number of words
counted from the Start Address. Up to
32 words can be designated.
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Start Time
Designate the first data logging start
time.

Duration
Designate the time period that datalog-
ging isperformed periodicaly. “S (sec-
ond)” setting options are “00”, “15”,
“307, and “45”, with 15 second inter-
vals. When designating data logging
time, datalogged from the start to end
timesishandled as 1 block.

Read Count
Designate thefrequency of datalogging
between the Start time and End time.
Based on thefrequency set here, the End
time is determined.

Block Count
Designate the number of data blocks.
Data logged for the number of blocks
designated here is handled as afile.
When designating data logging time,
datafor ablock islogged per day.
1 < Timesx Blocks < 2048

Data L ogging Auth. Bit Address
Designate the External Device' sBit Ad-
dress. WhentheBit Address designated
here is turned ON and it becomes the
designated logging time, data logging
is performed. (Device/PLCto LT)

Block’s Finish Bit Address
Designate the External Device' sBit Ad-
dress. When datalogging is completed
one time, the Bit Address designated
hereisturned ON. (LT to Device/PLC)
After the Device/PLC detects that the
Bit Addressisturned ON, turn it OFF.

File Full Bit Address
Designatethe External Device' sBit Ad-
dress. When datalogging is completed
for block, the Bit Address designated
hereisturned ON. (LT to Device/PLC)
After the Device/PLC detects the Bit
Addressisturned ON, turn it OFF.

Data Clear Bit Address
Designate the External Device' sBit Ad-
dress. WhentheBit Address designated
here is turned ON, data stored in the
backup SRAM isdeleted. After thedata
is deleted, LT turns OFF the Bit Ad-
dress. (Device/PLCto LT, LT to De-
vice/PLC)
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L oop
Selecting this feature means when data
logging iscompleted, it will beginagain
from the top-most data address and
overwrite the existing data.

B Trigger settings with Loop operation

Trigger settings will differ depending on the type of Loop operation desig-

nated.
@ Bit Method
Item (Trigger Settings) Without Loop Operation| With Loop Operation
Data Logging Start Address Designated by user Designated by user
No. of Words 1 to 32 Words 1 to 32 Words
Read Count 1102048 L 110 2048
Block Count 1102048 't 1 (fixed)

Trigger Bit Address

Designated by user

Designated by user

LT _ACK Bit Address

Designated by user

Designated by user

File Full Bit Address

Designated by user

Designated by user

Data Clear Bit Address

Designated by user

Designated by user

* 1. The maximum number of logging Wordsin all blocksis 2048.

Number of blocks x frequency < 2048

€ TimeMethod
Item (Trigger Settings) Without Loop Operation| With Loop Operation
Data Logging Start Address Designated by user Designated by user
No. of Words 1to 32 Words 1to 32 Words
Start Time Hour/Min. Hour/Min.
Finish Time No Setting *1 No Setting *1
Duration Hour/Min./Sec. Hour/Min./Sec.
Read Count 110 2048 =2 1102048 *2
Block Count 1102048 =2 1102048 »2
Data Logging Auth. Bit Address Designated by user Designated by user
Block's Finish Bit Address Designated by user No Setting

File Full Bit Address

Designated by user

Designated by user

Data Clear Bit Address

Designated by user

Designated by user

*1. The end time is automatically calculated using the time period and frequency.

*2. The maximum number of logging Wordsin all blocksis 2048.
Number of blocksx frequency < 2048
When using loop operation, the number of blocks needs to be designated to decide the
Logging area size.
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The Device/PLC monitors bits at approximately 150 ms inter-
vals. Therefore, a slight time delay may occur until the LT de-

Important tects the Trigger, or the Data Clear Bit. Set these Bit change

@Ikv\ote:

X2)

intervals to the length of communication cycle or to 150ms,
whichever is longer.

» Each piece of data to belogged inside therecord isonly 16 Bitslong. When
the Device/PL C device uses 32 Bit length addresses, only the lower 16 Bits
of data arelogged.

e TheLT’'sinternal clock controlstime using the last two digits of the year
display. Therefore, thelogging data’s year iscontrolled by these digits.

* When the Start and End times are the same, or when thetimeinterval is
“0”, datalogging is performed once for each block.

e Data stored in the backup SRAM iscleared via the Data Clear Bit Address,
when the Clear Bit changesfrom OFF to ON.

e When the LT’s power isturned ON, if the Data Clear Bit Address's Bit has
been turned ON, the LT deletesthe backup SRAM logging data and turns
OFF the Clear Bit.

» With loop operation and time setup designated, when Data L ogging Auth.
Bit Addressisturned OFF or when the LT’s power isturned OFF, after the
logging period elapses |loop operation becomes the same status as non-loop
operation.

(e.g.) Start time09:00 Endtime18:00 Timeperiod 3hrs.
If the 15:00 logging was skipped dueto the LT's power being turned OFF:

<Without L oop Operation> <With L oop Operation>
Block 1
09:00 Logging Logging at09:00
12:00 Logging Logging at 12:00
15:00 Read Error Read Error (15:00)
18:00 Logging Logging at 18:00
Block 2
09:00 Logging
12:00 Logging
Datalogging at 15:00 is Data logging at 15:00 is stored as a
stored as aread error. read error. (Same as without loop
operation)
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B Display
Data Logging Settings = Di Sp| ay (O N/OFF)
o] D Click on this check box to display data
F;‘ED]WDS:::‘;B\W Marne Eu::;pslay:ﬂock Name US- ng the Loggl ng DI Spl ay’ or Whm Sav-
Mo. of Block Name Fiows Mo. of Char.Atem Ing dma tO a CF Card
Mo.of Data Fows Mo. of Data Col
No.of Cale. Rows Row Setti ngs
DataChar. Sizz BX16 |7 No. of Char./Data D|Sp|ay Block Name
Check this check box to display data
together with its Block Name.
No. of Block Name Rows
Enter avaue hereto display block names
o [ et ][ e inmultiplerows. Up to 3 rows can be st

up.
No. of Data Rows

Set up the number of rows in the data
display area.

No. of Calc. Rows

Set up the number of rowsin the calcu-
lation area. Up to 4 rows can be set up.

Column Settings
Display Block Name
Check this check box to display data
together with its Block Name.
No. of Char./Item
Designate the maximum number of
block name characters.
No. of Data Coal.
Designate the number of data display
columnsin the datadisplay area.

Data Char. Size
Designate the character size for each
datain the data display area.

No. of Char. / Data
Designate the number of charactersin
the data display area.

Preview
The setting contents can be preview.
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€ Maximum Number of Rows and Columns

Up to 60 columns and up to 2100 rows of data can be entered. However,
since the file capacity is approximately 58K B, depending on the No. of
Block Name Rows and No. of Char./Name designated for the cells, these
column and row limits will decrease.

<Row/Column Settings>

00000 [ 00000 [ 00000 [ 00000 [ 00000 | o of Block
00000 [ 00000 | 00000 | 00000 | 00000 | | Names
00000 | OOOVO | QOOVO | OOVOQ | OOVVO || (1to 3)
00000 kkkokk *kkkk kkkokk *kkkk kkkokk -
00000 Xk *hkkok Xk *hkkok Xk
00000 *kkkk *kkkk *kkkk *kkkk *hkkk No. of Block
Xk *kkkok Xk *hkkok Xk Data Rows
88888 kkkkk *kkkk *kkkk *kkkk *kkkk (1 to 2100)
00000 Xk *hkkk Xk *hkkok Xk —
00000 Xk *hkkk Xk *hkkk Xk _
00000 kkkkk *kkkk *kkokk *kkkk *kkokk No. of Calc.
00000 Kokkkk *hokkk Xk *kkkok Xk Rows
00000 *kkkk *kkkk kkkokk *kkkk kkkk ] (1to 4)
I |
No. of Char./Col No. of Block Char./Col (1 to 16)
(1to 16)

No. of Data Col (1 to 60)

€ Row Setting When Using L oop Oper ation

When the loop feature is used, regardless of the logging frequency, the data
display will always be only one row.

The display row settings used during loop operation are as follows:

Data Display Row Only Block Name Row + Data Display Row
|  DataDisplay (Lrow) | Block Name
Data Display (1 row)
Data Display Row + T otal Row Block Name Row + Data Display Row + T otal Row
Data display (1 row) Block Name
Total Row(s) (1 to 4 rows) Data Display Row (1 row)

Total Row(s) (1 to 4 rows)

E.g.
aetings [ add ]|| Capy ||| Raste ||| Ty |

| [Date/Time |[value |[value |[value |[value|«|
Ttem Time Woltage |Temp. 1 [Temp, 2 Pressi_

TEREF FTFFFF FTEFFF FTFFFE
Data bk
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€ Row Setting Display When Using L oop Operation
When using the loop feature, the Data Logging Display is as follows:

E.0. When frequency isset to4
L ogging Data (Backup SRAM data)

@) ® © B ©
) ? ) ® | ©
a1 "ol T[] [0 @
| - [e] el [e] )
I [ | [ l—l—‘
A B C D E

Data L ogging Display (Changes over Time)

Time | Voltage | Temperaure [ Pressure Time | Voltage | Temperature [ Pressure
9:00 @ @ (@) 12:00 @ 2 2
12:00 @) @) @) 15.00 [€)] ?) ?)
15.00 [€)] [€)] [©) 18:00 @ @) @)
9:00 () () 5)
| I L |
I | E,..
A \ /v C \ /'
Time | Voltage | Temperature | Pressure Time | Voltage |Temperature | Pressure
9:00 (@) (@) @ 15:00 [©) [€)] [€)]
12:00 @) @) @) 18:00 €Y @ @
15:00 ?) ©) [€)] 9:00 () ®) )
18:00 @ @ @ 12:00 ©) ®) ®)
L I L I
I [
B D

Here, the oldest (acquired earliest) logging datais displayed in the top-most
cell. When asingle cycle of datalogging is completed from beginning to
end, data display rows will then shift upwards one row, every time datais
logged.

When using the loop feature, the Total (Total, Average, Max., Min.) rows
will disappear. However, these Total values will be the totals of backup
SRAM data at that one pointing in time. Therefore, the new data that over-
writes the old datawill not be included in the Total values.
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BPrint

1 Print (ON/OFF)
Click on this check box to print out the

{39 Block Unit £ Realtime Capy from Display .
? elfolumn Setting —I |0gg| ng dma.
] H’VNU of Data Col [ Block Unit
— RN R Logging data is printed in block units.

Corto Word s e QP O | Printing is started via the Control Word
Print Completed Bit Address Jrooo0n [ Addre$
Realtime
Logging datais printed out each timeitis
logged.

Copy from Display
Click on this button, when the display for-
Lo [ Coed e mat has already been set up, to use that
format for printing.
Row Settings
No. of Data Rows
Designates the number of rowsin the data
print area.
No. of Calc. Rows
Designates the number of rowsin the cal-
culation area.
Column Settings
No. of Data Coal.
Designates the number of rowsin the data
print area.
Header
Click on this button to display the header
edit window. Enter text on this window.
The maximum text entry sizeis 160 char-
actersfor each row and thetotal of 40 rows.
Footer
Click on this button to display the footer ed-
iting window. Enter text in the footer sec-
tion. The maximum entry sizeis 160 char-
actersfor each row and the total of 40 rows.
Preview
Click on thisbutton to view the printing im-
age of the data, header, and footer aress.
Control Word Address
When datais printed out for each block, the
printing Sartswith the Trigger Bit turned ON.
This setting designates that Word Address.

Control Word

Address 10

+0] Reservation (All OFF) [ 4— Trigger

+1 Block No.
Trigger (ON: Print, OFF: Not Print)
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Data Logging Settings

[Trigger

s |[Display][ Print [[Wiite Settings |

T Finifi N7 ) Block Unit £23 Realtime Copy from Display
Row Settir Column Settir
Mo, of Data Rows 2 [ No. of Data Col 3
No. of Cale. Rows 1
H Headzr || Footer H Preview |
Cortrol Word Addbess Donm00_ || Left Margin [T ]
Prirt Completed Bit Address o000 [+

[

|| Cancel | Bele

10.2 Logging

Print Completed Bit Address
Designates the Bit Address to be turned
ON at the end of printing, when datais
printed out for each block. After confirm-
ing that this Bit Address is turned ON,
perform the next printing.

Left Margin
Designates the left margin size to be used
when printing out the data. The space for
the number of the characters designated
hereis saved asablank. This setting con-
trols only the data print area.

Note:. For dialog printing settings, refer to 9.1 Print Settings.

X2

. For hardware printing settings, refer toLT SeriesUser’s
Manual.

* When using loop operation and performing real time printing, the Total
section will not be printed.

* When using loop operation to perform real time printing, if the logging
frequency isnot very high or a printer has not yet been connected, printing
cannot be performed at the speed the logging data is created, thereby
causing a difference between the two. Please note that thefirst cycle's
logging data will not be printed out when data logging is performed to the
end of aloop cycle and then repeats from the beginning, overwriting the
existing data.
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B WritetoLS
— | Write Settings (When Writingto LS
[‘ Trigger Settings @ “wiribe 5 ettings ] A r ea)

[Sro— Stores logging datain the LS area Dis-

Convlviord s o FlE plays logging data items in combina-
tion with Keypad Display.

Perform Data Write (On/Off)
Although all logging data can be dis-
played at a single time via the display
settings, using the LS Areaallows each
piece of logging data to be displayed
separately, together with Keypad Dis-
5 [ Cood || b | play. Click on this check box to usethis

“Write to LS Address 00450020

“Write Complete Bit Address 00/000000 [ ||

=it S ettings(T otal]
¥ Perfarm Data Wite[n/Of}

Controlword Address 00/0000 [~ || 22

& i

“Write to LS Address 00/L50020

write Comolete Bit Address 00000000 ] :‘;iirv

Setting.

Control Word Address

Designate a Word Address that is the
trigger or mode change for writing data
to the LS Area. This Trigger Bit is
turned ON or OFF by the Device/PLC.
When writing backup SRAM logging
datato the LS area, logging data trans-
fer isperformed by designating a Block
No. (when using loop operation, set to
“0”) and turning the Trigger Bit OFF
and then ON.

Control Word

Address 1o

+0] Reservation (All OFF) | 4— Trigger

+1 Block No.
Trigger (ON: Transmit, OFF: Not transmitted)

Writeto LS Address

Designatesthe LS Area Address where
dataiswritten to.

Write Complete Bit Address
Designates the Bit Address that will be
turned ON when data writeto the LS
Areais completed. After turning the
Bit Address ON is detected, use the
Device/PLC to turn it OFF. When there
isno designated Block No., the Perform
Data Write Bit Address is not turned
ON.
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10.2 Logging

Write Settings (Total)

Writes each column’s total value for
each block to the LS area. The Total
value is written to the LS area viathe
Control Word Address, according to the
Logging Settings Display Settings.
Perform Data Write (On/Off)
Designates whether or not the Total
valueiswritten to the LS area.
Control Word Address

When writing the Total valuetothe LS
area, transfers the Total value data to
the LS area by designating a Block No.
and turning the Trigger Bit OFF and
then ON.

Control Word

Address

10

+0] Reservation (All OFF) | 4+— Trigger

+1 Block No.
Trigger (ON: Transmit, OFF: Not transmitted)

Writeto LS Address

Designates the LS Area Address used
when writing data.

Write Complete Bit Address
Designates a Bit Address to be turned
ON when datawriteinto the LS Areais
completed. After the Bit Address ON
condition is detected, turn it OFF via
the Device/PLC. When thereisno des-
ignated Block No., the Perform Data
Write Bit Addressis not turned ON.
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& DatatobeWrittentoLSArea

Block and data structures to be transmitted to the LS Area are as follows:

Block
Logging data 1 Logging data
___________________ 15 0
+0 Code Flag *See below.
Logging data 2 +1 Year
Stored last two digits using
*2 Month Day the BCD format.
. +3 Hour Minute
™. +4 Second
A +5 Data Enabled/Disabled Bit *See below
N\ +6 Data Enabled/Disabled Bit * See below
+7 Word data 1
N\, +8 | Word data 2
Logging data n \
+(n+6)\‘\ Word Data n

15 - 87 - 0
+0f Code | Flag |
L Read flag
0: Data read incomplete
1: Data read completed
L—— Read Error Code
0: Normal finish
1: Read error

Word Data Enabled/Disabled Bit

15 0
+5|16(15| 14| 13|12|11{10|/9|8|7|6|5]|4|3|2]|1
+6(32| 31| 30{29|28| 27| 26|25(24| 23| 22(21(20]| 19| 18|17

Each Bitin a Word represents a data number.
When a Bitis "0" the Bitis Disabled. When a Bitis "1" the Bitis Enabled.

When using loop operation, logging datais transferred starting with the
oldest piece of data.

L ogging Data Process (in Backup SRAM)
Here, (1) to (6) represent logging data.

(1)

) In this case, logging datais written to the LS areain the
3) order of (1), (2), and (3).

(5)

(6) When using the Loop feature, logging datais writtenin
(3) the order of (3), (4), (5), and (6).

(4)
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10.2 Logging

If adatablock’s size exceeds the LS Area size, that data block cannot be

LS Area

transmitted.
Logging Data
(for each block)
\/ LS20
Not transmitted.
LS2031

@ Display Setting Examplefor Writingto LS Area

Thefollowing is an example of the display settings used when writing each
logging data column’s total value data to the LS area. (block units)

<Total Value Data and Average Value Data Display>

Display Settings

|| Setings |

o[ [ v |

[ Ttem |[Date/Time |[Value [Value

[Value =

Item

Data

vy mmidd | |FereE [Reeww

Data

vy mmidd  [FTEEE |FREEE

Data

Pt i

Data

P T i e

Total

wwwwwwwwww

Total

wwwwwwwwww

e rage

When using the above display settings, the Total value datawill be written
tothe LS areaasfollows. The Total values (Total, Average, Max., and Min.)
are all written as 32 bit data. Also, the Total values will be written from the
left column. All values (except Data and Item) will be automatically shifted
to the left in a column.

"Write to" LS area

+0 1st column's

+1 [ totalvalue

+2 1st column's

+3 | awragevalue |
+4 2nd column's

+5 | totalvalue |
+6 2nd column's

+7 | awragevalue |
+8 3rd column's

+9 [ totalvalue |
+10 3rd column's

+11 awragevalue |

— 1stcolumn's values

— 2nd column's values

— 3rd column's values

@Ikv\ote: If the size of the Total value data exceedsthe L S Area size, that data cannot
2] betransmitted.
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@ Display Settings ]

B Display Settings
In the [Display Settings] dialog box, the settings made in the [Display] tab

can be viewed and edited.
Data Logging 5ettings x|
Trigger Settings| Display | wiite Seltlngsl
¥ DisplapiIN/0FF) Display Setting
Row Settingg—————————— ~ Column Settings ————————————— d | al 0 g b oX
¥ Display Block Mame ¥ Display Block Mame
Mo, of Block Mame Fiows No. of Char. /ltem
Mouof Data Rows Mo, of Data Col.
Mo.of Calc. Rows
Dats Char. Size /~ Mo. of Char./Data |3 = Freview | N\
Option | Add | Copy | Faste | Cut |
Item [ate/Tin] value | -
Item
Data vy g e
Total | | [TFFT
ok
. LlJ
. J

'ENote: When using loop operation, regar dless of the logging frequency, the data
X2 display row will be designated as only a single row.

@ Settings
Rows and columns can be selected to change their attributes.
€ Add

Select a Datarow or Value column and click on the [Add] button, to create a
new row or column.

& Copy

Copiesthe currently selected Datarow(s) or Value column(s)’ datais copied
to the Clipboard.

& Paste

Pastes data row or Value column data copied to the Clipboard with the
[Copy] button in the desired position.

€ Cut
Deletes the currently selected Data row(s) or Value column(s).

10-46 LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide



Chapter 10 - ADVANCED FEATURES 10.2 Logging

B When copying row or column data with the same attribute
multiple times:

1. Designate the No. of Block Data and No. of Char./Col.

2. Set the attributes for arow or column to create the original datafor
copying.

3. Select that row or column.

4. Click on the [Copy] button.

5. Select the destination row or column to paste the copied datato. When
copying multiple times, select multiple rows or columns.

6. Click on the [Paste] button to paste the same attribute to all the selected
rows/columns.

1) Item Name Settings (Display)
B Ente [tem Names
Enter the Item Names for each cell.

=] [l

Hte/Ti

Time

¥y mmn

B Attribute Settings

To change the Item Name attributes, select the [tem Namettitle area and
click on the [ Settings] button.

=] [@i[=]=]l=])

Ite/”T' |Value

& General Info.

T R mmmmmeeeee— 1 NiS tab page provides information
Terera e [T | about the current settings for the Item
Colurin Mo. 1 N ame

Calumn Type

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 10-47



10.2 Logging

10-48

Chapter 10 - ADVANCED FEATURES

& Color
n Block Name Color
WHTI Select the desired colors for Fg (fore-
Color Setting ‘. ] ground), Bg (background), and Blk
Block e o | Fl e Bk (blink) display.

g I 2 )V [ B [

|| ok ||| Cancel ||| Help

2) Column Settings (Display)
B Attribute Settings

To enter column attribute data, click on a Date/Time or Valuetitle (top bar)
and then click on the [Settings| button.

Display Settings ‘

H Seltings | “ Add |” Copy ||| [Pasky Hl Cut ‘ H

@ General Info. [Column Type: Date/Time]
This tab page provides information about the current Column settings.

Column Settings COl umn Type
Gcer;era\ :fo IDataZFolmat Siza/Style || Alam Settings | Sel eCt the deSI red d| Spl ay |tem from
Column Type {3 Value @ iateTime {3 Char Col Val ue, DaIe/T| me, or Chal’ COl .
Data Type Date
Dizplay Format wmm/dd
Iriput
Alarmn Settings OFF
Dizplay Style Shift Left

Ma. of Display Digits
Decimal Places

& DataFormat

Date
General Info. || Data Format | Size/Style |[Alam Settings | .

wow @ime Displaysthe date.
Time

Displaysthe time.

Display For mat
Select the desired time/date display for-
mat.

/i /dd
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@Ikv\ote: There aretwo types of settingsin the Date/Time settings, i.e. date settings and
2] time settings. Timeisexpressed only by the 24 hour system.

e For date:
mm/dd/yy
mm/dd
yy/mm/dd
dd/mm/lyy

e For time:
hh:mm
hh:mm:ss

@ General Info. [Column Type: Valug]

Value

N Selecting this option displays actual
CobrinTiee g9 Vae | ) Da/Tine 3 Cra Col logging data in the Display Settings
s area.
@ Data Format (Absolute)
R A\ Dsolute
DisplaysLogging Addressarea Address
— data.
SSSSSS ‘ Address Offset
Pt The Logging Addressis changed by the
i:: Dcode ++- offset value entered here. For example,
- when the number of logging wordsis
I—— 4, the offset value becomes 0 to 3.

Display Data For mat
Select the desired dataformat from Dec,
Hex, and BCD.

Code +/-
Check this check box when displaying
negative values. Only available when
selecting the Dec dataformat.
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@ Data Format (Relative)

Relative
e o Data stored in the Address entered in
o [T T the Logging Address area is converted
Bwann  [5E] according to the Input Range area’sval -
N — ues and the converted data values are
S displayed.
Address Offset

et Fane Dipla R The Logging Addressis changed by the
R — [ g —:| offset value entered here. For example,

Mawvaie [BE B MasVole [F58 O . .
— — when the number of logging words is

T o= [ = | 4, the offset value becomes 0 to 3.

Bit Length (1-16)
Enter the Enabled Bit length of datato
be stored in the Logging Address.

Input Code
No Code
Displays positive values only.
+/-2's Complement
Uses 2's complement to express nega-
tive values.

Code +/-
Check this check box when displaying
negative values. Only available when
selecting the Dec data format.

Round Up
The decimal point numbers created dur-
ing relative value range conversion will
be rounded up or off. When thisoption
is not selected, those numbers will be
rounded off.

Input Range
Min. Value
Max. Value
Designates the range of values stored
in the Logging Address. The possible
ranges vary depending on the Input
Code Format.

Display Range
Min. Value
Max. Value
Designates the range of values dis-
played in the N-tag. The possible
ranges vary depending on the Display
Format and Code +/- settings.
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@ Size/Style

Column Settings

General Info. |[ Data Fomat]| Size/Style | Alam Setiings |

Digplay Fomat—o—
Na. of Display Digits =
Decimal |Places [0 =

=Colar Setting:

Display Celor BRI =
oo NI | e
7D{; ‘sa:m Right ] Zero Suppress Preview
£9 Shit Left
=y
{5 uto Clear OFF

123 Auto Clear ON

[ ok || Cencel | Bel

10.2 Logging

Display For mat

No. of Display Digits

Designates the number of digitsfor the
display within the range of characters
designated in the Display tab, usually
as1to 16 digits. Thelength designated
here includes digits after the decimal
point, but not the decimal point itself.
Decimal Places

Designates the number of digits dis-
played after the decimal point, usually
as0to 14 digits. Thissettingisvalid
only for Dec and BCD formats. Enter
“0” when not displaying decimal place
numbers.

Color Settings

Select the desired colors for Fg (fore-
ground), Bg (background), and BIk
(blink). When the Alarm option is se-
lected, the color attributes designated
here are used for normal display.

Display Style

Shift L eft

Shift Right

Select the display style from the Shift
Left and Shift Right. The datawill ap-
pear, starting from the side designated
here. Shift Left has been selected as
the default setting.

Zero Suppress

Check this check box to omit the lead-
ing zeros of display data. (e.g) When
the Display Length is 4 and the Zero
SuppressisNOT selected, “25” appears
as 0025.

Input Style

Auto Clear OFF

Inthismode, the previoudy entered val-
ues are not cleared and newly entered
values are added to those values. To
clear the previously entered values,
press“CLR” of the touch keyboard.

Auto Clear ON

When the first character of avalueis
entered (excluding moving the cursor,
entering ENT, DEL, and BS), the pre-
viously entered valueis cleared.
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élkv\ote: Date/Time and Value data, except for the text characters, are centered. Also,
2] aZ2dot spaceisautomatically inserted in the upper, lower, left and right sides.

2aos = | [T ] |« cel

5 dofts

For example, when the number of charactersare 7 and the number of nu-
meric value'sdigitsare5in a cell, space for one character is saved on both
left and right sides and displayed data is centered.

@ Alarm Settings
Alarm Display (On/Off)

Column Setings Select this check box to display the
Eener:a\ Info”w“w” MamSettngs | A | am dl Spl ay

e Alarm Range
Minvae 8 = Min. Value
MawVele 55 = M ax. Value

— When the Alarm Type is set to Direct,

- WEOCNEOONE [55E] designate the Alarm Range. When se-

s NEODENOCNE [Rosr] lecting Relative value display, the Dis-

play Range designated in the Data For-

meat tab isused asnormd display’sMin.

| = = and Max Values automatically. The

possible Alarm ranges varies depend-

ing on the Data Format sel ected.
Alarm Color

If the data exceeds the Alarm Range,

the Alarm display appearsin the desig-

nated colors.
<Alarm Range List>
Data Format Alarm Range
Code+/-

16Bit Dec +- -32768 to 32767
+ 0 to 65535
Hex 0 to FFFF(h)

BCD 0 to 9999
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@ Size/Style
Column Settings \ CO| or %ttl ngs
e Select the desired colors for Fg (fore-
Na. of Display Digts [ 1=
[ ——— ground), Bg (background), and Blk
= (olink).
= Colar Setting:
Display Celor fo MECICIWE CCIWE [Ho i 7]
e [ 0 O O ) ) U] o B ]
= Display Styl
(%) Shift Right I Zero Suppress Preview
O hintst
Trpoe—————————
@ Aula Clear OFF
23 o Clear ON
[ ok || Cencel | Bel

@ General Info. [Column Type: Char. Col]

Char.Col
General Info. [ Data Fomat |[Size/Style |[ Alarm Setfings Di Spl ays text

Column No. 2

Column Type {3 Value £ Date/Time {8 Char Cal!

Data Type

Display Format

Input:
Alarm Settings OFF

Display Style: Shift Left
Mo, of Display Digits
Decimal Place:

3) Row Settings (Display)
B Attribute Settings

Select either Item Name or Data row, and click on the [Settings] button to
edit each row’s attributes.

Display Settings ‘

=] [@[wle=]la])

@ General Info. [Selecting Item Name Row]

The General Info. page providesinfor-
Gensralni. [To | mation about the current settings for
Item Name Settings.

Row No. 1

Row Type

Color. Q

| 1[4 I H Cancel ||| Help
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@ Color
em 5ettings i
Gaer\n { Color } : COl or %ttlngs
cor e Select the desired colors for Fg (fore-
secktione £ IO WWOOINE ] ground), Bg (background), and Blk
s MWD WO B | (blink).

o [ cancel | Hel

‘Note: Therow color settings have priority over the column color settings.

X2

@ General Info. [Selecting Data Row]

The General Info. page provides information about the current settings for

Data settings.
Row Type
Genera o | Select the desired type of display from
onthrber 2 the Data and Char.Col. settings.
Fow Type #) Dala 1) Char. Cal.
|| Ok I H Cancel | “ Help
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4) Totals (Display)
B Attribute Settings

To set up the calculation attributes, select the Totals cell and click on the
[Settings] button.

F=] [ [es]la])
AterTim| Value | I

[y mm A

€ General Info.
The General Info. page provides information about the current settings for
Totals Settings.

ACTEETE Data Calculation Settings

General Info. | Size/Style |[ Alaim Settings |

R Mumber 3 Columin Murber 3

Select the desired calculation item from
Total, Average, Maximum, and Mini-
mum. The calculation attributes can be
set up for the entire Datarow or Value
column. At this time, the applicable
column’s attribute is Date/Time or
Char.Col., and the Data Cal cul ation Set-
tings cannot be designated. Data cal-
culation is performed viathe 32 Bit for-

Row Type Total

Data Caloulation Settings Tatal R

Alaim Settings: OFF [fverags
e 1 1,

Display Stle: Shif 1HA
Mo, of Digplay Digits: SMo. of Display Digits
Decimal Places: 0

mat.
& Szetyle
Total Setings Display For mat
prem Y ontoe No. of Display Digits
T Enter the number of display digits. The
DecnelPlaces [§_ ] numbers displayed after the decimal
o Seting point is also included. (However, the
tesiycia 2 WEIIJNECONE o F] decimal point is not included itself.)
e — Enter avaluein arange from 1 to 16.
[ — Decimal Places
@SR oo Enter the number of digitsafter the deci-
mal point inarangefrom 0to 14. This
setting is Enabled only when the Data
L I teed T 0 Format is designated as Dec or BCD.

If the values after the decimal point are
not displayed, enter “0”.
Color Settings

Select the desired colors for Fg (fore-
ground), Bg (background), and BIk
(blink). When the Alarm option is se-
lected, the color attributes designated
here are used for normal display.
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No. of data
display rows

10-56

Chapter 10 - ADVANCED FEATURES

Display Style

Shift Left

Shift Right

Select either shift type. Dataisdis-
played from the selected position. The
default setting is Shift Left.

Zero Suppress

When 0 suppression check box is
checked, all unnecessary Osare not dis-
played. When this check is removed,
Os are added to the front of numbers to
match the display length designated in
the No. of Display Digits area. (e.gQ.
When the No. of Display Digitsis4 and
0 suppression is OFF, value 25 appears
as“0025".)

B Display Settings Maximum File Size

The display settings’ file size capacity is approximately 58KB. However,
depending on the specific setting combination, the user’sfile size may
exceed this capacity. The following example is the standard display setting

Size.

* Enter the Block Name in the 1st column and then up to 8 single-byte
charactersin each column.

* Enter the Block Name in the 1st row and then up to 8 single-byte charac-
tersin each row.

* Four rows are available for totals. (Total, Average, Max., Min.)

Block Name
Data display
Data display
Data display
Data display
Total (Total)
Total (Average)

Total (Max.)

Total (Min.)

Block Name

Date

No. of value columns

Time Value  Value ------ Value

ABCDEFGH

ABCDEFGH |ABCDEFGH |ABCDEFGH ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

When using the pattern shown above, the maximum number of value col-
umns and data display rows are as follows.
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No.of Value | No.of Data
) Remarks
Columns |Display Rows

3 1007 When the No. of value columns (number of logging
words) is the maximum (32 columns).

16 1116 When the No. of value columns (number of logging
words) is the maximum (16 columns).

g 1170 When the No. of value columns (number of logging
words) is the maximum (8 columns).

A 1197 When the No. of value columns (number of logging
words) is the maximum (4 columns).

A When designating the columns as the block name display and
! entering characters in each column, the file size will become
important extremely large. Depending on the number of characters en-
tered and other items designated, approximately 1000 rows can
be used for the pattern shown above.

LT Editor Ver. 2.0 Operation Manual - Screen Creation Guide 10-57



10.2 Logging Chapter 10 - ADVANCED FEATURES

@ Print Settings ]

In this dialog box, the current Print Settings applied in the Print screen can

be viewed and edited.

For hardware printing settings, refer to LT SeriesUser’s
Manual.

D ata Logging Settings

Trigger Setlings |[Display]| Print [ “white Settings |

E Print[OM/OFF) %) Block Unit 23 Realtime Copy from Display

Raw Settings————— "CDMI‘HH Settings:

Mo, of Data Rows 2 ’V Mo. of Data Col 3
Mo of Cale. Rows 1
|| Header || Fonter || Presview |

Contral Word Address ponoon |+ Left Margin U_:‘E[

Prirt Completed Bit &ddress fin |~

Print Settings
dialog box

Print Settings ‘

] @] [ow ] [me][ ]

:DatefTJ_me Value |

e L

When using the L oop, regardless of the logging frequency, the data display
row will be designated as a single row.

@ Settings

To change row/column attributes, select the desired row or column and click
on the Edit button.

®Add

Select arow or column and click on the Add button, then one row or column
is added.

€ Copy

Copiesthe currently selected row or column data to the Clipboard.
& Paste

Pastes the copied row or column data to the desired position.
€Cut

Deletes the currently selected row(s) or column(s) are deleted.
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1) Column Settings (Print)
B Attribute Settings

To set up column attributes, select either a Ruled Line, the Date/Time, or a
String(Char.Cal.), and click on the Settings button.

Pmsems:
I Settings | EEESIEESIES

[ K MEE[Char. Col [orag[Date/Time [prog]  vall~
l Border + + | §
]Char. Col. | |
]W + R I
]W | |wwanmiog || =

l Border + + | o
K N4

@ General Info.

-1 | he General Info. page providesinforma-
Gerea . | ota ol sz | tion about the current Column Settingsin

Column No. 1

CohmnType 9 Wiis £9Date/Time 9 Char Col £ Border use.
Data Type Absolute  DO0000

Display Format Dec

Input:

Column Type
Select the desired display item from Value,
Date/Time, Char.Col. or Border.

@ General Info. [Column Type: Valug]

Value

Sore T | Bzt e When this option is selected, numeric data
Column Mo, 1 H M
Calumn Type £ Waiue ) Date/Time L3 Char. Col. £ Border IS prl nted OUt'
Data Type Absolute  DO0000
Display Farmat Dec
Input:
@ Data Format
Column Settings A bg)l ute
= Data stored in the Address displayed in the
12) Absalute 1) Relative . . i i
fodess Offset [0 E] Diata Logging Adchess [DO0N0N Loggl ng_ AddreSS areals dl reCtIy prl nted
out. Thisdatais handled as an absolute
R value.
o Lcwe-r Address Offset
£ Hex L

oo The Logging Address is changed by the
/ offset value entered here. For example,
' when the number of logging words is 4,
the offset value becomes 0 to 3.
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Display Data For mat

7 e Select the desired data format from Dec,
Address Offset LE’ Data Logging Address [D00000 HeX and BCD
Code +/-

Check this check box when printing nega-

[jcode vt tive values. Only available when select-

ing the Dec data format.
Relative
e e Data stored in the Address entered in the
e [E o rasenme T — ] !_OQQI ng Addressareais con\{erted accord-
nin 52 ing to the Input Range area's values and
i o the converted numeric datais printed out.
Heom Address Offset
The Logging Address is changed by the
R | e — offset value entered here. For example,
N [ e when the number of logging words is 4,
oo [ JE] | oo B the offset value becomes from 0 to 3.
Co [ == I = | Bit Length

Enter the Enabled Bit length of datato be
stored in the Logging Address.
Input Code For mat
No Code
Displays positive values only.
+/-2's Complement
Uses 2's complement to express negative
values.
Code +/-
Check this check box when displaying
negative values. Only available when se-
lecting the Dec data format.
Round Up
Round up displaying or printing values.
Input Range
Min. Value
Max. Value
Designate the range of values stored in the
Logging Address. The possible ranges
vary depending on the Input Code Format
settings.
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Column Settings

[General Info || Data Format | Size/Style |

20 Absalute 1) Relative

Address Difset = Data Logging Address 100000

Bit Length (1-1] =]

= nput Code:
) No Code I Code +/-
{23 +/- 25 Camplement | Round Up

=Input Rar Display Rang:
MinVaue |0 E] MinViaue |0 E]
MoxValue [F55% = MoxVahie [F55%5 =
o ceneel | B |
[GeneralInfo. || Data Fomat]|| Size/St |
Displap Fomal— ——
Na. of Display Digits E
Decimal | Places [0 E
Mo. of Char./Cal. |1 E
Display
-
{5 5hift Right | Zern Suppress e
@ Shit el

o] cancel | el

10.2 Logging

Display Range
Min. Value
Max. Value
Designate therange of valuesdisplayedin
the N-tag. The possible ranges vary de-
pending on the Display Format and Code
+/- settings.

Display For mat
No. of Display Digits
Designate the number of digitsfor thedis-
play within the range of characters desig-
nated in the Display Setting area, usualy
1to 14 digits. Thelength designated here
includes digits after the decimal point, but
not the decimal point itself.
No.of display digits=1~((No. of data
char.)-(Code+/-)-(Decimal places))
Decimal Places
Designates the number of digits displayed
after the decimal point usually as 0 to 16.
Thissetting isvalid only for Dec and BCD
formats. You can designate the value from
0to 16. Enter “0” when not displaying
decimal place numbers.
Decimal Places=0~(No.of display digits-1)
No. of Char./Col.
Designatesthe cell size. Enter avalueina
range from 1 to 32 (digits).

Display Style
Shift Right
Shift L eft
Select either shift type. Datais displayed
from the selected position. The default
setting is Shift Left.
Zero Suppress
When 0 suppression check box is checked,
all unnecessary Osarenot displayed. When
this check isremoved, Os are added to the
front of numbers to match the Display
Length. (e.g. When the No. of Display
Digitsis4 and O suppression is OFF, value
25 appears as “0025".)
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10-62

@V\ote: Date/Time and Value data, except for text data, is printed in the middle of a
21 cell. When the center point cannot be designated due to the number of
characters, text is shifted toright for one character. When designating
Char. Cal. for Column Type, datais printed being shifted left.

@ General Info. [Column Type : Date/Time]

Date/Time
Prints out Time and Date data.

Column Settings

General Info. | Data Format |[ Size/Style |

Column No. 1

Column Type £ Value ) Date/Time 40 Char. Col. 420 Border

Data Type Date

Display Farmat witnm/dd

Input.

& Data Format
Date
Prints out date data.
Tenerallnfa. || Data Foimat | Gze/aiie | )
BEEE D Tme Time

Prints out time data.
Display For mat
Select the desired time/date display format.

Display Format y/mimedd

@i}v\ote: Date/Time settings have two settings, i.e. Date settings and Time settings.
2] Timedataisprinted out only viathe 24 hour system.

* For date:
mm/dd/yy
mm/dd
yy/mm/dd
dd/mm/lyy

» For time:
hh:mm
hh:mm:ss

& Size/Style

No. of Char./Cal.

Designates the cell size. Enter avalue
GeneralInfo. || Data Famat]| Size/Styls | from 5 to 16 (d|g|ts)_

Display Fomat
[ Mo. of Char./Col =

Display Syl
9 Shiskiahe H Previev

) Shigalafy 8

|

o[ cancel H| Help
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@ General Info. [Column Type: Char. Col.]

Char. Col.
Prints out the text.

Column Settings

General Info. | Data Format |[ Size/Style |

Column No. 1

Column Type 42} Value £ Date/Time {53 {Char. Col: £ Border

Data Type

Display Foimat

Input;

¥ Size/Style
Column Seltings No. of Char./Coal.

[GeneralInfo. || Data Fomat]|| Size/St |

Disla Fomal——— Designatesthecell size. Enter avauefrom
{ Mo. of Char./Col =

5 to 16 (digits).

Display -
[ Doy H T Previsw

) Shiinlen 8

0K ||| Cancel || hHel

@ General Info. [Column Type: Border]

GeneralInfo. | Data Format | Size/Style |

Border
Prints out the borders.

Column No. 1

Colmn Type 420 Value i) Date/Time {3 Char. Col. {2 Border

Data Type

Display Format

Input;
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2) Row Settings (Print)
B Attribute Settings

To set up row attributes, select Border, String (Char. Col.), Data (Value), or
Total, and click on the Settings button.

Print Settings ‘

e H

"Viordg[Char. Col. |prdg[Date/Time |ordd]  wvall™

s/

& General Info.

o
e | | TheGeneral Info. page providesinforma-
b 1 tion about the current settings for Row
Fowe Type ) Data 20 Char. Col. 8 Horder %ttlngs
Row Type
o AT o [ & Select the desired print item from Data,

Char. Col., and Border.

e With thereal-time printing, if the Loop is not used, the header isalso
printed when thefirst item of logging data is printed. When the last item of
logging data is printed, the footer and total value(s) are printed.

@Ik‘v\ote:
2]

» With both real-time and block printing, when the L oop is not used, after
thelast item of logging data is printed, page feed is perfor med.

e The maximum number of columnsis 60 and the maximum number of rows
is4200. However, since the setting data file capacity is approximately 58K B
(maximum), the number of rowswill depend on the No. of Char. Col. to be
designated for the number of bordersand cells.

60 columns
—>

4200 rows
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2.

Note: » If the Windows system’sfont setting iseither Korean (Hangul), Taiwanese
2] or Chinese, image dataisprinted out.

* Regardless of the printer’scolor settings, all datais printed in black and
white.

e Alarm printing and screen hard copy commands are accepted even during
real-time printing. Therefore, during real-time printing, DO NOT enter
other printing commands.

« While multiplelines of data are being printed, if logging data is cleared,
data printingisinterrupted. Also, if the LT s power isturned OFF during
printing, the remaining data will not be printed out even if the LT’s power
isturned ON again.

e Theprinting format consists of thethree areas, i.e. header, main data, and
footer. Up to 160 characters can be printed per line.

lsszzzzo ST Header

Data

. - — Footer
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G,

No\t_gj: Thefollowing isan example of logging data printout. (The Loop isnot used.)

$ommmme $ommmm tommm - +
| Appr. | Check | Create |
$mmmmme T tommm- +
| | | |
| | | |
| | | |
$ommmme T tommm- +

Fommmm e Fommmm e R Fommmm e tom e +

| TME | VOLTAGE| TEMP1 | TEMPZ |PRESSURE|

Fommmm e Fommmm e T Fommmm o e +

| 09:00 | 3226 | 30.3 | 25.3 | B.1 |

| 10:00 | 3236 | 268.4 | 268.4 | 6.4 |

| 11:00 | 3244 | 286 | 276 | 6.2 |

| 12:00 | 3202 | 30.7 | 28.7 | B.5 |

| 13:00 | 3210 | 28.9 | 289.9 | 6.3 |

| 14:00 | 3219 | 29.2 | 24.0 | B.0 |

| 15:00 | 3227 | 31.1 | 2.1 | 6.3 |

| 16:00 | 323 | 27.3 | 28.3 | B.1 |

| 17:00 | 3243 | 204 | 27.4 | B.4 |

Fommmm o Fommmm e T Fommmm o e +

| TOTAL | 29044 | 2698.7 | 240.7 | 5B6.3 |

| AVERAGE| 3227 | 28.9 | 28.7 | 6.3 |

| MAX | 3244 | 31.1 | 299 | 6.5 |

| I | 3202 | 26.4 | 240 | 6.0 |

Fommmm o Fommmm e T Fommmm o e +
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When using the L oop, regardless of the logging frequency, the data display
row will be designated as a single row. Also, Char. Col., Border and Total
sections cannot be set.

Print Settings

|| Settings | || Add ||| Capy ||| Pagte ||| Cut |

Char. CD'I_.]Date/'ITiﬁ:C_har. Col.|[ value |Char. Ccﬂ_.] Value |Char. CD'I_.]

Data

<Real TimePrinting - using Loop>

| 10:00 | XXXX | XXX | XXX | XX |

| 1100 | XXXX | XXX | XXX | XX |

| 12:00 | XXXX | XXX | XXX | X.X | Prints the data
13:00 | xxxx | xxx | xxx X.X -

| 1400 | XXXX | XXX | XXX | XX | display rows only
15:00 | XXXX | XXX | XXX | XX | __ when data logging

| 16:00 XXXX XXX XX.X X.X is performed. The

| 17:00 I §§§§| XXX I XXX I XX I header, footer and

| 17:00 | X | X | X | % | other items will not

| 1200 | xxxx | Xxx | xxx | xx | be printed.

| 13:00 | XXXX | XXX | XXX | XX |

@V\ote: With real time printing, when using the L oop, the data display row will be
2] designated asasingle row.

A °* When using the Loop, only real time printing can be used.

- * When using the Loop and performing real time printing, the
Important . . .
Total section will not be printed.

 When using Loop and performing real time printing, if the
logging frequency is not very high or a printer has not yet been
connected, printing cannot be performed at the speed the log-
ging data is created, thereby causing a difference between the
two. In this case, only part of a single cycle’s logging data will
not be printed.
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No. of data
display rows

Chapter 10 - ADVANCED FEATURES

B Print Settings Maximum File Size

The print settings’ file size capacity islimited. Therefore, depending on the
specific setting, the user’sfile size may exceed this capacity. (The setting
file contains the print header, print footer and print data areas’ settings.) The
maximum number of characters that can be entered per row is 160. The
following is the standard print setting size.
* Enter the Block Name in the 1st column and then up to 8 single-byte
charactersin each column.
« Enter the Block Name in the 2nd row and then up to 8 single-byte charac-
tersin each row.
* Four rows are available for totals (Total, Average, Max., Min.)

Border
Char. Col.
Border
Data display
Data display
Data dilsplay

Data display
Border
Total (Total)

Total (Average)

Total (Max.,)
Total (Min.)
Border

Char. Col.

Date

No. of value columns

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

ABCDEFGH

When using the pattern shown above, the maximum number of value col-
umns and data display rows are as follows.

No.of Value | No.of Data
: Remarks
Columns |[Display Rows

The maximum number of characters that can be entered per

17 282 row is 160. Therefore, when 8 characters are entered for each
column, the number of value columns available will be 17.

16 205 When the No. of value columns (number of logging words) is
the maximum (16 columns).

g 489 When the No. of value columns (number of logging words) is
the maximum (8 columns).

4 683 When the No. of value columns (number of logging words) is
the maximum (4 columns).

When designating the columns as the block name display and

1 £ entering characters in each column, the file size will become

/,,,po',,a,,,extremely large. Depending on the number of characters en-
tered and other items designated, several hundreds rows can be
used for the pattern shown above.

10-68
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I his section contains alist of error messages and corrective actions, as

well as address conversion tables.

APPENdiX 1 oo Error M essages
APPENTIX 2 o Troubleshooting
AppendiXx 3 e, Address Conversion Tables
AppendiX 4 Software Trouble Report
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Appendix.1 Error Messages

m Error Messages

B Project Manager Errors
This section describes error messages that will be displayed during operation
of the LT Editor and how to solve these problems. If malfunction still occurs
after the measure is taken, describe the problem in the attached Software
Trouble Report and send it to us by facsimile.

APPENDICES

Error Message

Cause/Solution

Because of the change in PLC type, a part of
the device address used in the project may
be converted into a device address that
cannot be used with the current PLC.
Double-check all device addresses used in
the project and modify them as required.

This warning message is displayed every time an
attemptis made to change the Device/PLC type
and addresses. Double-check all device
addresses used in the projectand modify as
necessary.

Can't edit - Insufficient memory

The memory area for eding is insuficient Quit
other applicatons, then begin ediing your fle
again.

Cannot edit the files because the filing mode
[Use Multiple Folders] setting is not
selected! Click on [Use Multiple Folders].

When the fling mode setings ' [Use Muliple
Folders] was not selected, you attempted to open
2 or more kinds of fling data directy from the
Project Manager having nesting screen display
by double-clicking. Select[Use M ultiple Folders].

Cannot start up Internet browser

The browser setings are not correct or the
memory area for the browser is insufiicient
Check the setiings of the startup browser. If the
browser setings are correct, quit all other
applications and restart the browser.

Cannot read systemfile

The program file data required for setup cannotbe
opened or read, or the fle's data is not correct
The fle may be corrupt, or a disk error may have
occurred. After solving the problem, reinstall the
fle.

Cannot read the file’s system information

The project fle is corrupt Use LT Editor s
rebuilding tool to repair the fle. Afer repair is
completed, read the fle again.

Current Color Depth Not Supported
Convert to 256 colors or less

Only bit maps of 256 colors or less can be used
by tis sofware.

Destination screen number is too high.
Reduce the number of destination or source
screens

Set (Copy source end number - copy source
start number) >= (8999 - copy destination start
number).

Exceeds Data Backup Area Limit.
Please adjust your settings to fit this area’s
size limitations

The backup settings, backup area used cannot
exceed 2031. Set (Backup start address + the
number of devices) 1o less than or equal to 2031.

External Device File Type Error

The External Device table fle format is not the
same as the LT’s, or the file is corrupt. Selectan
External Device from the master disk and reinstall
the file.

Grouping Nesting Limit Reached.
Unable to group more than these objects

You are attempting to nest grouped objects more
than 10 tmes. Only 10 levels of nesting are
allowed.
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Appendix.1 Error Messages

Error Message

Cause/Solution

Internet Browser Not Selected Yet.
Please select a Browser

An Internet browser has not been selected yet.
Afeer clicking on the error message’s OK bution,
selecta browser from the dialog box that appears.

Invalid Address !

Before entering the device address, check that the
value is within the allowable range and that the
device is supported by the External Device.

Invalid External Device table

The External Device table fle format is not the
same as the LT's, or the file is corrupt for some
reason. Select an External Device from the
master disk and reinstall the fle.

Incorrect External Device Table Format

The External Device table fle format is not the
same as the LT’s, or the file is corrupt for some
reason. Select an External Device from the
master disk and reinstall the fle.

Non-LTE File

A flle has been selected that is not recognized by
LT Editor for Windows 95. Be sure to selectonly
Project (.Ite) files.

Old External Device table and some functions
may not work properly.
Please use latest table

The External Device table file from an old version
is being used. Selecta new External Device from
the master disk and reinstall it

Screen number to copy frommust be greater
than screen number to copy to.

Enter a “copy to” screen number that is greater
than the “copy from” screen number.

Selected project is the same as current
project.

You cannot copy data within the same project file.
Be sure to specify a project fle other than the
current project file.

Specified address is not used for screen
properties that can be displayed.

When opening the screen via the Global Cross
Reference List, designate an address within the
valid range of screen addresses.

Systemerror

The program file data required for setup cannotbe
opened and read, or the fle's data is not correct
The fle may be corrupt, or a disk error may have
occurred. Afer solving the problem, reinstall the
file.

Systemfile is corrupt

The program file data required for setup cannotbe
opened and read, or the fle's data is not correct
The fle may be corrupt, or a disk error may have
occurred. Afer solving the problem, reinstall the
file.

System open error

The program file data required for setup cannotbe
opened and read, or the fle's data is not correct
The file may be corrupt, or a disk error may have
occurred. After solving the problem, reinstall the
file.

System write error

The program file data required for setup cannotbe
opened and read, or the fle's data is not correct
The fle may be corrupt, or a disk error may have
occurred. After solving the problem, reinstall the
file.
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APPENDICES

Error Message

Cause/Solution

Unable to convert file. Please check disk.

The destination disk does not have sufiicient free
space. Prepare a disk that has sufiicient space
and re-ry.

Unable to read current project information

The projectfie is corrupt Use the LT Editor
rebuilding tool to repair the fle, and then read the
file again.

Unrecognizable Bitmap
File may be corrupted

The selected bit map fle is either corrupted or
unusable by this sofware.

B Screen Editor Errors

Error Message

Cause/Solution

Can't edit - Insufficient memory

The memory area is insufficient for ediing. Quit all
other applications and resume editing.

Can’t open more than 20 screens

The screen editor can have up to 20 screens
open at one time.

Cannot place screen on itself

You cannot call the screen being edited.

Change request will exceed maximum
number of Parts. Changes canceled

This change will exceed the Parts upper limit

Current Color Depth Not Supported.
Convert to 256 colors or less

Only bit maps created with 256 colors or less can
be used in this system.

Device address out of range

When the specified command is performed, the
device address exceeds the upper limit Specify
an address within the allowable range.

Exceeded maximum screen size. Changes
canceled

This change will exceed the screen size upper
limit.

1.5 Screen Editor

Exceeds alarm limit

Only one alarm can be used on a single screen.

Exceeds keypad limit

Only one keypad screen can be called to a Base
screen.

Exceeds time display limit

Only one tme display can be used on a single
screen.

Exceeds screen size limit

The screen size exceeds the upper limit, and you
cannot create any more graphic data. The last
data created will become invalid. Store the screen
data, and then open a new screen and call the
stored screen using [Load Screen] in the [Draw]
menu.

Exceeds Part Library limit.

If the number of Part Libraries used exceeds the
limit, Part Library data cannot be transferred to the
LT. Reduce the number of Part Libraries.

21 Pars m  Maximum
Number of Automatcally Created Part Libraries

Filing displays with the same ID No. cannot
be placed on a screen if [Cursor Position
Control] is selected.

M ultiple fiing displays with the same ID No. with
[Cursor Posiion Control] selected cannot be
placed on one screen. Either deselect [Cursor
Position Control] or change each fling display’ ID
No. so that the ID Nos. do not overlap.
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B Screen Editor Errors(from previous page)

Error Message

Cause/Solution

Grouping Nesting Limit Reached.
Unable to group more than these objects

You are attempting to nest grouped objects more
than 10 tmes. Only 10 levels of nesing are
allowed.

Invalid Screen (Number)

The eflective screen number is witin the range
from 1 t0 8999. Re-enter the screen number.

Logging Display and Keypad Input Display
cannot be placed on a screen
simultaneously.

Check whether a Logging display or Keypad Input
Display has already been placed on the screen.

Parts are not valid objects.

A library item containing Parts cannot be used in
a Picture Display.

Screen No. is out of range. Re-enter a
different Screen No.

Screen No. used after conversion is out of the
Screen No. range. Enter the correct number.

File write error

This file cannot be written to the destination media.
Please check the designated drive name and
directory.

The sumtotal of all the data saved by the LT’
s data backup features now exceeds the
backup memory unit’s limit. Please reduce
this amount.

The backup size exceeds the SRAM capacty.
Reduce the number of sampling data, or set this
ittm’s backup seting to “None”.

The area available for data sampling has been
exceeded.
Please re-enter this item’s settings.

The storage address used exceeds 2031. Set
(Storage start address + the number of sampling
data) to less than or equal to 2031.

The amount entered for the data sampling
feature is combined with the number of
Trend graph channels created, and their
combined total cannot exceed 20.

When 20 channels are preset, the Add bution is
clicked in the data sampling seting list display
dialog box. Delete unnecessary setings so that
the total of Trend Graph channel setings and the
data sampling setings will be within 20.

There are no screens created for this screen
type.

The screen that you atempt to open cannot be
created with the specified screen type. Open a
new screen.

The designated screen does not exist.

The screen that you attempted to open cannotbe
found in this project Select a screen from difierent
existing project

This object has a non-black background and
may not display properly on the LT. Also, be
sure that your loaded screen’s center point is
aligned with the object (loaded to) screen’s
center point.

If this screen is used as the screen for the
background color, be sure to align its center point
correctly with the destination screen.

Unrecognizable Bitmap
File may be corrupted

The selected bit map fie is either corrupted or
unusable by this software.
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APPENDICES

B Library Item Placement / Save Errors

Error Message

Cause/Solution

Grouping Nesting Limit Reached.
Unable to group more than these objects

You are attempting to nest grouped objects more
than 10 times. Only 10 levels of nesting are
allowed.

Not a library file

The library fle selected in the library browser
cannot be used in this system. Select a fle with a
CPW extension.

Out of memory Memory is not sufficient to execute the operation.
Quit other applications, re-allocate memory, and
then restart the operation.

Systemerror An error occurs when the library fle is being

stored. Reserve sufficient free disk space and
restart the operation.

Unable to convert memory block into cell

The memory is not suficient to execute the
operation. Quit other applicatons, re-allocate
memory, and then restart the operation.

Unable to create cell list

The library flle is corrupt for some reason. Use
the provided rebuilding tool to repair the file and
then restart the list creation.

B D-Script Errors

Error Message

Cause/Solution

Constant value out of range:

The preset constant value exceeds the specified
range. Enter a correctvalue.*

D-Script function name has not been
entered.

Please type the function’s name in the
description field.

Do not click OK without entering the function
name; you must first specify the function name.
Enter the funcion name.

Expression too complex.
See HELP screens for assistance.

Simplify the D-Script expression.

if ' expression requires a non-empty

An expression is required in{ } in the if clause. If

statement no expression is specified, the if clause is
ignored.*

Illegal Expression The entered expression contains an error and will
not be recognized.*

lllegal syntax

The entered D-Script expression has a syniax
error.

Illegal address

The entered address seting contains an error.
Enable the syntax help in the option seting menu
and enter the address by clicking the icon, or
enter it rom the keypad.

Negative numbers not supported - select
correct data type

A negative number cannot be used as a constant
Enter a positive number.*

This script expression is not legal (it will not
download). Do you still want to register this
data and quit the D-Script editor?

The preset D-Script expression has an error.
Even if this scriptis registered, the operation will
be not performed.

WARNING: Statement has no effect and has
been removed

The entered instruction is ignored because it will
notinfluence the expression.

Appendix -6

*  These messages are displayed only when the syntax check in the option

setting menu is selected.
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B Alarm Editor Errors

Appendix.1 Error Messages

Error Message

Cause/Solution

Can’t Add Messages - Insufficient memory

Memory is not suficient to add the messages. Quit
other applications, re-allocate memory and try to
add the messages again.

Can’t import more alarm message/summary.
Alarm message/summary limit has been
reached.

During message import the number of alarm
message/summary has exceeded the designated
limit Delete the messages currently set and adjust
the seting range so that the messages to be
imported can be stored.

Data in Blocks 2 and 3 cannot be uploaded to
the LT.

Since the “Block” feature was turned OFF when
this data was downloaded, please delete Blocks 2
and 3.

Low Memory - not all messages can be
pasted!

Memory is not sufiicient to paste all the messages.
Quit other applications, re-allocate memory and
paste the messages again.

Low Memory - not all alarms were copied!
Try copying a smaller group.

Memory is not sufficient to paste all the messages.
Quit other applications, re-allocate memory and
paste the messages again.

Not enough memory to perform undo!
Do you want to continue?

Memory is not sufficientto undo the messages. The
deleted message(s) cannot be undone (restored).

Not all alarms were saved.
Insufficient disk space

Disk capacity is not enough to store the data.
Create more free disk space and store the data
again.

Not all alarms were read.
Insufficient memory

Memory is not suficient to read the alarm
messages. Quit other applications, create more
memory and read in the alarms again.

Some data is incorrect and all data cannot be
imported.

The format of CSV data to be imported is
incorrect Dafa in and below the line with the
incorrect data will not be imported. Check Alarm
data’s CSV format.
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B Symbol Editor Errors

APPENDICES

Error Message

Cause/Solution

A

Addresses cannot be used as symbol names!

Enter a standard address in the address column.

D

Disk space is insufficient.

The disk in which the data is stored has no free
space. Create more free space and try again.

This Symbol Name is already in use.
Please choose another name.

A symbol of the same name has already been
defined. Rename the symbol.

This is not a symbol file. Please choose the
correct format file.

The chosen fle is not a fle that can be used for
symbol import Please choose a fle that is this
format, or modify the chosen fle so that it
becomes this format

This is not a device comment file. Please
choose the correct format file.

The chosen file is not a device comment import
fle. Please choose a file that is this format, or
modify the chosen fle so that it becomes this
format

This symbol name is already registered as a
Logic symbol. Please choose another name.

You atempted to change an existng symbol
name. Be sure that your symbol name used is
not one of those designated in the Word Symbol
area’s Logic Word or Real areas.

The total number of Logic symbols is over
2048 and a Save cannot be performed. Please
delete all unneeded symbols.

The maximum number of symbols has been
exceeded. Afer deleng unneeded symbols,
please retry saving the data.

Some data is incorrect and all data cannot be
imported.

The format of CSV data to be imported is
incorrect. Data in and below the line with the
incorrect data will not be imported. Check Alarm
data’ CSV format

Symbol *** ‘s number of characters is over
20, and cannot be imported.

You attempted to import a symbol with a name
over 20 characters long. Please reduce this
name 1 less than 20 characters.

%

%s cannot be found, or cannot be performed.

The fle(s) required to perform this action cannot
be found. Please re-install the application sofware.

B Screen Transfer Errors

Error Message

Cause/Solution

A different Extended Program is present in
the LT. The LT’s setup cannot be performed.

This extended program can only be sentto a LT
containing the same program. Please change the
LT type, or install the extended task's program in
the LT.

A different Extended Program is present in
the LT. Do you wish to continue?

A differenttype of Extended Program is presentin
the LT. Press OK to overwrite this program, or
Cancel to stop the transfer. Selecng OK will
change the LT's internal Extended Program.

Cannot transmit data at 115.2Kbps - used a
slower speed. Change Data Transfer Speed
to 38400 when sending data.

This error occurs when the speed of 115.2Kbps
cannot be used. Change the Dafa Transfer Speed
setiing to 38400 and re-try.
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B Screen Transfer Errors (from previous page)

Error Message

Cause/Solution

Command Parameter ERROR

Retry data transfer to the designated LT using
“Auto Setup”. If this message appears again, the
PC has a command-related problem. Or, there
may be an error in the cable or inthe PC. Check
both and retry data transfer. If the problem
persists, the cable may be damaged. If
necessary, contactyour local LT distributor.

Connected Device is not correct LT!

A device other than the LT or one that is not
supported by LT Editor is connected. Check the
model of the connected device.

Core - ID Command failed

An error has occurred during data transfer from
the PC. The cable may be disconnected or the LT
is OFF. Retry data transfer.

Data Transfer Port initialization error.

Inifalization of the communication port has failed.
Check the transfer serial port setings and transfer
cable connection.

Do you want to download the simulation
protocol?

When you wantto transfer the simulation protocol,
click OK. Otherwise, click cancel.

ERROR, Out of Memory

The LT 's internal memory is ful. Delete any
unnecessary Screens.

ERROR, Incomplete Transmission

Screen transfer to the LT has been aborted. Refer
to the error message code.

ERROR, No Configuration File

The file required for setup was not found in the
specified folder. Re-install the system from the
Master disk, or check the transfer path setiings.
(Transfer Setings area)

ERROR, Cannot Transfer Data

A communication error has occurred and transfer
has failed. Reset the LT and PC and retry data
transfer.

ERROR, Cannot open Screen

The system is trying to transfer the screen to the
LT but cannot open the Project File.

Handshaking ERROR - LT not
Responding

The LT power supply is turned OFF, the data
cable is unplugged, or te LT may be in
OFFLINE mode. Check all these points. When
the LT main unitis in OFFLINE mode, reset it to
transfer mode. Also, check the serial port

Invalid address substituted for unknown
aliases, or invalid address error

When using a symbol in the device address, use
the symbol edior to enter te actial symbol
addresses.
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APPENDICES

B Screen Transfer Errors (from previous page)

Error Message

Cause/Solution

Network Connection Failed

Connection to the specified party node is failed.
Check the PC network setings and the network
cable connecton. If the problem stil remains,
contact the network manager.

No Upload Information in LT Data File

Because the LT does not have the data required
for sending the data to the PC, the PC cannot
receive the screen. The screen originally may
have been sent with the upload information set to
“Not transfer”. A screen that is not sent together
with the upload information cannot be received.

PGO command failed
PLD command failed

The power supply to the LT may have been
turned OFF, or the cable has been un-plugged.
Resetthe LT and the PC and refry data transfer.

Protocol file not found

The External Device protocol fle to be sent to the
LT is not found in the system’s directory. Re-
install the LT's system staring from the master
disk.

Send SIO Error - Unable To Open a Com Port

The COM port cannot be used. In the transfer
seting menu’ s serial port seting, specify the
available serial port, and retry data ransfer.

Send File Error - Bad File Data

The data to be sent is not correct The data
created in the temporary fle cannot be read
correctly. Check that the disk has sufficient free
space and itis not corrupt, and retry fle ransfer.

Simulation data file cannot be found.

The CSV file is not stored in the directory as the
executon fle. The simulation information file may
be deleted, or the fle may have not been created.
Set the simulation feature when transferring the
screen and retry data transfer.

Simulation data file read-in error.

The CSV file cannot be read into the system. The
simulation information fle may have been deleted,
or the fle may have not been created. Set the
simulation feature when transferring the screen
and retry data transfer.
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B Screen Transfer Errors (from previous page)

Error Message

Cause/Solution

The Extended Program cannot be found.

The Extended Program required for setting up the
LT cannot be found. Please check the CFG file's
directory. Also, you may need to change the LT’s

ype.

The Extended Program cannot be found in
the LT. The LT’s Setup cannot be performed.

Unable 1o locate the program’s destinafion LT for
setup. Check the LT type settings and the LT type
selected. Change the LT type, if needed.

The currently selected Device/PLC does not
support the Simulation feature.

The currenty selected Device/PLC does not
supportthe Simulation feature. This feature cannot
be used with the destnaton LT. Deselect this
feature and re-send the data.

This LT does not support Extended
Programs. The LT ' s setup cannot be
performed.

The destination LT does not support Extended
Features. Either change the LT Type, or send
data thatis designed for the designated LT type.

Timeout Error

Communication tmeout has occurred. Reset the
LT and re-try data transfer.

Write Error

An error has occurred while reading the data to
LT internal memory. Re-try data transfer. If the
error occurs again, use the LT's self-diagnosis
feature and identfy the problem. If necessary,
contactyour local LT distributor.

B Project Compression and Execution Errors

Error Message

Cause/Solution

Disk Error - File Error During Read

The fle cannot be opened. The most probable
cause is corruption of the file or disk failure. Solve
the problem and try again to read the fle.

Disk Error - File Error During Write

The disk is write-protected. Take off the write
protection. This error also occurs when the disk is
defectve.

Unable to open file “***,
Would you like to try to find it elsewhere?

A portion of the fle cannot be found. To recover
divided files and recreate the original project file, all
the divided fles are required.

Unable to open file * ** ' for reading,
aborting...

The fle cannot be opened. The fle is corrupt or
the disk has a problem. Afer correcting the
problem, re-try opening the file.

* The file named is inserted here ***,

B Rebuild Tool Errors

Error Message

Cause/Solution

File version does not match

The specified fle contains setings for a version
which is not supported by this rebuilding tool. Re-
specify a projectfie (LTE fie).

Rebuilding the File has Failed

Recovery of the fle has failed. This fle is
damaged and cannot be rebuilt

LTE header is destroyed

The fle header information is corrupt This fie
cannot be rebuiltand cannot be used.
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B DXF File Conversion Errors
The error messages generated during DXF file conversion are as follows:
(xynn) <message> (line = 77?7?)

X: Conversion direction (1: DXF - LT/ 2: LT - DXF)
y: Procedure (1: Read 2: Conversion 3: Write)
nn: Error code

(line=7????) : Line No. of the DXF file causing the error

B DXF FileConversion Errors

Error
Code Error Message Cause/Solution

01 [Length Overin 1record (line, ???7?) The single record length of the DXF file exceeds
256 characters. Edit the error line so that the
length is less than 256 characters.
02 |DXF Format Error (line, ????) Non-DXF data may be included. Correct the
format of the data at the error line.
03 [HEADER SECTION Not Found The header section of the DXF fle to be read is
not found. Add the header section.
04 |$LIMMIN Not Found The header section of the DXF file to be read does
not have a $LIMMIN seting. Setthe option DXF
size 1o “Use $EXTMIN, SEXTMAX " and re-
execute the program, or add the $LIMMIN
seting.
05 |$LIMMAX Not Found The header section of the DXF file to be read does
not have a $LIMMAX setting. Setthe option DXF
size 1o “Use $EXTMIN, SEXTMAX " and re-
execute the program, or add the $SLIMMAX
seting.
06 [$EXTMIN Not Found The header section of the DXF fie to be read does
not have a $EXTMIN seting. Set the option DXF
size o “Use $LIMMIN, SLIMMAX" and re-
execute the program, or add the $EXTMIN
setting.
07 [$EXTMAX Not Found The header section of the DXF fie to be read does
nothave a SEXTMAX setting. Setthe option DXF
size o “Use $LIMMIN, SLIMMAX" and re-
execute the program, or add the SEXTMAX
setting.
08 |EOF Not Found The EOF record is not specified at the end of the
DXF fle to be read. Add the EOF record.
OA |ENDSEC Not Found The ENDSEC record is not specified atthe end of
the DXF fle to be read. Add the ENDSEC record.
0B |ENDTAB Not Found (line, ????) The ENDTAB record is not specified atthe end of
the TABLE section of the DXF fle to be read. Add
the ENDTAB record.
0C [(W) SEQEND Not Found (line, ????) SEQEND to be used as a pair with VERTEX
following the POLYLINE entty is not specified.
Add the SEQEND record to the error line.
0D [Insufficient Data (line, ???7?) The essential data for the element of each entity is
insufficient Add the required data to the error line.
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B DXF File Conversion Error S(from previous page)

Error
Code

Error Message

Cause/Solution

OE

LTYPE Not Defined (line, ???27?)

The line type name specified when the ently line
type is individually set is not defined in the TABLE
section. Add the data of the presetline name to the
TABLE section.

OF

LAYER Not Defined (line, ???7?)

The layer name setin the entity is not defined in
the TABLE section. Add the preset layer name to
the TABLE section.

10

STYLE Not Defined (line, ???27?)

The character style name used in the entity is not
defined in the TABLE section. Add the character
style name to be used to the TABLE secfon.

11

BLOCKS Not Defined (line, ????)

The composite picture name which is referenced
by the INSERT and DIMENSION enties is not
defined in the BLOCK section. Add the data of the
preset composite picture name to the BLOCK
section.

21

Application Error

An unexpected data case is found in the
intermediate fle. (This does not occur normally.)
The temporary fle created during conversion
may not have been writen. Check the free disk
space and disk condition and refry conversion.

22

BLOCKS Not Found

The specified composite picture is not found when
converting the INSERT and DIMENSION entes.
Add the preset composite picture data to the
BLOCK section.

23

(W) BLOCKS - Over Nesting Limit

The reference layers of the composite picture are
more than 10 layers. A compound graphic with
more than 10 layers cannot be converted. Correct
the graphic data so that the number of layers wil
be 10 or less.

24

(W) Conversion Data is Over 16 Kbytes

The output LT screen size (afier conversion)
exceeds 16 K bytes. The subsequent data cannot
be converted.

41

Format Error

The format of the LT data is not correct LT data
which is not supported may be involved, or the
screen data is corrupt Use the Editor to save the
screen again and retry conversion.

42

(W) Check Sum Error

The checksum of the LT screen read is not
correct. The data may be corrupt Use the Editor
to save the screen again and refry conversion.

43

(W) Library Screen Not Found ????

The screen being called is notfound in the project
Create a destination screen or delete the data
which calls the screen.

44

(W) Mark Screen Not Found ????

The mark screen being called is not found in the
project Create the destnaon mark screen or
delete the data which calls the mark.
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B DXF File Conversion Error s(from previous page)

Error
Code
45  |(W) Library Screen Type Error (0x???7?) The type of the screen used in the screen call
menu is not a base, mark, image, or a window
screen. LT data which is not supported may be
involved, or the screen data may be corrupt Use
the Editor to save the screen again and retry
conversion.
46 |(W) Screens - Over Nesting Limit The screen calling layers are greater than 10.
Screens with more than 10 layers cannot be
converted. Correct the data so that the number of
layers will be 10 screens or less.
81 |Disk Full When wriing the temporary file or output file, the
disk has become full. Increase the amount of free
disk space for the temporary fle and output file.
82 |Insufficient Memory The process is interrupted because of insufficient
memory area during operation. Close all other
applications and retry the operation.
FF |User Abort The user has interrupted the operation during
conversion.

Error Message Cause/Solution

B File Management Errors

Error Message Cause/Solution

C |Cannot Write File ???? The data cannot be writen to the specified output
fle name. Check the amount of free disk, or ifthe
disk is write-protected.

Input File Name Format Error The specified input fle name is different from the
fle name created by the editor. Specify the correct
file name.

Input File Not Found The specified input file is not found. Check the file
name and specify the existing file.

O  |Output File Name Format Error The specified output fle name cannot be
recognized by the editor. Specify the correct file
name.

W |Work Directory Not Found ??7?? The folder in which the temporary file is created is
not found. Specify the existing folder using the
environmentvariable TEMP.
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B Simulation Errors

Appendix.1 Error Messages

Error Message

Cause/Solution

Cannot read data in project file.

The screen data cannot be read from the project
file. Quit other functions and re-execute.

Cannot write simulation information data.
Unable to start simulation.

The system cannot write the data to the simulation
information fle. Check that the simulaton fle
(TAGDATA.CSV) is not used in other
applicafions and that the directory in which EXE
exists is not write-protected.

Not enough memory. Please close other
applications.

Rety this acton after closing other active
applicaions.

External Device Data File cannot be found.

The External Device table file does not exist in the
specified directory. The External Device table file
is deleted or itis not for the LT. Select the External
Device file from the master disk and reinstall the
file.

Simulation start failed.

The LT does not respond to the simulation start
command. The LT may be in another mode, or
dala transfer may have failed. Check the
communication port setings, cable connections,
LT unit power supply, and then retry the simulation
data ransfer.

Simulation data file cannot be found.

The simulation information fle (TAGDATA.CSV)
does not exist in the specified directory. Check
(turn on) the Transfer menu [Setings] area’s
[Simulation] selection, then retry the Simulation.

W Filing DataErrors

Error Message

Cause/Solution

Cannot import CSV file. Data is out of range
or format is incorrect.

The number of blocks or data amounts is
inappropriate in the CSV file to be imported. Enter
the correct value(s).

Data is larger than designated data range.
Please check the data settings.

Data from outside the Filing Data’s range is
present Check the designated data range settings
and change them if necessary.

Exceeds folder addition limit.

Up to 64 folders can be stored in the internal
memory and up to 8999 folders can be stored in
the CF card. Any folder cannot be added because
the number of folders will exceed the limit

Internal memory is not sufficient to save data.
Please reduce the block or data settings.

The current setings will overfow the LT ' s
memory. Please reduce either the block or data
setings.

Please enter a Block name.

Nothing has been entered for the Filing Data’s
Block data. Please enter a name.

The currently selected data range exceeds
the maximum amount allowed. Paste cannot
be performed.

Please reduce either the amount of data copied or
the number of blocks copied.

When using 32 bit data settings the
maximum number of data items is 20. OK to
delete items over 20?

When using 16 bit data, up to 40 ittms can be
used; with 32 bits, maximum is 20. Be sure the
data type fits your data needs.
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W L ogging Data Errors

APPENDICES

Error Message

Cause/Solution

Address Entry limit reached. No more
addresses can be entered.

Reduce the number of device addresses used.

Character size is too large. Please use a
different size.

Designated character is larger than LT 's
character matrix. Please selecta smaller size.

Display file data size is over maximum.

Reduce the size of the designated display.

Paste failed.

The current paste setiings (range, efc.) are notthe
same as the paste destinaton. Or, the paste
action may delete a column or effect another data
item’s setings.

Printer file data size is over.

Reduce the size of the area/amount of data to be
printed.

Time settings cannot exceed 24 hours. Please
adjust the settings.

Change the setings so that the tme value is 24
hours or less.

The no. of times x no. of blocks should be
less than or equal to 2048.

Be sure the number of times and number off
blocks produces a result thatis 2048 or less.
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Appendix 2 - Troubleshooting

m Troubleshooting

This section describes how to solve problems generated when using LT

Editor.

Before you begin troubleshooting, please check the following items again. If
you answer “Yes’ to all the questions, start troubleshooting. If you answer
“No” to any one of the questions, set the required item and then start
troubleshooting.

If the error still occurs after troubleshooting, fill the details of the error in
the provided trouble report sheet and follow the directions stated in Appen-

dix 4.

Item Check

Is your personal computer's OS Windows 95/98/Me/NT4.0/2000 or XP?

Is the memory capacity greater than 32 Mbytes?

Is your PC hard disk’s amount of free space sufficient?

Error

Cause/Solution

LT Editor
will not start up

Are all the environment setings correct?
LT Editor CD Jacket

Is your personal computer hard disk's free space amount sufficient?

Double-click on the Windows icon. Double-click on the drive in which LT Editor has been
installed. Use the [File] menu’s [Property] feature to check the amount of free disk space. If
the free disk space is insufficient, empty the trash box or delete unnecessary files from the
hard disk.

Is the PC's RAM memory capacity sufficient?

Memory of 16 M byte or more is required.

Click the Windows 95 [Starf] bution first, and then click on the [Setings], [Control Panel],
and [System] selections. Click the virtual memory bution in the system property dialog box
and check that “Auto Setting (recommended)” is selected. If“M anual Setting” is selected,
change the setting to “Auto Seting (recommended)”. Restartthe PC and then restart LT
Editor.

Some applications do notwork well with LT Editor and such an application may interfere
with the startup of LT Editor.

Quitall running applications and delete them from the Startup menu ([Startup] in the
Windows 95 [Program] menu. Restart the PC and then restart LT Editor.

Do the trigger commands (Config.sys, Autoexec.bat, etc.) operate correcty?

Restartthe PC. Press [F8] when “Starting windows” appears. When the menu appears,
select “Step-by-step Confrmation” to check that the commands all operate normally. Ifan
error message appears, correct the error. For details, refer to the PC's operation manual.
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Error

Cause/Solution

Cannot draw
graphic data

Is the LT Editor's screen open?

With LT Editor, you must select the project file and open a drawing screen before you can
draw any objects. Create a new a screen or open an existing one.

Does the disk have enough free space?
Prepare a disk which has enough free space.

Is the symbol editor started?
The screen editor and the symbol editor cannot be started at the same time. Check that the
symbol editor window has been closed.

Cannot save the
screen file’s data

Is the file write-protected?
Check whether the floppy disk is write-protected using the [Property] feature.

Does the disk you are saving to have enough free space?
Prepare a disk which has enough free space.

Cannot
communicate
between the PC and
the LT

Is the proper cable being used?
Be sure 1o use the DIGITAL transfer cable (option).

Is the LT in the “Screen Data Transfer Mode” or “Run Mode”"?
If not, communications between the PC and the LT will not be possible.
LogiTouch Series User Manual

When receiving data from the LT, does your PC’s hard disk have enough space?
Prepare the disk so that it has enough free space.

Is the communication port setting correct?
Check that the transfer cable’s serial port matches the port setin [Transfer].

Does another applicaiion use the same communication port?
Check whether there is competition between the LT and a modem, or other applications
which require the communication port

If:the Buzzer won't
stop. The LTwon't
display data. Data
transfer fails.

The Data Transfer cable may be loose or connected to the wrong COM port Also, the
System Data area may be incorrectly accessed, or the LT may be incorrectly setup. For
details, see the next page's Appendix 2.2.

The printer does
not run/ hard copy
is not printed

Is the OS's (Windows) printer seting correct?
Check the printer seting using the Control Panel's printer property.

The desired
External Device and
LT type are not
listed when
creating a new
project

Did you select the required External Device and LT type when installing LT Editor?
(Custom Installation)

When customizing the system installation, you can select the External Device and the LT
types. You cannotinstall an External Device or a LT type ifit has not been selected
previously. Re-install the system with the desired External Device and LT type.

Simulation cannot
be performed

Possible causes are that LS area data is being backed up to the LT, via the [System
Setup], or thatan LS area Special Relay is being used by D-Script start up bit. If any of
these are true, the simulation cannot be performed. Deselect the [Option] menu - [Settings]
- [LS Device Simulaton].
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m Buzzer will not Stop/No Display on the LT/Transfer Disabled ]

B Error Pattern by Symptom

PE[’Iern Buzzer Sound (Symptom) Scl;;en Probable Cause
Pip, pip, pip, ... Blank There is no startup program or the startup
1 (Continues 1o beep intermitiently or (Black) program has been corrupted.(When the LT is
beeps every second.) powered on)
Normal |Transfer cable was removed.
2 None

Display |Improper COM portwas used.
The system for the target model has notbeen

3 None (:::zt) downloaded.
(When the LT is powered on)
4 None Blank/ |Invalid access is made to "+9" or "+14" of the
Buzzer sounds continuously Normal [System Data Area.

Refer to Solution 1 when error pattern 1 is observed.

Similarly, Solution 2 corresponds to Error Pattern 2.

When error pattern 3 is observed, try the procedure described in Solution 3.
If Solution 1 or 2 does not solve the problem with error patterns 1 and 2, try
Solution 3 aswell.

Refer to Solution 4 when error pattern 4 is observed.

& Solution 1
1. Transfer from the PC

Transfer programs and screen data from the PC (LT Editor) to the LT
while the buzzer of the LT sounds. (Be sure that your PC and the transfer
cable are able to transfer programs and datato the LT.) LT Editor has
been programed to handle avariety of problems and retry data transfer
repeatedly if the LT failsto respond successfully. In thiscase, LT Editor
will try repeatedly to complete handshake mode (it may take more than a
minute in some situations). After handshaking is completed, LT Editor
will begin to transfer the Memory Loader program, system program,
communication protocol program, expansion program and screen data.

& Solution 2

Thetransfer cable isimproperly connected or has been removed. The
improper COM port may have been selected. Confirm that the cable and
port are set up properly for data transfer and try again.
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& Solution 3

If error pattern 3, 4 or 5 has been observed, or Solution 1 or 2 does not solve
the problem, perform aforced transfer from your PC. Perform the transfer
even if the buzzer is sounding. (Confirm that the cable and PC are config-
ured for successful transfers.)

1. Select [Setup] from the [ Setup] menu on the [ Screen Transfer] to display
the [ Transfer Settings] dialog box on the screen.

2. Select "Force System Setup” from the " Setup” field and click the [OK]

button.
Transfer Settings
=Send Information: Communications Port
Upload Infarmation COM1 |7'
g System Screen Baud Rate |[115.2K 1l ibps)
Cantral Data Reetry Count n

= Transfer Method
20 Send All Screens

%) Autarnaticaly Send Changed Screens
70 Send User Selected Screens

Usge Extended Program ;
g Sirnulation

Setup CFG file
%) English

i) Japanese
£9 Selection  [CAPROGRAM FILES\PROFACENLT sprotocal | [ Bawss.., |

|| ak. | || Cancel | || Help |

3. Select [Screen Transfer] from the [ Transfer] menu and perform aforced
transfer.

4. When the message "No System Program on the LT" is displayed on the
screen, click the [OK] button.
This message will not be displayed if the protocol has not been down-
loaded to the LT.

Force System Program Download

Send Systern o LT?

Cancel
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5. The message " Select Type" is displayed on the screen. Select the model
type and click the [OK] button.

Usually, the system automatically selects the connected model. However,
confirm the model type of the connected LT.

Select Type

k. Caricel

If an improper model type is selected here before a forced trans-
fer, the symptoms will recur.

Important

6. Check the LT type and click the [OK] button. The system begins transfer-
ring the System Program, Protocol Program and screen data.
The restoration is completed when the transfer is completed successfully.
In some cases, the "handshaking" (transfer to the LT unit) with the LT may
not be successful.
If handshaking is unsuccessful, the system displays the following message
on the screen to ensure successful handshaking with the LT.

LT not Rezponding |

Please turm aon LT

To re-establish communication

Power the LT OFF and ON again. The system will automatically resume the
transfer.

& Solution 4

Check whether an incorrect value has been entered into the LT in "+9" or

"+14" of the System Data Area, or an invalid Start Address has been as-
signed for the System Data Area.
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m Address Conversion Tables

Addresses can or cannot be converted depending on the address combina-
tion. The combinations which cannot be converted vary with the external
device manufacturers. See the following address global conversion table to
convert the addresses correctly.

B How to Read thetable

The symbols used in the table have the following meanings:

Q : When the address conversion device typeis set to [Word], the

system converts both Word and bit devices. When the [Bit] setting
isused, only bit device addresses are changed.

€ : Whenthe sdlected conversion mode is[Word], only Word ad

dresses are converted. Selecting [Bit] will convert only bit addresses.
% : When [Word] mode is selected, the system converts only word
addresses.
B @ When [Bit] modeis selected, the system converts only bit
addresses.
(Blanks cannot be converted)
For the timers and counters, the bit indicates the contact or coil used, and
the word indicates the current value (elapsed value) or setting value

B Address Conversion TableList
Memory link SIO Type

After
conversion
LS
Before
) LS System Area
conversion y O

B Mitsubishi Electric FREQROL Series

After Conversion
All devices except
P for parameter LS
Parameter except
for FR-S500, O Q Q Q
E500's Pr-37
s
2 P Q Q Q Q
>
[
S |Parameter for FR-
(&)
g S500, E500's Pr-37 O O O O
‘@ |All devices except
- for parameter O O Q O
LS
System Area O Q O Q
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B Yokogawa Electric FACTORY ACE

After Conversion
XIY|IT|EIM|IL|T]|C]|TP|CP|TS|CS[D|B|R | Z|W|LS
X olo|o|olo|o|n|m| x| x| x| x|o|o|olo|o]o
Input Relay
Y olo|o|olo|o|n|m| x| x| x| x|o|o|olo|o]o
Output Relay
! olololo|o|o|n|m| x| x| x| x|o|o|olo]|o|o
Internal Relay
E olololo|o|o|m|m| x| x| x| x|o|o|o|0|0]0
Common Relay
M olololo|o|o|m|m| x| x| x| x|o|ololo|o|o
Special Relay
b olololo|o|o|m|m| x| x| x| x|o|ololo|o|o
Link Relay
_T E(m|E|E(E(m|EE H(E|E|E|EE
Timer (contact)
c ¢ E(m|m|m(m(m|mm H(m|m|m|E
© | Counter (contact)
%]
sl P x| %] x| x| x| x x| x| *| *x|o|o|o|o|o|o
2| Timer (current)
o
© cP *o| x| % | K| x| * x| x| x| *|0o|o|o|lo|0|0
= Counter (current)
of 0TS x| x| x| x| x| *x| x| x| x|o|o|o|o|olo
Timer (setup)
CS | k| k| K| K| Kk * [ Kh|[*|[ XOQ[O[O[O|O|O
Counter (setup)
O olololo|o|o|m|m| x| x| x| x|o|ololo|o|o
Data Register
B olololo|o|o|m|m| x| x| x| x|o|ololo|o|o
File Register
R olololololo|m|m| x| x| x| x|o|o|o|o|o|o
Joint Register
2 1olololololo|m|m| x| x| x| x|o|o|olo]|o|o
Special Register
W olololo|o|o|m|m| x| x| x| x|o|ololo|o|o
Link Register
- olololo|o|o|n|m| x| x| x| x|o|o|olo]|o|o
System Area
R Joint Register isonly for FA-M3.

B Yokogawa M & C UT 100 Series

. After conversion
Device -
D Register d LS
Before D Register d O O
conversion LS Area Q Q
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B Yamatake Yamatake SDC SeriessDM C10

After Conversion
Data LS
s Data Q o
q-) - -—
s 2
T S LS
o S Q O
O |System Area

B Rika Kohgyou CB/SR-Mini Series

B Rika Kohgyou CB/REX-F/LE100 Series

APPENDICES

After Conversion

0000 to 02EE LS
Before 0000 to 02EE Q o)
Conversion LS o) o)

After Conversion
CB | REX| LE | LS
CB ©) ©) o o
Before REX| O o Q @)
Conversion LE o o o o
LS ©) o o o

B Omron THERMAC NEO Controller

After Conversion

Appendix -24

Before
Conversion

Co | C1| C3 A LS
Co o o o o o
C1 o Q Q Q O
C3 o o o o o
A Q o Q Q Q
LS o o Q Q O
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B Shinkoh Technos C/FC/FIR/GC/FCL/PC-900 Series

After Conversion
- S C LS
-------- Q Q Q Q
Before Seting Value Memory Q Q Q Q
Conversion Channel QO Q @) Q
LS Area LS @) O Q Q

B Fenwal Controls of Japan Temperature Controller AL Series

After Conversion

All Devices LS

Before All Devices Q Q
Conversion LSLASrea o) ®)

B JT Engineering Moisture Meter JE-70 Series

After Conversion
M D R LS
M O O O O
Before D Q Q Q Q
Conversion R @) @) @) @)
LS Area
LS O O O O

B Fuji Electric FRENICS, FVR Series

After Conversion
FITE|[C|[PJH|[AJo]S][M]LS
Fundamental
Function OO0 |0O0|0]|]0]0]10]10]|0
F
Term|naIEFunct|on Q|1 Ol OOl O]l O0]1O0OlOolOol1O] 0O
Controlgunctlon Q|lO|O|lO|lOo|lOolo]Oo|lO]|O
c
o M 1
: og)r olo|lolo|lolo|lol|lolo]|o
> = :
é ngh-leveLlFunctlon olololololololololo
g Motor 2
5 « Q|O0|O|O|O|O|O|O|O|O
m .
Op(t)lon ololol|lolololololo]|o
D
Commasnd ata olololololololololo
Mon|t|c\>/|r Data olololololololololo
S A
ystelinS rea Ololo|lo|lO|lO|lO|lO]lO]|O

LT Editor \r. 2.0 Operation Manual - Screen Creation Guide Appendix -25



Appendix 3 - Address Conversion Tables

B Fuji Electric Micro Controller X

Before Conversion

After Conversion

0 1]30)40]31] 41
0 H| E|(E (B H N
1 B{O[O]O[O]O
30 B|O|O[O[O]O
40 H|O|O[O0]0]0
31 B|O|O[O]OQ]0O
41 B|O|O[O[O]O

LS Area

LS - ONNORNORNORNG

B Mitsubishi Electric MEL SEC-F2

Appendix -26
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After Conversion
XY | N]|S |TTCTS |CICCICS LS
X (N BN BN | [ ] [ ] [ ]
Input Relay
Y
[ N BN BN [ ] [ [
Output Relay
M
S | AuxiliaryRelay, | ® | @ | @ | = [ [ | [ |
k) Keep Relay
o S
[ N BN BN [ ] [ [
s State
O
o T/T.C/TS N BN BN | @) @) [ ]
) Timer
()
3 Ci/ccCicS mlmlmlm o o -
Counter
D
.  HN BN BN
Data Register * * Q
LS
[ N BN BN
System Area * ¢ Q
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D

CSI/CN

*
*

Appendix 3 - Address Conversion Tables
TSITN

*
L 4
©)
O

*
L 2

After Conversion

S

After Conversion

OO0 |10 ]0O
OO0 |00

Q|0 |0 |0
Q|0 |0 |0
L IR JNIR 2RI 2
* |6 & o

OO0 |10 |0
OO0 |0 |0

Input Relay
Output Relay

M
Internal Relay
S
Step Relay
TS/TN
Timer
CSICN
Counter

LS

100_( 110_] 120_{300_[1020 | SSV|END| ST | SOK | SWZ| SWT|SON[ SOF|SRN |SEQO| LS

Data Register
System Area

UOISISAUOD 9.0Jag

10

QOO0 ]10[O[Q]|0]0|0[O0|0]10]19[9]90]19]19O
QO[O |O[Q]Q[Q|Q|O|Q|Q[Q]Q0[Q|OQ|O]Q]|Q
QO[O |O[Q]Q[Q|Q|O|Q|Q[Q]Q0[Q|OQ|O]Q]|Q
QOO0 ]1O[Q[Q|Q]Q0|Q[Q|O]|]0]Q0[Q0]0O0]|90]9O
QOO0 ]O[O[Q|0Q]Q0|QO[O|O0]|10]90[Q0|0]|9]9O
QOO0 ]10[O[Q]|0]0|0[O0|0]10]19[9]90]19]19O
QO[O |O[Q]Q[Q|Q|O|Q|Q[Q]Q0[O0]|Q0|O]Q]|Q

B Mitsubishi Electric MEL SEC-FX

APPENDICES

00

QOO0 QO[O[Q|Q]Q0|Q[Q|O]|10]O[Q]0O0]|0]9O

110_

10
120

100

B TohoElectronicsTTM Series

00

300
1020

ssvo[o]o]oo|olololofo]o]oolololo]o]0
e[ o[o|ofo]o]o]o|olololo]o]o]olo]o]o]0o
STl

sk|o[o]o]o]o|o]o]olo]o]o]o]ololo]o]o]0
wo[o]o]o|o|o]o]o|o]o]o]olololo]o]0o]0
wo[o[o]o]o|olololofo]o]oolololo]o]0
son[o|o|olololofo]o]o]ololololo]a]a]a]a

SOF
SRN

UOISISAUO0D ©10Jag
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QOO0 QO[O[Q|Q]Q0|QO[Q|O]0]Q0[Q]O0]|90]9O
QOO0 ]O[O[Q|0Q]Q0|O[O|O]|0]0[Q0]0]9]9O
QO[O O[Q]OQ[Q]|Q|O|Q|Q[Q]Q[Q]|Q]|O]Q]|Q

LS

SEOIOQ[Q|0|O|O[O[0|Q0|0|0|O0|0[0|0|0]0]0]|0
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B SHIMADEN SR253/SR90/SR80/M R13/FP93/SD16/EM 70 Series

After Conversion
Data Address LS Area
Before Data Address Q Q
Conversion LS Area O o)

B Matsushita Electric Industrial MINAS-A/S Series

After Conversion

All Devices LS

Before All Devices Q Q
Conversion LSLASrea 0 o

B Yasukawa Electric G7/F7 Seriesand VS mini V7/J7 Series Vari-
able-Speed Inverter (Varispeed)

After Conversion
BR —_— LS
Bit Register
BR a Q
Before Register o
Conversion —_—
LS Area

LS @] Q
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m Software Trouble Report

B When problems continue after following “ Troubleshooting” advice
If following the steps outlined in the troubleshooting section does not solve your
problem, please make a copy of the next page's Software Trouble Report, fill in any
relevant information, and fax it to your local Pro-face service center.
Please include any relevant details, including project data and/or screens so that the
problem can be duplicated. We guarantee all this datawill remain confidential.
Also, please take the time to use the * OSCHECK” tool installed with your LT Editor
software, and include a printout of its result with your fax.

Using the “OSCHECK” Program

This program, after it completesits test, produces atext file (*.txt). Please be sureto
print out this data and include it with your Software Trouble Report.

1) Click on the Windows main screen’s [ Start] button and then on the [Run] selec-
tion.

2) Here, use the [Browse] feature to find the OSCHECK .EXE program, located in
your PC's“LT Editor” folder. Onceyou find it, click on [ OK ] to start the program.

3) Designate the status report’s Save folder and filename. Click againon [ OK ] and
the text file will be created.

« When inquiring, be sure to write down your software’s serial
| No. Without your software’s serial No., your question(s) can-

Important not be answered.
e Understand that it may take some time for us to respond, since
your question must be carefully checked and recreated.

Pro-face FAX and Email Information:
* Pro-face Europe FAX No. +31-(0)20-6464-358 Email: support@proface.com

* Pro-FaceKorea: FAX No. +82-(0)2-3664-6839 Email: proface@proface.co.kr
* Pro-Face Taiwan: FAX No. +886-(0)2-8773-7892 Email: proface@proface.com.tw

* Pro-face America (North and South): FAX No. +1-630-351-1102
Email: support@profaceamericacom

Digital (Japan) FAX and Email Information:
« Digital Electronics Corporaion: FAX No. +81-6-6613-5982 Email: support@digitd.co.jp

Also, if you require instruction about the correct usage of your LT Editor software,
please use the above information to contact your local LT Editor distributor.
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Appendix 4 - Software Trouble Report APPENDICES

Date:
Software Trouble Report | | namber of pages

Company name Department TEL
Your name FAX
Company Address

SoftwareSeridNo.| | | | | | | [ |
* We cannot respond to any questions without your software’s serial number.
Software name : LT Editor ( ) Other ( )

Ver. ( )

Your LT mode!: Type of Device/PLC:

PC: Manufacturer: Model:

Printer Manufacturer: ( ) Modedl: ( )
Driver version: ( )

Describe the details and how to reproduce each problem. Also, please include alist of any
related documents. Prepare one report sheet for each problem.

Error message details:

(Thisareaisfor Pro-face use only) Processed by| Received by
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